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Summary 
Light microscopy has enabled biologists to visualize life with unprecedented resolution, 

however, super-resolution microscopy was not able to reach a resolution at the single-protein 

level until recently. Due to the relatively new technology developments in the field and 

especially to the emergence and implementation of DNA-PAINT, localization precisions in the 

size range of single fluorophore molecules have been reported1. Additionally, the 

programmable nature of DNA probes, which encode the molecular identity of a target, has 

enabled to perform multiplexing without being limited by the properties of fluorophores2. The 

third major advance using this technology is to count single biomolecules3.  

However, in order to apply this impressive technological development within a cellular context, 

it is of utmost importance to attach the DNA docking site to the target under investigation via 

labeling probes4. Different labeling strategies were explored during the course of the thesis, 

ranging from NHS ester and maleimide chemistry to attach DNA strands to antibodies, 

nanobodies and Affimers, to genetically encoded tags, including SNAP- or HaloTags. To 

evaluate the performance of the binders and their capability to resolve artificially templated 

nanopatterns, a DNA origami based labeling platform was developed. 

 

The high affinity reagents were then applied in a vast variety of different internal and 

collaborative research projects which harnessed different properties and advantages of DNA-

PAINT super-resolution microscopy, with the goal to advance the technique to single protein 

imaging. For example, we were able to measure the 12 nm distance separation of two 

structural NUP96 proteins within the nuclear pore complex. Additionally, we demonstrated the 

existence of a triple molecular complex within the densely packed focal adhesion structure 

consisting of activated b1 integrin, talin-1 and kindlin-2.  

 

Data analysis plays an important role in super-resolution microscopy to dissect protein 

organization and colocalization. In the last part of this thesis, an analysis pipeline was 

developed to detect single sites and simulations were performed to analyze complex formation 

under reduced labeling efficiency conditions.  
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1 Introduction 
 

1.1 Microscopy 
With the invention and application of highly precise lenses for microscopy apparatus, Antoni 

van Leeuwenhoek had a close look on the microworld already in the 17th century and was 

able to discover bacteria, analyzed sperm cells and observed the typical banded architecture 

of muscle fibers5. Since the significant advances in lens production and microscopy designs 

later advanced by Fraunhofer and Carl Zeiss, microscopes became a standard tool for 

biologists to dissect biological specimen6,7. In particular, they helped to understand the 

distribution of biomolecules, their trafficking8 as well as their molecular mechanisms of action. 

Many different mechanisms have been elucidated so far using microscopy approaches, 

ranging from isolated protein systems and in vitro reconstitution assays9 to animal studies10. 

 

However, in order to visualize those biomolecules and determine their molecular identity, 

fluorescent markers are necessary. In fluorescence microscopy, electrons of a fluorophore 

molecule can absorb photon energy from a laser light source and are excited from the ground 

state S0, to a higher energy state S1. Once the electrons return back into their energetic ground 

state, a photon with lower energy and higher wavelength is emitted. The shift in wavelength 

is called Stokes shift11. However, the electrons can also loose energy via vibrational relaxation 

and would not emit any photons during this process. The different processes occuring when 

electrons absorb light to reach a higher energy level can be depicted in a Jablonski diagram 

(Figure 1)12. Electrons can also converse into a triplet or a dark state T1 from their higher 

energy level, where they can reside longer and do not emit any photons upon returning back 

to the ground state S0. The requirement that a molecule can emit fluorescence depends on 

the electrons in the outer orbitals. In double bonds, the energy difference between the excited 

state and the ground state is lower, which enables electrons to change from the ground state 

to the excited state by absorbing light energy. Heterocyclic compound molecules harbor a 

multitude of double bonds and are therefore particularly suited as fluorophore agents13. These 

agents can be derived from small molecule scaffolds, for example from the cyanine family14,15. 

One major parameter important for the quality of a fluorophore is the quantum yield, which 

describes the percentage of absorbed photons necessary to yield in a fluorescent event.  
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Figure 1: Jablonski diagram. Electrons reside in a ground state S0 from which they can be excited to an 
activated energy state S1 by absorbing the energy of photons. Within the different levels of the excited 
state, they are able to undergo vibrational coupling and can return into a lower energy state in S1 or 
converse into a triplet or dark state T1. From there, electrons can return back into the ground state S0 
without emitting a photon. They can also return back from the excited state into the ground state and 
emit a photon with higher wavelength then previously absorbed. This shift in wavelength is called the 
Stokes shift and the process is called fluorescence. 

In order to dissect cell biological systems, these fluorescent molecules need to be brought to 

their target under investigation. There are two basic strategies of how this can be achieved. 

First, the biomolecule of interest can be tagged via a genetically encoded protein, which 

directly has or can be modified with a small molecule ligand to have fluorescent properties. 

Second, a high-affinity reagent against the protein of interest can be labeled with a fluorophore 

and added to the cell after fixation. The green fluorescent protein (GFP), as an example for 

the first case, was discovered by Osamu Shimomura in the jellyfish aequorea victoria16 and 

later engineered and applied to cell biological research by Roger Tsien17. GFP is a protein, 

which is 27 kDa in size and consists of a cylindrical beta barrel fold, harboring a chromophoric 

region in the center18. The basic discovery of the green fluorescent protein has led to countless 

variants with a variety of fluorescent properties within the visible light spectrum, for example 

mCherry19 or mNeonGreen20. Additionally, fluorescence encoded in those protein structures 

has proven particularly useful and led to a large variety of different applications, ranging from 

the analysis of protein trafficking21 to the tracing of neurons in whole brains22. For their 

groundbreaking work on the discovery and development of GFP, Tsien, Shimomura and 

Chalfie received the nobel prize in chemistry in 2008.  

Antibody-based reagents, which are an example for the second category, exploit the unique 

capability of the immune system of animals including donkeys, rabbits, goats or mice, to 
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produce high-affinity binders after several rounds of vaccination with the target protein of 

interest23. 

These high affinity reagents, can be extracted from the serum of the animals via affinity 

purification24. The antibodies are then labeled covalently with small organic fluorophores via 

available chemical residues for use in fluorescence microscopy. Labeling probes and covalent 

attachment strategies will be described in more detail in the chapters 1.7 and 1.8. In the next 

chapters we will first discuss the basics of microscopy and super-resolution. 

 

1.2 Microscopy Methods and Setup Types 
Different microscopy setup types exist and are suitable for different applications. The basic 

design consists of an epi-fluorescence setup, detailed in Figure 2a25. In this specific setup, a 

laser beam is coupled into the objective via a dichroic-mirror. Upon excitation of the sample, 

the emission light harboring a longer wavelength is collected via the objective and guided 

through the dichroic mirror to reach an array detector, e.g. a camera. However, for single 

molecule applications, where it is most important to achieve a high signal-to-noise ratio and 

which are therefore sensitive to background light, total internal reflection fluorescence 

microscopy (TIRF) was implemented to only excite fluorophores close to the surface26. In TIRF 

microscopy, the laser excitation beam creates an exponentially decaying evanescent 

electromagnetic field in the sample after being totally reflected at the coverglass-water 

interface27, which is depicted in Figure 2b. The total reflection usually takes place if the laser 

reaches the glass at an angle larger than the critical angle, which depends on the refractive 

index of the glass n1 as well as the refractive index of the water/cell side n2 and can be 

calculated with following formula: 

 

𝑎𝑟𝑐sin	(𝜃+,-.-+/0) =
𝑛4
𝑛5

 

 

For a typically used borosilicate glass in microscopy with a refractive index n1 of 1.52 and n2 

of 1.33 for water, the critical angle can be calculated to 61.04°.  

The evanescent wave along the glass-water interface can only penetrate ~100-200 nm into 

the sample. Therefore, only fluorophore molecules at the bottom of the glass coverslip are 

excited, which reduces the background from undesired excitation taking place deeper in the 

sample and ultimately increases the signal to noise ratio. The decay of the evanescent wave 

follows an exponential distribution and the depth can be described as: 
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𝑑 =	
𝜆

4𝜋:𝑛54𝑠𝑖𝑛4(𝜃) − 𝑛44
 

 

Deducing from this formula, the depth of the evanescent field depends on the incident angle 

of the laser beam, the refractive indices as well as the used wavelength l27. For wavelengths 

at 640 nm, 561 nm or 488 nm under an incident angle of 66°, the calculated penetration depths 

would be 127.6 nm, 111.9 nm and 97.3 nm respectively. One disadvantage of using this 

method is that structures located deeper within the cell are difficult to investigate. In order to 

image deeper, the TIRF principle can be modified to a highly inclined and laminated optical 

sheet (HILO), where the laser beam is highly inclined, creating an optical sheet through the 

sample28.   

 

 
Figure 2: Basic microscopy setup design and total internal reflection fluorescence. a) A basic 
microscope uses a laser to excite the fluorophores. This laser beam is guided via a dichroic mirror into 
the objective, where it excites the fluorophores in the sample. The fluorescence emission, which carries 
a longer wavelength, travels through the dichroic mirror and is detected on the camera where the image 
is displayed. b) In TIRF microscopy, the laser beam is totally reflected on the glass slide and creates 
an evanescent excitatory wave, which travels only ~100-200 nm into the sample for excitation. 
Fluorophores located deeper in the sample are not excited and therefore cannot be detected anymore. 

Ernst Abbe, a German Mathematician, developed in the 19th century a theory for the 

resolution limit of microscopy setups. Resolution of an imaging system can be defined as the 

distance at which two lines can be visualized as two separate entities29. According to Abbe, 

this can be described using following formula: 

 

𝑑 =
𝜆

2 ∗ 𝑁𝐴
 

 

In contrast, Rayleigh defined a microscopy image as consisting of point like emitters30, due to 

the wave nature of light and the process of diffraction and interference at interfaces. The 

resolution was described as the distance at which two spots can still be resolved following: 
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𝑑 =
1.22 ∗ 𝜆
2 ∗ 𝑁𝐴

 

 

The resolution therefore depends on the emitted wavelength l and the numerical aperture of 

the used objective. Assuming a short wavelength of 488 nm and a high-numerical aperture 

objective of 1.49, a maximal resolution of approximately 200 nm can be achieved. 

Unfortunately, biomolecules are on the order of several nanometers, which is 1-2 orders of 

magnitude below this resolution limit. Therefore, there was a need to develop super-resolution 

microscopy methods to circumvent this fundamental resolution limit, which is detailed in the 

next chapter. 

 

1.3 Super-Resolution Microscopy 
Several super-resolution microscopy methods have been developed to circumvent the 

fundamental resolution limit proposed by Abbe. The initial concepts were proposed in the 

1990s, with experimental proofs in the late 90s and 2000s31,32. They all engineer the states of 

fluorophores within a diffraction limited spot using different technical implementations. 

Stimulated emission depletion microscopy (STED) depletes the ground state of the 

fluorophores in the periphery of the excitation32-34. This depletion is performed using a ring-

shaped laser beam aligned around a central excitation beam. The molecules in the periphery 

of the excitation are switched off, whereas in the center, where a minimum of the depletion 

laser resides, the fluorescence of the molecules can be read out. Identically to a confocal 

microscope setup, the two aligned beams scan the whole sample area to acquire a full image. 

The achievable resolution of this super-resolution microscopy technique can be described 

using the following formula: 

 

∆𝑥 =
𝜆

2 ∗ 𝑁𝐴 ∗ F1 + 𝐼IJKL𝐼IMJ

 

 

In this respect, the achievable localization precision in STED inversely scales with the intensity 

of the STED laser (ISTED).  

 

In contrast to that, single molecule localization microscopy (SMLM) uses the stochastic 

switching of fluorescent molecules from a fluorescence emitting state into a dark state, so that 

in a diffraction limited spot only a single emitter is detected at a timepoint t31. In comparison to 

the previously mentioned STED example, where the beams scan the field of view and only 
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excite/deplete molecules at their current position, a full field of view is excited and multiple 

emitters are detected on the camera at the same time. The detected spots are fitted with a 

centroid estimation to find the center position of the molecule with high precision. The 

localization precision and therefore the resolution is inversely proportional to the square root 

of the detected photons35:  

 

△ 𝑥 ≈
1
√𝑁

 

 

The key to perform SMLM is to switch fluorophores from an off-state into an on-state and vice-

versa. Up to this point, different strategies were implemented to achieve this switching of 

states, which are detailed in chapter 1.4. 

Recently, a new super-resolution technique was proposed, combining targeted readout of the 

fluorophore position, like in STED, with the stochastic switching of fluorophores as 

implemented in SMLM. This new technique was termed MINFLUX36,37, and uses a ring-shaped 

excitation pattern to find the local minimum of excitation by only probing four different positions 

with fast optical positioning components. This enables high resolution on microsecond 

timescales, with the use of only a minimal of photons. The three described methods for super-

resolution microscopy are depicted in Figure 3.  

 

 
Figure 3: Basic super-resolution microscopy strategies. a) In STED microscopy, the ring-shaped 
depletion laser depletes the fluorescence from the surrounding molecules. Fluorophores within the inner 
circle are still excited and can be read-out. b) Single-Molecule Localization Microscopy: Fluorophores 
are stochastically switched on and off, so that fluorophores in the on-state can be separately detected 
on the camera. c) MINFLUX concept: combination of stochastic switching and targeted nanoscopy. The 
readout only takes place in the targeted spot. Adapted from [38]. 
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1.4 Single-Molecule Localization Microscopy 
The concept of single-molecule localization microscopy was first proposed by Eric Betzig in 

199531. The basic principle of SMLM is, that at a timepoint t, only one fluorophore is detected 

on the camera within a diffraction limited spot. The center positions of these spots are 

determined using a fitting procedure35,39, for example, using least-square estimations. Over 

the time course of the acquisition, all available fluorophores are sampled and a list of x, y and 

z-coordinates of the positions is generated from which the final super-resolution image can be 

reconstructed. The workflow of SMLM imaging is depicted in Figure 4. The main challenge for 

implementing SMLM is making the fluorophores switch from an on- to an off- state and vice 

versa40. 

 

 
Figure 4: Single Molecule Localization Microscopy. a) In single molecule localization microscopy, spots 
from single fluorophores are detected on a camera over a time course and a stack of images is 
generated. b) During the analysis, the spots are detected and fitted with a least square estimation. The 
quality of the fit, the localization precision, is inversely proportional to the square root of the detected 
photons. c) All important parameters of the fit for each spot/localization are noted in a table, e.g. when 
the spot was detected (Time), the exact position and the number of photons. d) From the list of spots, 
the final super-resolution image can be reconstructed. 

Different implementations of single-molecule localization microscopy have been introduced. 

The first one to mention is PALM (Photo-activated localization microscopy)41, which uses 

fluorescent proteins that are first switched off, then activated by a brief 405 nm laser pulse. 

After activation they emit photons and their position can be determined on the camera until 

they are bleached. Repeated activations using the 405 nm laser will switch a subset of 

fluorescent proteins into a fluorescence emitting state. These cycles are repeated until all 
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fluorescent proteins are bleached or until enough sampling of the positions was achieved. The 

second approach is  STORM42 or dSTORM43, which uses organic dyes, that can also be 

brought into a dark state and re-activated by UV laser (405 nm) excitation. However, optimized 

buffer conditions, allowing the fluorophore to be switched off and reactivated need to be 

established44. PAINT (Point-Accumulation in Nanoscale Topography)45, as a final class of 

SMLM, induces the stochastic switching of the fluorophores in an entirely different fashion. 

Freely diffusing probes from solution interact with their target and upon immobilization at the 

target site, their residence time becomes larger than the frame length of the acquisition and 

the fluorophore can be detected as a spot on the camera. In contrast, when the molecules 

diffuse in solution, their residence time in one pixel of the camera is smaller than the frame 

length and therefore the signal to noise ratio is too low in order to detect the molecule. In its 

original implementation, the molecules were immobilized in a membrane upon interaction and 

bleached after a certain time. This was extended by the concept of universal PAINT, in which 

a fluorophore labeled ligand of a receptor was used as a PAINT probe, that interacts with its 

corresponding receptor and is bleached after the fluorophore’s photon budget is exhausted46. 

However, there are also more novel approaches which use the concept of transient 

interactions, such as in DNA-PAINT47,48 or with IRIS probes49. DNA-PAINT uses short DNA-

labeled oligonucleotides (~7-10 bp) which transiently interact with their complementary target 

sequence to create the necessary stochastic on- and off-states. DNA-PAINT, which is the 

major method used in this thesis, will be explained in more detail in chapter 1.6. In contrast, 

IRIS probes take advantage of naturally occurring transient interactions of proteins. 

Investigating protein interaction networks carefully allows to deduct protein fragments which 

can be used as fluorophore labeled transient binders to perform the stochastic switching 

between an on- and an off- state. 

 

3D single molecule localization microscopy can be achieved by introducing an astigmatism in 

the beam path50. By placing a cylindrical lens just before the camera, the point spread function 

detected on the camera changes its shape according to the position of the fluorophore emitter 

with respect to the focal plane of the objective. If the emitter is in the focal plane, the detected 

signal of a spot on the camera is circular. Whereas if the emitter resides above or below the 

focal plane of the objective, the detected spot becomes elliptical, with the minor half-axis 

pointing towards the horizontal or in the vertical direction. Measuring the ellipticity of the point 

spread function at defined distances from the objectives focal plane, e.g. by using 

fluorescence beads and positioning them accurately via a piezo stage, enables the acquisition 

of a calibration curve which can be used as reference for the final sample acquisition. Figure 

5 describes the concept of introducing the astigmatism for point spread function shaping and 

3D imaging in more detail.  
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Figure 5: 3D single molecule localization microscopy with astigmatism. a) A cylindrical lens is inserted 
into the beam path and depending on the position of the fluorescence emitter with respect to the focal 
plane of the objective, the detected point spread function on the camera turns the minor semi-axis of 
the ellipse to the vertical direction (above the focal plane) or in the horizontal direction (below the focal 
plane). b) Fitting the width of the ellipse for the distinct distance from the objectives focal plane, a 
calibration curve can be generated and subsequently compared to the final sample acquisitions. From 
[50]. Reprinted with permission from AAAS. 

Beyond this easy to implement astigmatism lens approach, several efforts have been made 

to advance the 3D resolution capabilities of super-resolution implementations, such as 4Pi 

microscopy51,52 or super-critical angle 3D imaging53. 

 

The main challenges in the field, besides achieving high resolution, is also to detect multiple 

single species of proteins and map their interaction pattern in space. This requires not only a 

method that can achieve resolutions on the order of single proteins (<= 5-10 nm) but also the 

detection of multiple protein species and counting of the involved biomolecules. However, in 

order to assay if the super-resolution microscopy method can deliver on the above-mentioned 

requirements, it is essential to have a reliable reference standard for imaging. Known 

biological standards in the super-resolution community have mainly included the 

measurement of microtubule filament size54 or the symmetric arrangement of nuclear pore 

proteins55. Besides these biological reference structures, it is important to have a flexible tool 

that can be used as a universal reference standard and that can adapt to meet the resolution 

demands. DNA nanostructures provide excellent properties as a universal tool for super-

resolution imaging, which will be discussed in the next chapter56,57.  
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1.5 DNA Nanotechnology as standard for microscopy 
DNA is the building material of the genetic code. It consists of 4 different bases, adenine (A), 

guanine (G), thymine (T) and cytosine (C) which can form base pairs through two hydrogen 

bonds between A and T and three hydrogen bonds between G and C. Additionally, one base 

molecule consists of two different modules, the sugar phosphate backbone and the base. Due 

to the Watson-Crick base pairing, DNA forms a double-helical arrangement, which turns every 

10.5 base pairs58. The double helical structure is connected by the hydrogen bonding network 

between the bases and the base stacking interaction contributes additionally to its stability59. 

The basic structural units of DNA are depicted in Figure 6a. Due to its unique structural 

features, DNA can be used as a building material for nanoscale arrangement of elements. 

Ned Seemann first proposed to use crossover junctions and the base pairing of DNA to build 

nanoscale patterns of proteins to improve crystallization60. After initial proof of concepts with 

different structures61, for example cages62, this concept was expanded to the scaffolded DNA 

origami technique by Paul Rothemund in 200663.  

To assemble DNA origami structures, a single stranded scaffold strand, derived from 

M13mp18 phage (~7k bases long), is pooled together with short DNA oligonucleotides in the 

size range of 32-60 bases. The short DNA oligonucleotides, also called staple strands, are 

designed using freely available software packages, such as cadnano33 or Daedalus34 to form 

base pairs with the scaffold to mediate the folding process. With the addition of magnesium in 

the buffer, the oligonucleotides together with the DNA scaffold self-assemble into the 

preprogrammed two- or three-dimensional shape of interest during the course of a thermal 

annealing protocol, typically ranging from 80 °C to 4 °C. Since 2006, structural DNA 

nanotechnology was extended to different lattices64-66, to 3D curved and bended shapes67 and 

even to larger structural assemblies in the gigadalton range68. 

The ability to be able to fold structures in the size-range of viruses with 5 nm addressability 

opens up exciting new avenues for applications, where nanoscale spacing plays an important 

role, which is depicted in Figure 6b. Different applications were developed, using DNA 

nanostructures as tools to study biophysics, such as motor proteins69, to engineer more 

efficient enzyme cascades by spatial proximity70 or to template biomolecules for signaling 

studies71. However, one of the most promising applications is its use as a universal reference 

standard for microscopy, where fluorophores can be attached to any position. In this way the 

microscopy method can be evaluated on a standardized sample, templated with different 

fluorophore distances56,72.  
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Figure 6: DNA Nanotechnology and its applications. a) The basic building block of DNA are its bases, 
guanine and cytosine, which form three hydrogen bonds and thymine and adenine, which form two 
hydrogen bonds. The DNA is connected through a sugar-phosphate backbone via the 5’ and the 3’ 
carbon atoms of the deoxyribose. The overall structure of the DNA consists of a double helical 
arrangement which is ~2 nm in diameter and rises ~0.335 nm per base with approximately 10.5 
bases/turn. b) Due to the programmability of the bases, DNA can be used as a building material to form 
nanostructures. These structures can be functionalized with any guest molecule of interest, such as 
fluorophores (red dots), gold particles (yellow) or proteins (green) with 5 nm addressability. Adapted 
from [73]. 

1.6 DNA-PAINT 
In DNA-PAINT, a modification of the single molecule localization-based microscopy variant of 

PAINT45, fluorophore-labeled short oligonucleotides are used, which transiently hybridize to 

their complementary DNA strands on the target of interest to create the typically observed 

blinking behavior in SMLM47. The programmable DNA sequence (adenine base-pairs with 

thymine and cytosine base-pairs with guanine) with the hydrogen bonding network between 

the base-pairs stabilizes the interaction for an extended period of time so that the residence 

time of the fluorophore-labeled DNA strand at one position is larger than the camera readout 

frame rate. These binding events are detected as a spot on the camera during the course of 

acquisition. 

Since the transient and repetitive interaction of the fluorophore labeled oligonucleotide with its 

immobilized complementary strand is only encoded in the DNA sequence and does not need 

the complex engineering of fluorophores, the brightest obtainable dye can be chosen in order 

to extract all the photons from a single binding event. Additionally, the repetitive and reversible 

interaction enables to obtain in principle unlimited photons per single site. This enables super-

resolution imaging with resolutions down to 5 nm as was demonstrated on DNA 

nanostructures1,74. 

 

The programmable nature of DNA encodes the molecular identity of the target which allows 

to DNA-barcode biomolecules. One major challenge in fluorescence microscopy is that most 
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multiplexing relies on the microscopy setup in terms of available laser lines and optical filter 

sets. In DNA-PAINT this can be completely circumvented by only using the DNA sequence as 

a barcode, without the need to change the fluorophore. This is advantageous for multiplexing 

applications as it avoids any chromatic aberrations or performance differences from using 

different fluorophores. Since the whole DNA interaction process is of transient nature, the 

fluorophore labeled DNA strands can be washed away in a flow channel and substituted with 

new imager solution harboring a different DNA sequence for a new target. Exploring the whole 

sequence space of DNA base-pairing of 8-10 nucleotides2,4 enables for almost unlimited 

multiplexing. DNA encoded multiplexing was shown to be a powerful tool, not only for DNA-

PAINT super-resolution microscopy but also as a universal approach for different imaging 

modalities, such as STED75, STORM76 or even diffraction limited confocal microscopy77. 

 

The last challenge that DNA-PAINT tackles is how to accurately predict protein copy numbers. 

Different approaches where previously reported, such as intensity calibrations78, PALM 

counting79 or counting of blinking events80. However, due to the replenishment of fluorophores 

from solution in DNA-PAINT, the process is highly predictable and molecular numbers can be 

extracted from the frequency of binding3. The association process of the imager strand can 

be described as a second order kinetic model: 

 

[𝑐-] + [𝑐S]
𝑘UV
⇄
𝑘UXX

[𝑐-𝑐S] 

 

Ci and cd describe the concentration of the imager strand and the docking site respectively. 

The bright time 𝜏Z, in which the imager strand is bound to its complementary docking site, as 

well as the dark time 𝜏S, in which the docking strand is not occupied, can be explained by 

following formulae: 

 

𝜏Z =
1

𝑘UXX
 

 

𝜏S =
1

𝑘UV ∗ 𝑐-
 

 

The mean dark time 𝜏Sand the mean bright time 𝜏Z can be extracted directly from the 

experiment by analyzing the repetitive visits (length of interaction as well as event free time) 

of the imager strand to its complementary single docking site: koff as the inverse of the bright 

time and kon from a linear fit of the inverse mean dark time at different known imager 
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oligonucleotide concentrations can be inferred from these values. Typical values for a 9 nt 

interaction at 20 °C and 600 mM NaCl are for kon =  2.3 ∗ 10] 5
^∗_

  and for koff = 1.6	
5
_
.47 

For an imager concentration of 1 nM, a single docking site would be visited every ~435 

seconds, for an imager concentration of 10 nM, the single docking site would be visited every 

~43 seconds. As single visits of docking sites are assumed to be independent events, two 

docking sites would be visited every ~218 seconds at a concentration of 1 nM. This 

relationship can be used to count the absolute number of molecules in an area of interest3. 

 

The three major advantages of DNA-PAINT are all derived from the programmable nature of 

the DNA, which decouples the blinking properties from the fluorophore, enabling highest 

resolution, decouples the molecular identity from the dye molecule, enabling highly 

multiplexed target detection and the predictable repetitive nature of the interaction, enabling 

quantitative counting of target sites. These advantages and the basic principle of DNA-PAINT 

are summarized in Figure 7. 
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Figure 7: DNA-PAINT overview. a) DNA-PAINT uses the transient hybridization of fluorophore labeled 
DNA-strands to create the typical blinking pattern observed in SMLM. If the imager strands are diffusing 
in solution, no signal on the camera is detected, however once they bind to the docking strand a signal 
is detected. As the binding and unbinding is a very dynamic process, this process is completely 
reversible. b) The blinking behavior is only engineered by the DNA sequence, therefore the brightest 
fluorophores can be chosen and very high resolutions on the order of 5 nm can be achieved. Here 
exemplary displayed as a DNA origami structure depicted with a Wyss logo. Scale bar: 10 nm. 
Reprinted by permission from Springer Nature, Nature Nanotechnology [1], 2016. c) Multiple rounds of 
imaging and washing cycles, introducing fluorophore labeled DNA strands with different sequences can 
be employed to image many different targets in the field of view. Here depicted as 10 different numbers 
on DNA origami and a 3-color cell sample. Reprinted by permission from Springer Nature, Nature 
Methods [2], 2014. d) Introducing a cylindrical lens into the beam path allows to acquire 3D images, 
here depicted as a 3D DNA origami tetrahedron with 100 nm side-lengths. From [81]. Reprinted with 
permission from AAAS. e) The predictable interaction of single docking strands to their complementary 
imager strands enables to count docking sites. As an example, three docking sites in one spot are 
visited three times more often than a single docking site3. 
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In order to apply the advantages of DNA-PAINT microscopy in cell biological research, 

labeling probes against the targets of interest need to be established. The following two 

chapters will briefly describe common labeling probes and strategies of how to equip them 

with DNA strands for use in DNA-PAINT super-resolution microscopy.  

 

1.7 Labeling probes for super-resolution microscopy 
Highly efficient small binders are essential for a super-resolution technique which enables to 

acquire images with a resolution below 5 nm48. The adaptive immune system developed 

strategies to produce highly efficient binders to fight foreign pathogens. Antibodies, which are 

produced from B cells can recognize epitopes on bacteria or viruses and direct them to 

destruction. Vaccinations, which use virally derived antigens in combination with immune 

activators stimulate the immune system to produce antibodies against the respective 

pathogen and therefore establish a protection from infections82. Custom antibodies can be 

produced by immunizing animals, such as donkeys, mice, rabbits, rats as typical animal 

species, using the immunogen derived from the target of interest83. Polyclonal antibodies are 

directly purified from the blood serum via affinity chromatography techniques, e.g. the antigen 

of interest is bound at a column and binds the available high affinity antibodies. Low pH 

washes elute the antibody from the column24, which can be subsequently fluorophore labeled 

and used for imaging studies. However, one major limitation with polyclonal antibodies is, that 

there is a multitude of reagents in solution with different properties, exhibiting higher or lower 

affinity or different epitope binding specificities. This is undesired in applications where 

absolute protein copy number counting is indispensable. To circumvent these issues, 

monoclonal antibodies can be used, which are produced from B-cell clones isolated from the 

circulating B-cell population and produce one specific type of antibody84.  

The perfect binder for a target of interest for super-resolution microscopy should be small, 

smaller than the size of the protein under investigation, should have high affinity, specificity 

and labeling efficiency to the target of interest, and it should be possible to label it with a single 

chemical component, such as a fluorophore or a DNA strand for quantitative super-resolution 

microscopy. To unravel the full potential of DNA-PAINT multiplexing, it should also be 

commonly available for multiple targets of interest. Unfortunately, antibodies lack a few before 

mentioned traits: they are not small and it is not straightforward to label them site-specifically 

with a single DNA strand or fluorophore.  

 

As an alternative to antibodies, sharks and camelids, like alpacas, developed a different 

toolbox for antibody-based binders. Their antibodies only consist of 2x heavy chains with a 15 
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kDa large epitope-binding domain. This binding domain can be isolated to have small, highly 

efficient affinity reagents and they are called nanobodies85,86. Nanobodies are easily produced 

in bacterial cell culture and can be modified with a single fluorophore or DNA moiety via 

cysteines87. It was shown that nanobodies can outperform antibodies in terms of label size, by 

measuring the microtubule diameter, which was closer to the ground truth known from electron 

microscopy studies, in comparison to an antibody-based measurement88. However, there is 

still a limited repertoire of nanobodies available for different targets.  

Many small protein binding scaffolds have emerged during recent years, such as darpins89, 

Affimers (formerly adhirons)90 or anticalines91. They have in common, that the binders can be 

selected via phage-display libraries and do not rely on immunization of animals. A great 

advantage is, that they can be easily modified for attachment of single or double chemical 

moieties of interest, as they can be expressed in E.coli or cell-free expression systems. These 

binders have all their specific strengths and disadvantages, one of the main points being their 

current relatively low availability for any protein target of interest. How these binders are 

evolved and characterized is detailed in the next two paragraphs.  

 

Phage-display libraries for selection of high affinity reagents 
Phage-display libraries are an important tool to find novel small binders for any target of 

interest and was awarded the nobel prize in chemistry in 2018. In phage-display, the binder 

of interest is directly attached to a coat protein on the surface of a bacteriophage. The phages 

usually encode a large library of binders and interact with the antigen of interest on a support. 

Unbound phages can be washed away and only tightly bound phages are left leading to an 

enrichment of high affinity reagents. Over several cycles of washing and adapting the phage 

display library, high affinity binders for the target of interest are enriched and can be genetically 

identified and isolated from the bacteriophages. Once these binders are identified, they need 

to be thoroughly tested for their performance92. The general schematics of phage display is 

depicted in Figure 8. 
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Figure 8: Phage Display schematics. Phages are able to present protein-based binders on their surface. 
Starting with a gene library, phages expressing binders on their surface interact with the antigen of 
interest on a solid support. Low affinity binders are washed away, whereas high affinity binders are 
enriched. The high-affinity binders are washed away under stringent (low pH, high salt) conditions and 
can be expanded in bacteria. The high-affinity binder sequence can then be identified. After several 
cycles of selection, mutation, gene library adaptation and selection, high-affinity reagents are enriched 
and selected for further use. 

 

Evaluating reagent performance 
An important parameter for the quality of the binder is its affinity to the target of interest. The 

kD value describes the concentration at which half of the molecules are bound to each other. 

KD values can be measured with surface plasmon resonance, where the antigen of interest is 

immobilized on the surface, and a surface plasmon is created via laser excitation, which is 

very sensitive to changes at the interface. Different concentrations of the binder of interest are 

flown over the surface and from the changes in the interaction, the kD values including the 

specific on- and off- rates of the binder can be inferred93. In contrast to that, microscale 

thermophoresis is an immobilization free technique. A fluorophore-labeled protein interacts 

with its potential ligand in a capillary and upon a temperature gradient diffuses different 

distances. The diffusion is highly dependent on the size of the protein and upon interaction 

and complex formation of the proteins decreases. Testing different ligand concentrations 

enables to deduct the kD values of two proteins94.  
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All these binders have in common, that they are modified with a chemical moiety for detection 

(fluorophore, DNA strand) and are added to the cell system under investigation after fixation.  

Besides externally applied affinity reagents, protein tags are commonly used. Protein tags are 

directly fused to the protein of interest on a genetic level and are expressed as part of the 

protein under investigation. Some of the most common representatives are fluorescent 

proteins, such as GFP18 or mCherry19. However, although fluorescent proteins showed 

exquisite performance and allowed to visualize many different processes in nature, their 

fluorophore properties are not always the most desired one for super-resolution applications 

in terms of blinking behavior or quantum yield and extinction coefficient. For this reason, some 

of these tags can be additionally targeted with nanobodies attached with the chemical moiety 

of desire. Besides the fluorescent protein tags, small self-labeling tags have been developed, 

with the well-known representatives of SNAP-95 or HaloTag96 fused to the target protein of 

interest. These protein tags, which are 20 kDa and 33 kDa in size, react with a small-molecule 

ligand (benzylguanine or chloroalkane respectively) to attach any chemical moiety of interest.  

There are also smaller peptide tags to intervene as little as possible with the function of the 

protein of interest. These small peptide tags mostly interact with an enzyme to catalyze a 

reaction in order to attach a chemical moiety of interest, most prominent are the sortase tag97, 

which uses a triple-glycine motif or the yBBR-tag98 which uses a co-enzyme A catalyzed 

reaction. Some newer development showed, that small peptide-based tags can also be used 

to bind nanobodies with high affinity. The ALFA-tag99 and the bivBC2-tag100,101 are examples 

of such systems, which provide high affinity nanobody-reagents to small peptide tags (<20 

aa). The smallest site possible however is to stain a single amino acid in a target protein under 

investigation. This can be achieved with modifying the genetic code in combination with a 

clickable unnatural amino acid. This was shown for DNA-PAINT with nuclear pores by the 

Lemke Lab102. To label proteins with unnatural amino acids the amber (TAG) stop codon is 

repurposed to bind to an additional tRNA. The additional tRNA combined with an additional 

tRNA synthetase need to be expressed in the cell together with the protein of interest with the 

repurposed stop-codon. The incorporated unnatural amino acid usually harbors a cyclooctyne 

derivative and can attach covalently to a tetrazine harboring chemical moiety of interest via 

strain-promoted inverse-electron-demand Diels-Alder cycloaddition103,104.  

An overview over available labeling strategies for immunolabeling is shown in Figure 9. All 

these methods require to add an externally applied binder, engineered to bind the target of 

interest, or an engineered cell-line harboring a tag at the protein under investigation to attach 

the chemical moiety of interest.  

Protein networks in cells are highly dynamic and highly specific transient interactions occur 

between many different proteins. One particularly elegant way, which was published in 2015 

was to harness the transient binding of protein domains to their complementary interaction 
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partners and perform super-resolution microscopy with it. These protein domains or peptides, 

modified with a fluorescent moiety can be directly used to visualize the protein in the cell with 

super-resolution microscopy49.  

 

 
Figure 9: Labeling probes. Labeling probes are used to stain cell samples. From left to right: Antibodies, 
GFP in complex with a GFP nanobody, HaloTag, SNAP-Tag, Affimer and Somamer. For DNA-PAINT 
microscopy, probes have to be labeled with a DNA docking strand as depicted with the GFP nanobody 
construct. Cartoons were made in Chimera105 using following pdb IDs. Antibody: 1IGT, GFP and GFP 
Nanobody: 3K1K, HaloTag: 4KAF, SNAPTAG: 3KZZ, Affimer: 4N6T, Somamer: 4HQU. 

 

Once the binders are characterized to have high affinity and specificity to the target protein 

under investigation, the desired chemical moiety, such as a fluorophore or, in case of DNA-

PAINT, a DNA strand need to be covalently attached in order to use them for the desired 

microscopy application.  

 

The next chapter will discuss how to attach a DNA strand to the binder of interest. 
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1.8 Labeling Chemistries 
There are different methods available to attach a chemical moiety, such as a fluorophore or a 

DNA strand covalently to the binder of interest. The presented methods mainly attach to a 

single amino acid residue. Amine-based labeling, which can attach to available primary 

amines, available for example at surface lysine residues or at the N-terminus of a protein, 

attaches via NHS-chemistry, which yields in a covalent amide bond formation and the release 

of the NHS molecule106. Usually bi-functional crosslinkers are used, which attach to the 

primary amines at the protein binder of interest and brings along a second reactive moiety in 

order to attach to the DNA strand. For example, in the case of NHS-chemistry, the crosslinker 

harbors an additional dibenzocyclooctyne, which can react via a strain promoted azide-alkyne 

cycloaddition (SPAAC) with an azide-modified DNA strand107. As an alternative for SPAAC, 

the trans-cyclooctene tetrazine ligation which is an inverse-electron-demand Diels-Alder 

reaction (IEDDA)108 can be used.  

 

One disadvantage of the first step in the reaction chain is that it is relatively unspecific as 

primary amines are relatively common on proteins and multiple sites can be targeted without 

control of exact stoichiometry. On small proteins, this can be tuned via the excess of reactant 

and buffer conditions to only attach the moiety to the N-terminus of the protein. Another 

elegant way to improve the site-selectivity for this chemistry was proposed by Rosen and 

colleagues, where they used conserved histidine clusters on an antibody, targeted via Tris-

NTA and a guide DNA strand to attach an oligonucleotide via NHS chemistry to a nearby 

primary amine109.  

Nevertheless, NHS chemistry is usually not an option for large proteins, if absolute protein 

copy number counting is desired for which absolute control over stoichiometry of attached 

DNA strands is necessary. For more specific attachments, engineered cysteines can be used 

which harbor a sulfhydryl/thiol group and can be labeled via maleimide groups110. This enables 

a highly site-specific attachment of single DNA strands to the binder of interest. Staying with 

the single amino-acid targeting chemistry, DNA strands can also be attached to methionine 

via redox reactivity, which is also highly specific as methionine’s are usually the start codons 

and not very prevalent in proteins. For the reaction to proceed, an oxaziridine group is used 

which forms a sulfimide bond upon oxidation111. All of the above methods are performed in a 

two-step reaction, first the amino-acid residues (Lysines, Cysteines, Methionines) are attacked 

on the protein of interest with a chemical crosslinker and afterwards the DNA strand is clicked 

to the crosslinker. In addition to the direct amino-acid targeting and attachment of the DNA 

strand, the tools mentioned in chapter 1.7, such as implementing an unnatural amino acid in 

the expression system112 or adding a small peptide- (yBBR)98, or protein tag (SNAP/HALO) 
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for site-specific attachment of the DNA strand can be used. However, these increase the size 

of the reagent, which should be avoided. Three major chemical labeling strategies used in this 

thesis are shown in Figure 10. 

One problem which remains after successful attachment of the DNA strand is to purify the 

successfully conjugated high-affinity reagent from unconjugated reagents. There are different 

methods available to purify oligonucleotides from proteins from oligonucleotide-protein 

constructs. The major methods used are size-exclusion chromatography or ion-exchange 

chromatography, in which for the first one, the molecules are separated by size and for the 

latter one by charge113. Depending on the protein, usually the DNA strand adds a significant 

amount of charge to the binder of interest and anion exchange chromatography is a method 

of choice, where a positively charged resin retains the negatively charged DNA tail, which can 

be eluted under high salt conditions. Via a gradient based elution, the free DNA, the protein 

and the protein-DNA conjugate can be eluted in separate fractions.  

 

 
Figure 10: Chemical labeling strategies. a) NHS-ester reaction uses primary amines to couple a linker 
to it. b) In maleimide chemistry, cysteines or free-thiols are coupled. c) Click chemistry, especially a 
strain promoted azide-alkyne cycloaddition (SPAAC) works under physiological conditions and is used 
to attach DNA strands. 
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Once the binders of interest are produced with an attached DNA strand, biological phenomena 

can be investigated. Figure 11 shows a brief overview over typical super-resolution 

microscopy data of a diverse array of targets in cell biological research. One particular 

macromolecular complex of interest are focal adhesions, which mediate the interaction of cells 

with their extracellular environment and will be discussed in more detail in chapter 1.9.  

 

 
Figure 11: Super-resolution microscopy of cellular components. Different organelles and higher-order 
molecular structures in cells can now be investigated with unprecedented resolution. Cell surface 
receptors, here EGF-receptors appear under non-stimulated conditions as homogenously distributed 
spots on the cell surface. Organelles like the mitochondrial network are studied for their internal 
organization. With super-resolution microscopy, details of the cytoskeletal architecture can be 
visualized, which were previously unseen, here vimentin (left) and microtubules (right) as two examples. 
Focal adhesions, here stained for talin-1 are a macromolecular complex which regulates cell 
homeostasis, migration and proliferation. Clathrin-coated vesicles are here depicted as vesicles. 
Nuclear pores are the gate keeper of the nucleus, which harbors the genetic information. NUP107, one 
of the structural proteins which build the nuclear pore architecture is depicted here. For further 
information and acquisition parameters see supplementary table 6. Scale bars: Nuclear Pores: 200 nm, 
Vesicles: 300 nm, Focal Adhesions: 500 nm, Cell Surface Receptors: 5 µm, Mitochondrial Network: 5 
µm, Cytoskeleton: 5 µm  
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It is now possible to acquire images with molecular scale resolution using DNA-PAINT. The 

final processed data consists of single spots, which can include single or multiple proteins. To 

analyze, if there are underlying patterns or if the organization of the proteins follow random 

distributions, thorough investigation of the resulting localization clouds and clustering plays an 

important role, especially considering the low labeling efficiencies, on the order of 30-50 %55. 

In chapter 1.10 clustering algorithms will be discussed in more detail. 

 

1.9 Focal Adhesion Biology 
Focal adhesions play a crucial part for the cell in sensing the extracellular matrix. The 

mechanical properties of the extracellular environment influence heavily cell homeostasis, 

migration or differentiation114. Focal adhesions are a multimolecular complex involving 

hundreds of proteins which are responsible to transduce the extracellular environment sensing 

to intracellular mechanical and chemical signalling115. It was shown that adhesions are 

organized in three main horizontal layers spreading over around 50 nm:  the integrin signaling 

layer, the force transduction layer and the actin regulatory layer116 (Figure 12). Integrins, which 

are heterodimeric proteins consisting of an a- and a b-unit engage directly with extracellular 

matrix proteins117,118. 24 different heterodimeric combinations of a- and b-units exist build from 

18 a and 8 b proteins exposing different ligand specificities and harbor characteristic tissue 

distributions. Ligands for integrin engagement are derived from extracellular matrix proteins 

and are fibronectin, collagen or laminin as examples. Both subunits contribute to the tuning of 

the binding affinity to the extracellular ligand. Upon binding to its ligand, integrins can reinforce 

the binding by forming a catch bond, which leads to the opening of additional binding interfaces 

that strengthen the interaction between the receptor and the ligand119. Integrin clustering at 

the cell surface by ligand engagement plays an important role for focal adhesion formation. 

The cytoplasmic tails of both subunits are short peptide tails harboring motifs that interact with 

intracellular force transducing or signaling molecules. Two major adaptor proteins, which are 

crucial for integrin activation and focal adhesion formation are talin and kindlin120. Talin, which 

is a 270 kDa large protein, binds via its FERM domain to the NPxY peptide motif at the b 

integrin tail. There are two different talin isoforms reported, talin-1 which is expressed in all 

tissues and talin-2, which is predominantly expressed in muscle and neuronal tissue120. Talin 

harbors various actin and vinculin binding sites, which are force sensitive and get exposed 

upon tensile stress. It was shown, that talin as well as vinculin transduce mechanical load 

within focal adhesions121,122 and are coupling the focal adhesome directly to the force-loading 

actomyosin network.  

In contrast to that, kindlin is ~75 kDa in size and binds to the NxxY motif at the b integrin tail. 

Kindlin consists of 3 family members, Kindlin 1 is predominantly found in epithelial cells, 
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whereas kindlin 2 and 3 are expressed outside or inside the hematopoietic system123. Kindlin 

functions as a signaling hub, by activating paxillin, focal adhesion kinase and recruiting the 

Arp 2/3 complex to the integrin tail124. In focal adhesions, no tension was detected over kindlin, 

suggesting that it regulates the focal adhesion formation mainly by regulating the actin 

network. It is still unknown if talin and kindlin interact with the peptide motifs at the b integrin 

tail at the same time in the cell. 

 

 
Figure 12: Focal adhesion architecture. The focal adhesion macromolecular complex is built up on 
several layers, the integrin signaling layer is followed by the force transduction layer, including one of 
its main players talin (yellow rod), followed by the actin regulatory layer as well as actin stress fibers 
(dark blue). Reprinted by permission from Springer Nature, Nature [116], 2010. 
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1.10 Clustering 
Analyzing the clustering properties of proteins in cells is inherently different in a fixed system 

compared to life dynamics. Some of the proteins might be en route to their interaction partner 

of interest, whereas others are shuttled to their destruction and only a portion of the proteins 

might engage with their dedicated interaction partners and from those, due to the low labeling 

efficiencies only 30-50% can be detected55. Due to the high-resolution capabilities of SMLM, 

where high density clouds of localizations can originate from single sites, traditional co-

organization or colocalization definitions, which analyze the degree of overlap like for example 

the Manders coefficient does, are outdated125. With these new high-resolution capabilities, co-

organization can be defined as distance measure to the next protein. 

However, this problem is multi-facetted, the first problem is how to detect the organization of 

the proteins under investigation in an automated fashion. In order to achieve this different 

methods have been proposed, like Density-Based Spatial Clustering of Applications with 

Noise (DBSCAN)126. The main problem in SMLM is that there is an ocean of noise, interrupted 

by high density islands, which are the spots of interest. Noise can be multifold, noise or 

undesired detection can occur by sticking of a fluorophore labeled oligonucleotide to an 

undesired site in the cell, it can be an accidental double blinking event, which leads to a track 

of localizations in between two true sites or it can be an unspecific attachment of an affinity 

reagent to the cell, which shows the same signature as true repetitive visits. The first challenge 

in this respect is to detect true sites: high density localization clouds in an ocean of noise and 

the second part of the clustering is to detect patterns of the detected high-density localization 

clouds.  

 

Different clustering algorithms have been proposed to find the localization islands, one 

prominent example is k-means clustering127. K-means divides the image into a predefined 

number of clusters and optimizes for minimal quadratic distance deviation from the cluster 

centers and selects for clusters with similar sizes. K-means cluster optimization can be 

described with following formula: 

 

𝐴 =a ab𝑥c − 𝜇-b
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Si are the clusters, xj the localizations and µi the cluster centers. The biggest disadvantage of 

k-means clustering is, that it requires a predefined number of expected clusters as input 

parameter. For single-molecule localization microscopy of arbitrary patterns, it is not very 

straightforward to estimate the number of clusters as input parameter.  
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As an alternative, the DBSCAN clustering method considers high-density areas with noise, 

which fit the description requirement for SMLM data above. To find clusters, DBSCAN has two 

input parameters, one parameter is density as a number of points, the second parameter 

defines a search radius. DBSCAN defines core points of the clusters as points which have at 

least the density number of points within the local search radius. Border points of the cluster 

are points, which can be reached by the search radius, but do not have more neighbors then 

the defined number of points and are therefore at the edge of the cluster. Via connectivity 

through the distance search radius parameter as well as the local density definition of core 

and border points, DBSCAN defines the clusters. Advantageous of DBSCAN is, that it does 

not require any preknowledge of how many clusters it should detect, like k-means does, 

additionally it can detect any kind of shapes and patterns as a cluster and it does consider 

noise, which is usually less dense then the high-density islands. A disadvantage is, that 

depending on the density of the separate clusters, subclustering or undesired merging of 

individual clusters can occur126.  

Specific for single molecule localization data, Tesseler has been proposed, which uses 

Voronoi based tessellation to find high density areas and apply this to multicolor and 3D 

imaging128. Voronoi diagrams subdivide an area defined by points or so-called seeds, by 

drawing polygons, in which the edges are equidistantly apart from the neighboring points. 

Each position within a polygon is closer to its defining point than to any other point of the whole 

area. In this respect, the polygon surrounding a point can be defined as its direct area of 

influence. The full image is subdivided into these polygons. From the created polygons, 

different parameters can be computed which give an impression of the clustering, such as the 

area or the smallest distance to the next point, a polygon shape index or a density value. As 

an example, for large polygons, above the localization precision, the local density of points is 

low, whereas high-density areas are marked by small polygon areas. By thresholding the 

parameters and merging neighboring polygons, objects and clusters can be identified, for 

which downstream further parameters, like localizations, center of mass or area size can be 

computed. Choosing different density parameters enables to segment out areas of interest. 

While the tessellation-based approach showed to detect organizations on multiple length 

scales, it is still prone for noise in densely packed areas and merges clusters128,129. 

Localizations in SMLM data consist of highest density areas, originating in a circular fashion 

from single sites, in which the true center position has the highest density of localizations. 

Ripley’s K function analyzes the local density, by calculating the number of neighbors within 

a certain distance and compares the occurring density to randomly dispersed particles to 

detect clustering. Different distances are usually evaluated to detect cluster formation over 

different length scales130,131. Figure 13 shows an overview over clustering algorithms which 

have been developed and applied to SMLM data. 
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Once these single sites/single clusters have been determined, potential patterns can be 

investigated. One measure is the nearest neighbor distance, which should yield a different 

distance distribution at the same molecular density in comparison to a random distribution, if 

an underlying organization of the proteins is present. The same holds true for colocalization 

with a second or third protein species, however with protein-based probes the labeling 

efficiency needs to be considered.  

Once these clusters and patterns have been determined, machine learning approaches can 

be used to automatically detect them and perform statistical analysis, which was previously 

reported with ASAP132. 
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Figure 13: Clustering methods in SMLM. a) Explanation of k means clustering, where an expected value 
of clusters is given and the algorithm tries to find the clusters via minimal distances to their center points. 
b) DBSCAN. DBSCAN is a density-based method, which checks for neighbors in a certain radius and 
defines a cluster if the threshold of minimal elements in the defined radius is reached. c) Voronoi 
tessellation d) Ripley’s K function analyzes the local density over different distances and compares it to 
randomly dispersed particles.  
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2 Aim of Thesis 
In this PhD thesis I aimed to develop a toolbox for DNA-PAINT microscopy for the dissection 

of molecular complexes in cells. The major advantages of DNA-PAINT are that the molecular 

identity of the proteins under investigation is encoded in the attached DNA sequence, which 

enables to perform super-resolution imaging, almost unlimited multiplexing in subsequent 

rounds of imaging and counting of biomolecules.  

However, to harness its full potential, small and efficient high affinity reagents are necessary. 

Therefore, aim 1 of the thesis was to develop strategies to attach DNA strands to any binder 

of interest using a diverse array of covalent biochemical linking strategies. NHS chemistry was 

used to attach DNA strands to antibodies or small secondary binders, maleimide chemistry 

was used for site-specific attachment of DNA strands via engineered cysteine residues to 

nanobodies and Affimers. Additionally, small genetically encoded tags, such as SNAP and 

Halo were used to attach DNA strands via small molecule ligands. These binders were applied 

to a diverse array of applications in cell biology. Specifically, I was able to show for the first 

time, the 12 nm distance of the Y-complex in the nuclear pore architecture.  

In aim 2, the influence of the reagent probe size on the true achievable resolution was 

investigated. In order to achieve a controlled analysis, a DNA origami nanoplatform, which 

can harbor several antigens of interest at distinct nanopatterns, was developed and applied 

to two different probe sets, a nanobody against the ALFA-tag and an antibody against a 

phosphorylated peptide CTD motif.  

Aim 3 was to dissect cluster formation and complex detection computationally. In order to 

accomplish this, a modified Ripley’s K function was implemented to detect single, repetitively 

visited sites in DNA-PAINT data and was used for downstream clustering analysis to detect 

underlying patterns. For complex detection, simulations were implemented to analyze the 

influence of labeling efficiency. 

In aim 4, I wanted to investigate if DNA-PAINT based super-resolution microscopy can be 

used to prove the existence of molecular complexes on a single protein level. For this we 

chose to investigate the co-organization of talin, kindlin and integrin as important players in 

focal adhesion formation and regulation, combining all the previously established tools. 
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3 Brief summary of manuscripts 
 

3.1 Paper Ⅰ: DNA nanotechnology and fluorescence 
applications 

T. Schlichthaerle, M.T. Strauss, F. Schueder, J.B. Woehrstein, R. Jungmann 

 

DNA nanotechnology has enabled great advances in fluorescence applications in recent 

years. In this review we analyzed the current state-of-the-art of DNA as a biotechnological tool 

for fluorescence applications. The programmable nature of DNA enables to build 

nanostructures with molecular addressability and use them as breadboards to template a large 

variety of molecules63. One particularly interesting aspect is to harness the molecular 

addressability of DNA to template fluorophores and subsequently use DNA origamis as size-

standards in two and three dimensions for super-resolution fluorescence microscopy56. 

Dynamic DNA hybridization with short fluorophore-labeled oligonucleotides was also recently 

developed to be used as a transiently interacting probe for single-molecule localization based 

super-resolution microscopy47. These probes were used to characterize a diverse array of 

DNA nanostructures or molecules templated on DNA origamis. In addition, another advantage 

of the DNA programmability enables it to encode the molecular identity of the target within the 

DNA sequence and use it for multiplexed imaging in cell biology2. The third pillar, where DNA 

nanotechnology plays an important role in fluorescence applications, is again linked to its 

programmable nature as a building material. There is a large research direction in which gold 

nanoparticles of different shapes and sizes are templated on DNA origami structures, 

particularly to build plasmonic devices with local field enhancements for sensitive detection of 

biomolecules133. In this review, we emphasized three main research directions in which DNA 

nanotechnology helped to advance fluorescence applications. 
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3.2 Paper Ⅱ: Super-Resolution Microscopy with DNA-
PAINT 
J. Schnitzbauer*, M.T. Strauss*, T. Schlichthaerle, F. Schueder, R. Jungmann 

 

DNA-PAINT as single molecule localization microscopy method has major advantages over 

previously established SMLM techniques. Since the repetitive blinking behavior and the 

molecular identity is encoded in the programmable DNA probes, super-resolution can be 

achieved with almost unlimited photons for localization per single site1. Additionally, from 

exchanging the buffer and imager solutions, an almost unlimited number of targets can be 

visualized within the same cell. In fact, multiplexing is only truly limited by the available labeling 

probes and the orthogonal DNA sequence space4. Although different software packages for 

SMLM are already available, they are not adapted to the variety of experiments and analysis 

that can be achieved with DNA-PAINT. Therefore, Picasso was developed and included in 

this paper as a software tool to be specifically applied for DNA-PAINT. My part in this project 

was to devise a strategy to make DNA conjugation to antibodies more easily adaptable and 

scalable. For this the original protocol using NHS-maleimide chemistry (which has a laborious 

reduction step of the DNA via DTT) was redesigned to a protocol using a strain-promoted 

alkyne-azide cycloaddition, thereby reducing the time to produce antibody DNA-conjugates 

down to four hours and can be easily parallelized. These conjugates were tested in cellular 

applications in imaging microtubule networks and mitochondria. 

 

In summary, this paper was published as a universal reference to make DNA-PAINT highly 

available to the super-resolution community, covering a range of methods from labeling 

chemistry of antibodies, to DNA origami design, to cellular investigations and provide the 

software tool Picasso for downstream data analysis. 
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3.3 Paper Ⅲ: Site-specific labeling of Affimers for  
DNA-PAINT microscopy  
T. Schlichthaerle, A.S. Eklund, F. Schueder, M.T. Strauss, C. Tiede, A. Curd, J. Ries, M. 

Peckham, D.C. Tomlinson, R. Jungmann 

 

One of the main challenges in DNA-PAINT microscopy is to attach a DNA strand via an affinity 

reagent to the target molecule under investigation. There is a large repertoire of labeling 

chemistries available to attach a DNA strand to a specific binder, however having 

stochiometric control over the number of docking strands is more challenging. Stochiometric 

labeling of binders with a specific amount of DNA strands is important in order to count 

biomolecules in clusters. In this publication, we used a site-specific attachment chemistry via 

engineered cysteine residues. A second challenge in the field of super-resolution microscopy 

is to apply the technique to any biological target of desire. However, this is still limited by the 

available affinity reagents. Therefore, it is of great importance to expand the spectrum of 

usable binders. In this paper, small scaffolds called Affimers were site-specifically labeled with 

a DNA strand via cysteine-maleimide chemistry. Affimers are a 12 kDa large protein scaffold, 

derived from cystatins, which are cysteine protease inhibitors and consist of a beta-sheet and 

an alpha-helix90. Two loops can be engineered with various amounts of amino acid insertions 

to engineer affinity for any target of interest. As exemplary Affimer, an actin binder was chosen 

to make it available for DNA-PAINT134. Since the blinking behavior in DNA-PAINT is usually 

controlled by the imager sequence, concentration and buffer conditions, it is challenging to 

find the phenotype under investigation in cells. Therefore, a strategy was devised for 

diffraction-limited screening of cellular phenotypes. To achieve this, the DNA docking strand 

was equipped at its 3’-end with a fixed Atto488 fluorophore. Beyond the demonstration of the 

Affimers’ general applicability for site-specific labeling for DNA-PAINT microscopy, we also 

investigated the actin network in Cos-7 cells in three-dimensions. We were able to show a 

layer-to-layer distance of the dorsal and ventral side of the actin fiber network of ~130 nm. In 

the future our devised strategy could pave the way for molecular counting applications with 

site-specifically labeled small protein scaffolds in a highly multiplexed fashion. 
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3.4 Paper Ⅳ: Bacterially derived antibody binders as 
small adapters for DNA-PAINT microscopy 
T. Schlichthaerle*, M. Ganji*, A. Auer, O.K. Wade, R. Jungmann (* equal contribution) 

 

Labeling probes are essential to visualize cellular targets with fluorescence microscopy. 

However as current super-resolution microscopy techniques approach molecular resolution, 

it becomes increasingly important to have small and efficient binders for the target of interest. 

In order to perform DNA-PAINT imaging, a DNA strand needs to be attached to the target, 

usually via a protein-based binder. Unfortunately, there are only limited amount of small 

protein ligands available against any target of interest. In contrast, there is a large repertoire 

of antibody-based binders which can be applied at the cost of compromising the size of the 

probe. However, labeling primary antibodies with DNA strands can be tedious, if they are not 

commercially available in the correct buffer conditions (e.g. if they are supplemented with 

protein stabilizers like BSA or gelatin). In these cases, before the actual labeling procedure 

can take place, a pre-purification step might be necessary. Additionally, even with careful 

optimization of labeling conditions, the antibody might lose the ability to bind to the antigen of 

interest. Usually polyclonal secondary antibodies are used to visualize the binding of primary 

antibodies but they are relatively large in size (150 kDa) and therefore do not display the true 

target positions. In this publication, we implemented small bacterially derived antibody binders, 

which were previously already extensively used in antibody purification strategies135, namely 

protein A and protein G, to show their universal applicability as adapters for different primary 

antibodies. 

Protein A and protein G are bacterially derived FC binders (staphylococcus aureus and 

streptococcus), which help the bacteria to evade detection by the immune system. These two 

proteins have nanomolar affinity to different antibody species and are only a fraction of the 

size of full antibodies (42 kDa and 58 kDa in comparison to 150 kDa)136,137. Their capability to 

bind site-specifically to antibodies makes them an excellent probe to reduce probe sizes. My 

part in this project was to device a conjugation strategy to attach DNA strands to the small 

probes and apply them to biological targets. First, protein A and protein G were conjugated to 

DNA strands by targeting primary amines via NHS-chemistry and attaching the DNA strand in 

a second step via an inverse-electron-demand Diels-Alder cycloaddition between a TCO 

group and a TZ-modified DNA. Protein A was shown to bind to rabbit antibodies staining the 

mitochondrial marker Tom20 and protein G was shown to bind to rat antibodies staining for 

microtubule filaments. After the initial proof of concept, the capability of the small secondary 

binder to decrease resolution and avoid labeling probe size artefacts was evaluated. As an 
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ideal test case for single spots, EGF receptors were investigated. EGF receptors in A549 cells 

were labeled with primary/secondary antibodies as well as with the primary antibody in 

combination with protein A as secondary adapter. At the same technical resolution, the 

detected cluster sizes, defined by the full width half maximum, was increased by a factor of 

two in the case of the double antibody staining in comparison to the small secondary probe. 

As a last experiment, the resolution enhancement was tested with microtubule staining as a 

three-dimensional test system. According to EM data, the microtubule diameter is around 25 

nm, however, when imaged with three-dimensional DNA-PAINT microscopy and primary-

secondary antibody staining, the diameter of microtubules was measured to be 57 nm. 

Applying the newly developed secondary adapters for DNA-PAINT decreased the measured 

diameter by 9 nm to 48 nm which demonstrates the impact of the probe size. Taken together 

we showed that commonly applied primary - secondary antibody stainings lead to artificially 

increased cluster sizes and we provide a small universal and cheap labeling probe, which can 

be used for multiple primary antibodies of different species and can display the true molecular 

identity more accurately.  
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3.5 Paper Ⅴ: Direct visualization of single nuclear 
pore complex proteins using genetically-encoded 
probes for DNA-PAINT 
T. Schlichthaerle*, M.T. Strauss*, F. Schueder*, A. Auer, B. Nijmeijer, M. Kueblbeck, V.J. 
Sabinina, J.V. Thevathasan, J. Ries, J. Ellenberg, R. Jungmann (* equal contribution) 
 

DNA-PAINT relies on the labeling of proteins with high-affinity reagents. One route to target 

the proteins is by using genetically-encoded tags, such as SNAP-95, Halo-96 or GFP-tags87. 

These tags provide well established ligands, such as benzylguanine (BG), chloroalkane or 

GFP nanobodies, which can be easily modified with DNA strands and allow for stochiometric 

labeling of the target under investigation. The cell lines were tagged via zinc-finger nucleases 

and CRISPR Cas9 technology to ensure endogenous expression levels. In this paper the 

position of nuclear pore scaffolding proteins, namely NUP107 and NUP96 in the nuclear pore 

architecture was investigated. The nuclear pore consists of a cytoplasmic and a nuclear ring, 

harboring an 8-fold symmetry with two protein copies in one symmetry center predicting 32 

copies of each individual protein forming the two rings138. This knowledge, previously acquired 

through cryo-EM, enables the use of the nuclear pore architecture as a reference standard for 

counting proteins and estimating absolute labeling efficiencies. SNAP- and HaloTag are self-

labeling enzymatic tags, which use small molecule ligands for covalent attachment of 

respective DNA strands to the target protein. As an additional tool, a DNA-modified GFP 

nanobody, which was site-specifically labeled via a single cysteine residue, as previously 

established in the Affimer paper (Paper Ⅲ), was used to evaluate the NUP107 protein 

distribution and directly compared to a GFP antibody-based staining. We found that the 

antibody increased the measured diameter. For NUP96 and NUP107 we found an average 

diameter of 55.9 nm and 53.7 nm respectively and a z-separation of NUP96 of 61 nm between 

the nuclear and the cytoplasmic ring, which agrees with previously published EM data. The 

diameter for the different tags, GFP, SNAP & Halo did not vary, meaning that they can be 

equally applied. Using the nuclear pores as an estimate for labeling efficiency, we were able 

to show that from the expected 32 copies, only ~8-14 were labeled on average for all the 

different targets, which lead to a labeling efficiency of around ~30%. According to EM data, 

the two copies of NUP96 are ~12 nm apart in one symmetry center. I tried to optimize the 

imaging conditions with respect to number of visits of a single DNA docking site as well as 

optimized the resolution in 2D and 3D carefully in order to resolve these two sites in the nuclear 

pore. Using super-resolution fluorescence microscopy in 3D, I was able to show for the first 

time the arrangement of two NUP96 protein copies that are only 12 nm apart exist in cells. 
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Taken together, we showed in this manuscript, that SNAP/Halo and GFP tags perform equally 

well at around ~30% labeling efficiency and that it is possible to resolve closely spaced 

proteins (~12 nm) in a dense macromolecular complex. This technology can now be applied 

to study any kind of biological complexes in cells.  
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3.6 Paper Ⅵ: Spatial association of integrin-talin-
kindlin during cell matrix adhesion 
L. Fischer*, C. Klingner*, T. Schlichthaerle*, M. T. Strauss, R. Böttcher, C. Schreiber, J. O. 
Rädler, R. Fässler, C. Grashoffº, R. Jungmannº (* equal contribution, º co-corresponding) 
 
 
Mechanosensing of the extracellular environment plays an essential role for cell homeostasis 

and differentiation. Focal adhesions, which are a macromolecular complex at the cell surface, 

mediate the extracellular rigidity sensing. Upon integrin engagement and cell adhesion, a 

macromolecular complex assembles which ultimately connects the extracellular matrix to the 

cellular cytoskeleton. However, until now it is still unclear how the molecular clustering of the 

involved protein species occurs in such a dense structure. In this publication, we analyzed the 

co-organization of talin-1, kindlin-2 and β1 integrins during cell adhesion on fibronectin. For 

this, we used genetically-encoded tags such as SNAP-tag and HaloTag in combination with a 

9EG7 antibody, which binds to an epitope available upon β1 integrin engagement and 

extension and measured the nanoscale distribution of the three proteins in and out of focal 

adhesions. We determined, that their distribution within focal adhesions peaks at protein to 

protein distances between 40 nm – 70 nm in fibroblasts. To estimate, whether we were 

analyzing truly single proteins within this densely packed structure, I used DNA nanostructures 

for calibrating the DNA-PAINT kinetics and was able to conclude that they were single binding 

sites. Additionally, we were not able to find any unimodal monomolecular complex formation 

of talin-1 within the focal adhesion, but its distribution followed an extracellular matrix 

fibronectin micropatterned surface and therefore the clustering of integrin. Furthermore, we 

determined the degree of spatial association within the focal adhesion by calculating a 

threshold interprotein distance of 25 nm. Kindlin-2, Talin-1 as well as extended β1 integrins 

seem to associate together, which was not only driven by the high density of the proteins as 

demonstrated with simulations of randomly distributed particles. Our data shows the existence 

of a basic functional unit between three proteins which mediate cell-matrix adhesion. We 

showed for the first time that a triple molecular complex formation can be imaged using super-

resolution microscopy even in high density environments such as focal adhesions.  
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4 Further developments 
4.1 DNA origami as a universal platform to analyze 
probes and cluster formation 
Super-resolution microscopy enabled the biological community to shed light on different 

biological phenomena. However up to this point, mainly findings concerning structural 

proteins, such as microtubule filaments, nuclear pore structures139 or actin-spectrin rings140 

were reported. Additionally, different studies presented the analysis of surface receptor 

nanoclusters, such as EGFR141 or ryanodine receptors in heart tissue142. However, since novel 

super-resolution microscopy techniques, such as DNA-PAINT or MINFLUX can obtain 

resolutions down to the level of single proteins, the size of the labeling probe on the target 

becomes increasingly important1,37. Novel tools including DNA origami structures can be used 

to assay the performance of microscopy techniques with the highest resolution56, but so far, 

there are only limited tools55 available to assay the labeling probe performance at the highest 

resolution level. These labeling probes should not only be small, label quantitatively to extract 

true molecular numbers, easily available for multiple targets but also have a high efficiency of 

binding. Common artefacts arising from imaging with large probes were recently reported in 

different applications, such as analyzing the nuclear pore architecture, investigating 

microtubules or looking at surface receptor nanoclusters141,143,144. However, a comparison of 

the true molecular position of the antigen within the same sample is so far elusive. 

Here we aimed to evaluate binders on a DNA origami platform to truly determine the influence 

of the probe size on nanopattern recognition. To achieve this, we built synthetic antigen 

nanoclusters on DNA origami structures to show that large labeling probes can mask 

underlying antigen spacings, which can be circumvented by using novel small labeling probes. 

We demonstrated that combining novel super-resolution methods, such as DNA-PAINT, with 

the availability of small labeling probes should enable to dissect true molecular spacings and 

absolute compositions of molecular complexes within the next decade.  

In cell signaling events, proteins come together and form nanoclusters for efficient triggering 

of the signaling pathway. To mimic such behavior, we nanotemplated antigens on a DNA 

origami platform and compared their resolvability with different binders (Figure 14a,b). The 

antigens were anchored via complementary DNA strands to the DNA origami structure 

harboring an additional site for DNA-PAINT microscopy to assay its presence and the true 

antigen position. The antigens in question were short peptides either derived from the ALFA- 

tag99 regarding the nanobody analysis, or phosphorylated CTD (derived from RNA 

Polymerase 2) in case of the antibody and were conjugated via a strain-promoted azide-alkyne 
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cycloaddition reaction to the DNA oligonucleotide of interest. The DNA-conjugated peptides 

were directly added in the folding reaction with the DNA origami structures, which were 

designed to arrange the antigens in a 20 nm grid pattern. The DNA-conjugated binders of 

interest were added after the origami structures were surface immobilized on a PEG-

passivated glass coverslip via biotin-streptavidin linkages. In an Exchange-PAINT experiment, 

the binder position was first assayed and compared to the true antigen position on the origami. 

We demonstrated, that nanobody staining clearly resolves the underlying nanocluster at a 

spacing of 20 nm, whereas antibody staining masks the underlying complex formation (Figure 

14c,d). Therefore, we proved that the ultimate goal of SMLM to dissect single complex 

formation on a single protein scale, is only achievable with small labeling probes. 

 

 
Figure 14: Labeling platform. a) Antibodies and nanobodies were 
assayed to resolve artificially templated nanoclusters on DNA 
origami. Both were labeled with DNA strands. b) Artificially 
templated antigen clusters (red) on DNA origami, in which the 
position of the antigen can be visualized in order to readout the 
underlying true position. Labeling probes (cyan) can be assayed for 
their performance with DNA-PAINT microscopy. c) Nanobody 
imaging (cyan) of the ALFA-tag antigen demonstrates, that the 
single antigen sites (red) spaced 20 nm apart can be clearly 
separated. d) Antibody imaging (cyan) of pCTD does not show 
single antigen sites (red) spaced 20 nm apart. Scale bar: 50 nm 
(c,d). PDB IDs: Antibody: 1IGT, ALFA-tag nanobody: 6I2G. 

  



 
4.2 Quantitative cluster analysis and detection 
 

 40 

4.2 Quantitative cluster analysis and detection 
Novel approaches in super-resolution microscopy, such as MINFLUX36, DNA-PAINT1 or 

expansion microscopy145 can achieve resolutions down to the size of single proteins. This was 

not possible with previous techniques. Therefore, novel discoveries were mainly made for 

structural proteins or higher order clusters. However, dissecting the protein composition within 

high density nanoclusters is only possible to a limited extend, as the cluster sizes are highly 

biased depending on the size of the labeling probe146.  

However with the established tools, it should now be possible to use super-resolution 

microscopy to quantitatively assess cluster distributions as well as their heterogeneity and 

utilize this to reconstruct single-molecular complexes. This should enable to truly map 

distances between proteins interacting in transient signaling events. However, to detect single 

sites, the single molecule localization data needs to be analyzed via clustering algorithms as 

previously emphasized in section 1.10. DNA-PAINT data achieves high-resolution so that 

single-binding sites even within 10 nm distance can be detected1. The profile of a single site 

in DNA-PAINT resembles a gaussian distribution of localizations around the true position of a 

single docking site. A modified Ripley’s K function was implemented for cluster detection as a 

possible method to find the centers of the gaussian distribution of localizations. Ripley’s K 

function analyses the local density of the localizations by calculating the number of neighbors 

within a certain radius130. To find the local cluster centers, the algorithm was modified, so that 

within a distance r to one localization, no other localization harbors a larger number of 

neighbors within the same distance r. This creates a gradient ascent towards the point of 

highest density. The clusters are then defined as the localizations within the defined radius 

from the cluster center and can be filtered for a threshold number of localizations or repetitive 

visits over the whole course of imaging (Figure 15a). For performance evaluation we tested 

the implemented novel clusterer against the DBSCAN algorithm in simulations. First, the 

algorithms were tested at an exemplary simulated dataset of 50 pairs of two single clusters, 

spaced 10 nm apart and at a NeNa147 localization precision of 2.5 nm. The optimal distance 

parameter for the novel clusterer was a window (2-4 nm) around the localization precision to 

detect all clusters. Smaller values led to subclustering, whereas larger values merged the 

paired clusters. For the DBSCAN algorithm, no parameter was found which could successfully 

detect the single clusters (Figure 15b,c). In a second simulation, the resolvable distance was 

determined by simulating again 50 pairs at various distances (2 nm – 20 nm) at a fixed 

localization precision of 2.5 nm. The optimal parameter of 3 nm derived from the previous 

experiment was chosen as distance input parameter for the algorithm. The novel clusterer 

was already able to successfully detect the pair separations at 6 nm, whereas DBSCAN only 

started to detect single clusters at separations of 12 nm (Figure 15d). 
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Additionally, the novel clustering algorithm was assayed on two different DNA origami 

samples, which were previously published48. One dataset with 20 nm distances on DNA 

origami and one Exchange-PAINT dataset, where sites were as close as ~6 nm apart. The 20 

nm grid distances, its underlying pattern of 29 nm in the diagonal direction to the nearest 

neighbor and 40 nm to the second nearest neighbor in the horizontal direction could be 

automatically detected. Additionally it was possible to find the distances between the different 

docking sites in the exchange experiment (Figure 15e,f,g). 

 

 
Figure 15: Cluster detection. a) Depiction of implemented clustering algorithm, which counts the number 
of neighbors within a certain radius and performs a gradient ascent to detect the cluster center (left). 
The detected cluster centers are then defined as clusters with their appropriate neighbors (middle), 
these clusters can afterwards be filtered for repetitive visits or the number of elements in them (right). 
b) Successful detection of clusters depends on the distance parameter plugged into the used clustering 
algorithm. Values smaller than the localization precision lead to subclustering, whereas larger values 
lead to combined clusters. For the novel clustering algorithm (Clusterer), the optimal distance parameter 
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is a window around the localization precision, for the DBSCAN algorithm, no distance parameter was 
found to optimally detect all clusters. Data from 50 simulated pairs with two clusters at 10 nm distance 
at a NeNa localization precision of 2.5 nm. c) Images from datasets from b. Top left: localized data, top 
right: subclustering induced by a small distance parameter, bottom left: Merging of clusters due to large 
distance parameter, bottom right: successful detection of clusters with the optimal distance parameter 
of 3 nm. d) Comparison of detected clusters through the two different clustering methods (Clusterer and 
DBSCAN) in comparison to the cluster pair spacing at a fixed distance parameter of 3 nm. The clusterer 
detects the clusters at a distance difference of 6 nm, whereas DBSCAN only detects the clusters 
properly at a distance separation of 12 nm. Data from 50 simulated pairs at increasing distances and 
fixed NeNa localization precision of 2.5 nm. e) 20 nm DNA origami image (top left) and corresponding 
distance analysis (top right). Automated detection of clusters with the clustering algorithm (bottom left) 
and distance measurements for a large sample area (bottom right). The major peak corresponds to a 
distance of 20 nm and peaks corresponding to distances of 29 nm and 40 nm can also be observed. 
The later distances are a result of low incorporation efficiencies, e.g. if staples are missing. f) Exchange 
experiment on DNA origami structure and the cluster detection. g) Nearest neighbor distance analysis 
of one dataset yields a peak at 20 nm (top). Nearest neighbor distance analysis of one dataset to the 
other, yields a major peak at 6 nm, which corresponds to the designed pattern (bottom). Scale bars: 20 
nm (c), 50 nm (e,f). 

 

After successful detection of the single sites in DNA-PAINT data, it is important to determine 

whether distances in the histogram occur randomly or if complex formation occurs. In order to 

extract the degree of complex formation, simulations of the data were performed. As 

previously reported, the labeling efficiency for different binders can be in the order of ~30% in 

cell biological applications55,144. How do these low percentages influence the analysis of 

complex formation? To investigate a relatively high-density environment in a cell, 867 particles 

per µm2 were assumed for two species and different degrees of complex formation (0-100%) 

were simulated (Figure 16). Complex formation was defined as percentage of colocalization 

within 25 nm. Particles were otherwise randomly distributed at x and y positions, complexes 

were set to be between 12-16 nm and labeling efficiency was assumed to be 30%. The 

simulated point pattern was not subjected to an additional SMLM process or cluster detection 

pipeline, to prevent biased interpretation of the system. At 0% complex formation, the analysis 

showed that already ~40% of proteins appear colocalized just by proximity. At 100% complex 

formation only ~58% of colocalization was detected. Extracting molecular densities from real 

data enables now to apply simulations to assume the percentage of complex formation 

between different protein species in cells. 
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Figure 16: Simulated complex formation. In cells, labeling efficiency is a major issue and was reported 
to be in the order of ~30% for genetically encoded tags. Here colocalization was defined as the distance 
to the nearest neighbor within 25 nm and 0-100% of the molecules were simulated to reside in a 
complex. Assuming a protein copy number density of 867 particles per µm2 at 0% complex formation, 
already ~40% of colocalized molecules were detected. At 100% complex formation only ~58% of 
colocalization was detected. 
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5 Discussion and Outlook 
 

General 
In this thesis, DNA-PAINT was further developed to unravel its true potential in cellular 

systems. Different labeling chemistries were developed to attach DNA strands to 

biomolecules. Additionally, DNA nanoplatforms were generated to test the capability of 

labeling probes to resolve nanotemplated antigens. The probes were in the end applied to 

cellular super-resolution imaging to dissect molecular complexes. Finally, a cluster detection 

method to detect single DNA docking sites was implemented and simulations were performed 

for a more comprehensive interpretation of the DNA-PAINT data.  

 

Some important topics and challenges for the future of super-resolution microscopy are 

discussed in the following paragraphs. 

 
Resolution 
The field of super-resolution microscopy enabled the imaging and analysis of cellular 

processes beyond the diffraction limit of light. However, until recently it was not possible to 

analyze the distribution of single proteins. With the resolution revolution of the newly emerging 

technologies such as DNA-PAINT47, MINFLUX36 and expansion microscopy145, the resolution 

capabilities from a technical perspective are now on the order of single fluorophores. With this 

strong technical development, other aspects in super-resolution microscopy including labeling 

probes and data analysis pipelines have become the limiting factors. 

 

Labeling Probes 
Antibodies are a powerful tool for cell imaging, since they are widely available and have high 

specificity and high affinity to their targets. However, as depicted with the nanotemplating of 

antigens in chapter 4.1, antibodies are relatively large in size in comparison to the technical 

resolution capabilities of DNA-PAINT. Additionally, it is not straightforward to label them site-

specifically with a single DNA docking site for quantitative imaging approaches. To obtain site-

specifically modified DNA-Antibody constructs, site-click148 chemistry has been developed, 

which uses sugar side-chains of the antibody to modify them with a single chemical moiety. 

An alternative approach uses conserved histidine clusters that can mediate the local 

attachment of a chemical moiety to the antibody via tris-NTA guidance109. However, these 

methods are still tedious to implement. Small genetically-encoded tags such as SNAP95, 

Halo96, GFP87 or the ALFA tag99 can alternatively be used with small-molecule ligands or site-

specifically labeled nanobodies for the detection of single proteins in cells. Unfortunately, their 
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labeling efficiency has been recently reported to be only on the order of 30-60%55. 

Furthermore, these tags are not universally applicable since certain cell lines are difficult to 

engineer and an additional level of complexity arises if three or more targets are to be 

investigated in the same cell.   

In general, the remaining challenge in the field of labeling probes is that a perfect reagent 

needs to fulfill four main requirements: they need to be small (ideally the size of a fluorophore 

or a single amino acid), provide high labeling efficiency (~90-100%), have the possibility to be 

labeled site-specifically with a single DNA strand (for quantitative analysis and single-protein 

counting) and be universally applicable. This implies that a probe should be available for any 

target of interest, without the requirement of genetic engineering and tagging, which is not 

always possible. One universally applicable tool could be the use of FAB fragments, where 

screening libraries such as HUCAL149 are already available. FAB fragments can be site-

specifically labeled via the available disulfide-bridge between the heavy and light chain150. 

Beyond that, there are emerging scaffold libraries, including previously mentioned Affimers151, 

anticalines152, nanobodies87 or darpins89 which can be used as small alternative probes. Taken 

together, validated binders for super-resolution imaging are still limited.  

As an alternative to available scaffold libraries, the previously mentioned IRIS probes49 could 

be a solution as universally applicable binders with high labeling efficiency. IRIS probes utilize 

fragments of transiently and highly specific interacting proteins extracted from protein 

interaction networks and can be directly applied for PAINT imaging. However, one 

disadvantage of using IRIS probes is that the kinetics of each probe would have to be 

characterized in a cell-free system to truly quantify the molecular density. In this respect, DNA-

PAINT is much more universally applicable. Another attractive route would be to rationally 

design binders against targets of interest153.  

Nevertheless, in order to move DNA-PAINT based super-resolution microscopy to massive 

multiplexing applications, well characterized probes for 100s or 1000s of targets would be 

necessary. 

 

Massive high-throughput multiplexing 
So far, multiplexing was mainly limited to the microscopy setup specifics including available 

laser lines in combination with appropriate filter sets, thereby limiting the readout to three to 

four colors. More advanced strategies were able to decode up to 5-8 colors154. However, using 

programmable DNA sequences to encode different pseudo-colors has given a new 

perspective on multiplexing where up to 10 colors in one sample have been imaged with DNA-

PAINT2. Unfortunately, at some point the manual exchange of probes by buffer exchange is 

experimentally difficult, meaning that it needs to be highly automated. Regardless, the process 

is highly time consuming as it scales linearly with the number of targets. DNA as a 
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programmable building material harnesses the unique opportunity to encode the target with 

binary-encoding schemes as proposed by the Zhuang lab. Their approach enabled imaging 

of >1000 targets in only 12-16 exchange rounds with a method called MERFISH155. One pitfall 

of their method is that the sites need to be clearly discernible, for example using single mRNA 

species hybridized to tens of fluorophores. However, with DNA-PAINT and its associated high-

resolution, unlimited imaging and high sensitivity capabilities, this approach could in principle 

be translated to single protein imaging.  

 

Data analysis 
Once the data has been acquired with the highest resolution, using small labeling probes and 

with the largest number of targets possible, the data needs to be analyzed adequately and the 

main question remains: what can a list of spots tell us about the organization of proteins, which 

cannot be derived by other means? For example, protein interactions can be identified using 

mass spectrometry pull down assays. It is mainly the context in the cellular environment and 

the interplay with other proteins, which cannot be easily retrieved by other means. The first 

step is to really define the single protein sites, which can be determined by a variety of 

methods, including k-means127 clustering, DBSCAN126, a modification of Ripley’s K130 or the 

newly developed bagol156. All of these methods have their shortcomings and advantages, 

therefore, they need to be thoroughly evaluated against each other and against an underlying 

truth. To a certain extent, this can only be done accurately using DNA nanostructures. 

However, in a cellular environment, different factors come into play, such as the sticking of 

DNA labeled fluorophores to random sites. Once these single sites are determined, the 

second challenge of data analysis begins. Protein networks inside cells are highly dynamic 

systems. For instance, there are proteins that engage in the desired complex formation, 

proteins that are shuttled towards their site of action or towards degradation and more 

importantly, only a fraction of the molecules will be labeled and detected. In order to correctly 

interpret the data, simulations can be an extremely helpful tool to consider the labeling 

efficiency and extract the true molecular densities of the proteins. Such simulations can help 

to understand the distribution pattern of proteins. Additionally, machine learning approaches 

were developed132 to automatically detect patterns and assay their heterogeneity or their 

complex formation. With those tools at hand it should now become possible to dissect single 

protein distributions.  

 

Molecular Timers 
Another major challenge in single-molecule localization microscopy, and especially in DNA-

PAINT is that it is currently not applicable for live-cell microscopy due to several technical 

limitations, hence why it is mostly performed in fixed cell systems. Therefore, if a molecular 
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mechanism needs to be dissected (such as a receptor activation), the timing of signaling 

events play an important role. For this, a molecular timer could be extremely useful, which 

could be envisioned using micropatterns, where cells repetitively perform the same action. For 

example, it would be possible to infer the timing of focal adhesion formation through 

progression of the cell within the micropatterned environment157. Such a molecular timer could 

alternatively be envisioned as a reference protein which is known to progress in a certain way 

and was demonstrated in Mund et al’s work for clathrin mediated endocytosis158. 

 
Structural context 
Single-molecule localization data consists of a list of spots or clustered spots. However, cells 

are usually organized in organelles, such as mitochondria, vesicles, ER or Golgi. One 

remaining challenge is that there is barely any structural context associated with the 

localization data, unless structural proteins are investigated. To achieve this, it could be of 

interest to combine SMLM with electron microscopy to provide organellar and structural 

context, as was previously reported by Hoffman et al.159. 

 

With the now available tools, super-resolution microscopy techniques should aim to unravel 

the function of single bio-functional units on the single-protein level in the future. 
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8 Appendix 
 

The first part of the Appendix includes the methods applied in chapter 4 of the thesis followed 

by the publications which were written during the course of the PhD. 

 

8.1 Methods  
 
Microscopy Setup 
Fluorescence imaging was carried out on an inverted Nikon Eclipse Ti microscope (Nikon 

Instruments) equipped with the Perfect Focus System, using an objective-type TIRF 

configuration with an oil-immersion objective (Apo SR TIRF 100×, NA 1.49, Oil) as previously 

reported160. In brief, TIRF/Hilo angle was adjusted for highest signal to noise ratio when 

imaging. A 561 nm (200 mW, Coherent Sapphire) laser was used for excitation. The laser 

beam was passed through cleanup filters (ZET561/10, Chroma Technology) and coupled into 

the objective using a beam splitter (ZT561rdc, Chroma Technology). Fluorescence light was 

spectrally filtered with an emission filter (ET600/50m and ET575lp, Chroma Technology) and 

imaged on a sCMOS camera (Andor Zyla 4.2) without further magnification, resulting in an 

effective pixel size of 130 nm (sCMOS after 2×2 binning). 

 
Nanobody conjugation 
ALFA-tag nanobody conjugation to DNA strands was performed at cysteine residues as 

reported previously144,160. In brief, ALFA-tag nanobodies (NanoTag Biotechnologies, cat. no. 

N1502) were first concentrated for 5 min via Amicon 10 kDa spin filters (Merck, cat. no. 

UFC501096) and buffer was changed to 5 mM TCEP (ThermoFisher Scientific, cat. no. 20490) 

in 1xPBS (ThermoFisher Scientific, cat. no. 20012-019) supplemented with 3 mM EDTA 

(Ambion, cat. no. AM9261). 5 mM TCEP was additionally added to 100 µl of nanobody solution 

and incubated in the dark at 4°C. Afterwards, nanobody was buffer exchanged with 10 kDa 

Amicon Spin filters at 14.000xg for 5 min for 5 rounds and subsequently DBCO-Maleimide 

crosslinker (Sigma-Aldrich, cat. no. 760668) was added to 100 µl of nanobody solution at 20x 

molar excess of linker over nanobody in 5 µl and reacted at 4°C overnight. Free crosslinker 

was removed via 10 kDa Amicon spin filters at 14.000xg for 5 min for 5 rounds. Azide-modified 

DNA was then added to the nanobody at 10x molar excess over nanobody. Removal of free 

DNA from nanobody was performed using a GE Aekta purifier system and a 1 ml RESOURCE 

Q (GE Healthcare, cat. no. 17-1177-01) anion-exchange chromatography column. Salt 
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gradient from 1xPBS to 1xPBS+1M NaCl was performed at a flow rate of 1 ml/min over 30 

min. Peak fractions were concentrated and buffer exchanged into 1xPBS via 10 kDa Amicon 

spin filters. DNA conjugated nanobody was stored at 4°C until further use. 

 
 
Antibody Conjugation 
Antibody conjugation was performed as reported previously48 using SPAAC. In brief, 300 µl of 

secondary donkey anti-rabbit antibody (Jackson ImmunoResearch, cat. no. 711-005-152) was 

concentrated using 100 kDa Amicon ultra spin filters (Merck, cat. no. UFC510096) at 14.000xg 

for 5 min and adjusted to 100 µl in 1xPBS. NHS-DBCO heterobifunctional crosslinker (Jena 

Bioscience, cat. no. CLK-A124-10) was added in 10x molar excess over antibody in 5 µl to 

100 µl of antibody solution and incubated at 4 °C in the dark for 2 h. Free crosslinker was 

removed after 2 h using 7 kDa zeba spin columns (ThermoFisher Scientific, cat. no. 89882) 

according to the manual and commercially available azide-modified DNA (Biomers.net) was 

added at 10x molar excess to the antibody for 1 h at room temperature. Final purification was 

performed via 100 kDa amicon spin filters for three rounds at 14.000xg for 5 min each and 

antibody was adjusted to 100 µl and stored at 4 °C until further use.  

 
Peptide-DNA conjugation 
Peptides were ordered and produced at the Max-Planck Institute of Biochemistry Peptide 

facility, harboring an azide-modified amino acid at their N-terminus (Iris Biotech, cat. no. 

FAA1793). Peptide was reacted at 20x molar excess over commercially available DBCO-DNA 

(Biomers.net) at 4°C overnight in 1xPBS. Purification of DNA-peptide conjugates was 

performed via a RESOURCE Q anion-exchange chromatography column using a 30 min 

gradient from 1xPBS to 1xPBS+1M NaCl. Peak fractions were concentrated via 3 kDa Amicon 

ultra spin filters (Merck, cat. no. UFC500396). DNA-Peptide conjugates were aliquoted and 

stored at -20°C. 

Peptides were attached to following strand:  

5’-DBCO-TTC CTC TAC CAC CTA CAT CAC TTT CTT CAT TA – 3’ 

 

Peptides:  

ALFA: Azide-Lysine-SRLEEELRRRLTE 
 

pCTD: Azide-Lysine-YSPTSpPS 
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DNA Origami Design 
20 nm grid DNA origami structure was designed with the Picasso software suite as reported 

previously48. Following design was chosen: 

 
Supplementary Figure 1: 20 nm grid DNA origami design. Green hexagons mark the staple extension 
positions, grey hexagons are core staples without extension. 
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Supplementray Table 1: Staple list for DNA origami assembly: 

Plate Staple Staple Name Sequence 

1 A1 21[32]23[31]BLK TTTTCACTCAAAGGGCGAAAAACCATCACC 

1 A2 19[32]21[31]BLK GTCGACTTCGGCCAACGCGCGGGGTTTTTC 

1 A3 17[32]19[31]S1 TGCATCTTTCCCAGTCACGACGGCCTGCAG 
TTGTGATGTAGGTGGTAGAGGAA 

1 A4 15[32]17[31]BLK TAATCAGCGGATTGACCGTAATCGTAACCG 

1 A5 13[32]15[31]BLK AACGCAAAATCGATGAACGGTACCGGTTGA 

1 A6 11[32]13[31]BLK AACAGTTTTGTACCAAAAACATTTTATTTC 

1 A7 9[32]11[31]S1 TTTACCCCAACATGTTTTAAATTTCCATAT 
TTGTGATGTAGGTGGTAGAGGAA 

1 A8 7[32]9[31]BLK TTTAGGACAAATGCTTTAAACAATCAGGTC 

1 A9 5[32]7[31]BLK CATCAAGTAAAACGAACTAACGAGTTGAGA 

1 A10 3[32]5[31]BLK AATACGTTTGAAAGAGGACAGACTGACCTT 

1 A11 1[32]3[31]S1 AGGCTCCAGAGGCTTTGAGGACACGGGTAA 
TTGTGATGTAGGTGGTAGAGGAA 

1 A12 0[47]1[31]BLK AGAAAGGAACAACTAAAGGAATTCAAAAAAA 

1 B1 23[32]22[48]BLK CAAATCAAGTTTTTTGGGGTCGAAACGTGGA 

1 B2 22[47]20[48]BLK CTCCAACGCAGTGAGACGGGCAACCAGCTGCA 

1 B3 20[47]18[48]BLK TTAATGAACTAGAGGATCCCCGGGGGGTAACG 

1 B4 18[47]16[48]BLK CCAGGGTTGCCAGTTTGAGGGGACCCGTGGGA 

1 B5 16[47]14[48]BLK ACAAACGGAAAAGCCCCAAAAACACTGGAGCA 

1 B6 14[47]12[48]BLK AACAAGAGGGATAAAAATTTTTAGCATAAAGC 

1 B7 12[47]10[48]BLK TAAATCGGGATTCCCAATTCTGCGATATAATG 

1 B8 10[47]8[48]BLK CTGTAGCTTGACTATTATAGTCAGTTCATTGA 

1 B9 8[47]6[48]BLK ATCCCCCTATACCACATTCAACTAGAAAAATC 

1 B10 6[47]4[48]BLK TACGTTAAAGTAATCTTGACAAGAACCGAACT 

1 B11 4[47]2[48]BLK GACCAACTAATGCCACTACGAAGGGGGTAGCA 

1 B12 2[47]0[48]BLK ACGGCTACAAAAGGAGCCTTTAATGTGAGAAT 

1 C1 21[56]23[63]BLK AGCTGATTGCCCTTCAGAGTCCACTATTAAAGGGTGCCGT 

1 C2     

1 C3     

1 C4 15[64]18[64]BLK GTATAAGCCAACCCGTCGGATTCTGACGACAGTATCGGCCGCAAGGCG 

1 C5 13[64]15[63]BLK TATATTTTGTCATTGCCTGAGAGTGGAAGATT 

1 C6 11[64]13[63]BLK GATTTAGTCAATAAAGCCTCAGAGAACCCTCA 

1 C7 9[64]11[63]BLK CGGATTGCAGAGCTTAATTGCTGAAACGAGTA 

1 C8 7[56]9[63]BLK ATGCAGATACATAACGGGAATCGTCATAAATAAAGCAAAG 

1 C9     

1 C10     

1 C11 1[64]4[64]BLK TTTATCAGGACAGCATCGGAACGACACCAACCTAAAACGAGGTCAATC 

1 C12 0[79]1[63]BLK ACAACTTTCAACAGTTTCAGCGGATGTATCGG 
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1 D1 23[64]22[80]BLK AAAGCACTAAATCGGAACCCTAATCCAGTT 

1 D2 22[79]20[80]BLK TGGAACAACCGCCTGGCCCTGAGGCCCGCT 

1 D3 20[79]18[80]BLK TTCCAGTCGTAATCATGGTCATAAAAGGGG 

1 D4 18[79]16[80]BLK GATGTGCTTCAGGAAGATCGCACAATGTGA 

1 D5 16[79]14[80]BLK GCGAGTAAAAATATTTAAATTGTTACAAAG 

1 D6 14[79]12[80]BLK GCTATCAGAAATGCAATGCCTGAATTAGCA 

1 D7 12[79]10[80]BLK AAATTAAGTTGACCATTAGATACTTTTGCG 

1 D8 10[79]8[80]BLK GATGGCTTATCAAAAAGATTAAGAGCGTCC 

1 D9 8[79]6[80]BLK AATACTGCCCAAAAGGAATTACGTGGCTCA 

1 D10 6[79]4[80]BLK TTATACCACCAAATCAACGTAACGAACGAG 

1 D11 4[79]2[80]BLK GCGCAGACAAGAGGCAAAAGAATCCCTCAG 

1 D12 2[79]0[80]BLK CAGCGAAACTTGCTTTCGAGGTGTTGCTAA 

1 E1 21[96]23[95]BLK AGCAAGCGTAGGGTTGAGTGTTGTAGGGAGCC 

1 E2 19[96]21[95]BLK CTGTGTGATTGCGTTGCGCTCACTAGAGTTGC 

1 E3 17[96]19[95]S1 GCTTTCCGATTACGCCAGCTGGCGGCTGTTTC 
TTGTGATGTAGGTGGTAGAGGAA 

1 E4 15[96]17[95]BLK ATATTTTGGCTTTCATCAACATTATCCAGCCA 

1 E5 13[96]15[95]BLK TAGGTAAACTATTTTTGAGAGATCAAACGTTA 

1 E6 11[96]13[95]BLK AATGGTCAACAGGCAAGGCAAAGAGTAATGTG 

1 E7 9[96]11[95]S1 CGAAAGACTTTGATAAGAGGTCATATTTCGCA 
TTGTGATGTAGGTGGTAGAGGAA 

1 E8 7[96]9[95]BLK TAAGAGCAAATGTTTAGACTGGATAGGAAGCC 

1 E9 5[96]7[95]BLK TCATTCAGATGCGATTTTAAGAACAGGCATAG 

1 E10 3[96]5[95]BLK ACACTCATCCATGTTACTTAGCCGAAAGCTGC 

1 E11 1[96]3[95]S1 AAACAGCTTTTTGCGGGATCGTCAACACTAAA 
TTGTGATGTAGGTGGTAGAGGAA 

1 E12 0[111]1[95]BLK TAAATGAATTTTCTGTATGGGATTAATTTCTT 

1 F1 23[96]22[112]BLK CCCGATTTAGAGCTTGACGGGGAAAAAGAATA 

1 F2 22[111]20[112]BLK GCCCGAGAGTCCACGCTGGTTTGCAGCTAACT 

1 F3 20[111]18[112]BLK CACATTAAAATTGTTATCCGCTCATGCGGGCC 

1 F4 18[111]16[112]BLK TCTTCGCTGCACCGCTTCTGGTGCGGCCTTCC 

1 F5 16[111]14[112]BLK TGTAGCCATTAAAATTCGCATTAAATGCCGGA 

1 F6 14[111]12[112]BLK GAGGGTAGGATTCAAAAGGGTGAGACATCCAA 

1 F7 12[111]10[112]BLK TAAATCATATAACCTGTTTAGCTAACCTTTAA 

1 F8 10[111]8[112]BLK TTGCTCCTTTCAAATATCGCGTTTGAGGGGGT 

1 F9 8[111]6[112]BLK AATAGTAAACACTATCATAACCCTCATTGTGA 

1 F10 6[111]4[112]BLK ATTACCTTTGAATAAGGCTTGCCCAAATCCGC 

1 F11 4[111]2[112]BLK GACCTGCTCTTTGACCCCCAGCGAGGGAGTTA 

1 F12 2[111]0[112]BLK AAGGCCGCTGATACCGATAGTTGCGACGTTAG 

1 G1 21[120]23[127]BLK CCCAGCAGGCGAAAAATCCCTTATAAATCAAGCCGGCG 

1 G2     
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1 G3     

1 G4 15[128]18[128]BLK TAAATCAAAATAATTCGCGTCTCGGAAACCAGGCAAAGGGAAGG 

1 G5 13[128]15[127]BLK GAGACAGCTAGCTGATAAATTAATTTTTGT 

1 G6 11[128]13[127]BLK TTTGGGGATAGTAGTAGCATTAAAAGGCCG 

1 G7 9[128]11[127]BLK GCTTCAATCAGGATTAGAGAGTTATTTTCA 

1 G8 7[120]9[127]BLK CGTTTACCAGACGACAAAGAAGTTTTGCCATAATTCGA 

1 G9     

1 G10     

1 G11 1[128]4[128]BLK TGACAACTCGCTGAGGCTTGCATTATACCAAGCGCGATGATAAA 

1 G12 0[143]1[127]BLK TCTAAAGTTTTGTCGTCTTTCCAGCCGACAA 

1 H1 21[160]22[144]BLK TCAATATCGAACCTCAAATATCAATTCCGAAA 

1 H2 19[160]20[144]BLK GCAATTCACATATTCCTGATTATCAAAGTGTA 

1 H3 17[160]18[144]BLK AGAAAACAAAGAAGATGATGAAACAGGCTGCG 

1 H4 15[160]16[144]BLK ATCGCAAGTATGTAAATGCTGATGATAGGAAC 

1 H5 13[160]14[144]BLK GTAATAAGTTAGGCAGAGGCATTTATGATATT 

1 H6 11[160]12[144]BLK CCAATAGCTCATCGTAGGAATCATGGCATCAA 

1 H7 9[160]10[144]BLK AGAGAGAAAAAAATGAAAATAGCAAGCAAACT 

1 H8 7[160]8[144]BLK TTATTACGAAGAACTGGCATGATTGCGAGAGG 

1 H9 5[160]6[144]BLK GCAAGGCCTCACCAGTAGCACCATGGGCTTGA 

1 H10 3[160]4[144]BLK TTGACAGGCCACCACCAGAGCCGCGATTTGTA 

1 H11 1[160]2[144]BLK TTAGGATTGGCTGAGACTCCTCAATAACCGAT 

1 H12 0[175]0[144]BLK TCCACAGACAGCCCTCATAGTTAGCGTAACGA 

2 A1 23[128]23[159]BLK AACGTGGCGAGAAAGGAAGGGAAACCAGTAA 

2 A2 22[143]21[159]BLK TCGGCAAATCCTGTTTGATGGTGGACCCTCAA 

2 A3 20[143]19[159]S1 AAGCCTGGTACGAGCCGGAAGCATAGATGATG 
TTGTGATGTAGGTGGTAGAGGAA 

2 A4 18[143]17[159]BLK CAACTGTTGCGCCATTCGCCATTCAAACATCA 

2 A5 16[143]15[159]BLK GCCATCAAGCTCATTTTTTAACCACAAATCCA 

2 A6 14[143]13[159]BLK CAACCGTTTCAAATCACCATCAATTCGAGCCA 

2 A7 12[143]11[159]S1 TTCTACTACGCGAGCTGAAAAGGTTACCGCGC 
TTGTGATGTAGGTGGTAGAGGAA 

2 A8 10[143]9[159]BLK CCAACAGGAGCGAACCAGACCGGAGCCTTTAC 

2 A9 8[143]7[159]BLK CTTTTGCAGATAAAAACCAAAATAAAGACTCC 

2 A10 6[143]5[159]BLK GATGGTTTGAACGAGTAGTAAATTTACCATTA 

2 A11 4[143]3[159]S1 TCATCGCCAACAAAGTACAACGGACGCCAGCA 
TTGTGATGTAGGTGGTAGAGGAA 

2 A12 2[143]1[159]BLK ATATTCGGAACCATCGCCCACGCAGAGAAGGA 

2 B1 23[160]22[176]BLK TAAAAGGGACATTCTGGCCAACAAAGCATC 

2 B2 22[175]20[176]BLK ACCTTGCTTGGTCAGTTGGCAAAGAGCGGA 

2 B3 20[175]18[176]BLK ATTATCATTCAATATAATCCTGACAATTAC 

2 B4 18[175]16[176]BLK CTGAGCAAAAATTAATTACATTTTGGGTTA 
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2 B5 16[175]14[176]BLK TATAACTAACAAAGAACGCGAGAACGCCAA 

2 B6 14[175]12[176]BLK CATGTAATAGAATATAAAGTACCAAGCCGT 

2 B7 12[175]10[176]BLK TTTTATTTAAGCAAATCAGATATTTTTTGT 

2 B8 10[175]8[176]BLK TTAACGTCTAACATAAAAACAGGTAACGGA 

2 B9 8[175]6[176]BLK ATACCCAACAGTATGTTAGCAAATTAGAGC 

2 B10 6[175]4[176]BLK CAGCAAAAGGAAACGTCACCAATGAGCCGC 

2 B11 4[175]2[176]BLK CACCAGAAAGGTTGAGGCAGGTCATGAAAG 

2 B12 2[175]0[176]BLK TATTAAGAAGCGGGGTTTTGCTCGTAGCAT 

2 C1 21[184]23[191]BLK TCAACAGTTGAAAGGAGCAAATGAAAAATCTAGAGATAGA 

2 C2     

2 C3     

2 C4 15[192]18[192]BLK TCAAATATAACCTCCGGCTTAGGTAACAATTTCATTTGAAGGCGAATT 

2 C5 13[192]15[191]BLK GTAAAGTAATCGCCATATTTAACAAAACTTTT 

2 C6 11[192]13[191]BLK TATCCGGTCTCATCGAGAACAAGCGACAAAAG 

2 C7 9[192]11[191]BLK TTAGACGGCCAAATAAGAAACGATAGAAGGCT 

2 C8 7[184]9[191]BLK CGTAGAAAATACATACCGAGGAAACGCAATAAGAAGCGCA 

2 C9     

2 C10     

2 C11 1[192]4[192]BLK GCGGATAACCTATTATTCTGAAACAGACGATTGGCCTTGAAGAGCCAC 

2 C12 0[207]1[191]BLK TCACCAGTACAAACTACAACGCCTAGTACCAG 

2 D1 23[192]22[208]BLK ACCCTTCTGACCTGAAAGCGTAAGACGCTGAG 

2 D2 22[207]20[208]BLK AGCCAGCAATTGAGGAAGGTTATCATCATTTT 

2 D3 20[207]18[208]BLK GCGGAACATCTGAATAATGGAAGGTACAAAAT 

2 D4 18[207]16[208]BLK CGCGCAGATTACCTTTTTTAATGGGAGAGACT 

2 D5 16[207]14[208]BLK ACCTTTTTATTTTAGTTAATTTCATAGGGCTT 

2 D6 14[207]12[208]BLK AATTGAGAATTCTGTCCAGACGACTAAACCAA 

2 D7 12[207]10[208]BLK GTACCGCAATTCTAAGAACGCGAGTATTATTT 

2 D8 10[207]8[208]BLK ATCCCAATGAGAATTAACTGAACAGTTACCAG 

2 D9 8[207]6[208]BLK AAGGAAACATAAAGGTGGCAACATTATCACCG 

2 D10 6[207]4[208]BLK TCACCGACGCACCGTAATCAGTAGCAGAACCG 

2 D11 4[207]2[208]BLK CCACCCTCTATTCACAAACAAATACCTGCCTA 

2 D12 2[207]0[208]BLK TTTCGGAAGTGCCGTCGAGAGGGTGAGTTTCG 

2 E1 21[224]23[223]BLK CTTTAGGGCCTGCAACAGTGCCAATACGTG 

2 E2 19[224]21[223]BLK CTACCATAGTTTGAGTAACATTTAAAATAT 

2 E3 17[224]19[223]S1 CATAAATCTTTGAATACCAAGTGTTAGAAC 
TTGTGATGTAGGTGGTAGAGGAA 

2 E4 15[224]17[223]BLK CCTAAATCAAAATCATAGGTCTAAACAGTA 

2 E5 13[224]15[223]BLK ACAACATGCCAACGCTCAACAGTCTTCTGA 

2 E6 11[224]13[223]BLK GCGAACCTCCAAGAACGGGTATGACAATAA 

2 E7 9[224]11[223]S1 AAAGTCACAAAATAAACAGCCAGCGTTTTA 
TTGTGATGTAGGTGGTAGAGGAA 
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2 E8 7[224]9[223]BLK AACGCAAAGATAGCCGAACAAACCCTGAAC 

2 E9 5[224]7[223]BLK TCAAGTTTCATTAAAGGTGAATATAAAAGA 

2 E10 3[224]5[223]BLK TTAAAGCCAGAGCCGCCACCCTCGACAGAA 

2 E11 1[224]3[223]S1 GTATAGCAAACAGTTAATGCCCAATCCTCA 
TTGTGATGTAGGTGGTAGAGGAA 

2 E12 0[239]1[223]BLK AGGAACCCATGTACCGTAACACTTGATATAA 

2 F1 23[224]22[240]BLK GCACAGACAATATTTTTGAATGGGGTCAGTA 

2 F2 22[239]20[240]BLK TTAACACCAGCACTAACAACTAATCGTTATTA 

2 F3 20[239]18[240]BLK ATTTTAAAATCAAAATTATTTGCACGGATTCG 

2 F4 18[239]16[240]BLK CCTGATTGCAATATATGTGAGTGATCAATAGT 

2 F5 16[239]14[240]BLK GAATTTATTTAATGGTTTGAAATATTCTTACC 

2 F6 14[239]12[240]BLK AGTATAAAGTTCAGCTAATGCAGATGTCTTTC 

2 F7 12[239]10[240]BLK CTTATCATTCCCGACTTGCGGGAGCCTAATTT 

2 F8 10[239]8[240]BLK GCCAGTTAGAGGGTAATTGAGCGCTTTAAGAA 

2 F9 8[239]6[240]BLK AAGTAAGCAGACACCACGGAATAATATTGACG 

2 F10 6[239]4[240]BLK GAAATTATTGCCTTTAGCGTCAGACCGGAACC 

2 F11 4[239]2[240]BLK GCCTCCCTCAGAATGGAAAGCGCAGTAACAGT 

2 F12 2[239]0[240]BLK GCCCGTATCCGGAATAGGTGTATCAGCCCAAT 

2 G1 21[248]23[255]BLK AGATTAGAGCCGTCAAAAAACAGAGGTGAGGCCTATTAGT 

2 G2     

2 G3     

2 G4 15[256]18[256]BLK GTGATAAAAAGACGCTGAGAAGAGATAACCTTGCTTCTGTTCGGGAGA 

2 G5 13[256]15[255]BLK GTTTATCAATATGCGTTATACAAACCGACCGT 

2 G6 11[256]13[255]BLK GCCTTAAACCAATCAATAATCGGCACGCGCCT 

2 G7 9[256]11[255]BLK GAGAGATAGAGCGTCTTTCCAGAGGTTTTGAA 

2 G8 7[248]9[255]BLK GTTTATTTTGTCACAATCTTACCGAAGCCCTTTAATATCA 

2 G9     

2 G10     

2 G11 1[256]4[256]BLK CAGGAGGTGGGGTCAGTGCCTTGAGTCTCTGAATTTACCGGGAACCAG 

2 G12 0[271]1[255]BLK CCACCCTCATTTTCAGGGATAGCAACCGTACT 

2 H1 23[256]22[272]BLK CTTTAATGCGCGAACTGATAGCCCCACCAG 

2 H2 22[271]20[272]BLK CAGAAGATTAGATAATACATTTGTCGACAA 

2 H3 20[271]18[272]BLK CTCGTATTAGAAATTGCGTAGATACAGTAC 

2 H4 18[271]16[272]BLK CTTTTACAAAATCGTCGCTATTAGCGATAG 

2 H5 16[271]14[272]BLK CTTAGATTTAAGGCGTTAAATAAAGCCTGT 

2 H6 14[271]12[272]BLK TTAGTATCACAATAGATAAGTCCACGAGCA 

2 H7 12[271]10[272]BLK TGTAGAAATCAAGATTAGTTGCTCTTACCA 

2 H8 10[271]8[272]BLK ACGCTAACACCCACAAGAATTGAAAATAGC 

2 H9 8[271]6[272]BLK AATAGCTATCAATAGAAAATTCAACATTCA 

2 H10 6[271]4[272]BLK ACCGATTGTCGGCATTTTCGGTCATAATCA 

2 H11 4[271]2[272]BLK AAATCACCTTCCAGTAAGCGTCAGTAATAA 
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2 H12 2[271]0[272]BLK GTTTTAACTTAGTACCGCCACCCAGAGCCA 

 

 

Supplementary Table 2: Sequences of biotinylated staples: 
No Positi

on 
Name Sequence Mod. 

1 C02 18[63]20[56]BIOTIN ATTAAGTTTACCGAGCTCGAATTCGGGA
AACCTGTCGTGC 

5'-BT 

2 C09 4[63]6[56]BIOTIN ATAAGGGAACCGGATATTCATTACGTCA
GGACGTTGGGAA 

5'-BT 

3 G02 18[127]20[120]BIOTIN GCGATCGGCAATTCCACACAACAGGTG
CCTAATGAGTG 

5'-BT 

4 G09 4[127]6[120]BIOTIN TTGTGTCGTGACGAGAAACACCAAATTT
CAACTTTAAT 

5'-BT 

5 K02 18[191]20[184]BIOTIN ATTCATTTTTGTTTGGATTATACTAAGAA
ACCACCAGAAG 

5'-BT 

6 K09 4[191]6[184]BIOTIN CACCCTCAGAAACCATCGATAGCATTGA
GCCATTTGGGAA 

5'-BT 

7 O02 18[255]20[248]BIOTIN AACAATAACGTAAAACAGAAATAAAAAT
CCTTTGCCCGAA 

5'-BT 

8 O09 4[255]6[248]BIOTIN AGCCACCACTGTAGCGCGTTTTCAAGG
GAGGGAAGGTAAA 

5'-BT 

 

 

Staple strands for peptide attachment were extended with following sequence:  

Staple – TTGTGATGTAGGTGGTAGAGGAA-3’ 
 
DNA Origami Folding 
DNA origami structures were folded with 10 nM M13mp18 scaffold strand (tilibit nanosystems), 

100 nM core staple strands (Eurofins Genomics, see supplementary table), 300 nM 

biotinylated strands (Eurofins Genomics, see supplementary table) for surface attachment, 

300 nM of extension strands (Eurofins Genomics, see supplementary table) and 4 µM of 

Peptide-DNA in a total of 50 µl. Buffer conditions were 5 mM Tris (Ambion, cat. no. AM9856) 

and 1 mM EDTA (Ambion, cat. no. AM9261) supplemented with 12.5 mM MgCl2 (Ambion, cat. 

no. AM9530G) Folding reaction was carried out in a thermocycler with following program: 

5 min at 80 °C followed by a fast cool down to 60 °C and a slow cooling from 60-4 °C over the 

course of 3 h in 1 °C steps.  

 
DNA Origami Purification 
DNA nanostructures were purified via PEG purification as previously reported161. In brief, 

folded DNA origami was mixed 1:1 with 15 % of PEG-buffer (consisting of: 7.5 g PEG-8k, 

1xTAE, 12.5 mM MgCl2 and 500 mM NaCl). Mixed solution was centrifuged at 20.000xg at 4 

°C for 30 min after which supernatant was removed and the DNA was resuspended with 50 

µl of folding buffer and 50 µl of 15 % PEG-buffer was added. Centrifugation and supernatant 
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removal were repeated three additional times, at the last step, DNA origami was resuspended 

in 50 µl folding buffer only. DNA origami structures were stored at -20 °C. 

 
Microscopy Slide Preparation 
PEG surfaces were prepared as previously reported162. Microscopy slides (Marienfeld, cat. 

no. 0107032) were rinsed twice with Milli-Q water and bath-sonicated for 10 min to remove 

any organic residue from the surface. Rinsing and sonication steps were repeated with 

methanol (Sigma Aldrich, cat. no. 34860-2.5l-M) and acetone (ThermoFisher Scientific, cat. 

no. A060017). To activate the surface for silane functionalization, the slides were sonicated in 

1 M KOH (Carl Roth, cat. no. K017.1) for 20 min and then rinsed with Milli-Q water. Afterwards, 

the slides were blow dried and aminosilane solution mix (86 ml of methanol, 5 ml acetic acid 

(Honeywell, cat. no. 607-002-00-6) and 10 ml aminosilane (Sigma Aldrich, cat. no. 104884-

100ML)) were poured over the slides and incubated in the dark for 20 min. The slides were 

then washed with methanol and water for 1-2 min per wash, blow dried and stored under argon 

atmosphere until use. For PEG passivation, slides were attached to a home build channel 

system on a microscopy slide. 16 mg of NHS-mPEG 5000 (Rapp Polymere, cat. no. 125000-

35) were mixed with 0.3 mg of NHS-biotin-PEG (Rapp Polymere, cat. no. 135000-25-35) in 

sodium bicarbonate buffer (Sigma Aldrich, cat. no. S5761-1kg) at pH 8.5 for 2 h. The channel 

was then washed with milli-Q water and buffer A (10 mM Tris-HCL supplemented with 100 

mM NaCl at pH 8.0) and incubated with 0.5 mg/ml neutravidin (ThermoFisher Scientific, cat. 

no. 31000) in buffer A for 10 min. Afterwards, the slide was washed with buffer A, buffer C 

(1xPBS supplemented with 500 mM NaCl) and DNA nanostructures harboring the antigenic 

peptide were added to the surface for 10 min at a concentration of 500 pM in buffer C. After 

washing the channel with buffer C, DNA-labeled binders were added and incubated with the 

origami structures for 20 min. In case of the pCTD antigen, the primary probe was washed 

away and the secondary DNA labeled antibody was added in an additional round for 20 min. 

After an additional washing step, gold nanoparticles (Cytodiagnostics, cat. no. CG-90-100) in 

a 1:3 ratio in buffer C were incubated for 5 min on the slide. After washing the slide with buffer 

C, the prepared channels were used directly for imaging. 

 
Super-Resolution Microscopy with DNA-PAINT 
The prepared microchannels on the microscopy slide with the DNA origami structures were 

imaged in imaging buffer (1xPBS supplemented with 500 mM NaCl and 

1xPCA/1xPCD/1xTrolox) with P1 first and an exchange was performed to the true target 

position P3. Imaging was performed for P1 (6 nM imager concentration) and P3 (7 nM imager 

concentration) for 20.000 frames at a frame rate of 100 ms and a readout rate of 540 MHz on 

a 2x2 binned sCMOS camera with a power density of 0.8 kW/cm2. 
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Supplementary Table 3: DNA-PAINT imager strands 

Imager Name Sequence 5’mod 3’mod Company 
P1 AGA TGT AT None Cy3b Eurofins 
P3 AAT GAA GA None Cy3b Eurofins 
X61 AATTGAGGA None Cy3b Eurofins 
P7 GTACTCAATT 

 
None Cy3b Eurofins 

 

Supplementary Table 4: DNA-PAINT docking site strands 

Docking Site  Sequence 5’mod 3’mod Company 
P1 TTATACATCTA Azide None Biomers 
P3 TTTCTTCATTA Azide/Halo 

Ligand 
None Biomers 

X61 TTTCCTCAATT Snap Ligand  Biomers 
P7 TTAATTGAGTA Azide  Biomers 
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Image Reconstruction 
Image reconstruction was performed via the Picasso software suite48. First, single 

localizations were detected and fitted with Picasso localize. Localized lists were then drift 

corrected and aligned in Picasso Render using gold nanoparticles. 

 

Description of modified Ripley’s K Function implementation (Clusterer) 
The function was implemented to find cluster centers and only uses a distance parameter as 

input variable. The number of neighboring localizations within the distance parameter is 

calculated for each localization. The first step of the algorithm is to make it fast and generate 

overlapping 30nmx30nm quadrants of the dataset. Afterwards from every localization in a 

quadrant all localizations within a distance r are counted. In the next step, the cluster centers 

are determined via a gradient ascent to the localization at the point of highest density. A cluster 

center is defined if within the distance r, no localization is found, which harbors a larger number 

of neighbors. Once the cluster centers are determined, the localizations within distance r are 

assigned to the cluster. In the next step, the clusters are filtered for the number of localizations 

and for the mean frame of all localizations to be within 20 and 80 percent of the total 

acquisition. As a last filtering step, if in one localization window (5% of total acquisition) more 

then 70% of the localizations occur, the cluster is removed. This step is performed to remove 

clusters which were detected only due to imager sticking events. The algorithm yields a list of 

localizations assigned to a certain cluster, which can be displayed with Picasso Render. 

Additionally, it provides the center of mass for every detected cluster, which was further used 

to calculate the nearest neighbor distances between the individual clusters. The code works 

with any Picasso generated hdf5 localization file. 

 

Performance evaluation of clustering algorithm 
50 pairs of DNA-PAINT clusters were simulated with the parameters depicted in 

supplementary table 5. For the 10 nm separated clusters, various distances as input 

parameter (1-10 nm) were assayed for the clustering algorithms (Clusterer and DBSCAN) 

using a fixed threshold value of 10 localizations to be a specific cluster. The detected clusters 

were counted and compared to the simulated input number of clusters. To assay the 

performance to resolve pairs at various distances (2 – 20 nm), 3 nm was chosen as input 

distance parameter for the different clustering algorithms. Detected sites were compared to 

the simulated number of clusters (100) and analyzed with OriginPro 9.1. 

 

Simulation of complex formation 
Particles were positioned with a random x and y coordinate. Depending on the degree of 

complex formation (0-100%), molecules of dataset two were reassigned within a distance of 
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12-16 nm in a random direction of a molecule from dataset one. After repositioning of the 

molecules, 70% of the simulated particles were randomly removed in both datasets to account 

for the labeling efficiency. The percentage of colocalization below 25 nm between the 

remaining molecules of the two datasets was afterwards calculated and analyzed with 

OriginPro 9.1. Five replicates of the simulation were performed and a total of 25000 molecules 

per dataset and replicate were simulated.  

 
Supplementary Table 5: Simulations for performance evaluation of clustering algorithms 

Parameter Value 
Number of Structures 50 

Columns:  

Rows: 

2 

1 

Structure X 0.0, variable distance (2-20 nm) 

Structure Y 0.0, 0.0 

kon 2300000 M-1s-1 

Imager concentration 7 nM 

Bright time 500 ms 

Incorporation 100 % 

PSF 0.82 

Power density 1 kW/cm2 

Photonbudget 1500000  

Photon detection rate 35 cm2kW-1 ms-1 

Image size 32 Px 

Integration time 200 ms 

Frames 15000 

Pixelsize 130 
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Supplementary Table 6: Imaging parameters for Figure 11 
Target & Cells Fixation Condition Staining Acquisition Parameters 

Nuclear Pores: 

Cells: SNAP-UO2S 

2.4 % PFA for 30 min SNAP-X61 [c] = 100 pM, 68143 Frames,  

200 ms/frame, Power: 0.3 kW/cm2 

Vesicles: 

Cells: U2OS 

Prefixation: 0.4% 

Glutaraldehyde + 0.25% 

Triton X-100  

for 90 sec 

Fixation: 3% Glutaraldheyde  

for 15 min 

Clathrin: SantaCruz, 

cat. no. sc-11415 

Secondary antibody:  

Dianova, cat. no. 

DKxGt-003-F (P7-

conjugated) 

 

[c] = 1 nM, 30000 Frames,  

100 ms/frame, Power: 1.5 kW/cm2 

Focal Adhesions: 

Cells: Fibroblasts (Tln1-/- 

Tln2-/-) resubstituted with 

Tln-HaloTag447 

Fixation: 

4 % PFA for 20 min 

Halo-P3 [c] = 2.5 nM, 140000 Frames,  

100 ms/frame, Power: 0.8 kW/cm2 

Cytoskeleton: 

Microtubules 

Vimentin 

Cells: Cos-7 

Prefixation: 0.4% 

Glutaraldehyde + 0.25% 

Triton X-100  

for 90 sec 

Fixation: 3% Glutaraldheyde  

for 15 min 

a-Tubulin: 

ThermoFisher 

Scientific, cat. no. 

MA1-80017  

Secondary: Jackson 

ImmunoResearch, cat. 

no. 712-005-150 (P1-

conjugated) 

Vimentin: Abcam, cat. 

no. ab24525 

Secondary: 

Jackson 

ImmunoResearch, cat. 

no. 703-005-155 (P3-

conjugated) 

 

Tubulin: [c] = 200 pM, 20000 

Frames, 250 ms/frame, Power: 3.3 

kW/cm2 

 

Vimentin: [c] = 1.5 nM, 20000 

Frames, 100 ms/frame, Power: 1.4 

kW/cm2 

Surface Receptors 

Cells: A549 

4 % PFA for 20 min EGFR: Cell Signalling, 

cat. no. 4267 

Secondary: Dianova, 

cat. no. 711-005-152 

(P3-conjugated) 

[c] = 200 pM, 80000 Frames,  

100 ms/frame, Power: 2.5 kW/cm2 

Mitochondrial Network 

Cells: Hela 

3 % PFA + 0.1 % 

Glutaraldehyde  

for 20 min 

Tom20: SantaCruz, 

cat. no. sc-11415  

Secondary: 

Dianova, cat. no. 711-

005-152 (P3-

conjugated)  

[c] = 200 pM, 20000 Frames,  

200 ms/frame, Power: 1.2 kW/cm2 
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Structural DNA nanotechnology allow researchers to use the

unique molecular recognition properties of DNA strands to

construct nanoscale objects with almost arbitrary complexity in

two and three dimensions. Abstracted as molecular

breadboards, DNA nanostructures enable nanometer-precise

placement of guest molecules such as proteins, fluorophores,

or nanoparticles. These assemblies can be used to study

biological phenomena with unprecedented control over

number, spacing, and molecular identity. Here, we give a

general introduction to structural DNA nanotechnology and

more specifically discuss applications of DNA nanostructures

in the field of fluorescence and plasmonics.
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Introduction
In 1982, Nadrian Seeman proposed that DNA molecules,
beyond their purpose as carriers of genetic information,
could be used to build two and three-dimensional rationally
designed objects with prescribed size, shape, and function
on the nanoscale [1]. Using the unique programmability and
molecular recognition properties of DNA, objects ranging
from junctions [1] to more complex structures such as a 3D
cube [2] and extended lattices [3] could be constructed. In
2004, Shih and co-workers created a DNA octahedron
(!22 nm in diameter) by ‘folding’ a !1600 nucleotides
(nt) long single-stranded synthetic DNA molecule using
five complementary !40 nt long oligonucleotides [4].

2006 marked a major breakthrough in structural DNA
nanotechnology, when Paul Rothemund developed DNA

origami [5 ""]. Here, a long single-stranded DNA molecule
(called the ‘scaffold’, usually derived from M13mp18
phage, !7000 nt long) is folded into programmable
shapes by !200 short, single-stranded DNA oligonucleo-
tides (called ‘staples’). Every staple has a defined se-
quence and specifically binds to defined parts of the
scaffold, thus folding it into the desired shape. Structures
are usually assembled in a one-pot reaction using thermal
annealing. DNA origami sparked a true revolution in the
field, for the first time enabling researchers to use relatively
simple design rules to create self-assembled nanostructures
with thus far unprecedented complexity and yield. In 2009,
Douglas et al. extended DNA origami to three dimensions
[6"], now even allowing the construction of a larger variety
of structures, which could be based on different underlying
lattice types [7,8], exhibit curvature and twist [9,10] or use
principles of tensegrity [11]. In 2012, Wei et al. demonstrat-
ed, that structures could be formed without the use of a
scaffold strand using single-stranded tiles (SST) [12]. Re-
cently, Benson et al. introduced structures, which construc-
tion is based on arbitrary polygonal meshes, allowing the
creation of shapes that would be currently difficult to realize
with incumbent approaches [13].

Part of the still developing success story of using DNA to
construct shapes and patterns on the nanoscale is the ease
of construction of these structures. The design process is
considerably facilitated by the availability of free, com-
puter-aided design and analysis tools such as caDNAno
[6"], vHelix [13], or CanDo [14]. With these tools at their
disposal, even ‘non-experts’ from outside the DNA nano-
technology community can now design and construct
structures de novo within only a few days.

In this review we will discuss recent developments in
structural and dynamic DNA nanotechnology for applica-
tions in fluorescence microscopy and plasmonics.

DNA nanostructures as molecular
breadboards
The creation of DNA nanostructures with ever increasing
complexity and shape diversity demonstrates the gener-
ality and modularity of their construction approaches.
However, the true utility of the structures lies in their
unique addressability. This makes them useful for appli-
cations where exact positioning of distinct molecular
species may be required. Abstracted as molecular bread-
boards, DNA origami enable nanometer-precise place-
ment of guest molecules such as proteins, fluorophores, or
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nanoparticles and can thus be used to study molecular
interactions of these molecules on the nanoscale. A sche-
matic representation demonstrating the unique address-
ability of DNA origami structures is depicted in
Figure 1a. A large variety of, for example DNA-labeled
guest molecules (carrying an ‘anti-handle’ strand) can be
easily placed on DNA origami structures by hybridization
to their complementary staple strand extensions (handle
strands).

In one of the first applications for DNA origami as sensory
entities, Ke et al. employed the unique addressability of
rectangular sheets for multiplexed, label-free detection of
RNA by using atomic force microscopy to study position-
dependent hybridization to handle strands on the struc-
ture [15 ] (Figure 1b). In a different application, Fu et al.
assayed and enhanced enzymatic activity in protein cas-
cades by placing enzymes in close proximity on DNA
origami structures [16 ] (Figure 1c). Shaw and co-workers
used DNA origami to unravel distance-dependent effects
in receptor–ligand interactions on cell membranes. The

authors used ephrin-A5  ligands attached to DNA nanos-
tructures with different distances and applied them to
breast cancer cell lines [17 !]. They could show that the
activation of EphA2 receptors was enhanced when li-
gands were spaced 40 nm apart in comparison to a spacing
of 100 nm. Recently, Douglas et al. reported on one of the
first ‘active’ DNA origami-based devices [18 !!]. These
structures were able to undergo a conformational change
upon detection of a cellular input signal: Two aptamer
locks ‘opened’ upon recognition of tumor antigens on the
cell surface and activated the ‘device’. Molecular payload
placed in the interior of the structure could then interact
with cell surface receptors and induce programmed cell
death (Figure 1d). Recently, this device was applied in
vivo in a cockroach model, where a population of these
structures performed logical operations [19 ].

DNA nanostructures were also used to study molecular
motor protein assemblies. In 2012, Derr et al. analyzed the
behavior of these motors walking in different directions
on microtubule filaments. Coupled to the same cargo, a
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DNA origami as molecular breadboards. (a) Synthetic DNA nanostructures can be used to position different molecular species, such as
fluorophores (red), gold particles (yellow) or proteins (green) with nanometer precision. Top left: Staple and scaffold strand routing details. Bottom
left: Staple strands can be extended with a specific sequence (handle strands). DNA-conjugated proteins can be attached to the structure via
complementary sequences (anti-handle strands). (b) Staple strands can be extended to detect RNA via hybridization. Molecular binding events are
visualized using atomic force microscopy. Adapted from [15 ]. Reprinted with permission from AAAS. (c) Nanoscale artificial assembly lines can be
constructed to study enzyme cascades. Horseradish peroxidase (HRP) as well as glucose oxidase (GOx) are positioned on a DNA origami. A
bridging molecule mediates transfer of intermediate products. Reprinted with permission from [16]. Copyright (2012) American Chemical Society.
(d) Decision making DNA ‘devices’ can be constructed using DNA origami. Two aptamer locks open upon recognition of target molecules, that is
on cancer cells. The inside of the device can be functionalized with proteins to specifically trigger cell death. From [18 !!]. Reprinted with
permission from AAAS. (e) Dynein motors are attached to a 12 helix-bundle chassis nanostructure via DNA handles. From [20!], reprinted with
permission from AAAS. (f) DNA ‘nanomotors’ can walk over a synthetic track on DNA origami structures. Adding fuel and anti-fuel strands powers
the DNA walker and leads to binding and unbinding from the structure by strand displacement reactions. ‘Walking’ is visualized using single-
molecule Förster Resonance Energy Transfer (FRET). Reprinted with permission from [21]. Copyright 2013  American Chemical Society.
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synthetic 12 helix-bundle DNA nanostructure, kinesin-1
and dynein engaged in a tug-of-war. By specifically dis-
engaging one motor species using photocleavable linkers,
this tug-of-war could be resolved [20!] (Figure 1e). Simi-
larly, DNA nanostructures can also be used as molecular
tracks for synthetic walkers. In 2013, Tomov et al. used
toehold-mediated strand displacement cascades and sin-
gle-molecule fluorescence techniques to design and char-
acterize DNA-based walkers along origami tracks [21]
(Figure 1f).

Fluorescence and super-resolution
applications
Using the addressability of DNA nanostructures, it is
also possible to arrange fluorescent molecules at defined

positions and distances, thus providing a unique tool to
study a multitude of properties of single and multiple
fluorophores in defined geometries. Stein et al. used DNA
origami to investigate Förster resonance energy transfer
(FRET) between donor and acceptor dyes placed at
specific distances on DNA origami [22] (Figure 2a). By
comparing their results to single dsDNA molecules (tra-
ditionally used in FRET studies), they found that the
FRET data obtained on the DNA origami structures
directly yielded the theoretical distance dependence of
the energy transfer. The authors contributed this to the
fact that the influence of fluorophore-linker distances is
significantly reduced in the more rigid and geometrically
defined DNA origami structures. Schmied et al. used
DNA origami to position defined numbers of fluorophores
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Fluorescence and super-resolution applications. (a) Single-molecule FRET ruler based on rigid DNA origami blocks. Green dots indicate donor, red
dots acceptor positions. FRET distance dependency can be studied with high precision. Reprinted by permission from Wiley [22], copyright 2011.
(b) Fluorescence brightness standards constructed from DNA origami. Bottom right inset: DNA origami with 36 dye molecules. Top insets:
fluorescence images of 12", 24", 36" ATTO647N dyes attached to origami. Intensity increased linearly with the number of dyes. Reprinted by
permission from Macmillan Publishers Ltd: Nature Methods [23], copyright 2012. (c) Geometrically encoded DNA nanobarcodes constructed from
DNA origami. By dimerizing two six-helix bundle structures (each consisting of 28  segments of 42 bp) a structure with a total length of #700 nm is
constructed, allowing for diffraction-limited readout of fluorescent zones. Top: three-color fluorescence micrograph of DNA nanobarcode. Bottom:
detailed view of structure and dye attachment of one fluorescently labeled zone (green). Reprinted by permission from Macmillan Publishers Ltd:
Nature Chemistry [24], copyright 2012. (d) Calibration structures for super-resolution microscopy: Dyes can be placed at designed distances using
DNA origami structures. Reprinted by permission from Macmillan Publishers Ltd: Nature Protocols [28 !], copyright 2014. (e) DNA-PAINT super-
resolution microscopy: DNA nanostructure ‘labeled’ with single-stranded ‘docking’ strands on two faces (red, 16 nm distance). (f) Transient
binding of ‘imager’ strands creates ‘blinking’ and allows super-resolution imaging. (g) Transmission Electron Micrograph (TEM) of DNA structure.
(h) Optical DNA-PAINT super-resolution image reveals two lines spaced #16 nm apart. (i) 3D DNA-PAINT image of a DNA tetrahedron. (j)
Exchange-PAINT allows sequential multiplexing with a single color dye on origami structures (digits 0–9) and inside a cell. (k) 3D DNA-PAINT
super-resolution imaging of a conducting polymer immobilized on a 3D DNA nanostructure in a helical shape. Reprinted by permission from
Macmillan Publishers Ltd: Nature Nanotechnology [34], copyright 2015.
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at distances as small as !5  nm from each other [23]
(Figure 2b). Placing up to 36  fluorophores per DNA
origami interestingly resulted in a linear dependency of
fluorescence intensity versus number of fluorophores. This
underlines the unique capability of DNA nanostructures to
precisely define molecular spacing, making them ideal
‘standards’ for fluorescence intensity calibration [23].

While exact spatial control not only allows the placement
of fluorophores at defined positions and to study their
interactions, it does also create the possibility to use
fluorescently-labeled DNA origami structures as unique
identifiers — or barcodes — based on their programma-
ble fluorescent properties. In 2012, Lin et al. developed
geometric barcodes by arranging spectrally distinct fluor-
ophores in defined spots spaced beyond the optical dif-
fraction limit on six-helix-bundle DNA origami [24]
(Figure 2c). This allowed them to create 216  unique
barcoded DNA origami using three spots and up to
two spectrally distinct colors per spot. These barcoded
structures could, for example be used for multiplexed in
vitro quantification of RNA molecules from cell lysates
[25 ].

Beyond their use as brightness standards, origami’s ability
to place fluorescent molecules at precise distances below
the optical diffraction limit renders them ideal as molec-
ular rulers for emerging super-resolution techniques. In
2009, Steinhauer et al. reported on the creation of the first
super-resolution rulers based on DNA origami [26 ""]
(Figure 2d). In their study, they found that the inaccuracy
of the measured distance could be almost completely
attributed to the localization precision of their employed
super-resolution technique, thus indicating that DNA
origami are robust and reproducible ‘nanoscopic rulers’
for super-resolution microscopes. The same group also
used three-dimensional DNA origami structures as rulers
for 3D super-resolution techniques [27 ]. Detailed experi-
mental protocols for the preparation of DNA structures in
fluorescence microscopy are also available [28 "].

As discussed in the paragraphs above, DNA nanostruc-
tures possess unique features that make them ideally
suited for fluorescence studies and calibration standards.
However, dynamic DNA nanotechnology was used to
enable a novel super-resolution technique, based on points
accumulation imaging in nanoscale topography (PAINT).
In 2010, Jungmann et al. developed DNA-PAINT, which
uses the molecular recognition capability and programma-
bility of DNA molecules (Figure 2e) to create the necessary
blinking for stochastic super-resolution microscopy. In
DNA-PAINT, stochastic switching between fluorescence
on-states and off-states is facilitated by repetitive, transient
binding of short fluorescently labeled oligonucleotides
(‘imager’ strands) to complementary ‘docking’ strands.
Upon binding of an imager strand, its fluorescence emission
is detected and subsequently localized for super-resolution

reconstruction. DNA-PAINT is able to overcome some of
the limitations of current super-resolution approaches such
as photo-activated localization microscopy (PALM) [29] or
stochastic optical reconstruction microscopy (STORM)
[30], by allowing researchers to decouple the blinking of
fluorophores from their complex photophysical properties
using programmable DNA-based imaging probes. DNA-
PAINT can also be used for 3D super-resolution imaging of
3D DNA origami structures (Figure 2f). Additionally, as the
imager strands only transiently bind to the docking strand,
orthogonal imager strands can be sequentially applied to
the same biological sample. In this technique, called Ex-
change-PAINT, a single fluorophore and a single laser
source is used to achieve 10-color super-resolution imaging
of DNA origami targets and a 4-color image of cellular
proteins in fixed cells (Figure 2g). In addition to imaging,
Johnson-Buck and co-workers used DNA-PAINT to ana-
lyze binding and dissociation kinetics of imager strands to
docking strands on DNA origami structures. Their studies
elucidated apparent differences in association and dissoci-
ation kinetics dependent on the length of docking strands,
their positions and spacing on the DNA nanostructures
[31,32]. Additionally, using the predictable binding kinetics
of transient nucleic acid hybridization, Johnson-Buck et al.
were able to ‘count’ miRNA molecules from solution and
distinguish between single nucleotide polymorphisms with
high accuracy [33].

Combining DNA nanostructures to arrange molecules in
three dimensions and DNA-based super-resolution im-
aging, Knudsen et al. used a novel DNA barrel structure to
route a conducting polymer in a ‘nano-helical’ shape [34].
The polymer was modified with anti-handle sequences to
attach to handle sequences on the barrel. Subsequently,
3D DNA-PAINT imaging was used to confirm the correct
routing of the polymer in its designated 3D helical shape
(Figure 2h).

Plasmonic applications
Besides placing fluorescent molecules, DNA origami can
also be used to arrange inorganic nanoparticles to study
plasmonic effects. Plasmonic interactions strongly de-
pend on the spatial arrangement, stoichiometry, distance,
and orientation of nanoparticles with respect to each
other. Recent studies demonstrated the ability to place
a multitude of inorganic molecules such as gold nanopar-
ticles [35 ], silver nanoparticles [36 ], quantum dots [37 ],
and fluorescent nanodiamonds [38 ] on DNA origami
structures.

In 2012, Kuzyk et al. arranged gold particles with a defined
size into a prescribed nano-helical shape using 24 helix-
bundle DNA origami (Figure 3a). The authors found, that
inline with their theoretical predictions, the structures
exhibited a defined circular dichroism (CD) emerging
from nanoparticle plasmon–plasmon interactions. DNA
origami structures allowed them to precisely design and
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tune the plasmonic properties of the assemblies, such as
their handedness. Experimentally, after excitation with
electromagnetic radiation, a plasmonic response was ob-
served by measuring the CD absorption spectra of the
nanoscale gold assembly in the visible range [39!!,40].
Furthermore, the authors demonstrated that DNA origa-
mi gold nanoparticle arrangements can also be reconfi-
gured by either a toehold-mediated strand displacement
reaction [41] (Figure 3b) or by attaching them to a glass
substrate and switching the orientation by a change in the
surrounding environment from PBS buffer solution
(structures perpendicular to the glass surface) to a ‘dry’
environment (structures parallel to the glass) [42].

In 2012, Acuna et al. used DNA origami structures to
create fluorescent field enhancement at plasmonic hot-
spots. In their study, they placed a pair of 100 nm gold
nanoparticles 23 nm apart. A DNA origami structure
placed ‘upright’ on a glass surface allowed them to
achieve the precise placement of the nanoparticles away
from the surface at a designed height (Figure 3c). Using
transient hybridization of fluorescently-labeled strands to
their targets (as in DNA-PAINT) within this reaction
volume showed that the fluorescence of a dye molecule
can be enhanced 117-fold at the plasmonic hotspot [43!!].
In a study by Kuhler et al. plasmonic hotspots were used
for signal enhancement in Raman spectroscopy [44].

Summary and outlook
In summary, structural DNA nanotechnology provides a
unique way to position molecules in a programmable and

self-assembled fashion on the nanoscale. Very recently,
Funke et al. [45] increased the positioning accuracy of
DNA origami from "5 nm down to "0.04 nm. In the
future, this might allow researcher to, for example engi-
neer rationally designed catalytic functionalities into
DNA nanostructures similar to enzymes. Extending the
toolkit of barcoded, fluorescent DNA origami structures,
one could envision the creation of barcodes based on
fluorescence intensities in addition to geometrically
encoded structures. In combination with recently devel-
oped compact DNA cubes [46], these barcodes could see
applications as multiplexed labeling probes for the de-
tection of dynamic processes such as membrane-bound
molecules on cell surfaces. Furthermore, ultra-compact
DNA-based barcodes could enable the identification of,
for example, a multitude of RNA molecules in  situ  in
single cells.

Combining recently developed fast and sensitive light
sheet microscopes [47] with novel cargo-carrying fluores-
cently-barcoded DNA structures, it will be possible to
study their cellular uptake mechanisms with high spatial
and temporal resolution, thus paving the way to engineer
smarter DNA nanostructure-based drugs. So far different
delivery devices made of DNA were reported which for
example stimulated the immune system by CpG oligo-
nucleotide presentation [48,49].

Finally, DNA nanostructures as plasmonic hotspots are
promising tools to characterize a multitude of biomolec-
ular reactions. The local field enhancement provides an
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Plasmonic applications. (a) DNA origami bundle composed of 24 parallel double helices. Gold nanoparticles are arranged in a ‘secondary’ left-
handed helix on the DNA origami structure. Zoom in: 10 nm gold nanoparticle functionalized with thiolated ssDNA hybridized to the DNA origami
24HB. Upper right: TEM image of a gold-labeled DNA nanohelix. Scale bar: 50 nm. Reprinted by permission from Macmillan Publishers Ltd:
Nature [39 !!], copyright 2012. (b) Reconfigurable 3D plasmonic metamolecule: two gold nanorods (AuNRs) are attached to a ‘switchable’ DNA
origami structure consisting of two connected bundles with a tunable angle in-between. The relative angle between the AuNRs and therefore the
handedness of the 3D chiral nanostructure can be actively controlled by two DNA locks, which are extended from the sides of the DNA origami
template. Reprinted by permission from Macmillan Publishers Ltd: Nature Materials [41], copyright 2014. (c) DNA origami nanopillar with two Au
NPs forming a dimer. Using transient DNA hybridization as in DNA-PAINT, dye-labeled strands (red sphere) are temporarily immobilized between
the NPs within the central bundle of the pillar, and thus placed in a plasmonic hotspot, leading to a "117-fold increase in fluorescence emission.
From [43!!]. Reprinted with permission from AAAS.
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ideal environment to study these reactions in physiologi-
cally relevant concentration regimes [50].
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INTRODUCTION
For biomedical research, super-resolution microscopy is a prom-
ising tool developed in recent years, allowing optical imaging 
beyond the diffraction limit of light, for up to molecular-scale 
resolution inside cells. The significance of this group of imag-
ing modalities is underlined by the Nobel Prize in Chemistry 
in 2014 ‘for the development of super-resolved fluorescence 
microscopy’. Super-resolution has been achieved by a variety of 
imaging modalities, most notably nonlinear structured illumina-
tion microscopy (SIM)1, stimulated emission depletion (STED) 
microscopy2, (fluorescent) photo-activated localization micros-
copy ((f)PALM)3,4 and (direct) stochastic optical reconstruction 
microscopy ((d)STORM)5,6. All these techniques achieve image 
resolution beyond the diffraction limit by controlling the state 
of fluorophores such that only a small subset of them are detect-
able at any given time. However, super-resolution approaches can 
be generally divided into the following two groups according to 
the specific mechanism for controlling the fluorophore state7: 
(i) illumination-pattern-based (SIM and STED) and (ii) single- 
molecule-localization-based (PALM and STORM) methods. All 
these super-resolution methods have been successfully used to 
reveal biological insights8–12, but each has its own advantages 
and difficulties. A practical advantage of both illumination-based 
methods is that they do not require specific fluorophores, which 
makes these techniques straightforward to use for biologists with 
conventional samples. However, instrumental implementations 
are typically more complex and intricate. By contrast, the branch 
of localization-based techniques uses stochastic blinking of spe-
cific fluorescent probes. This blinking permits them to be observed 
one at a time so that their spatial coordinates can be localized with 
subdiffraction precision13. Typically, this blinking is an intrinsic 
property of fluorescent proteins (PALM) or specific organic dyes 
(STORM), which can be provoked by specific excitation schemes 
and buffer conditions14,15. Although instrumentation is typically  

simpler for localization-based as compared with illumination-
based modalities, the complexity lies in achieving suitable blink-
ing behavior of the dyes. Troubleshooting often means testing a 
number of parameters such as the choice of dye, labeling den-
sity, buffer conditions and excitation illumination, making the 
blinking a hard-to-control phenomenon. In fact, the choice of 
‘well-behaving’ probes is limited, and further development of 
substantially improved probes is complex and time-consuming. 
Moreover, because of the limited choice of probes with appropri-
ate blinking kinetics, photon rates and excitation conditions, mul-
tiplexing is still difficult to implement. Furthermore, the complex 
photophysics of the probes impedes the predictability of blinking 
events so that quantitative image interpretation is error-prone. 
Last, owing to limited photon rates and bleaching, optimal locali-
zation precision and spatial sampling are still not achieved—the 
two major factors in resolution16. Although many biological ques-
tions could be addressed with the aforementioned techniques8–12, 
researchers are still struggling with these complications to truly 
exploit the power of super-resolution microscopy.

A different route to single-molecule localization microscopy 
is PAINT17. Here, instead of labeling target molecules with fixed 
fluorophores, freely diffusing dyes17 or dye-labeled ligands (as in 
uPAINT)18 target molecules of interest by permanent or transient 
binding. PAINT is straightforward to implement and does not 
require special experimental conditions to obtain photoswitch-
ing, as long as probes are able to diffuse and reach their target 
molecules. However, PAINT’s original implementation makes it 
difficult to specifically label a larger variety of biomolecules, as 
interactions are mainly limited to hydrophobic interactions or 
electrostatic coupling and are thus difficult to program.

DNA nanotechnology represents a promising tool for utiliz-
ing the advantages of the PAINT concept and establishing a pro-
grammable target–probe interaction system at the same time. 

Super-resolution microscopy with DNA-PAINT
Joerg Schnitzbauer1–3, Maximilian T Strauss1–3, Thomas Schlichthaerle1,2, Florian Schueder1,2 & Ralf Jungmann1,2

1Department of Physics and Center for Nanoscience, Ludwig Maximilian University, Munich, Germany. 2Max Planck Institute of Biochemistry, Martinsried, Germany.  
3These authors contributed equally to this work. Correspondence should be addressed to R.J. (jungmann@biochem.mpg.de).
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Super-resolution techniques have begun to transform biological and biomedical research by allowing researchers to observe 
structures well below the classic diffraction limit of light. DNA points accumulation for imaging in nanoscale topography (DNA-
PAINT) offers an easy-to-implement approach to localization-based super-resolution microscopy, owing to the use of DNA probes. 
In DNA-PAINT, transient binding of short dye-labeled (‘imager’) oligonucleotides to their complementary target (‘docking’) strands 
creates the necessary ‘blinking’ to enable stochastic super-resolution microscopy. Using the programmability and specificity of DNA 
molecules as imaging and labeling probes allows researchers to decouple blinking from dye photophysics, alleviating limitations 
of current super-resolution techniques, making them compatible with virtually any single-molecule-compatible dye. Recent 
developments in DNA-PAINT have enabled spectrally unlimited multiplexing, precise molecule counting and ultra-high, molecular-
scale (sub-5-nm) spatial resolution, reaching ~1-nm localization precision. DNA-PAINT can be applied to a multitude of in vitro 
and cellular applications by linking docking strands to antibodies. Here, we present a protocol for the key aspects of the DNA-
PAINT framework for both novice and expert users. This protocol describes the creation of DNA origami test samples, in situ sample 
preparation, multiplexed data acquisition, data simulation, super-resolution image reconstruction and post-processing such as 
drift correction, molecule counting (qPAINT) and particle averaging. Moreover, we provide an integrated software package, named 
Picasso, for the computational steps involved. The protocol is designed to be modular, so that individual components can be chosen 
and implemented per requirements of a specific application. The procedure can be completed in 1–2 d. 
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Specifically, DNA-based PAINT (DNA-PAINT) has been devel-
oped as a straightforward approach to overcome some limitations 
of current localization-based super-resolution techniques19–24. 
Similar to the original PAINT concept, DNA-PAINT decouples 
blinking from dye photophysics, but it also adds the program-
mability and specificity of using DNA molecules as imaging and 
labeling probes. A DNA-PAINT system, illustrated in Figure 1a, 
consists of the following two components: a docking strand and 
an imager strand. These are short, complementary single-stranded 
DNA oligomers, usually 8–10 nucleotides long. Although the 
docking strand is fixed to a biological target of interest (e.g., using 
standard immunolabeling approaches with DNA-conjugated 
antibodies targeting proteins of interest25 or direct hybridiza-
tion of docking strands to DNA or RNA molecules), the imager 
strand is conjugated to an organic dye and diffuses freely in the 
imaging buffer. Generally, imager strands appear undetectable 
in the camera because they diffuse over numerous camera pixels 
during the duration of a single frame. However, owing to their 
complementary sequence, imager strands can transiently bind 
to docking strands. During the bound state, imager strands are 
fixed at the same place for an extended amount of time, allowing 
the camera to accumulate enough photons from the dye to be 
detected. The binding duration depends solely on the stability of 
the formed DNA duplex, and can hence be programmed at will 
(e.g., by modulating strand length, GC content, temperature or 
salinity of the imaging buffer). On the other hand, the frequency 
of binding events is tunable by the influx rate of imager strands 

(e.g., by modulating either the concentration of imager strands 
in the buffer or the association constant). As a result, the user has 
fine control over the blinking kinetics, which is independent of 
dye properties or illumination specifics. To date, DNA-PAINT 
has been used to resolve nanometer-scale structures of DNA ori-
gami (Fig. 1b), as well as those of cellular proteins, by conjugating 
docking strands to antibodies (Fig. 1c–e).

Advantages and limitations of the method
The properties of DNA-PAINT result in several improvements 
over more traditional super-resolution approaches. First, the 
use of DNA-based imaging probes enables high multiplexing by 
Exchange-PAINT20 that is restricted only by the number of orthog-
onal DNA sequences, as compared with the spectrally distinct 
dyes used in classic multiplexing experiments. Figure 2 illustrates 
the concept, procedure and results of Exchange-PAINT experi-
ments in vitro and in situ. When tagging biological targets with 
orthogonal docking strand sequences, they can be probed sequen-
tially by the respective complementary imager strands (Fig. 2a).  
Specifically, after one DNA-PAINT image has been acquired, the 
buffer can be exchanged to introduce a different imager strand 
species. Repeated imaging, washing and reintroduction of new 
imager strand species then allows researchers to create a multi-
plexed image of many biological targets. Although we have thus 
far demonstrated nine-target super-resolution imaging25, multi-
plexing could reach thousands of species, as the only limitation is 
the orthogonality of DNA-PAINT sequences.
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Figure 1 | DNA-PAINT. (a) DNA-PAINT concept. Transient binding of dye-labeled DNA strands (imagers) to their complementary target sequence (docking  
site) attached to a molecule of interest. The transient binding of imager strands is detected as ‘blinking’, illustrated by the intensity versus time trace.  
(b) Diffraction-limited (left) and super-resolved DNA-PAINT images (right) of DNA origami nanostructures. Each structure consists of 12 docking strands  
that are arranged in a 20-nm grid (scheme in lower right corner). (c) In situ protein-labeling strategy for DNA-PAINT using primary and DNA-conjugated 
secondary antibodies. (d) Overlay of a diffraction-limited A-tubulin image (top left) with a super-resolved DNA-PAINT image (bottom right). (e) Close-ups of the  
highlighted area in d, comparing diffraction-limited image (left) with DNA-PAINT super-resolved image (right). Scale bars, 100 nm (b), 2 Mm (d), 500 nm (e).
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Second, the predictability and tunability of DNA binding and 
unbinding events, combined with effectively nonexistent bleach-
ing, allow for accurate quantitative image interpretation (i.e., 
counting of single molecules in an integer manner), implemented 
in quantitative PAINT (qPAINT)22. Figure 3  depicts the qPAINT 
concept, procedure and results. A more detailed description of 
the method will be given below.

Third, DNA-PAINT simplifies the selection of suitable dyes 
for imaging, as the parameter space is reduced from rather com-
plex photophysical properties (e.g., switching behavior) to basi-
cally a single parameter—the photon budget. This also means 
that DNA-PAINT can use a large pool of existing fluorophores 
that were previously not applicable to localization-based super- 
resolution microscopy.

Finally, by programming the binding duration, an extremely 
high number of photons can be detected from a single binding 
(or blink) event, enabling optimal localization precision. The 
only limitations regarding the achievable photon budget are 
experimental time and photobleaching during a single bind-
ing event. However, the latter can be greatly reduced by specific 
imaging buffer compositions, such as oxygen-scavenging systems  

and triplet-state quenchers26–28. Even if bleaching of individ-
ual dyes does occur, it has only a minimal detrimental effect 
overall, because of the practically infinite supply of replenish-
able ‘fresh’ imager strands from solution. All things considered,  
photobleaching—which is a considerable complication for all 
other super-resolution techniques—is eliminated as a restric-
tion on achieving optimal sampling of the biological structure 
under investigation. Such optimized experimental conditions 
for high localization precision, combined with intricate drift 
correction methods, enable imaging at thus far unprecedented 
resolution in optical microscopy, for the first time enabling true 
molecular-scale resolution23, which, to our knowledge, has not 
been achieved using any other super-resolution method. Example 
results of images with localization precisions of ~1 nm, yield-
ing resolution better than 5 nm, and intermediate results of the 
applied drift correction are shown in Figure 4 . To achieve these 
results, a large number of DNA origami structures were used as 
drift markers, considering first the whole structure, followed by 
the use of individual DNA-PAINT binding sites as fiducials. To 
eventually translate the in vitro ultra-resolution achievements to 
in situ samples such as fixed cells, a key challenge is the labeling 
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Figure 2 | Exchange-PAINT. (a) Schematic representation of sequential Exchange-PAINT imaging of multiple targets with orthogonal sequences using the same 
fluorophore. Left to right: P1* imager strands are in solution and interact with their complementary target sequence, P1. After the first acquisition round, 
the P1* imager strands are washed away and P2* imagers are introduced to image the next target. This is then repeated for the remaining target cycles, and 
pseudocolors are assigned for each respective imaging round. Last, all rounds are aligned and overlaid to form the final multiplexed Exchange-PAINT image 
of n targets. (b) Fluid exchange chamber for in vitro samples (e.g., for DNA origami imaging). Liquid is introduced by pipetting into the inlet. The outlet is 
attached to a syringe with a flexible tube to remove the liquid. (c) Fluid exchange chamber for in situ samples (i.e., used for in situ cellular imaging). Two 
tubes with syringes are connected to an 8-well chambered cover glass to facilitate fluid exchange. (d) Two rounds (‘colors’) Exchange-PAINT image of a frame-
like DNA origami structure carrying two orthogonal docking strand species (red and cyan; see also f, for design schematics). (e) Pseudocolor image after 
alignment of the imaging rounds using Picasso’s automated align function. (f) Top: DNA origami design. Bottom: Close-up (white box from e) of one frame-like 
structure. The distance between red and blue handles is ~5 nm. (g) In situ Exchange-PAINT image of protein targets A-tubulin (red) and Tom20 (cyan) with 
two primary and DNA-conjugated secondary antibody sandwiches. Inset: Images of one alignment marker (gold nanoparticle) in each Exchange-PAINT round 
without channel alignment (top), after Picasso’s automated cross-correlation analysis (middle) and after manually selecting the particle as an alignment 
fiducial (bottom). Scale bars, 100 nm (d, e), 20 nm (f), 2 Mm (g), 300 nm (g, insets).
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probe size. The size of the labeling probes introduces a linkage 
error and effectively limits the labeling density (because of sterical 
hindrance). Both these effects finally limit the achievable resolu-
tion. One way to address these issues in cells could be the use of 
smaller labeling agents such as nanobodies29 or aptamers30, rather 
than antibodies.

Although DNA-PAINT offers several advantages over tradi-
tional super-resolution techniques, as discussed above, we also 
note that there are currently limitations. One disadvantage is the 
fact that ‘imager’ strands are nonfluorogenic, with the following 
two implications: first, DNA-PAINT is limited to optical section-
ing techniques such as total internal reflection (TIR), oblique31 
or light-sheet32 illumination because of elevated background 
fluorescence originating from unbound imager strands. Second, 
the nonfluorogenic nature of imager strands furthermore sets 
an upper limit to the achievable image acquisition speed as com-
pared with those of STED, PALM, STORM or SIM. Furthermore, 
DNA-PAINT applications are currently limited to fixed speci-
mens. Live-cell imaging could be more difficult to achieve as  
compared with the aforementioned techniques, because of the 
complexity of infusing dye-labeled nucleic acid strands into liv-
ing cells and the unforeseen consequences of introducing nucleic 
acids in general. However, we note that DNA-PAINT applications 
to molecules on cell surfaces such as membrane-bound receptors 
should be feasible even for living cells.

All in all, the DNA-PAINT imaging framework greatly reduces 
many technical difficulties of localization-based super-resolution 
microscopy and opens up possibilities for new technical devel-
opment and biological applications. It will therefore allow many 
research groups to address their biological question with much 
greater efficiency. To ease the adoption of DNA-PAINT for novice 
and expert researchers in the super-resolution field, this proto-
col details the involved procedures and provides an integrated  
software package, named Picasso, which is specifically designed 
for DNA-PAINT applications. Except for data acquisition, Picasso 
can handle all computational efforts required in this protocol, 
including in silico data simulation, DNA origami design, and 
basic and advanced functionality for localization-based super- 
resolution microscopy.

Overview of the main procedures
The overarching goal of this protocol is to enable both novices 
and expert users to quickly obtain high-quality DNA-, Exchange-
PAINT and qPAINT imaging data in silico, in vitro and in situ, 
without prior expertise in super-resolution microscopy. Here, we 
are using the term in vitro for DNA-PAINT studies with DNA ori-
gami structures on BSA/biotin/streptavidin-coated glass slides. By 
contrast, in situ is used to describe experiments involving fixed-cell 
samples. The protocol is based on several studies19,20,22,23,25 and is 
arranged into four major sections, as illustrated in Figure 5: sample 
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Figure 3 | qPAINT. (a) Design schematics for two DNA origami structures with 12 target sites spaced 20 nm apart (top, black-dotted box) and 42 binding sites 
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preparation (in vitro and in situ), data acquisition, image recon-
struction and image post-processing. For sa mple preparation, 
we describe the following two procedures: in vitro imaging (i.e., 
of DNA origami nanostructures) (Steps 1–18; Box 1 ) and in situ 

imaging (i.e., of cell samples) (Steps 19–33). Although not covered 
in this protocol, the procedures could be adjusted for DNA-PAINT 
imaging in tissue or whole organisms. Subsequently, we explain 
data acquisition (Steps 34–49), including a detailed procedure  
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Figure 4 | ‘Ultra-resolution’ with DNA-PAINT. (a) Workflow for ultra-resolution imaging with advanced drift correction and particle averaging. (b) Multistage 
drift correction with Picasso. Top: 20-nm-grid DNA origami structures used as reference structures and drift markers. Bottom: DNA origami target structure 
(designed to display the letters ‘MPI’ (upside down) with 5-nm ‘docking strand resolution’) present in the same sample as the 20-nm origami. In the first 
drift correction stage, an RCC procedure is applied to the whole field of view (image column after RCC arrow shows results). The second step uses Picasso’s  
semiautomated particle pick function (picked structure visualized by yellow circle) to select 1,675 DNA origami structures as fiducials for drift correction 
(drift for all structures is globally averaged and subtracted from the localization data). The result for this step is depicted in the third column. The third and 
last iteration uses the individual binding sites of the 20-nm grid for drift correction. Here, 29,157 binding sites were used as fiducial markers. The resulting 
image for the MPI target structures shows clearly resolved single binding sites spaced 5 nm apart. (c) Selection of two MPI origami after drift correction. 
Localization clusters of individual DNA-PAINT binding sites with a distance of ~5 nm are well resolved and circular, indicating that the residual drift is 
minimal and rotationally invariant. (d) Selection of two DNA origami, designed to show the letters ‘LMU’, from a different sample than in b,c,e, but after an 
analogous drift correction as shown in b. The images demonstrate minimal residual drift similar to that of the MPI structures shown in c. (e) Average image 
of 295 DNA origami with the letters ‘MPI’. The mean number of localizations in individual images is 3,485 ± 1,197. All DNA-PAINT binding sites are visible, 
even though individual images miss binding sites because of incomplete strand incorporation, as seen in c. (f) Average image of 215 DNA origami with the 
letters ‘LMU’. The mean number of localizations in the individual images is 2,323 ± 436. Scale bars, 10 nm (c–f). 
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to achieve very high spatial resolution (<5 nm) with DNA-PAINT, 
which requires particular care in sample preparation and data 
acquisition (Box 2). Furthermore, we lay out the procedure to 
simulate typical DNA-PAINT data in silico for test and optimiza-
tion purposes (Box 3). Then, image reconstruction is explained 
in two steps: fitting of single-molecule spots and subsequent ren-
dering of the super-resolution image (Steps 50–58). Finally, we 
describe multiple procedures for post-processing such as drift 
correction (Steps 59 and 60), selection of regions of interest (Steps 
61–68), filtering of localizations (Step 69A), quantitative imaging 
with qPAINT (Step 69B and C), particle averaging (Step 69D) and 
channel alignment for multiplexed images (Step 69E). Additional 

steps required for multiplexed imaging with Exchange-PAINT are 
described as optional steps in the respective sections.

One of the defining components of this protocol for DNA-
PAINT is an integrated software package called Picasso, which ena-
bles researchers to quickly obtain meaningful reconstructed image 
results without the need of additional third-party software tools.

The Picasso software package
Like similar localization-based super-resolution methods, DNA-
PAINT requires intricate data analysis. For that matter, we provide 
an integrated software package named ‘Picasso’ (free to download 
from http://www.jungmannlab.org). Although Picasso is suitable 
for any localization microscopy technique, it provides specific 
support for DNA-PAINT applications, e.g., qPAINT. All compu-
tational steps described in this protocol can be performed with 
Picasso. This includes designing of DNA origami structures and 
simulating typical DNA-PAINT data. After installation, Picasso is 
available as several stand-alone (but interlinked) modular compo-
nents with graphical user interfaces. The components are named 
‘Design’, ‘Simulate’, ‘Localize’, ‘Filter’, ‘Render’ and ‘Average’. The 
‘Design’ component allows the user to visually design rectan-
gular 2D DNA origami structures, which we call Rothemund’s 
rectangular origami (RRO)33, with DNA-PAINT handles. For 
that matter, ‘Design’ autogenerates order lists and pipetting 
instructions. With ‘Simulate’, the user may generate typical 
DNA-PAINT raw data from in silico simulations. After data have 
been acquired or simulated, the ‘Localize’ component allows the 
user to identify and fit the coordinates of single-molecule spots.  
‘Picasso: Filter’ offers a convenient tool to inspect the localization 
list, plot histograms of localization properties and filter locali-
zations with undesired properties. Super-resolution images can 
be rendered and inspected with the Picasso component ‘Render’. 
‘Picasso: Render’ also offers various post-processing func-
tions such as advanced drift correction and quantitative image 
evaluation by qPAINT. Last, the ‘Average’ module provides the 
functionality to perform particle averaging (i.e., rotational and 
translational alignment) of multiple images of the same structure. 
Analogous to single-particle reconstruction in the electron micro-
scopy field, this procedure helps to improve the signal-to-noise 
ratio of images. Overviews of the graphical user interfaces for the 
‘Design’, ‘Simulate’, ‘Localize’, ‘Render’ and ‘Filter’ components are 
shown in Supplementary Figures 1–5.

Although in principle a cross-platform development, we 
currently supply a one-click installer of Picasso for Microsoft 
Windows 64-bit operating systems. This single executable  
setup file can be downloaded from our website at http://www.
jungmannlab.org. Picasso is developed in Python, and the source 
code is available at https://github.com/jungmannlab/picasso.

Design and preparation of DNA origami structures
As DNA-PAINT makes use of the programmability of (transient) 
DNA strand hybridization to enable super-resolution imaging, 
DNA-based objects are convenient in vitro test targets for imaging. 
Nucleic acids can serve as powerful building blocks for nanom-
eter-scale structures based on sequence-guided self-assembly, 
which is the foundation of structural DNA nanotechnology34,35. 
DNA origami are complex, self-assembled, 2D or 3D struc-
tures created by annealing DNA strands of specifically designed 
sequences33. In DNA origami, a long single-stranded DNA 

In situ
Labeling
sample

preparation

19 – 33
Box 1

In vitro
Design
sample

preparation

1 – 18

In silico

Filter

Picking

AverageKinetics/
qPAINT

Image
recon-

struction
50 – 58

Image
postpro-
cessing
59 – 60

Box 3

69A

61– 68

69B/C 69D

Ultra- 
resolution

Box 2

Channel
alignment

69E

Sample
preparation

Data
acquisition

34 – 49

Figure 5 | DNA-PAINT protocol workflow. Starting with sample preparation, 
the user can perform either in vitro or in situ experiments. Next, data 
acquisition is performed (parameters for ‘Ultra-resolution’ are described 
in Box 2). The user may additionally generate DNA-PAINT data by in silico 
simulations. During image reconstruction, single-molecule fluorescence 
spots are localized, and resulting super-resolution images are visualized with 
‘Picasso: Render’. Image post-processing focuses first on drift-correction 
procedures. Then, special emphasis is given to analyzing the localization-
based DNA-PAINT data through picking regions of interest, performing 
kinetic and qPAINT analysis, averaging images for ultra-resolution analysis 
and channel alignment for Exchange-PAINT or filtering of the localization 
list. Program icons indicate in which Picasso component the respective step 
is performed—hexagons: ‘Design’; microchip: ‘Simulate’; mountain peaks: 
‘Localize’; paint palette: ‘Render’; funnel: ‘Filter’; stacked layers: ‘Average’. 
The Picasso program icons are based on contributions from the Noun Project 
(https://thenounproject.com)—‘Design’: hexagon by Creative Stall;  
‘Simulate’: microchip by Futishia; ‘Localize’: mountains by Montana Rucobo; 
‘Filter’: funnel by José Campos; ‘Render’: paint palette by Vectors Market; 
‘Average’: layers by Creative Stall.
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molecule (called the ‘scaffold’, derived from M13mp18 single-
stranded phage DNA) is folded into a desired shape by ~200 short,  
single-stranded DNA strands (called ‘staples’). Each staple has 
a defined sequence and specifically binds certain parts of the 
scaffold together. Structures are usually assembled in a one-pot 
reaction using thermal annealing. After the self-assembly is com-
pleted, the scaffold is ‘folded’ into the desired shape with the staple 
strands at prescribed positions in the final origami.

The rather complex and time-consuming procedure of manu-
ally designing DNA origami structures has been markedly simpli-
fied by computer-aided design tools, such as the freely available 
caDNAno36 and vHelix37 packages, as well as by simulation  
programs such as CanDo38. Furthermore, folding protocols for 
structure formation are now optimized for structure yield and 
folding speed39–41. In addition, several methods for subsequent 
purification of DNA nanostructures from unwanted excess of sta-
ple strands are described in the literature, such as agarose gel puri-
fication42, rate-zonal centrifugation43 or PEG purification44.

One of the early applications of DNA origami was its use as a 
microscopy standard in the form of a self-assembled nanoruler45. 
Owing to the unique positioning accuracy of DNA origami and 
its excellent structural integrity, the structures present an ideal 
platform to directly validate imaging methods and compare 
instrumentation. Specifically, they are a valuable tool in calibrat-
ing fluorescence and super-resolution microscopes46.

Although it is possible to create a wide range of structures with 
the DNA origami technique, some are more suitable for use as a 
reference structure with DNA-PAINT than others. In this proto-
col, we use a flat, rectangular 2D DNA origami structure, adapted 
from the one originally described33, here referred to as RRO. With 
dimensions of 90 × 70 nm and, in our case, 176 freely address-
able staples arranged in a hexagonal lattice with 5-nm spacing, 

it is an ideal structure for DNA-PAINT imaging (see Fig. 1b  
as an example). For surface immobilization, the structure is 
modified with eight biotinylated staple strands that can bind to 
a BSA–biotin–streptavidin-coated glass surface.

‘Picasso: Design’ is an essential tool in this protocol that reduces 
all design steps to a minimum. Figure 6 shows screenshots and 
outlines the procedure for creating DNA origami, from design to 
purification. For a detailed overview of the graphical user inter-
face, refer to Supplementary Figure 1. The program displays a 
hexagonal lattice that serves as a canvas representing all possible 
staple positions available for modification in the RRO struc-
ture. It features a ‘point-and-click’ approach, so that the desired  
pattern can be made by simply ‘painting’ on the canvas. Clicking 
a hexagon will fill it with a previously selected color; each color 
corresponds to a built-in staple extension on the 3`-end. As all 
modifications are just staple extensions of the RRO structure, 
the core sequences are not altered, and time-consuming tasks 
such as altering the routing of staples or modifying their base 
sequence are not necessary. In addition, ‘Picasso: Design’ auto-
matically calculates folding recipes for a given design based on 
optimized excess rates for the RRO and creates visual pipetting 
aids for 96-well plates so that pipetting of staple mixes is greatly 
facilitated. In consequence, the creation of DNA origami refer-
ence structures for DNA-PAINT can be achieved in the most  
straightforward way.

In situ sample preparation
A unique advantage of fluorescence microscopy, making it one 
of the preferred characterization tools in biological research, is 
its ability to interrogate biomolecules of interest, such as proteins 
or nucleic acids, with high efficiency and specificity. Generally,  
fluorescent labeling of target molecules is achieved either by 

Box 1 | Construction of a fluid exchange chamber for in situ imaging  
L TIMING 30 min 
Procedure
For in situ Exchange-PAINT experiments, we recommend a simple, custom-built fluid exchange system. The lid of an 8-well chambered 
cover glass can be modified with one inlet and one outlet, which can be connected to imaging and washing buffer reservoirs by 
silicone tubing. The modified lid can be used for multiple imaging experiments, although the connected tubing should be thoroughly 
cleaned before reuse. Using a syringe, flush at least 3 ml (as reference for 1-m tubing with a 1.5-mm diameter; adjust accordingly) of 
H2O, followed by 3 ml of 80% EtOH and finally 3 ml of H2O, through the tubing. Follow these instructions to prepare such a lid:
1. Drill two holes with a diameter of 1.5 mm into the lid of an 8-well chambered cover glass, so that two needles can penetrate it.
2. Use a rotary tool with cutting disc or equivalent to remove the syringe connectors from two 1.2 × 40-mm needles. Alternatively, use 
a side cutter (although this could potentially lead to a ‘less clean cut’) and squeeze the channel shut. To reopen, carefully apply pres-
sure with the side cutter at the side of the cut. Make sure that the needle is at least 2.5 cm long to be able to reach the bottom  
of the chambered cover glass.
! CAUTION Handle the needles with care and do not puncture yourself.
3. Cut away the sharp end of one of the needles, so the channel can reach the bottom of the wells. Carefully apply pressure to open 
the metallic channel of the needle at the cut side with the side cutter.
! CAUTION Handle the needles with care and do not puncture yourself.
4. Connect the cut needles to ~50 cm of tubing. Make sure that the tubing is long enough that there is enough space to handle the 
liquids and syringes at the microscope. To connect the tubing to the syringes, use 1.1 × 40-mm needles on the other end of the tubing.
M CRITICAL STEP The length of the tubing depends heavily on the accessibility of the microscope; adjust the tubing length for proper 
handling.
5. For imaging, fix the tubing to the microscope body via tape.
M CRITICAL STEP Leakage could lead to damage of the microscope. Check all tubing and connections before use.
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genetically fusing a protein tag to the target47 or by attaching an 
external binder molecule during a staining procedure—e.g., dye-
labeled antibodies48. For DNA-PAINT, the labeling requirement 
is that a DNA docking strand is attached to the target. Although 
a variety of strategies could be feasible for that29,30,49–52, this 
protocol focuses on immunostaining with DNA-conjugated anti-
bodies25. Specifically, we describe how antibodies can be chemi-
cally modified and used for in situ DNA-PAINT imaging of fixed  
cells (Steps 19–33).

The concept of in situ DNA-PAINT with primary and sec-
ondary antibody labeling is shown in Figure 1c: imager strands 
from solution transiently bind to handle sites on the secondary 
antibody. Imaging results for in situ samples prepared with anti-
body labeling are shown in Figure 1d,e, displaying a gradient 
overlay of diffraction-limited microtubules in comparison with 
the reconstructed super-resolved image. Furthermore, Figure 2g 
shows DNA DBCO-labeled antibody staining of Tom20, located 
mainly at the outer mitochondrial membrane, and DNA thiol-
labeled antibody staining of microtubules.

Various avenues are possible for attaching DNA strands to 
antibodies, including biotin–streptavidin linkage20 or covalent 
attachment of the DNA to the antibody22,53,54. Although biotin–
streptavidin linkage was used in the initial in situ DNA-PAINT 
demonstration20, we here discuss a covalent attachment strat-
egy, which was used in subsequent work22 similar to previously 
reported strategies for DNA–protein conjugation53,54. Here, an 
NHS ester linker is covalently attached to amino groups on the 
antibody and to certain functional groups on the DNA, such as 
reduced thiols22, azides53,55, alkynes53 or DBCO55, for click chem-
istry. This results in cross-talk-free attachment, as well as smaller 
linker sizes between antibody and DNA strand, as compared with 
the biotin–streptavidin linkage20.

Depending on the target molecules under investigation, it is 
furthermore important to evaluate different fixation strategies. 

For example, structural proteins, such as actin filaments or micro-
tubules, can be fixed with pre-extraction and glutaraldehyde to 
decrease background and preserve structural integrity56. However, 
structural artifacts can arise from the various fixation strategies. 
For an in-depth discussion of fixation artifacts, we refer to a recent 
article by Whelan et al.57. DNA-PAINT was also applied to tissue 
samples, as was recently shown in Drosophila embryos22, generally 
following the same procedures as described here. However, we do 
note that potential changes to the herein described protocol for 
more complex tissue samples might become necessary.

Data acquisition
A multitude of acquisition software packages are available for 
performing localization-based super-resolution microscopy, in 
particular for commercial microscope setups. In this protocol, we 
describe our procedures based on the freely available open-source 
acquisition software MManager58. MManager is used in a wide 
range of microscopy areas and offers broad device support for 
microscope bodies, cameras and peripherals. The Picasso software 
suite is specifically designed to be compatible with MManager.

Currently, two types of cameras are typically used in the field 
of single-molecule localization-based imaging—scientific com-
plementary metal oxide semiconductor (sCMOS)- and electron-
multiplying charge coupled device (EMCCD)-based cameras. 
sCMOS cameras provide better temporal resolution because of 
their faster readout electronics, resulting in a larger optical field 
of view as compared with EMCCDs under similar conditions. 
EMCCD cameras, in comparison, provide better quantum yields 
in low-light applications and thus higher signal-to-noise ratios59. 
As DNA-PAINT provides comparably higher signal-to-noise 
ratios (SNRs), both camera types are suitable in this context.

It has been shown that a pixel-dependent noise calibra-
tion for sCMOS cameras can improve localization precision in 
STORM60. However, for DNA-PAINT experiments—including the  

Box 2 | Ultra-resolution imaging L TIMING ~7 h 
Procedure
To achieve ultra-resolution (<5 nm), imaging conditions must be carefully adjusted. The key to higher spatial resolution is to extract 
more photons per frame from a blinking event while simultaneously keeping the background low. This can be achieved by optimizing 
the laser excitation power, as well as the fluorescence ON time (and adjusting the integration time accordingly). The background can 
be reduced, for example, by decreasing the imager concentration. In this case, the acquisition time should be increased to ensure  
proper sampling of the target structure. However, with an imager concentration that is too low, drift correction might become less  
accurate owing to the smaller number of localizations per frame. We also want to note that the number of drift markers in a field of 
view should be as high as possible, to ensure precise drift correction. One way to achieve this is to make use of the larger field of  
view obtainable with today’s sCMOS cameras. For advanced drift correction, a 20-nm and a 10-nm grid DNA origami should be used  
as fiducials. Furthermore, oxygen-scavenging systems, such as the PCA/PCD/Trolox (PPT) system, allow the harvesting of more photons  
as they increase fluorophore stability27. The following steps describe in detail how to achieve ultra-resolution for imaging DNA  
origami structures.
1. Design and fold DNA origami structures for ultra-resolution imaging—e.g., the LMU or MPI logo. In addition, fold 20-nm and  
10-nm grid DNA origami for use as drift markers (see Steps 1–17).
2. Prepare the oxygen-scavenging system PPT at least 1 h before imaging.
3. Prepare a sample with the target structure and DNA origami drift markers (see Step 18) using the following parameters:
L Origami solution ratio: 1/4 target structure (i.e. LMU or MPI logo), 1/4 20-nm drift marker, 1/4 10-nm drift marker  
and 1/4 Buffer B+
L Imager concentration (with PPT): 0.5 nM–1 nM.
4. Follow steps 34–48 with the following adjustments: 350 ms exposure time, 80,000 total number of frames. Set the excitation power 
density to ~4.5 kW/cm2 at the sample plane.
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ultra-resolution measurements in this protocol—we did not 
account for the pixel-dependent noise of our sCMOS camera. 
Although such calibration might also improve DNA-PAINT 
image quality, it was not required to achieve the ~1-nm localiza-
tion precision that allowed us to resolve 5-nm spaced binding sites 
on DNA origami structures (Fig. 4 ).

In this protocol, we generally suggest rather long camera inte-
gration times (a few hundred milliseconds) as compared with 
other localization-based microscopy methods such as PALM or 
STORM. Typically, for localization-based super-resolution tech-
niques, the integration time is roughly matched to the ON-time  
of blink events to maximize the signal-to-noise ratio of the fluo-
rescence image. Analogously, the integration times suggested here 
are roughly matched to the binding kinetics of the recommended 
nine-base-pair DNA duplex. This allows the collection of far more 

photons in a single frame as compared with typical PALM or 
STORM experiments, thus enabling better localization precision. 
However, it is worth noting that the combination of slower blink-
ing and longer integration time comes at the expense of extended 
total data acquisition time to detect the same number of events. 
Nonetheless, it is certainly possible to shorten the binding duration,  
integration time and thus the total acquisition time by using DNA 
duplexes with fewer base pairs. For example, the recommended 
integration time for 8-mers is only tens of milliseconds and that 
for 7-mers is even less. With such faster kinetics, the integra-
tion time and achievable localization precision would then be 
similar to those in PALM or STORM experiments. An advantage 
of DNA-PAINT is therefore that it gives the researcher intricate 
control over the desired localization precision as a trade-off for 
total acquisition time.

Box 3 |  In silico simulation of DNA-PAINT data L TIMING 10–60 min 
Picasso’s simulation module (‘Picasso: Simulate’) is a tool for evaluating experimental conditions for DNA-PAINT and generating ground-
truth data for test purposes. This allows systematic analysis of how different experimental parameters such as imager concentration, 
target density or integration time influence the imaging quality and whether the target structure can be resolved with DNA-PAINT.
By default, ‘Picasso: Simulate’ starts with preset parameters that are typical for a DNA-PAINT experiment. Thus, meaningful raw  
DNA-PAINT data can be readily simulated for a given input structure without the need of a super-resolution microscope. The simulation 
output is a movie file in .raw format, as it would be generated during an in vitro DNA-PAINT experiment on a microscope.

Procedure
1. Start ‘Picasso: Simulate’.
2. Define the number and type of structures that should be simulated in the group ‘Structure’. Predefined grid- and circle-like structures 
can be readily defined by their number of columns and rows, or their diameter and the number of handles, respectively. Alternatively, 
a custom structure can be defined in an arbitrary coordinate system. To do so, enter comma-separated coordinates into ‘Structure X’ 
and ‘Structure Y’. The unit of length of the respective axes can be changed by setting the spacing in ‘Spacing X,Y’. For each coordinate 
point, an identifier for the docking site sequence needs to be set in ‘Exchange labels’ as a comma-separated list. Correctly defined 
points will be updated live in the ‘Structure [nm]’ window. Note that entries with missing x coordinate, y coordinate or exchange label 
will be disregarded. When a structure has been previously designed with ‘Picasso: Design’, it can be imported with ‘Import structure 
from design’. A probability for the presence of a handle can be set with ‘Incorporation’. By default, all structures are arranged on a  
grid with boundaries defined by ‘Image size’ in ‘Camera parameters’ and the ‘Frame’ parameter in the ‘Structure’ group. ‘Random  
arrangement’ distributes the structures randomly within that area, whereas ‘Random orientation’ rotates the structures randomly.  
Selecting the button ‘Generate positions’ will generate a list of positions with the current settings and update the preview panels.  
A preview of the arrangement of all structures is shown in ‘Positions [Px]’, whereas an individual structure is shown in ‘Structure [nm]’.
3. The group ‘PAINT Parameters’ allows adjustment of the duty cycle of the DNA-PAINT imaging system. The mean dark time is  
calculated by Td = (kon·c)−1. The mean ON time in a DNA-PAINT system is dependent on the DNA duplex properties. For typical 9-bp 
imager/docking interactions, the ON time is ~500 ms. ON times can be experimentally estimated with Picasso as described in Step 69B.
4. In ‘Imager Parameters’, fluorophore characteristics such as PSF width and photon budget can be set. Adjusting the ‘Power density’ 
field affects the simulation analogously to changing the laser power in an experiment.
5. The ‘Camera parameters’ group allows the user to set the number of acquisition frames and integration time. The default image size 
is set to 32 pixels. As the computation time increases considerably with image size, it is recommended to simulate only a subset of the 
actual camera field of view.
6. Select ‘Simulate data’ to start the simulation. The simulation will begin by calculating the photons for each handle site of every 
structure and then converting it to a movie that will be saved as a .raw file, ready for subsequent localization. All simulation settings 
are saved and can be loaded at a later time with ‘Load from previous simulation’.
?� TROUBLESHOOTING
7. (Optional step for multiplexing) Multiplexed Exchange-PAINT data can be simulated by adjusting the ‘Exchange Labels’ setting.  
For each handle in the custom coordinate system (‘Structure X’, ‘Structure Y’), an Exchange round can be specified. The different  
imaging rounds can be visually identified by color in the ‘Structure [nm]’ figure. For each round, a new movie file will be generated.  
By default, the simulation software detects the number of exchange rounds based on the structure definition and will simulate all  
multiplexing rounds with the same imaging parameters. It is possible to have different imaging parameters for each round, e.g.,  
when using image s with different ON-times. To do so, one can simulate multiplexing rounds individually. In the ‘Exchange rounds  
to be simulated’ field, enter only the rounds that should be simulated with the current set of parameters. Change the set parameters 
and the multiplexing round and simulate the next data sets. Repeat until all multiplexing rounds are simulated.
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The number of localizations and thus the total experiment time 
strongly influence the resolution of a localization-based super-
resolution image. Ideally, to resolve a target structure, it should 
be spatially probed at least at its Nyquist frequency61. More pre-
cisely, it has been shown that the overall image resolution for 
localization-based super-resolution microscopy is governed by 
two main factors: sampling density and localization precision16. 
In the same work, it was demonstrated that longer acquisition 
times increase spatial resolution of the reconstructed image 
because of increased spatial sampling up to the point at which 
image resolution is solely limited by localization precision. As the 
molecule density of a target structure might be unknown, it is 
often necessary to evaluate a range of acquisition times to deter-
mine how many frames are sufficient to represent the structure 
with the desired resolution. In silico simulations of localization- 
based super-resolution imaging can be a practical method of 
assaying a large number of data acquisition parameters such as 
the total acquisition time62, reducing the need for time-con-
suming experiments. The Picasso software package comes with 
a module for simulating DNA-PAINT data, thus providing the 
tools for this approach. A more detailed discussion of the ‘Picasso: 
Simulate’ module follows below. Finally, we want to provide an 
exemplary thought-experiment as a guide to estimating appro-
priate acquisition lengths t. Consider an imager concentration 

c of 10 nM and a probe association rate kon of 106 (Ms)−1. This 
leads to a mean time in between binding events (or dark time 
Td) for a single site of 100 s according to Td = (kon × c)−1. For an 
~98% probability (P) of any single binding site being visited at 
least once, a total imaging time of t = 4 × Td = 400 s is required, 
according to P = 1 – e−t/Td. To achieve multiple binding events 
per site resulting in a decent image quality, we recommend a total 
imaging time of ~33 min.

In silico simulation of DNA-PAINT data
A fundamental challenge in single-molecule localization micro-
scopy is to systematically design, optimize and validate super-
resolution experiments. In silico simulations provide a convenient 
way to address this challenge. Software packages such as SuReSim 
generate a ground truth model and simulate localization micros-
copy data using parameters matching an experimental microscope  
setup62. Similar to this approach, the Picasso software suite 
can simulate localization data with its ‘Simulate’ component, 
which is specifically tailored to DNA-PAINT. In a graphical 
user interface, shown in Figure 7 and Supplementary Figure 2, 
simulation parameters can be set for the type of target struc-
ture, DNA-PAINT kinetics, dye properties and hypothetical data 
acquisition settings such as integration time and total number of  
acquisition frames.
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Figure 6 | Designing DNA origami structures for DNA-PAINT with ‘Picasso: Design’. (i) Screenshot of the design interface displaying a 20-nm grid structure  
with 12 docking sites (red) selected to carry the extension P1. After design is completed, a list of plates is generated as a .csv file ready for ordering (ii). 
‘Picasso: Design’ also creates PDF sheets that can be placed underneath the ordered 96-well plates to facilitate pipetting of staple strands (iii). The folding 
table (iv) gives detailed instructions for preparing components to assemble the DNA nanostructure through thermal annealing. Staple master mixes are 
pipetted from the plates according to the pipetting scheme. For a successful assembly process, single-stranded DNA scaffold, biotinylated staples, staple 
master mixes (unmodified core (gray) and docking-strand-extended (red) staples), water and folding buffer need to be mixed (v). After structures are formed 
(usually through thermal annealing), an agarose gel can be run for analysis or subsequent structure purification (vi). Here, a DNA ladder (L) and the  
scaffold strand (S) are seen as clear bands together with bands for the correctly folded DNA structures and excess staple strands (Ex). Extracted origami 
structures are now ready for DNA-PAINT imaging.
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The simulated imaging targets are nanometer-sized 2D struc-
tures (similar to RROs) on which the positions of DNA-PAINT 
handles can be defined. These handles serve as a ground truth 
model for localization events. On the basis of the values set for 
DNA-PAINT kinetics, the simulation algorithm will calculate a 
kinetic series of ON- and OFF-events over the total acquisition 
time for each handle.

The duration of an ON-event is calculated by random selection 
from an exponential distribution defined by a mean ON-time. 
This time can be either determined experimentally (i.e., using 
Picasso’s kinetic analysis tool; see Step 69B) or estimated by the 
number of base pairs in the imager/docking strand duplex19.  
The length of an OFF-event is generated accordingly. Here, the 
mean OFF-time is calculated from the user-defined binding rate 
constant and the imager concentration19.

The user-defined integration time of the simulated camera is 
used as a sampling window to calculate how long an imager was 

bound during each frame. To emulate experimental results, the 
simulation randomly selects a photon detection rate for each 
binding event from a normal distribution. The mean and standard 
deviation of this normal distribution increase linearly with the 
user-definable laser power density according to experimentally 
determined coefficients. For each frame (or fraction of a frame) in 
which the binding event occurs, the detected number of photons 
is then selected randomly from a Poisson distribution. The mean 
of this Poisson distribution is equal to the mean expected photon 
number for the binding event duration within this frame (photon 
detection rate × duration). In addition, the simulation considers 
an upper-limit for detected photons from a single binding event, 
based on a user-defined photon budget per fluorophore.

After the number of photons for all binding events in each 
frame is calculated, photons are distributed around the center 
position of their handle by a user-adjustable 2D normal distribu-
tion, representing the microscope’s point spread function (PSF). 

a

Start: c i = 1 nM c i = 20 nM c i = 5 nM c i = 5 nM

c i too low c i too high Desired c i Good agreement
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cr
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ec
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c i

Simulation 1 Simulation 2 Simulation 3 Experiment

c
Simulated RAW data

Reconstructed
DNA-PAINT data

Figure 7 | Simulating DNA-PAINT raw data from DNA origami-like structures. (a) Overview of the graphical user interface for ‘Picasso: Simulate’. A DNA-PAINT 
simulation can be defined by parameters in four categories, indicated by colored frames: ‘Structure’ (blue), PAINT parameters (red), ‘Imager parameters’ 
(green) and ‘Camera parameters’ (yellow). Two overview plots are shown in the upper row. ‘Positions [Px]’ shows the arrangement of individual structures 
within the field of view and ‘Structure [nm]’ shows the positions of DNA-PAINT binding sites in an individual structure. The positions of binding sites in 
individual structures can be defined in the ‘Structure’ section by (i) importing RRO structures designed with ‘Picasso: Design’, (ii) using predefined geometric 
shapes (circles, grids), or (iii) manually entering coordinates. In the ‘PAINT parameters’ section, kinetic parameters for DNA-duplex formation can be set. 
Imager-related properties (PSF width, laser power, photon budget, photon detection rate and background) are defined in the ‘Imager parameters’ section. 
Last, acquisition settings, such as image size, integration time, number of frames and pixel size can be set in the ‘Camera parameters’ section. (b) Example 
of simulated raw DNA-PAINT data in ‘Picasso: Localize’ after spot identification and fitting. The simulation program simulates blinking events as if they were 
acquired with a microscope. (c) Reconstructed DNA-PAINT image from data generated with ‘Picasso: Simulate’. The overview of all structures corresponds 
to the ‘Positions [Px]’ window shown in a. A close-up shows the structure that is presented in the ‘Structure [nm]’ window in a. (d) Example of an iterative 
process for optimizing DNA-PAINT experiments with simulations. A DNA origami structure is simulated with an imager concentration of 1 nM (Simulation 1). 
The simulation shows that the concentration is too low, because features of the structure are not clearly visible. Consequently, in a next iteration, data are 
simulated with a higher concentration, here 20 nM (Simulation 2). Now the simulation reveals that the imager concentration chosen is too high, resulting 
in ‘cross-talk’ localizations between the structures. Such cross-talk arises when two imagers bind simultaneously to nearby structure sites. Their diffraction-
limited images spatially overlap and are falsely identified as a single event with a fitted center coordinate in between the two true positions. For the next 
iteration, the imager concentration is decreased to 5 nM. The resulting simulation shows structures with clear features and no inter-structure cross-talk. 
Hence, the 5 nM imager concentration was chosen to perform a DNA-PAINT experiment (Experiment), which in turn is in good agreement with the simulation. 
Scale bars, 500 nm (c), 100 nm (c inset, d).
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This results in a list of all photon positions for each frame, which 
is converted to an image by calculating a 2D histogram. Poissonian 
noise is added to each frame specified by the background level. 
Finally, the frames are exported as a raw movie file. The default 
values for all parameters were estimated from calibration  
experiments on our TIR fluorescence (TIRF) setup described in 
the EQUIPMENT section. The imager sequence for calibration 
experiments was CTAGATGTAT (P1), which was labeled with a 
Cy3B dye that was excited by a 561-nm laser.

Super-resolution image reconstruction
After a movie of DNA-PAINT data has been acquired (either  
in silico, in vitro or in situ), single-molecule spots must be identi-
fied and fitted to find their center position with subpixel accuracy. 
These routines are performed with Picasso’s ‘Localize’ compo-
nent. An overview of the graphical user interface with identified 
and fitted localizations is shown in Supplementary Figure 3,  
as well as screenshots of parameter dialogs.

A multitude of spot identification algorithms have been devel-
oped and applied to localization-based super-resolution micro-
scopy63. In ‘Picasso: Localize’, spot identification makes use of 
the image gradient to minimize the impact of nonhomogeneous 
background. First, local maxima are detected by identifying pixels 
with highest count in their local neighborhood. This local neigh-
borhood is defined by a square box around the pixel with a user-
defined side length. Then, the net gradient (Gnet) is calculated for 
each box around a local maximum pixel by 

Gnet i i
box

� �£ g u

where the sum is taken over all pixels of the box, gi is the central 
difference gradient at pixel i and ui is a unit vector originating 
at pixel i and pointing toward the center pixel of the box. Hence, 
the net gradient of a spot is the sum of intensity flowing toward 
the spot center, which is roughly proportional to the number of 
signal photons. A user-defined minimum threshold for the net 
gradient defines whether a spot will be further considered for 
fitting or disregarded.

After spots have been identified by the net gradient method, 
their box serves as input for a maximum likelihood fitting pro-
cedure64. Although a plethora of spot-fitting algorithms have 
been published and used for localization microscopy63, we chose 
to implement the maximum likelihood algorithm because it 
achieves theoretically minimum uncertainty at the Cramer-Rao 
lower bound with good computational performance. However, 
it is critical to this fitting algorithm that the camera images be 
converted correctly to photons, because the algorithm incorpo-
rates the Poisson noise statistics inherent to light detection. In 
‘Picasso: Localize’, the user can set the required parameters for 
converting camera counts to photons. One result of the maximum  
likelihood fitting is the Cramer-Rao lower bound (CRLB) for each 
spot. The localization precision is then obtained by calculating 
the square root of the CRLB.

Finally, super-resolution images are rendered with the ‘Picasso: 
Render’ component based on a list of subpixel spot center coordinates  
(see Supplementary Fig. 4 for an interface overview). The super-
resolution image is a pixel image with arbitrary pixel size, although 
super-resolution pixels that are too large result in insufficient spa-
tial sampling and a potential loss in resolution. We define the ratio 

of super-resolution image pixels to camera pixels as the ‘oversam-
pling’ parameter. In Picasso, the oversampling can be set either 
manually or automatically according to how far the user zooms 
into the image. In the dynamic case, each computer display pixel 
corresponds to one pixel of the super-resolution image.

Picasso offers several rendering modes for the super-resolution  
image. The basic option is to use no ‘Blur’, in which case the 
super-resolution image is merely a 2D histogram of localization 
coordinates65. The second option is ‘One-Pixel-Blur’, in which the 
2D histogram is convolved with a Gaussian probability density 
function of volume and standard deviation equal to one. The 
third option, ‘Global Localization Precision’, is similar to the 
‘One-Pixel-Blur’. However, the standard deviation of the Gaussian 
kernel is set to the median localization precision of all localiza-
tion coordinates. In the fourth option, ‘Individual Localization 
Precision’, each localization is added to the super-resolution image 
as a Gaussian probability density with volume equal to one and 
standard deviation equal to the individual coordinate localization  
precision3. For the localization-precision-based representation 
methods (‘Global’ and ‘Individual Localization Precision’), a 
minimum blur width can be defined by the user, so that the blur 
width is equal to the localization precision, unless the precision 
is smaller than the set minimum blur width.

Picasso furthermore allows for contrast adjustment of the 
super-resolution image based on the density of localizations in 
one super-resolution image—i.e., the number of localizations per 
pixel (or in the case of ‘blurred’ images, the sum of probability 
densities from localizations at each pixel).

Drift correction
A critical post-processing step for localization-based super-resolu-
tion imaging is to compensate for stage drift that occurred during 
data acquisition. In fact, with intricate drift correction methods, 
extremely high resolution (well below 5 nm) can be achieved23. 
After such post-processing steps, drift is almost completely 
removed as a factor for resolution degradation. Consequently, 
localization precision and structure sampling are the only remain-
ing factors that determine image quality. Even so, localization  
precision can be greatly optimized, because DNA-PAINT decou-
ples dye photophysics from blinking, and particle averaging 
(described below) allows reducing of the effects of undersampling 
the structure of interest.

Picasso offers two major routes for drift correction: (i) using 
the localization events themselves and (ii) using specific fidu-
cials in the sample. The localization-events-based drift correction 
is an implementation of a redundant cross-correlation (RCC) 
algorithm66 in which localizations are split and rendered into 
multiple super-resolution images according to their temporal 
appearance in the movie. Image cross-correlation of all result-
ing super-resolution images then yields the spatial shift between 
temporal movie segments from which the drift is interpolated. 
Another conventional way for compensating drift in localization-
based super-resolution microscopy is by using fiducial markers3. 
Such fiducial markers are luminescent and typically observed in 
the same emission channel as the fluorescent signal. Commonly 
used fiducials are gold nanoparticles, quantum dots and fluores-
cently dyed microspheres. With Picasso, localizations from such 
fiducial markers can be selected and used for drift correction, 
as the localizations can be assumed to originate from a single  
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point-like source. Recent developments in extremely high reso-
lution in DNA-PAINT applications have used a large number 
of DNA origami as fiducial markers23. When using hundreds of 
DNA origami structures as markers, their intrinsic size does not 
affect the drift estimation because of their random rotational 
orientation. In the same work, an additional drift correction 
step was applied by selecting single DNA-PAINT binding sites as 
drift markers. Similar to the case of whole DNA origami, a large 
number of binding sites (usually several thousands) are required, 
as each individual site does not comprise sufficient localizations 
to interpolate the drift for each movie frame accurately. Although 
DNA origami and their DNA-PAINT binding sites are excellent 
choices, this type of fiducial-based drift estimation is not limited 
to these structures. It is feasible to use any distinctly visible land-
marks in the image as fiducial markers—for example, protein 
clusters such as the nuclear pore complex.

In this protocol, we recommend subsequent applications of drift 
correction by RCC and, if available, fiducial-based correction with 
DNA origami markers followed by fiducial-based correction with 
single DNA-PAINT binding sites as markers. Example results after 
each drift correction step of such a process are shown in Figure 4b. 
In the final images, drift is almost completely eliminated as a factor 
in image resolution. This is corroborated by the fact that the spread 
of imaged DNA-PAINT binding sites is similar to the estimated 
localization precision by nearest neighbor analysis (NeNA)67.

Multiplexing
One major benefit of DNA-PAINT is its straightforward exten-
sion to multiplexed imaging. Here, the simplest implementation 
is to use spectrally distinct dyes coupled to orthogonal imager 
sequences68. Unlike other multiplexed localization-based super-
resolution techniques69, no photo-switching of dyes is necessary, 
and thus it is rather simple to find compatible spectrally distinct 
fluorophores68 (i.e., Atto488, Cy3B and Atto655).

However, one major drawback of spectral multiplexing is the 
limited number of distinguishable dyes in the visible spectrum. 
This limitation can be overcome with Exchange-PAINT20. Here, 
the unique programmability of DNA-PAINT docking and imager 
strands is used to enable spectrally unlimited multiplexing by 
sequentially applying orthogonal imager strands (carrying the 
same dye) to targets of interest.

In each imaging round, only one imager species is present in solu-
tion for one target. After acquisition, the imager is washed out and 
the imager for the next round is introduced. This is then repeated 
for the total number of targets. A multicolor image is achieved by 
assigning a pseudocolor to each imaging round and stacking the 
acquisitions on top of each other, which is depicted in Figure 2a.

Preparation of samples for Exchange-PAINT is similar to that 
for singleplex experiments, only that an open chamber allowing 
for fluid exchange is used as displayed in Figure 2b,c.

To create multicolor images, Picasso automatically assigns pseu-
docolors when several data sets are loaded. Different imaging rounds 
potentially comprise an offset with respect to each other because of 
instrumentation drift during data acquisition. However, alignment 
procedures can detect and correct for such image offsets.

Picasso offers cross-correlation or fiducial-based alignment 
algorithms. When images share features as reference points, such 
as DNA origami or the general cell shape, the cross-correlation 
can align images with high precision—e.g., sub-5-nm channel 

alignment, as demonstrated in Figure 2d–f. When few reference 
points are available, e.g., for in situ imaging of different cell tar-
gets, alignment markers or drift fiducials can be added to the 
sample and used in Picasso’s alignment procedure.

A distinct advantage of Exchange-PAINT over spectral multi-
plexing is that for each imaging round the same dye is used, and 
thus misalignment and inhomogeneous image warping due to 
chromatic aberrations are avoided. This allows for very precise 
channel alignment and makes Exchange-PAINT ideal for colocali-
zation studies to assess spatial proximity and possible molecular 
interactions. Such results are illustrated in the in situ example 
in Figure 2g, in which the morphology of the mitochondrial  
network and the spatial relationship to microtubules is studied. 
It shows how mitochondria are embedded in the microtubule 
network, as described in previous work70.

Quantitative imaging with qPAINT
Most super-resolution studies to date harness their exquisite sub-
diffraction spatial resolution to address challenges in the bio-
logical sciences by structural imaging. However, although still 
challenging, counting integer numbers of biomolecules when 
localization precision is insufficient to spatially resolve them can 
bring further insight into biological systems8,71,72. To achieve this, 
researchers began using the spatiotemporal information of single-
molecule localization microscopy data sets beyond just binning 
localization events for visualization. The basic concept involves 
extracting molecule numbers by evaluating the kinetics of the 
blinking behavior of photoswitchable molecules73–75. Most of 
these counting techniques use rather complex modeling of the 
dye photophysics, in some cases combined with spatiotemporal 
clustering72–76. However, incumbent techniques have certain limi-
tations that prevent them from achieving the highest accuracy and 
precision over a wide range of molecular densities in resolution-
limited areas. These limitations generally lead to overcounting 
or undercounting artifacts, because the dyes typically have envi-
ronmentally sensitive photophysics that are hard to predict and 
model. Furthermore, distinct dyes behave differently even under 
similar experimental conditions, which severely complicates 
multiplexed quantitative imaging. In addition, inhomogeneous 
excitation and photoactivation intensities due to uneven illumina-
tion across a sample can lead to inaccurate quantification as well.  
Last, dyes typically bleach over the course of an experiment, which 
deteriorates quantification accuracy and precision.

Recently, DNA-PAINT has been used to achieve precise and accu-
rate counting—because of its independence from dye photophysics 
and immunity to photobleaching—in an implementation called 
qPAINT22. In contrast to the traditional approach of fixing blinking 
dyes to the target molecule, DNA-PAINT creates target ‘blinking’ by 
transient binding of dye-labeled imager strands to complementary 
docking strands on the target. As opposed to dye photoswitch-
ing, DNA hybridization kinetics is more predictable. Hence, com-
bined with the effective absence of photobleaching, qPAINT can  
extract molecule numbers with high precision and accuracy.

Figure 3 illustrates the procedure and results of a typical 
qPAINT experiment. Using Picasso’s quantification capabilities, 
we now provide users with an integrated software solution for 
calibrating and quantifying molecule numbers in DNA-PAINT 
data sets. qPAINT relies on the fact that mean dark times for a 
given influx rate of imager strands (X = kon × c) are dependent 
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only on the number of docking strands (and thus biomolecules) 
in an area of interest. To illustrate this, we compare two DNA 
origami structures, carrying 12 or 42 binding sites in 20-nm and 
10-nm grid arrangements, respectively (Fig. 3a). A schematic  
representation of their respective intensity vs. time traces is shown 
in Figure 3b. By plotting the cumulative distribution function 
of both dark time distributions, we can obtain mean dark times 
for the two structures (Fig. 3c). To translate these dark times to 
actual numbers of binding sites (or units), the influx rate per 
unit needs to be calibrated. This can be achieved with DNA ori-
gami structures in which binding sites can be visually identified 
(see Fig. 3d, 20-nm grid structures displaying 12 binding sites).  
In Picasso, users can now select these calibration structures dis-
playing a known number of units (or binding sites in this case) 
and calibrate the probe influx rate for subsequent quantification 
of target molecules of interest in the same data set (Fig. 3d).

The results for a typical qPAINT experiment post calibration 
are illustrated in Figure 3e–g. 20-nm DNA origami grid structures 
can be used to compare visually counted numbers of spots with 
qPAINT results, which are in good agreement (Fig. 3e). Note that 
not all DNA origami carry all binding sites, because typical staple 
incorporation efficiencies are <100%. qPAINT allows binding-site 
identification on 10-nm DNA origami grid structures, in which 
single sites are not clearly identifiable (Fig. 3f).

Finally, Picasso allows users to quickly obtain statistics from 
qPAINT data sets using its integrated ‘Pick’ and ‘Pick similar’ 
tools. Figure 3g illustrates the resulting number of binding-site 
distributions for 20-nm and 10-nm DNA origami grid struc-
tures in a single sample. The average number of binding sites is 
in excellent agreement with expectations. For 20-nm structures, 
the incorporation efficiency is ~78%, whereas it is slightly lower 
for 10-nm grid structures at 70%. This, however, is to be expected, 
as staple incorporation efficiency should be lower for larger num-
bers of modified staple strands in DNA origami structures.

Filtering localizations
After identification and fitting of single-molecule spots, filtering 
the list of localizations might improve super-resolution image 
quality3,5,6,69,70,77. Only after fitting a single-molecule spot, are 
properties such as spot width or an accurate estimation of the 
number of photons available. Hence, spot identification itself 
may not reliably rule out false-spot detections. A typical filter-
ing procedure is to remove localizations with spot widths that 
are too small or too large. Ideally the spot width matches that of 
the microscope’s PSF. Therefore, if the spot width is, for exam-
ple, too big, it is likely that the spot originates from two close-
by and overlapping events. The resulting fit coordinate will be 
between the two correct center positions and should therefore 
be disregarded. Another example of filtering is to remove local-
izations with a number of photons or a localization precision 
that is too low. After such filtering, the super-resolution image 
quality can improve, because only high-precision localizations 
remain. Picasso’s ‘Filter’ component provides a convenient, visu-
ally guided way to filter localizations based on histograms of their 
properties. An overview of its graphical user interface, as well 
as screenshots of filtering procedures in progress, is shown in 
Supplementary Figure 5. We recommend studying histograms 
of localization properties and joint histogram maps of two 
localization properties with the goal of identifying the true signal  

population and removing false populations or outliers. An 
overview of localization properties saved by Picasso is shown  
in the Supplementary Manual.

Particle averaging
When imaging a structure that appears multiple times in the 
field of view, aligning the individual images on top of each other 
and ‘summing them up’ can generate an ‘average’ image with 
improved image quality23,78. Such a procedure is analogous to the 
particle averaging often applied for structural biology in single-
particle electron microscopy79 and has already been successfully 
applied to localization-based super-resolution microscopy80,81. 
Although, strictly speaking, we do not create an ‘averaged’ but 
rather a ‘sum image’ from all localizations, we here will con-
tinue to use the notion of averaging as a historical term from 
the electron microscopy field. ‘Averaging’ primarily increases 
the image signal-to-noise ratio, which translates for localization 
microscopy to the proportion of true, high-precision localiza-
tions (signal) to false or imprecise localizations (noise). Hence, 
structure sampling, a major factor for image resolution16, can be 
improved by the averaging procedure. This is exemplified by the 
individual and average images of two RRO DNA origami struc-
tures in Figure 4c–f, showing the letters ‘MPI’ and ‘LMU’. The 
average image comprises a greatly enhanced signal-to-noise ratio 
as compared with images of individual structures. Moreover, 
even though some binding sites are missing in individual struc-
tures, averaging could reconstruct all binding sites and resolve 
their ~5-nm distances well.

Picasso offers a graphical user interface for averaging multiple 
images of the same structure with the ‘Average’ component. The 
underlying algorithm does not require a reference and is based 
on a traditional procedure borrowed from single-particle electron 
microscopy82. Briefly, the individual images are first translation-
ally aligned on top of each other by overlaying the center of mass 
of localizations. Then, several iterations of rotational and refined 
translational alignment are applied. In each iteration, an average 
image is constructed by pooling all localizations and rendering 
them on a super-resolution pixel grid. Then, localizations from 
each individual structure are rotated over 360 degrees in small 
steps and rendered as a super-resolution image for each rotational 
step. The angular step size is dynamically chosen so that the rota-
tion distance at twice the root mean square (RMS) deviation of all 
localizations from their center of mass matches the size of a super-
resolution pixel. Each rotated image is cross-correlated with the 
average image of the current iteration, and the maximum value and 
position of the cross-correlation are recorded. Finally, the localiza-
tions of an individual structure are rotated and translated according 
to the rotation and translation with the highest cross-correlation 
value. In the next iteration, a new improved average image can be 
generated from the now updated localization coordinates. After a 
certain number of iterations, the average image will converge—i.e., 
the pixel values will not change after an iteration. At this point, the 
algorithm can be stopped, and the new localization list is saved.

Averaging results, as shown in Figure 4e,f, rely on experimental 
conditions and post-processing steps that are specifically aimed 
at ultra-resolution. In particular, intricate drift correction as 
described above is a key contribution. Experimental conditions for 
ultra-resolution are described in Box 2; refer to Supplementary 
Figures 6–9 for structure design.
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MATERIALS
REAGENTS
! CAUTION All reagents can be potentially hazardous and should be handled 
only by trained personnel.
DNA labeling

PBS, pH 7.2 (Life Technologies, cat. no. 20012-019)
0.5 M EDTA, pH 8.0 (Ambion, cat. no. AM9261) ! CAUTION EDTA may 
cause eye and skin irritation; avoid breathing the dust or fumes.
DMF (Thermo Fisher Scientific, cat. no. 20673) ! CAUTION DMF is a toxic 
and flammable liquid; protect your eyes and skin, and avoid breathing the 
dust or fumes. It may also damage fertility and cause harm to the unborn 
child. Handle it under a chemical hood.
AffiniPure Donkey Anti-Rat IgG (Jackson ImmunoResearch,  
cat. no. 712-005-150)
AffiniPure Donkey Anti-Rabbit IgG (Jackson ImmunoResearch,  
cat. no. 711-005-152)
AffiniPure Goat Anti-Mouse IgG (Jackson ImmunoResearch,  
cat. no. 115-005-003)

Antibody labeling via maleimide-PEG2-succinimidyl ester
Maleimide-PEG2-succinimidyl ester (Sigma-Aldrich, cat. no. 746223)
No-Weigh Format DTT (Thermo Fisher Scientific, cat. no. 20291)  
! CAUTION This compound causes skin and respiratory pathway irritation, 
as well as serious eye irritation. It is toxic if swallowed and causes long-term 
damage to aquatic life.
Micro BCA Protein Assay Kit (Thermo Fisher Scientific, cat. no. 23235)
Thiol-DNA (P1 handle: Thiol-TTATACATCTA; MWG Eurofins)
Thiol-DNA (P3 handle: Thiol-TTTCTTCATTA; MWG Eurofins)

Antibody labeling via DBCO-sulfo-NHS ester
DBCO-sulfo-NHS ester (Jena Bioscience, cat. no. CLK-A124-10)
Azide-DNA (Biomers.net) P1 Handle: Azide-TTATACATCTA
Azide-DNA (Biomers.net) P3 Handle: Azide-TTTCTTCATTA

Immunofixation and cell imaging
8-well chambered cover glasses (Eppendorf, cat. no. 0030742036 or  
Thermo Fisher Scientific, cat. no. 155409)
BSA (Sigma-Aldrich, cat. no. A4503-10g)
Triton X-100 (Carl Roth, cat. no. 6683.1) ! CAUTION This compound is 
toxic if swallowed, and it can cause serious eye damage.
0.22-Mm sterile filters (Merck/EMD Millipore, cat. no. SLGS033SS)
Sodium chloride (Ambion, cat. no. AM9759) ! CAUTION Sodium  
chloride may cause skin and eye irritation, and it may be harmful if  
inhaled or swallowed.
Sodium borohydride (Carl Roth, cat. no. 4051.1) ! CAUTION This  
compound reacts in a volatile manner with H2O, is toxic if swallowed  
and can cause serious skin damage. Handle it under a chemical hood.
16% (vol/vol) Paraformaldehyde (Electron Microscopy Sciences,  
cat. no. 15710) ! CAUTION This compound is flammable, a carcinogen and 
toxic if swallowed; avoid breathing the fumes or dust. It can cause serious 
eye, skin or respiratory pathway irritation. Handle it under a chemical hood.
25% (vol/vol) Glutaraldehyde (SERVA, cat. no. 23115.01) ! CAUTION Glu-
taraldehyde is toxic if swallowed; it causes serious skin damage, and acute 
and chronic toxicity in aquatic life. Avoid breathing the fumes or dust. Wear 
protective equipment and handle the compound under a chemical hood.
A-Tubulin (YL1/2) antibody (Thermo Fisher Scientific, cat. no. MA1-80017)
A-Tubulin (DM1A) mouse antibody (Cell Signaling, cat. no. 3873S)
Tom20 (FL-145) rabbit antibody (Santa Cruz, cat. no. sc-11415)
DNA-labeled secondary antibodies and imager kit (Ultivue, cat. no. U10001)
Imager strand (P1-Cy3B: CTAGATGTAT-Cy3B; Eurofins Genomics)
Imager strand (P3-Atto655: GTAATGAAGA-Atto655; Eurofins Genomics)
Imager strand (P3-Cy3B: GTAATGAAGA-Cy3B; Eurofins Genomics)

Cell culture
PBS, pH 7.2 (Thermo Fisher Scientific, cat. no. 20012-019)
MEM (Thermo Fisher Scientific, cat. no. 31095-052)
Eagle’s Minimum Essential Medium (EMEM; ATCC, cat. no. 30-2003)
l-Glutamine (Thermo Fisher Scientific, cat. no. 25030-149)
Non-essential amino acids (Thermo Fisher Scientific, cat. no. 11140-035)
FBS (Thermo Fisher Scientific, cat. no. 10500-064)
Penicillin–streptomycin (P/S; Thermo Fisher Scientific, cat. no. 15140-122) 
! CAUTION It may damage fertility and cause harm to the unborn child. 
Avoid breathing fumes or dust.
Trypsin-EDTA (Thermo Fisher Scientific, cat. no. 25300-054)
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HELA cell line (Leibniz Institute DSMZ: Catalogue of Human and Animal 
Cell Lines (http://www.dsmz.de), cat. no. ACC-57) ! CAUTION The cell lines 
used in your research should be regularly checked to ensure that they are 
authentic and they are not infected with mycoplasma.
BS-C-1 cell line (ATCC, cat. no. CCL-26) ! CAUTION The cell lines used in 
your research should be regularly checked to ensure that they are authentic 
and they are not infected with mycoplasma.

DNA origami folding
Staple strands, modified and unmodified (Eurofins Genomics)
M13 bacteriophage ssDNA scaffold p7249 (New England BioLabs,  
cat. no. N4040S)
Tris, pH 8.0, 1 M (Ambion, cat. no. AM9856) ! CAUTION Tris can cause skin 
and serious eye irritation.
EDTA, pH 8.0, 0.5 M (Ambion, cat. no. AM9261) ! CAUTION EDTA may 
cause eye and skin irritation; avoid breathing the dust or fumes.
Water (Gibco, cat. no. 10977-035)
Magnesium, 1 M (Ambion, cat. no. AM9530G)
Agarose (Biomol, cat. no. 01280.100)
50× TAE Buffer (Fluka Analytical, cat. no. 67996-10L-F)
SYBR safe DNA gel stain (Invitrogen, cat. no. SS33102) ! CAUTION Protect 
your eyes and avoid breathing the dust, fumes or mist; it causes eye, skin 
and respiratory irritation.
DNA gel loading dye (Thermo Fisher Scientific, cat. no. R0611)
DNA ladder (Invitrogen, cat. no. 10787-018)

In vitro sample preparation
Protocatechuic acid (PCA; Sigma-Aldrich, cat. no. 37580-25G-F) ! CAUTION 
PCA causes skin, respiratory pathway and serious eye irritation. Avoid 
breathing the dust, fumes or mist.
Protocatechuate 3,4-dioxygenase (PCD; Sigma-Aldrich, cat. no. P8279-25UN)
Trolox (Sigma-Aldrich, cat. no. 238813-1G) ! CAUTION Trolox causes skin, 
respiratory pathway and serious eye irritation. Avoid breathing the dust, 
fumes or mist.
NaOH (VWR, cat. no. 31627.290) ! CAUTION NaOH causes serious skin 
and eye damage; avoid breathing the dust, fumes or mist. Wear protective 
equipment.
Methanol (Sigma-Aldrich, cat. no. 32213-2.5L) ! CAUTION Methanol is a 
flammable liquid, and it is toxic upon ingestion and skin contact; avoid 
breathing the dust, fumes or mist.
Potassium chloride (Carl Roth, cat. no. 6781.1)
Glycerol (Sigma-Aldrich, cat. no. 65516-500ml)
Isopropanol (Carl Roth, cat. no. 33539-2.5L-R) ! CAUTION Vapor and liquid 
phases are easily flammable, and the compound causes heavy eye irritation.
Epoxy Glue (Toolcraft, cat. no. TC-EPO5-24)
Albumin, biotin-labeled bovine (Sigma-Aldrich, cat. no. A8549-10MG)
Streptavidin (Thermo Fisher Scientific, cat. no. S888)
Tween 20 (Sigma-Aldrich, cat. no. p2287)

EQUIPMENT
Thermocycler (Mastercycler Nexus Gradient; Eppendorf, cat. no. 6331000017)
10-liter Tank (Carl Roth, cat. no. K653.1)
Sub-cell GT system gel chamber (Bio-Rad, cat. nos. 170 4401-4406 and  
170 4481-4486)
PowerPac basic power supply (Bio-Rad, cat. no. 1645050)
Microwave (Severin, cat. no. 7891)
Erlenmeyer flask, 250 ml (Carl Roth, cat. no. NY87.1)
Razor blade (Carl Roth, cat. no. CK07.1)
Visi-blue light transilluminator (UVP, cat. no. 95-0461-02)
Centrifuge 5430R (Eppendorf, cat. no. 5428000414)
NanoDrop 2000c (Thermo Fisher Scientific, cat. no. ND-2000c)
Shaker (GFL, cat. no. 3015)
Biological safety cabinet (HeraSafe; Thermo Electron Corporation,  
cat. no. 51022482)
Water purification system (PURELAB classic; ELGA LabWater,  
cat. no. CLXXUVFM2)
Incubator (Heracell 240; Thermo Fisher Scientific, cat. no. 51026333)
Pipetboy acu 2 (Integra, cat. no. 155017)
Eppendorf Research plus 0.1–2.5 Ml pipette (Eppendorf, cat. no. 3120000011)
Eppendorf Research plus 0.5–10 Ml pipette (Eppendorf, cat. no. 3120000020)
Eppendorf Research plus 2–20 Ml pipette (Eppendorf, cat. no. 3120000038)
Eppendorf Research plus 10–100 Ml pipette (Eppendorf, cat. no. 3120000046)
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Eppendorf Research plus 20–200 Ml pipette (Eppendorf, cat. no. 3120000054)
Eppendorf Research plus 100–1000 Ml pipette (Eppendorf, cat. no. 3120000062)
Multipette M4 pipette (Eppendorf, cat. no. 4982000314)
Eppendorf Research plus, 8-channel, 0.5–10 Ml pipette (Eppendorf,  
cat. no. 3122000019)
Gel imager (Typhoon FLA 9500; GE, cat. no. 28996943)
Side cutter (Hoffmann Group, cat. no. 725310)
Amicon spin filters, 3 kDa (Merck/EMD Millipore, cat. no. UFC500396)
Amicon spin filters, 100 kDa (Merck/EMD Millipore, cat. no. UFC510096)
Nap5 columns (GE Healthcare, cat. no. 17-0853-02)
Zeba desalting spin columns (Thermo Fisher Scientific, cat. no. 89882)
Amicon spin filters, 100 kDa (Merck/EMD Millipore, cat. no. UFC510096)
NORM-JECT 2-ml syringe (Henke Sass Wolf, cat. no. 4020-000V0)
NORM-JECT 10-ml syringe (Henke Sass Wolf, cat. no. 4100-000V0)
NORM-JECT 20-ml syringe (Henke Sass Wolf, cat. no. 4200-000V0)
FINE-JECT Needle, 1.2 × 40 mm (Henke Sass Wolf, cat. no. 4710012040)
FINE-JECT Needle, 1.1 × 40 mm (Henke Sass Wolf, cat. no. 4710011040)
Silicon tubing, inner diameter = 0.5 mm, outer diameter = 1 mm (GM GmbH, 
cat. no. 35605)
T75 Flasks (Falcon, cat. no. 353136)
10-ml Serological pipettes (Greiner Bio-One, cat. no. 607180)
5-ml Serological pipettes (Greiner Bio-One, cat. no. 606180)
2-ml Serological pipettes (Falcon, cat. no. 357507)
Glass Pasteur pipettes (Brand, cat. no. 747720)
90-nm Gold particles (prepared in house83)
DNA LoBind Tube, 0.5 ml (Eppendorf, cat. no. 0030 108.035)
PCR tubes (Trefflab, cat. no. 96.09852.9.01)
Freeze ’N Squeeze columns (Bio-Rad, cat. no. 732-6165)
Aluminum foil (VWR, cat. no. 391-1257)
1.5-ml Eppendorf tubes (Eppendorf, cat. no. 0030 120.086)
15-ml Falcon tubes (Falcon, cat. no. 352096)
50-ml Falcon tubes (Falcon, cat. no. 352070)
ibidi sticky-Slide VI 0.4 (ibidi, cat. no. 80608)
High-precision cover glasses 18 × 18 mm, no. 1.5H (Marienfeld,  
cat. no. 0107032)
High-precision cover glasses 24 × 60 mm, no. 1.5H (Marienfeld,  
cat. no. 0107242)
Microscopy slide (Thermo Fisher Scientific, cat. no. 10756991)
Double-sided adhesive tape (Scotch, cat. no. 665D)
Weighing paper (VWR International, cat. no. 12578-121)

TIRF super-resolution setup
Optical air table (Newport, cat. no. RS4000-46-12)
Inverted fluorescence microscope (Nikon, Ti Eclipse with Perfect Focus System)
XY Stage (Physik Instrumente, cat. no. M-545.2MN)
Lenses and mirrors (Thorlabs)
Filter cubes (Chroma Technology, cat. nos. TRF49904-NK, TRF49909-NK, 
TRF49914-NK)
Oil-immersion objective, 100× Apo SR TIRF objective, numerical aperture 
(NA) = 1.49, working distance (WD) = 0.12 (Nikon)
Immersion oil, refractive index (n) = 1.515 (23 °C), (Nikon, Type A)
sCMOS camera (Hamamatsu Orca Flash 4.0 V2)
EMCCD camera (Andor, iXon Ultra, model no. DU-897)
Excitation laser, 488 nm, 200 mW (Toptica iBeam smart, model no.  
488-S-HP)
Excitation laser, 561 nm, 200 mW (Coherent Sapphire, model no. 561-200 
CW CDRH)
Excitation laser, 640 nm, 150 mW (Toptica, iBeam smart, model no. 640-S)
Microscopy slide thermal power sensor (Thorlabs, model no. S170C)
Digital power meter (Thorlabs, model no. PM100D)
Acquisition computer: a computer used to acquire microscope data with 
the MManager software package58. See EQUIPMENT SETUP for hardware 
requirements.
Analysis computer: a computer with a Microsoft Windows 64-bit operating 
system. See EQUIPMENT SETUP for hardware requirements.
Analysis software: our analysis software package ‘Picasso’ can be downloaded  
from our website at http://www.jungmannlab.org.

REAGENT SETUP
Pre-extraction buffer The pre-extraction buffer consists of 0.4% (vol/vol) 
glutaraldehyde and 0.25% (vol/vol) Triton X-100 in 1× PBS at pH 7.2. It can be 
stored at −20 °C for 12 months.
Enhanced microtubule fixative The enhanced microtubule fixative consists 
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of 3% (vol/vol) glutaraldehyde in 1× PBS at pH 7.2, and it can be stored at 
−20 °C for 12 months.
Standard fixative The standard fixative consists of 3% (vol/vol)  
paraformaldehyde and 0.1% (vol/vol) glutaraldehyde in 1× PBS at pH 7.2.  
It can be stored at −20 °C for 12 months.
Blocking solution The blocking solution contains 3% (wt/vol) BSA and 
0.2% (vol/vol) Triton X-100 in 1× PBS at pH 7.2, and it must be filter- 
sterilized. It can be stored at 4 °C for up to 6 weeks.
Antibody dilution solution The antibody dilution solution contains 3% 
(wt/vol) BSA in 1× PBS at pH 7.2, and it must be filter-sterilized. It can be 
stored at 4 °C for up to 6 weeks.
DTT solution The DTT solution consists of 250 mM DTT, 1.5 mM EDTA 
and 0.5× PBS, pH 7.2. It must be freshly prepared for the reduction of the 
thiolated DNA.
BCA mix The BCA mix includes 500 Ml of reagent A, 500 Ml of reagent B and 
25 Ml of reagent C (from the Micro BCA Protein Assay Kit), and it must be 
freshly prepared.
HeLa cell medium The HeLa cell medium consists of MEM, 10% (vol/vol) 
FCS, 1% (vol/vol) P/S, 2 mM l-glutamine and 1× non-essential amino acids. 
HeLa cell medium can be stored at 4 °C for up to 4 months.
BSC1 cell medium The BSC1 cell medium consists of EMEM, 10% (vol/vol) 
FCS and 1% (vol/vol) P/S.
Cross-linker aliquots Cross-linkers should be divided into aliquots at a 
concentration of 10 mg/ml in DMF, and they can be stored at −80 °C for up 
to 12 months.
Buffer A Buffer A consists of 10 mM Tris-HCl and 100 mM NaCl at pH 8.0, 
and it can be stored at room temperature (RT; 21 °C) for 6 months.
Buffer A+ Buffer A+ consists of 10 mM Tris-HCl, 100 mM NaCl and 0.05% 
(vol/vol) Tween 20 at pH 8.0, and it can be stored at RT for 6 months.
Buffer B Buffer B consists of 5 mM Tris-HCl, 10 mM MgCl2 and 1 mM 
EDTA at pH 8.0, and it can be stored at RT for 6 months.
Buffer B+ Buffer B+ consists of 5 mM Tris-HCl, 10 mM MgCl2, 1 mM EDTA 
and 0.05 % (vol/vol) Tween 20 at pH 8.0, and it can be stored at RT for 6 months.
Buffer C Buffer C consists of 1× PBS at pH 7.2 supplemented with addi-
tional 500 mM NaCl, and it can be stored at RT for up to 6 months.
Exchange washing buffer Exchange washing buffer consists of Buffer B+ for 
in vitro samples and of 1× PBS, pH 7.2, for in situ samples; it can be stored at 
RT for 6 months.
100× Trolox solution 100× Trolox solution consists of 100 mg of Trolox, 430 Ml 
of methanol and 345 Ml of NaOH (1 M) in 3.2 ml of H2O. It should be divided 
into 20-Ml portions in PCR tubes and can be stored at −20 °C for up to 6 months.
40× PCA solution 40× PCA solution consists of 154 mg of PCA in 10 ml of 
water, adjusted to pH 9.0 with NaOH. The solution should be divided into 
20-Ml aliquots in PCR tubes and can be stored at −20 °C for up to 6 months.
100× PCD solution 100× PCD solution consists of 9.3 mg of PCD and  
13.3 ml of buffer (50% glycerol stock in 50 mM KCl, 1 mM EDTA and  
100 mM Tris–HCl, pH 8.0). It should be divided into 20-Ml aliquots in PCR 
tubes and can be stored at −20 °C for up to 6 months.
Oxygen-scavenging system PPT solution PPT solution consists of a 1:1:1 
ratio of 1× PCA/1× PCD/1× Trolox. Mix with imaging buffer at least 1 h 
before imaging.
Imager solution For in vitro samples, the imager solution consists of 1× 
Buffer B+, optional scavenger system PPT solution (1× Buffer B+, 1× PCA, 
1× PCD, 1× Trolox) and a fluorophore-labeled DNA strand. For in situ  
samples, the imager solution consists of 1× Buffer C, optional scavenger 
system PPT solution (1× Buffer C, 1× PCA, 1× PCD, 1× Trolox)  and a 
fluorophore-labeled DNA strand. The concentration range for the fluorophore-
labeled DNA strand is highly target dependent, but it ranges between 100 pM 
and 10 nM. The solution should always be freshly prepared.
10× Folding buffer 10× folding buffer consists of 125 mM MgCl2, 100 mM 
Tris and 10 mM EDTA at pH 8.0, and it can be stored at RT for up to 6 months.
Gel buffer Gel buffer consists of 1× TAE buffer, and it can be stored at RT 
for 1 year.
Gel running buffer Gel running buffer consists of 1× TAE buffer and  
12.5 mM MgCl2, and it can be stored at RT for up to 1 year.
BSA–biotin stock BSA–biotin stock contains 10 mg/ml BSA–biotin in Buffer 
A, and it should be divided into 20-Ml aliquots. It can be stored at −20 °C for 
up to 6 months.
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BSA–biotin solution BSA–biotin solution contains 1 mg/ml BSA–biotin  
in Buffer A+ and should be freshly prepared. It can be stored for up to  
3 d at 4 °C.
Streptavidin stock Streptavidin stock contains 10 mg/ml streptavidin in 
Buffer A and should be divided into 10-Ml aliquots. It can be stored at −20 °C 
for up to 6 months.
Streptavidin solution Streptavidin solution contains 0.5 mg/ml streptavidin in 
Buffer A+ and should be freshly prepared. It can be stored for up to 3 d at 4 °C.
Staple strands Staple strands can be ordered in different purity grades. 
High-purity salt-free purification is sufficient for standard staples; however, 
we recommended ordering modified staples, such as those with fluorophores 
or biotins, HPLC or PAGE purified. Staple strands for nanostructures  
should be ordered in 96-well plates (0.2 ml) to facilitate the handling and 
creation of master mixes with the help of multipipettes. To keep the manual 
handling to a minimum, the staples should be ordered prediluted at a 
 concentration of 100 MM in H2O. The plates can be stored at −20 °C for  
at least 12 months.
EQUIPMENT SETUP
Acquisition computer The following computer system was used for all data 
acquisition in this protocol: Dell Precision T7910, Dual Intel Xeon Processor 
E5-2620 v3 at 2.4 GHz (12 cores), 32 GB RAM, four 2 TB HDD configured 
in a Hardware RAID 0, Windows 7 Professional 64-bit operating system.  
M CRITICAL A RAID 0 setup is optimized for fast input/output. For long-term 
data storage, users are advised to use data storage facilities with daily backup 
available to research groups at universities or research institutes.

Acquisition software As image acquisition software, install MManager, an 
open-source software58 that can be downloaded from https://micro-manager.org.  
Follow the installation instructions and set up the software to control the 
microscope equipment.
Analysis computer We do recommend performing all postacquisition steps 
with Picasso on a separate analysis workstation. The hardware requirements 
depend on the specific file size of the data set to be analyzed. Generally, the most 
important factors are the number of available CPU cores and RAM. The follow-
ing system was used for all analyses in this protocol: Dell Precision T7910, Dual 
Intel Xeon CPU E5-2680 v3 at 2.5 GHz (24 cores), 256 GB RAM and four 2 TB 
HDD configured in a Hardware RAID 0, Windows Server 2012 R2 64-bit  
operating system. M CRITICAL A RAID 0 setup is optimized for fast input/output. 
For long-term data storage, users are advised to use data storage facilities with 
daily backup available to research groups at universities or research institutes.
Analysis software Download the ‘Picasso’ installer available at our website 
(http://www.jungmannlab.org). Follow the installation instructions. Multiple 
Picasso components will appear as shortcuts in a start menu subfolder 
named ‘Picasso’.
Power density calibration Determine the laser power at the sample by 
placing the microscopy slide thermal power sensor with immersion oil on 
the sample holder. The power density is then calculated as an average density 
over the illuminated area. See Supplementary Table 1 for an exemplary 
calibration on our microscope.
Fluid exchange chamber To prepare a fluid exchange chamber for in situ 
imaging, see Box 1.

PROCEDURE
Design of DNA nanostructures L TIMING 1 h
1| Start ‘Picasso: Design’, which displays a canvas of a hexagonal lattice, representing the staple strand positions  
(Fig. 6) in a 2D RRO33.

2| Design a pattern of DNA-PAINT binding sites by clicking on the canvas hexagons. Clicking on a hexagon will change  
its color and marks the respective staple to be extended with an external sequence. Each color corresponds to a specific 
extension that may be defined later. The default state without an external extension is indicated by a gray hexagon.  
The center-to-center distance between two hexagons is ~5 nm on the DNA origami. To change the ‘current color’, click on  
a colored hexagon in the color palette to the right. Clicking on a hexagon with a currently selected color will reset the  
‘current color’ to the unmarked state (gray). Click ‘Clear’ to reset all hexagons in the lattice. The eight white double-hexagons 
within the structure are placeholders for biotinylated staples for surface attachment and are not intended for modification. 
In total, the structure consists of 176 staples available for modification.

3| Click ‘Save’ to save the design. Progress can be saved at any time and loaded at a later point by selecting ‘Load’.  
A screenshot of the design can be saved by clicking on ‘Screenshot’.

4| Click on ‘Extensions’ to specify the extensions corresponding to each color. A table with all the colors present in the  
design will open. A selection of commonly used DNA-PAINT handles can be obtained via the dropdown menu in the ‘Preselection’  
column. This list can be extended by modifying ‘paint_sequences.csv’ in the subfolder ‘picasso’ of the Picasso install directory. 
See Supplementary Table 2 for a table of the default sequences. Alternatively, define a custom ‘Shortname’ and ‘Extension’ 
by entering them in the table. After defining all colors used in the canvas, select ‘OK’ to confirm the extensions. The display 
will update with the ‘Shortname’. The sequence specified will be added to the 3`-end of the staple and will point out of the 
structure (away from the cover glass). For a full list of all unmodified core staples, refer to Supplementary Table 3.

5| Once the design step is complete, the sequences for the corresponding structure need to be obtained. Click on ‘Get 
plates’ to generate a staple list for ordering. As an RRO origami structure consists of 184 staples, the staples in the list are 
arranged in two 96-well plates, so that each well corresponds to a position on the hexagonal lattice. It is possible to export 
only the sequences of a particular structure (in total, two plates) or to get a list of plates for which all possible positions 
are extended with all extensions used in the design. This is particularly useful in the case in which different origami designs 
with different extensions and patterns will be tested, so all staples are ready to be mixed and matched for subsequent  
design iterations. The software will export the list in .csv format, so that the file can be used for direct ordering at your 
favorite oligo synthesis company. Choose high-purity salt-free purification and order oligonucleotides in solution with a 
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concentration of 100 MM in H2O (see also Reagent Setup). Store the .csv file in a folder so that the program can later create 
pipetting schemes based on your plate stock. In addition, order the biotinylated staples (for cover glass attachment of the 
DNA origami) that can be found in Supplementary Table 4.
J�PAUSE POINT Typically, synthesis of unmodified oligonucleotides at a commercial vendor will take between 2 and  
10 working days.

Folding of DNA structures L TIMING 6–7 h
6| Once all sequences are obtained, staples with the same extension are pooled together from plates and place in micro-
centrifuge tubes as stock mixes. Picasso will generate a visual pipetting aid to help identify which staples need to be pooled 
together in a separate microcentrifuge tube. To so initiate this, select ‘Pipetting scheme’ and select the folder with all 
previously generated plates. ‘Picasso: Design’ will search in all .csv files in that folder for sequences that are needed for the 
design. Note that only .csv files that contain staple lists (that were generated with ‘Get plates’ in ‘Picasso: Design‘) should 
be present in that folder. A list will be generated with all necessary sequences and the visual pipetting aid in .pdf format for 
the origami stock mixes. The dimensions of the printed pipetting scheme match those of typical 96-well plates, so that wells 
that need to be pipetted can be easily identified.
M CRITICAL STEP If the software does not find all sequences that are needed in the plate list, it will display an error 
message but still compile the pipetting aid and the staple list. Missing staples are indicated by ‘NOT FOUND’ in the list.

7| Print out the pipetting aid and place a transparent 96-well plate above it. Pool staples according to their color and 
the pipetting aid for stock mixes in microcentrifuge tubes. The volume of each staple that is needed when pooling can be 
estimated considering the final amount of structures. When folding, i.e., 40 Ml of DNA origami with a 10-nM final scaffold 
concentration (enough for ~80 DNA-PAINT experiments), the amount of staples needed is ~0.04 Ml for each core staple and 
~0.4 Ml for each extended staple. As pipetting precision decreases with small volumes, pipette at least 1 Ml per staple when 
pooling for mixes. Avoid contamination of the plates, do not talk while pipetting and cover the plates whenever possible. 
Seal the plates immediately after use. Store mixes at −20 °C in tubes for up to 12 months.

8| Select ‘Folding Scheme’ to generate a table with a folding protocol. Adjust the initial concentrations in the table  
according to the ordered stocks and click ‘Recalculate’, if applicable. The software will automatically calculate the  
concentration of a strand in a staple mix depending on the number of staples in the mix. Adjust ‘Excess’ or ‘Total Volume’  
to your needs and mix all items on the folding scheme list in the calculated quantities. Refer to Supplementary Table 5  
for n exemplar folding table.

9| Use a thermocycler and fold the origami mix using the following thermal gradient:

Cycle number Parameters

1 80 °C

2–57 60 °C–4 °C, 3 min 12 s per °C

58 Hold at 4 °C

J�PAUSE POINT The structures can be stored at 4 °C for up to 1 week or at −20 °C in DNA LoBind Tubes for long-term storage 
(at least several months).

Purification of DNA nanostructures L TIMING ~3.5 h
10| Purify the DNA nanostructures using your favorite method. Several methods for purification of DNA nanostructures,  
such as Gel42, rate-zonal centrifugation43 and PEG44, are described in the literature. For DNA-PAINT, it is possible in most 
cases to use the structures without purification, as excess staple strands will be washed out of the flow chamber.
M CRITICAL STEP When folding DNA origami for the first time, it is recommended to run an agarose gel to confirm the  
folding (Fig. 6). Typically, well-folded monomeric structures will appear as a single sharp gel band (upper highlighted area  
in the gel in Fig. 6) together with a faster migrating band consisting of excess staple strands (lower highlighted area in the 
gel in Fig. 6).
J�PAUSE POINT The structures can be stored at 4 °C for up to 1 week or at −20 °C in DNA LoBind Tubes for at least 1 year.

11| Prepare a solution of 1.8 g of agarose in 120 ml of gel buffer in an Erlenmeyer flask (1.5% (wt/vol)).
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12| Use a microwave to heat up and completely solubilize the agarose solution by stirring the flask in between the heating phases.
! CAUTION Use heat-resistant gloves when handling the hot flask to avoid burns.

13| If no agarose particle traces are visible anymore, let the solution cool for 1 min, and add 1.5 ml of 1M MgCl2 and 14 Ml 
of Sybr Safe.
! CAUTION Avoid inhaling solutions with Sybr Safe.

14| Pour the solution into a gel chamber, add an appropriate comb and let it solidify for 45 min.

15| Load the gel with the DNA origami structures. Prepare two lanes for a DNA ladder and scaffold (same concentration  
as origami) as reference. Mix the origami solution with loading dye (20 Ml of folded DNA Origami + 5 Ml of loading dye) and 
run the gel in running buffer at 90 V for 90 min at 4 °C or on ice.

16| Acquire an image using a gel imager for documentation.

17| Cut out the origami band with a razor blade on a blue-light transilluminator table. The origami band should appear as  
a distinct band with a slight shift as compared with the scaffold. Excess staples will have created a broader band that 
traveled further. Crush the gel piece with a pestle, transfer it to a Freeze ’N Squeeze column, and spin it for 6 min at 1,000g 
at 4 °C. Keep the flow-through and discard the filter.
?�TROUBLESHOOTING
J�PAUSE POINT The origami can be stored at 4 °C for 1 week or at −20 °C in LoBind tubes for long-term storage.

Preparation of DNA origami for DNA-PAINT imaging L TIMING ~45 min
18| There are two options for preparing microscopy slides. See option A for the preparation in a custom-built flow chamber 
that will be sealed after immobilization of structures and addition of imager solution. For Exchange-PAINT experiments that 
require fluid exchange, see option B for preparation in an open chamber. The process of making custom-built chambers is 
also depicted in Supplementary Figure 10 .
(A) Immobilization in a custom-built chamber
 (i)  Clean the microscopy slide and the cover glass with isopropanol and dry it with lab wipes.
 (ii)  Prepare a flow chamber by taping two stripes of double-sided adhesive tape ~8 mm apart on the microscopy slide and 

form a flow chamber by placing a cover glass on top. The resulting channel will have a volume of ~20–30 Ml. Use a 
pipette tip and press the cover glass firmly against the sticky tape. The sticky tape will appear darker when the cover 
glass is in good contact. 
M CRITICAL STEP Do not use excessive force, as the glass may break.

 (iii)  Remove excess adhesive tape by pulling the tape over the edges of the cover glass.
 (iv)  Fill the chamber with 20 Ml of BSA–Biotin solution (1 mg/ml) and incubate it for 2 min.
 (v)  Wash the channel with 40 Ml of Buffer A+ by holding the tip of a folded lab wipe on one end of the channel and  

simultaneously pipetting in washing buffer on the other side. The capillary forces of the tissue will suck the liquid 
out of the chamber, whereas the pipetting will introduce additional volume. Control the flow by variation of pipetting 
speed and tissue pressure. 
M CRITICAL STEP Avoid bubbles by keeping an even flow. Do not let the chamber dry out. Practice with an empty 
slide and water if necessary.

 (vi)  Add 20 Ml of streptavidin solution (0.5 mg/ml) to the channel and incubate it for 2 min.
 (vii)  Wash the channel with 40 Ml of Buffer A+.
 (viii)  Wash the channel with 40 Ml of Buffer B+.
 (ix)  Add 20 Ml of (5 Ml of gel-purified DNA origami and 15 Ml of Buffer B+) origami solution and incubate for 2 min. 

? TROUBLESHOOTING
 (x)  Wash the channel with 40 Ml of Buffer B+.
 (xi)  Add 20 Ml of imager solution to the channel. 

M CRITICAL STEP Imager concentration has a critical role in proper acquisition of DNA-PAINT data. For in vitro  
samples, consider an ~5 nM imager concentration for a DNA nanostructure with 12 binding sites as a start value.

 (xii)  (Optional) For spectral multiplexing, use 2 different DNA sequences with spectrally distinct fluorophores, such as  
Cy3B and Atto655.

 (xiii)  Use epoxy glue to seal the chamber. Pour the glue on a piece of weighing paper, mix with a pipette tip and distribute 
the glue evenly on the edges of the cover glass. Once the chamber is sealed, place the pipette tip standing up in the 
remaining epoxy to later evaluate the glue dryness.
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 (xiv)  Wait for ~15 min for the epoxy to dry. The drying process can be evaluated by checking the pipette tip in the epoxy. 
Once the epoxy is completely dry, the pipette tip should stick. The sample is now ready for imaging. 
M CRITICAL STEP Wait until the epoxy is completely dry to avoid glue contamination of the microscope objective.

(B) Immobilization in a 6-channel ibidi sticky-Slide
 (i)  Clean the cover glass (24 × 60 mm) with isopropanol and dry it with lab wipe.
 (ii)  Attach the cover glass upside down to the sticky-Slide and press it with the help of a pipette tip against the cover glass.
 (iii)  Add 80 Ml of BSA–biotin solution to the channel. Tilt the slide slightly to ensure that the chamber is completely  

filled and incubate it for 5 min.
 (iv)  Wash the channel with 180 Ml of Buffer A+ by pipetting the solution into one opening and pipetting out 180 Ml  

from the opposing opening.
 (v)  Incubate 40 Ml of streptavidin solution twice for 5 min.
 (vi) Wash the channel with 180 Ml of Buffer A+.
 (vii) Wash the channel with 180 Ml of Buffer B+.
 (viii)  Icubate the DNA origami solution (20 Ml of gel-purified DNA origami + 60 Ml of Buffer B+) for 20 min. 

? TROUBLESHOOTING
 (ix)  Wash the channel two times with 100 Ml of Buffer B+.
 (x)  Add Imager strand solution to the sample for imaging. 

M CRITICAL STEP Imager concentration has a critical role in proper acquisition of DNA-PAINT data.  
For in vitro samples, consider ~5 nM for DNA nanostructures with 12 binding sites as a start value. (Optional)  
For spectral multiplexing, use two different DNA sequences with spectrally distinct fluorophores, such as  
Cy3B and Atto655.

 (xi)  Put the lid back on the chamber. The sample is now ready for imaging.

Sample preparation for in situ samples
19| Generate DNA-conjugated secondary antibodies. Here, two methods are presented: option A describes the use of a  
maleimide-PEG2-succinimidyl ester cross-linker, which links free amino groups on the protein to reduced thiolated DNA22, 
and option B describes the use of a DBCO-sulfo-NHS ester, which binds to amino groups on the protein and via copper-free  
click chemistry to an azide-modified DNA strand55. The copper-free click chemistry allows for conjugation of multiple 
antibody species in parallel, whereas the attachment via Maleimide chemistry is more cost-effective, considering the DNA 
components. The reduction of the thiol group and the subsequent purification of the DNA from DTT using the Nap-5 column 
is time-consuming and time-critical. Long waiting times will lead to disulfide bridging of the DNA strands. The copper-free 
click chemistry in comparison does not have such a time-consuming and time-critical step in regard to the reagent stability, 
and therefore allows for parallel labeling of the antibodies. Alternatively, DNA-labeled antibodies can also be obtained from 
Ultivue (http://www.ultivue.com).
(A) DNA labeling of antibodies via maleimide-PEG2-succinimidyl ester for cellular labeling L TIMING 1 d 1 h
 (i)  To reduce the thiolated DNA for the Maleimide reaction, mix 30 Ml of 1-mM thiolated DNA with 70 Ml of freshly  

prepared DTT solution and incubate the mixture on a shaker for 2 h at RT covered with aluminum foil.
 (ii)  Concentrate the antibody using Amicon spin filters (100 kDa). Wash the filters with 1× PBS for 10 min at 14,000g  

at 4 °C. Discard the flow-through, add 300 Ml of antibody solution and spin at 14,000g for 5 min at 4 °C. Discard the  
flow-through and invert the spin filter in an empty tube. Spin for 6 min at 1,000g at 4 °C. Adjust the volume to 100 Ml  
with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer. Keep the antibody on ice. The final 
concentration should be >1.5 mg/ml.

 (iii)  Prepare the cross-linker solution in 1× PBS and add it to the antibody in a 10:1 molar ratio. Incubate the solution  
for 90 min at 4 °C on a shaker covered in aluminum foil. Start the reaction 1 h after the DNA reduction step  
was started. 
M CRITICAL STEP The desired amount of cross-linker must be no more than 5 Ml in volume in order to avoid adding 
too much of DMF or diluting the antibody further.

 (iv)  20 min before the DNA reduction step is completed, start to equilibrate a Nap-5 column with ddH2O filled to the  
top three times. Add DNA–DTT solution to the column and immediately add 400 Ml of ddH2O. After 400 Ml has passed 
through, add 1 ml of ddH2O and start collecting fractions immediately. Collect three drops in the first four tubes,  
two drops in the following four and one drop in the last eight tubes. Starting from the last collected tube, add 25 Ml 
of BCA mix to the tubes. If DTT is still present, the solution turns purple. Discard those tubes. If no color change  
is visible anymore, discard the next tube as well and measure the concentration of the remaining fractions via the  
NanoDrop spectrophotometer. Pool the fractions with the highest concentrations. The highest fractions will have a  
DNA concentration between 200 and 800 ng/Ml. 
M CRITICAL STEP If DTT is still present in the DNA solution, it will interfere with the Maleimide reaction.
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 (v)  Concentrate the reduced DNA using Amicon spin filters (3 kDa). Wash the filter with 1× PBS for 30 min at 14,000g  
at 4 °C. Discard the flow-through and add the pooled fractions of reduced DNA to the filter. Centrifuge for 30 min  
at 14,000g at 4 °C and discard the flow-through. Invert the spin filter in an empty new tube and spin for 6 min at 
1,000g at 4 °C. Measure the concentration with the NanoDrop spectrophotometer; the DNA should have a concentra-
tion >700 ng/Ml.

 (vi)  After the antibody–cross-linker reaction has completed, use a Zeba desalting column to remove the linker. Remove the 
storage solution by centrifugation at 1,500g for 1 min at 4 °C. Mark the side where the resin slid up, and perform the 
subsequent centrifugation steps in the same orientation. Wash the Zeba column with 300 Ml of PBS and centrifuge it 
at 1,500g for 1 min at 4 °C. Dry the bottom of the column and use a fresh 1.5-ml tube. Add the antibody–cross-linker 
solution to the Zeba column, and spin at 1,500g for 2 min at 4 °C. Discard the Zeba column, retain the flow-through 
and measure the concentration with the NanoDrop spectrophotometer. The antibody concentration should be > 1.5 
mg/ml.

 (vii)  Incubate a 10:1 molar ratio of thiolated DNA to antibody overnight on a shaker covered in aluminum foil in  
a cold room.

 (viii)  Remove excess DNA by Amicon spin filtration (100 kDa). For this, wash the filters with 1× PBS for 10 min at 14,000g 
at 4 °C. Discard the flow-through, add antibody–DNA solution, add 300 Ml PBS and spin at 14,000g for 5 min at 4 °C. 
Discard the flow-through and invert the spin filter into an empty tube. Spin the solution for 6 min at 1,000g at 4 °C. 
Adjust the volume to 100 Ml with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer.  
The peak signal should be shifted toward 260 nm from 280 nm, and the concentration should be >5 mg/ml because  
of the stronger absorbance of DNA. Keep the antibody on ice and store it at 4 °C for a maximum of 6 months. 
? TROUBLESHOOTING

(B) Labeling via DBCO-sulfo-NHS ester L TIMING 4 h
 (i)  Concentrate the antibody using Amicon spin filters (100 kDa). For this, wash the filters with 1× PBS for 10 min at 

14,000g at 4 °C. Discard the flow-through, add 300 Ml of antibody solution and spin at 14,000g for 5 min at 4 °C.  
Discard the flow-through and invert the spin filter in an empty tube. Spin for 6 min at 1,000g at 4 °C. Adjust the  
volume to 100 Ml with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer. Keep the  
antibody on ice. The final concentration should be >1.5 mg/ml.

 (ii)  Prepare 5 Ml of cross-linker solution in 1× PBS so that the final solution after addition of 100 Ml of the antibody  
contains a 10:1 molar ratio of cross-linker to antibody. Incubate the solution for 90 min at 4 °C on a shaker covered  
in aluminum foil.

 (iii)  After the antibody–cross-linker reaction is completed, use a Zeba desalting column to remove the linker. Remove the 
storage solution by centrifugation at 1,500g for 1 min at 4 °C. Mark the side where the resin slid up, and perform the 
subsequent centrifugation steps in the same orientation. Wash the Zeba column with 300 Ml of 1× PBS at 1,500g for  
1 min at 4 °C. Dry the bottom of the column and use a fresh 1.5-ml tube. Add antibody–cross-linker solution to the 
Zeba column and spin it at 1,500g for 2 min at 4 °C. Discard the Zeba column, retain the flow-through and measure 
the concentration on the NanoDrop spectrophotometer. The antibody concentration should be >1.5 mg/ml.

 (iv)  Create a 15:1 molar ratio of DNA to antibody and incubate the solution for 1 h at RT on a shaker covered in aluminum 
foil.

 (v)  Remove the excess DNA by Amicon spin filtration (100 kDa). For this, wash the filters with 1× PBS for 10 min at 
14,000g at 4 °C. Discard the flow-through, add antibody-DNA solution, add 300 Ml of 1× PBS and spin at 14,000g for 
5 min at 4 °C. Discard the flow-through and invert the spin filter in an empty tube. Spin for 6 min at 1,000g at 4 °C. 
Adjust the volume to 100 Ml with 1× PBS, and measure the concentration with the NanoDrop spectrophotometer.  
The peak signal should be shifted toward 260 nm from 280 nm, and the concentration should be >5 mg/ml because  
of the stronger absorbance of DNA. 
? TROUBLESHOOTING
J�PAUSE POINT Keep the antibody on ice and store it at 4 °C for a maximum of 6 months.

Immunofixation of cells L TIMING 2.5 d
M CRITICAL In Steps 20–33, we describe procedures for immunofixation optimized for DNA-PAINT super-resolution micros-
copy. Fixation strategies depend on the target of interest, as well as on the antibody-recognition motifs57.
20| Seed 30,000 cells in 8-well chambered cover glasses, and let them grow overnight at 37 °C and 5% CO2 in an incubator.

21| After 24 h, the cells are ready to be fixed.

22| In this step, fixative is added to the cells; this can be performed in two ways: option A, an optimized protocol for maximum 
preservation of cellular cytoskeletal structures (recommended for imaging microtubules) and option B, a standard protocol.
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(A) Optimized microtubule fixation
 (i)  Pre-extract the cells with prewarmed (37 °C for 10 min) pre-extraction buffer for 90 s.
 (ii)  Remove the extraction buffer and fix the cells for 15 min in prewarmed enhanced microtubule fixative.
(B) Standard fixation
 (i)  Fix the cells in standard fixative for 15 min.

23| Aspirate the fixative solution and reduce the sample with 1 mg/ml sodium borohydride for 7 min.
M CRITICAL STEP Sodium borohydride must be prepared just before application to the sample and is very volatile.

24| Wash the chamber four times (1 × 20 s, 3 × 5 min) with 1× PBS at pH 7.2.

25| Block and permeabilize the cell sample in blocking buffer for 90 min at RT.

26| Dilute the primary antibody according to supplier instructions in antibody dilution buffer, and incubate the sample  
at 4 °C overnight on a rocking platform.

27| Wash the sample three times for 5 min in 1× PBS.

28| Dilute DNA-labeled secondary antibody (5–50 Mg/ml) in antibody dilution buffer, and apply it to the sample  
for 60 min. (Optional) For multiplexing experiments, use different secondary antibodies with orthogonal DNA handles;  
see Supplementary Table 2 for recommended sequences.

29| Wash the sample three times for 5 min in 1× PBS.

30| Dilute 90-nm gold particles at a 1:10 ratio in PBS as fiducial markers and incubate for 5 min on the cell sample.

31| Wash the sample three times for 5 min in 1× PBS.

32| Add a target-specific imager solution to the sample.
M CRITICAL STEP Imager concentration has a critical role in proper acquisition of DNA-PAINT data. The concentration should 
be adjusted for the target (hence docking strand) density. For microtubules, we recommend starting with a 500 pM imager 
strand concentration and adjusting as necessary.

33| (Optional) For multiplexed Exchange-PAINT experiments, place the exchange lid with the connected tubing on the  
chambered cover glass.

Data acquisition L TIMING 10 min to 10 hours
M CRITICAL The following section describes the procedure for performing DNA-PAINT experiments using imager sequences 
labeled with Cy3B fluorophores. As the SNR for DNA-PAINT is rather high, both CCD or sCMOS cameras are suitable for  
imaging. The procedure is written for use of an iXon Ultra DU-897 EMCCD camera, although electron-multiplying is not  
necessary. Considerations in regard to acquisition of images with ultra-high resolution are described in Box 2. For test  
purposes, raw DNA-PAINT data can also be simulated in silico with ‘Picasso: Simulate’ (see Box 3 for procedure details).
34| Place the sample on the microscope stage, and move the objective up until the immersion oil touches the sample.

35| (Optional) For multiplexing with Exchange-PAINT, attach tubing with syringes to the exchange chamber. Consider using 
an ~15-ml syringe volume of exchange buffer per exchange round for in situ exchange experiments, and ~1 ml of exchange 
buffer per exchange round for in vitro experiments. For in situ experiments, additionally attach tubing to the chamber inlet. 
Put the connected syringes into plastic trays to avoid accidental fluid spills. The syringes should be at the same level as the 
chamber to avoid liquid exchange, as they are communicating vessels.
M CRITICAL STEP Handle liquids extremely carefully if they are close to the microscope. Improper handling and leakage can 
lead to damage of delicate microscope components.

36| Start MManager, select the configuration file for the camera and select ‘Ok’. The main window of MManager will open.

37| Set ‘Exposure [ms]’ with regard to the following considerations: exposure times for DNA-PAINT experiments are dependent  
on the imager length and concentration, the imaging buffer and the docking strand density of the target structure. Typical 
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exposure times for 9-bp DNA duplexes are hundreds of milliseconds, and those for 8-bp DNA duplexes are tens of  
milliseconds, as they have a shorter ON-time. For the samples used in Figure 1, an exposure time of 300 ms for in vitro 
(Buffer B+) and 200 ms for in situ (Buffer C) samples was used. ‘Picasso: Simulate’ can be used to determine ideal exposure 
times for given sample parameters. As a general rule of thumb, camera integration times should be matched to mean  
ON-times of DNA-PAINT imager/docking duplexes for best performance; these can be experimentally determined using  
Picasso (see Step 69B). Refer to Supplementary Table 6 for the acquisition settings used for the images in this protocol.

38| Open ‘Tools’ > ‘Device Property Browser’.

39| Set the camera parameters: set ‘Output_Amplifier’ to ‘Conventional’, set ‘Region of Interest’ to ‘Full Image’, set ‘Frame 
Transfer’ to ‘On’, set ‘PixelType’ to ‘16bit’, set ‘ReadMode’ to ‘Image’ and set ‘Camera shutters’ to ‘Open’.

40| Click on ‘Live’ in the main window, and the ‘Snap/Live’ window will appear. Select ‘Autostretch’ in the contrast settings. 
The ‘Snap/Live’ window should show background noise.

41| Set the laser to a low power density of 0.25 kW/cm2 at the sample plane (refer to the calibration as performed in the 
Equipment Setup), and open the laser shutter.
?�TROUBLESHOOTING

42| Focus the image.
M CRITICAL STEP A focused image should show blinking diffraction-limited spots, each representing the binding and  
unbinding of an imager strand to its target. Adjust the contrast by dragging the black and white triangles in the ‘Contrast’ 
window if needed. For prefocusing, preferably use a focus-lock system such as the Nikon Perfect Focus System or, in case of  
in situ samples, prefocus with the bright-field image.
?�TROUBLESHOOTING

43| Increase the laser power to a power density of ~ 2.5 kW/cm2 at the sample plane.

44| Adjust the laser incident angle. When starting in an epifluorescence configuration, increase the angle until  
total internal reflection occurs. Continue until no more light is reflected and the signal decreases. Then, go back by  
decreasing the angle and optimize the SNR. When imaging structures beyond the TIRF illumination range, decrease the  
incident angle—potentially moving to oblique (HILO) illumination31—just until the structure of interest is properly  
illuminated. Keeping the incident angle as high as possible limits out-of-focus excitation above the target structure,  
which is particularly critical for DNA-PAINT, as free imager strands in solution increase background and therefore affect  
imaging quality adversely.

45| In the device manager, adjust the ‘Readout Mode’ to the frequency with the lowest readout noise possible for the  
currently selected integration time. This is usually the lowest frequency at which the readout time does not exceed  
the exposure time. The readout time will be displayed in ‘ReadoutTime’ and should be shorter than the ‘Exposure’ time.  
Please double-check that the field ‘ActualInterval-ms’, which denotes the true duration between two frames, does not  
exceed the exposure time.

46| Click on ‘Multi-D-Acq.’ in the main window to open the ‘Multi-Dimensional Acquisition’ window. Activate ‘Time points’ 
and set the ‘Number’ to the number of frames to be acquired—e.g., 7,500 for in vitro samples and 15,000 for in situ samples. 
These exemplar numbers for total acquisition frames are suggestions for initial experiments and may have to be adjusted  
according to the specific experiment. For a detailed discussion of optimal acquisition time, refer to Nieuwenhuizen et al.16 
and respective sections in the introduction of this protocol.

47| Set the interval to ‘0’ and ‘ms’. Set ‘Acquisition Order’ to ‘Time’. Activate ‘Save images’ and set a destination filename and folder.

48| Select ‘Acquire!’ to start the acquisition. A live image will pop up. The progress of the acquisition can be followed  
on the upper left corner.
?�TROUBLESHOOTING

49| (Optional) Multiplexed image acquisition. There are two methods for performing multiplexed target acquisition with  
DNA-PAINT. Spectral multiplexing (option A) uses spectrally distinct fluorophores, whereas Exchange-PAINT multiplexing 
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(option B) uses (typically) the same fluorophore attached to orthogonal DNA species that are sequentially supplied to the 
sample. With Exchange-PAINT, only one species is present in the imager buffer in each multiplexing round, and it will be 
washed out afterward. Option A provides a relatively fast workflow for imaging multiple targets by imaging in multiple emis-
sion channels. Option B has almost no limitation in multiplexing but requires a fluid exchange system. In addition, option B 
provides the capability of using the most favorable fluorophore for all targets. Refer to Supplementary Table 7 for a list of 
dye recommendations for DNA-PAINT.
(A) Spectral multiplexing
 (i)  Perform Steps 34–48 for the first fluorophore. 

M CRITICAL STEP To reduce photodamage, start acquisition with the dye that has the longest excitation wavelength, 
and then proceed to those with shorter wavelengths.

 (ii)  After acquisition of the first imager species, change the laser line and the filter set on the microscope to match the 
next wavelength.

 (iii)  Click on ‘Live’ in the main window of MManager and adjust the TIRF angle if necessary.
 (iv)  Adjust the file name in the ‘Multi-Dimensional Acquisition’ window.
 (v)  Select ‘Acquire!’ to start a new acquisition.
 (iv)  (Optional) Repeat the procedure for any other spectrally distinct imager species in solution.
(B) Exchange multiplexing
 (i)  Perform Steps 34–48 to acquire a movie for the first imager species.
 (ii)  Click on ‘Live’ in the main window and adjust the contrast so that individual blinking events are visible. Deselect  

‘Autostretch’. It is important to keep the contrast to determine when all imagers are washed out.
 (iii)  Apply several washing steps while observing the ‘Live/Snap’ window until no more blinking events are visible.  

One washing step consists of filling the chamber by adding exchange buffer (for in vitro imaging use ~180 Ml,  
and for in situ imaging use 1 ml) to the inlet and then removing the same volume from the outlet. For in situ  
imaging a total of ~15 ml and for in vitro imaging a total of ~1 ml of exchange buffer will be needed per  
exchange round. 
M CRITICAL STEP Do not remove all liquid from the chamber; it should never dry out. Perform liquid exchange slowly 
to avoid introducing air bubbles into the chamber or disturbing the sample. 
? TROUBLESHOOTING

 (iv)  After washing, introduce a new imager solution into the chamber. For in vitro samples, simply pipette the required 
amount into the chamber and remove the same amount from the outlet. For in situ samples, empty the inlet tubing  
by disconnecting the empty syringe and pumping air through it. Connect a new 2-ml syringe with a new imager  
solution and fill the chamber.

 (v)  While introducing the new imager, the ‘Live/Snap’ window should show reappearing blinking events.
 (vi)  Adjust the filename in the ‘Multi-Dimensional Acquisition’ window.
 (vii)  Select ‘Acquire!’ to start a new acquisition.
 (viii)  (Optional) Repeat the procedure for subsequent imaging rounds.

Image reconstruction L TIMING 5–30 min
50| Identification and fitting of single-molecule spots. In ‘Picasso: Localize’, open a movie file by dragging the file into  
the window or by selecting ‘File’ > ‘Open’. If the movie is split into multiple MManager .tif files, open only the first file.  
Picasso will automatically detect the remaining files according to their file names.

51| Adjust the image contrast (select ‘View’ > ‘Contrast’) so that the single-molecule spots are clearly visible.

52| To adjust spot identification and fit parameters, open the ‘Parameters’ dialog (select ‘Analyze’ > ‘Parameters’).

53| In the ‘Identification’ group, set the ‘Box side length’ to the rounded integer value of 6 × S + 1, where S is the standard 
deviation of the PSF. In an optimized microscope setup, S�is one pixel, and the respective ‘Box side length’ should be set to 7.  
The value of ‘Min. net gradient’ specifies a minimum threshold above which spots should be considered for fitting. The net 
gradient value of a spot is roughly proportional to its intensity, independent of its local background. By checking ‘Preview’, 
the spots identified with the current settings will be marked in the displayed frame. Adjust ‘Min. net gradient’ to a value at 
which only spots are detected (no background).

54| In the ‘Photon conversion’ group, adjust ‘EM Gain’, ‘Baseline’, ‘Sensitivity’ and ‘Quantum Efficiency’ according to your 
camera specifications and the experimental conditions. Set ‘EM Gain’ to 1 for conventional output amplification. ‘Baseline’ is 
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the average dark camera count. ‘Sensitivity’ is the conversion factor (electrons per analog-to-digital (A/D) count) and  
‘Quantum Efficiency’ should be set according to the average emission wavelength.
M CRITICAL STEP These parameters are critical to converting camera counts to photons correctly. The quality of the upcom-
ing maximum likelihood fit strongly depends on a Poisson photon noise model, and thus on the absolute photon count.

For simulated data, generated with ‘Picasso: Simulate’ as described in Box 3 and Figure 7, set the parameters as follows:  
‘EM Gain’ = 1, ‘Baseline’ = 0, ‘Sensitivity’ = 1, ‘Quantum Efficiency’ = 1.

55| From the menu bar, select ‘Analyze’ > ‘Localize (Identify & Fit)’ to start spot identification and fitting in all movie 
frames. The status of this computation is displayed in the window’s status bar. After completion, the fit results will be saved 
in a new file in the same folder as the movie, in which the filename is the base name of the movie file with the extension 
‘_locs.hdf5’. Furthermore, information about the movie and analysis procedure will be saved in an accompanying file with  
the extension ‘_locs.yaml’; this file can be inspected using a text editor.

56| Rendering of the super-resolution image: In ‘Picasso: Render’, open a movie file by dragging a localization file (ending 
with ‘.hdf5’) into the window or by selecting ‘File’ > ‘Open’. The super-resolution image will be rendered automatically.  
A region of choice can be zoomed into by a rectangular selection using the left mouse button. The ‘View’ menu contains 
more options for zooming and panning.

57| (Optional) Adjust rendering options by selecting ‘View’ > ‘Display Settings’. The field ‘Oversampling’ defines the number 
of super-resolution pixels per camera pixel. The contrast settings ‘Min. Density’ and ‘Max. Density’ define at which number of 
localizations per super-resolution pixel the minimum and maximum color of the colormap should be applied.

58| (Optional) For multiplexed image acquisition, open HDF5 localization files from other channels subsequently.  
Alternatively, drag and drop all HDF5 files to be displayed simultaneously.

Image post-processing: drift correction L TIMING seconds to minutes
59| Picasso offers two procedures to correct for drift: an RCC algorithm66 (option A), and use of specific structures  
in the image as drift markers23 (option B). Although option A does not require any additional sample preparation,  
option B depends on the presence of either fiducial markers or inherently clustered structures in the image. On the other 
hand, option B often supports more precise drift estimation and thus allows for higher image resolution. To achieve the  
highest possible resolution (ultra-resolution), we recommend consecutive applications of option A and multiple rounds of  
option B. The drift markers for option B can be features of the image itself (e.g., protein complexes or DNA origami) or  
intentionally included markers (e.g., DNA origami or gold nanoparticles). When using DNA origami as drift markers, the  
correction is typically applied in two rounds: first, with whole DNA origami structures as markers, and, second, using  
single DNA-PAINT binding sites as markers. In both cases, the precision of drift correction strongly depends on the  
number of selected drift markers.
(A) Redundant cross-correlation drift correction
 (i)  In ‘Picasso: Render’, select ‘Postprocess’ > ‘Undrift by RCC’.
 (ii)  A dialog will appear asking for the segmentation parameter. Although the default value, 1,000 frames, is a sensible 

choice for most movies, it might be necessary to adjust the segmentation parameter of the algorithm, depending on 
the total number of frames in the movie and the number of localizations per frame66. A smaller segment size results in 
better temporal drift resolution but requires a movie with more localizations per frame.

 (iii)  After the algorithm finishes, the estimated drift will be displayed in a pop-up window and the display will show the 
drift-corrected image.

(B) Marker-based drift correction
 (i)  In ‘Picasso: Render’, pick drift markers as described in Steps 61–64. Use the ‘Pick similar’ option (Step 65) to  

automatically detect a large number of drift markers similar to a few manually selected ones. 
M CRITICAL STEP If the structures used as drift markers have an intrinsic size larger than the precision of individual 
localizations (e.g., DNA origami, large protein complexes), it is critical to select a large number of structures.  
Otherwise, the statistic for calculating the drift in each frame (the mean displacement of localization to the  
structure’s center of mass) is not valid.

 (ii)  Select ‘Postprocess; > ‘Undrift from picked’ to compute and apply the drift correction.

60| (Optional) Save the drift-corrected localizations by selecting ‘File’ > ‘Save localizations’.
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Picking of regions of interest L TIMING 5–30 min
61| Manual selection. Open ‘Picasso: Render’ and load the localization HDF5 file to be processed.

62| Switch the active tool by selecting ‘Tools’ > ‘Pick’. The mouse cursor will now change to a circle.

63| Set the size of the pick circle by adjusting the ‘Diameter’ field in the tool settings dialog (‘Tools’ > ‘Tools Settings’).

64| Pick regions of interest using the circular mouse cursor by clicking the left mouse button. All localizations within the 
circle will be selected for further processing.

65| (Optional) Automated region of interest selection. Select ‘Tools’ > ‘Pick similar’ to automatically detect and pick structures 
that have similar numbers of localizations and RMS deviation (RMSD) from their center of mass than already-picked struc-
tures. The upper and lower thresholds for these similarity measures are the respective standard deviations of already-picked 
regions, scaled by a tunable factor. This factor can be adjusted using the field ‘Tools’ > ‘Tools Settings’ > ‘Pick similar ± 
range’. To display the mean and standard deviation of localization number and RMSD for currently picked regions, select ‘View’ 
> ‘Show info’ and click ‘Calculate info below’.

66| (Optional) Exporting of pick information. All localizations in picked regions can be saved by selecting ‘File’ > ‘Save picked 
localizations’. The resulting HDF5 file will contain a new integer column ‘group’ indicating to which pick each localization is 
assigned.

67| (Optional) Statistics about each pick region can be saved by selecting ‘File’ > ‘Save pick properties’. The resulting  
HDF5 file is not a localization file. Instead, it holds a data set called ‘groups’ in which the rows show statistical values  
for each pick region.

68| (Optional) The picked positions and diameter itself can be saved by selecting ‘File’ > ‘Save pick regions’. Such saved pick 
information can also be loaded into ‘Picasso: Render’ by selecting ‘File’ > ‘Load pick regions’.

Additional post-processing steps
69|Depending on the experimental goals, a variety of post-processing steps may be used. To filter localizations based on 
their properties, for example to remove localizations below a certain photon threshold, use option A. For investigating the 
statistics of DNA-PAINT binding kinetics and how to count DNA-PAINT binding sites with qPAINT22, use options B and C,  
respectively. Option D describes the procedure to generate an average image of multiple structures. Finally, option E  
describes the procedure to align images from multiplexed experiments.
(A) Filtering of localizations L TIMING 5–10 min
 (i)  Open a localization HDF5 file in ‘Picasso: Filter’ by dragging it into the main window or by selecting ‘File’ > ‘Open’.  

The displayed table shows the properties of each localization in rows. Each column represents one property (e.g.,  
coordinates, number of photons); see the Supplementary Manual for details.

 (ii)  To display a histogram from values of one property, select the respective column in the header and select ‘Plot’ > 
‘Histogram’ (Ctrl + h). 2D histograms can be displayed by selecting two columns (press Ctrl to select multiple columns) 
and then selecting ‘Plot’ > ‘2D Histogram’ (Ctrl + d).

 (iii)  Left-click and hold the mouse button down to drag a selection area in a 1D or 2D histogram. The selected area will be 
shaded in green, as shown in Supplementary Figure 5b,c. Each localization event with histogram properties outside 
the selected area is immediately removed from the localization list.

 (iv)  Save the filtered localization table by selecting ‘File’ > ‘Save’.
(B) Analysis of blinking kinetics L TIMING 5–60 min
 (i)  In ‘Picasso: Render’, pick regions of interest as described in Steps 61–65.
 (ii)  Select ‘View’ > ‘Show info’.
 (iii)  In the opened dialog, click ‘Calculate info below’. The mean and standard deviation per pick of several values will be 

calculated and displayed. The ‘Length’ row describes the blinking ‘ON’ time (Tb) and the ‘Dark time’ row describes the 
blinking ‘OFF’ time (Td).

 (iv)  Click ‘Histograms’ to open a new window showing histograms for the picked region’s kinetics.
 (v)  (Optional) Individual values for each picked region can be obtained by exporting the data. Select ‘File’ > ‘Save  

pick properties’. The saved HDF5 file will contain a data set called ‘groups’, in which each row corresponds to one  
pick region.



 
  8 Appendix 
 

   111  

©
20

17
 M

ac
m

ill
an

 P
ub

lis
he

rs
 L

im
ite

d,
 p

ar
t o

f S
pr

in
ge

r 
N

at
ur

e.
 A

ll 
ri

gh
ts

 r
es

er
ve

d.

© 2017 Macmillan Publishers Limited, part of Springer Nature. All rights reserved.

PROTOCOL

1224 | VOL.12 NO.6 | 2017 | NATURE PROTOCOLS

(C) Counting of molecule numbers with qPAINT L TIMING 5–60 min
 (i)  In ‘Picasso: Render’, pick calibration regions as described in Steps 61–64. Typically, calibration regions are regions with 

a known number of binding sites. Do not use the option ‘Pick similar’ (Step 65), as this may bias the calibration.
 (ii)  Select ‘View’ > ‘Show info’ and click ‘Calculate info below’.
 (iii)  Set ‘# Units per pick’ to the number of units to which the counting should be calibrated. Typically, one unit is equal  

to one DNA-PAINT binding site, but other user-defined units might be suitable too. This could, i.e., be useful in the 
case in which calibration is performed on single antibodies, which can carry multiple docking strands for protein  
quantification using qPAINT. The final counting result will be reported in number of units. For example, if the  
calibration regions contain 12 binding sites and the counting result should be reported in ‘number of binding sites’, 
then ‘# Units per pick’ should be to be set to 12.

 (iv)  Click ‘Calibrate influx’ for an estimation of the influx rate from the calibration regions kinetics. The influx rate will  
be displayed in the respective field. As an alternative to the experimental calibration, the influx rate (X) can be  
theoretically calculated via X = kon × c if the ON rate (kon) and imager concentration (c) are known. In that case,  
enter the influx rate manually into the respective field.

 (v)  Select ‘Tools’ > ‘Clear picks’ to remove the calibration pick selections.
 (vi)  Pick structures of interest (Steps 61–65) from which the unknown number of units should be determined.
 (vii)  In the ‘Info’ dialog, click ‘Calculate info below’. The mean number of units per picked region will be displayed in the ‘# 

Units’ row, as calculated from the currently displayed influx rate.
 (viii)  (Optional) The individual number of units for each picked region can be obtained by exporting pick property data. 

Select ‘File’ > ‘Save pick properties’. The saved HDF5 file will contain a data set called ‘groups’, which holds statistics 
about each pick region as rows, including a column for the unit number (‘n_units’).

(D) Particle averaging L TIMING 10–30 min
 (i)  In ‘Picasso: Render’, pick structures to be averaged as in Steps 61–65.
 (ii)  Save the picked localizations by selecting ‘File’ > ‘Save picked localizations’.
 (iii)  Load the resulting file with picked localizations into ‘Picasso: Average’ by selecting ‘File’ > ‘Open’ or dragging and  

dropping it into the window.
 (iv)  ‘Picasso: Average’ will immediately perform a translational alignment of the picked structures and display an average 

image. Rotational and refined translational alignment will follow in the next steps.
 (v)  Select ‘Process’ > ‘Parameters’ and adjust the ‘Oversampling’ parameter. We recommend choosing the highest number 

at which the average image still appears smooth. High oversampling values result in substantial computational time. 
Hence, it might be useful to first use low oversampling to generate a less-refined average image and perform a second 
averaging step with higher oversampling for optimized resolution.

 (vi)  Adjust the number of average iterations in the ‘Iterations’ field. In most cases, a value of 10 is more than sufficient.  
If you are unsure about the computational time of the process, choose one iteration as a starting point. More  
iterations can be added later by repeating the processing steps. After a certain number of iterations, the average  
image will converge, meaning that it will not change with more iterations.

 (vii)  Select ‘Process’ > ‘Average’ to perform particle averaging with the current oversampling for the set number of  
iterations. This step can be repeated with different settings. The program will use the current average image  
as a starting point.

 (viii)  Once the average image has converged, save the transformed localizations by selecting ‘File’ > ‘Save’. The resulting 
HDF5 localization file contains the aligned localizations in the center of the movie dimensions. It can be loaded like 
any other HDF5 localization file into ‘Picasso: Render’.

(E) Aligning of channels from multiplexed experiments L TIMING 5–10 min
 (i)  To align images from multiplexed data acquisition, the images need to share some features as reference points.  

Such reference features can be the cell shape for in situ images (typically, background is higher inside the cell)  
or overlapping clusters (for example, on the same DNA origami). If alignment results are ambiguous or not satisfying 
because of the lack of inherent reference features, drift or alignment markers should be included and imaged in  
all channels.

 (ii)  In ‘Picasso: Render’ display all HDF5 localization files to be aligned.
 (iii)  (Optional) If the reference features are too weak to create proper alignment, they can be selected manually,  

as described in Steps 61–65. Ensure that within a picked region the reference structures of all channels are included.
 (iv)  Select ‘Postprocess’ > ‘Align’.
 (v)  (Optional) Export the aligned localizations by selection ‘File’ > ‘Save localizations’.

?�TROUBLESHOOTING
Troubleshooting advice can be found in Table 1.
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TABLE 1 | Troubleshooting table.

Steps Problem Possible reason Solution

Sample preparation

Step 17 There is no band  
visible on the gel

Depending on the used final scaffold 
concentration, the bands can  
appear very faint on the blue-light 
transilluminator table and seem  
difficult to excise

To improve brightness of the sample band, use a more  
sensitive DNA stain such as SYBR Gold, or increase scaffold 
concentration

The structure does 
not fold

Thermal gradients have an important 
role during the assembly process of 
DNA nanostructures. However, the 
rectangle 2D origami design shows 
extremely robust folding behavior and 
forms with high yield within ~75 min

Different temperature gradients between 15 and 72 h  
can be used to improve folding performance. Prepare fresh 
staple stocks for the origami structure with particular focus 
on correct magnesium concentration and staple excess

Step 
18A(ix), 
18B(viii)

There are not 
enough DNA origami 
structures on the 
surface

Depending on the purification 
method, different origami concentra-
tions are obtained—e.g., the size of 
the excised gel band will influence 
the concentration after the Freeze  
‘N Squeeze column purification step

Compensate for this by incubating with a higher origami  
concentration and/or increased incubation time. 
Concentration adjustment can be estimated by counting the 
number of targets on the surface and interpolating to the 
desired density. A good sample density can be achieved by 
incubation with 125–500 pM of origami. Typical concentra-
tions after gel purification are between 1 and 2 nM, and 
those after PEG purification are approximately 8–10 nM. 
Alternatively, the DNA origami solution can be incubated 
longer (up to 45 min)

Step 
19A(viii), 
19B(v)

After purification, 
there still seem to 
be free DNA strands 
in solution

The DNA strands might not be 
completely filtered out by the spin 
columns, which are optimized for 
protein concentration

For further purification of DNA-labeled antibodies, use  
size-exclusion column chromatography to remove the free 
DNA (with a Superdex 75/200)

Not enough DNA 
strands are attached 
to the antibodies

Not enough cross-linker or DNA  
was used

For more DNA handles attached to the antibodies, use larger 
excess of cross-linker (40×) and DNA (30×). However, please note 
that an increased DNA-to-antibody ratio might lead to reduced 
binding affinity of antibodies or increased off-target binding

Data acquisition

Step 41 Poor data quality Laser power not adjusted to sample To achieve the best possible data quality, it is important to 
extract the largest possible number of photons from a single 
binding (blinking) event of the fluorophores. A good indicator of 
a suitable laser power setting can be estimated by measuring 
the bright time versus laser power. Increase laser power until 
the bright time decreases. What happens is that imager strands 
start to bleach while they are still bound to docking strands. 
This should be the upper limit of your laser power setting. 
When a laser power meter is available, a good reference value 
for power densities in DNA-PAINT experiments using, i.e., Cy3B 
as dye and 561-nm laser excitation is 1–6 kW/cm2

Step 42 The focal plane is 
difficult to find

Focusing was not performed in  
bright-field mode, or the immersion 
oil was not in contact with the  
cover glass.

For cellular samples, focusing should be performed in  
bright-field. For DNA nanostructures, the immersion oil on 
the objective should touch the cover glass; use oblique 
illumination and then slowly raise the objective until the 
surface of the cover glass is reached. Monitor the approach 
in ‘Live’ mode. Reaching the cover glass will be visible via 
an increase in fluorescence and appearance of diffraction-
limited blinking spots. Add fluorescent beads that have 
increased brightness to find the focal plane, if necessary

(continued)
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L TIMING
Steps 1–5, design of DNA nanostructures: 1 h
Steps 6–9, folding of DNA nanostructures: 6–7 h
Steps 10–17, purification of DNA nanostructures: ~3.5 h
Step 18, preparation of DNA origami for DNA-PAINT imaging: 45 min
Step 19A, preparation of DNA-labeled antibodies using maleimide-PEG2-succinimidyl ester: 1 d and 1 h
Step 19B, labeling via DBCO-sulfo-NHS ester: 4 h
Steps 20–33, immunofixation of cells: 2.5 d
Steps 34–49, data acquisition: 10 min to 10 h; for each multiplexing round ~20 min–2 h
Steps 50–58, image reconstruction: 5–30 min
Steps 59 and 60, drift correction: seconds to minutes
Steps 61–68, picking of regions of interest: 5–30 min
Step 69A, filtering of localizations: 5–10 min
Step 69B, analysis of blinking kinetics with qPAINT: 5–60 min
Step 69C, counting of molecule numbers with qPAINT: 5–60 min
Step 69D, particle averaging: 10–30 min
Step 69E, aligning of channels for multiplexed experiments: 5–10 min
Box 1, construction of a fluid exchange chamber for in situ imaging: 30 min
Box 2, ultra-resolution imaging: ~7 h
Box 3, in silico simulation of DNA-PAINT: 10–60 min

ANTICIPATED RESULTS
Examples of single-color DNA-PAINT super-resolution images can be found in Figure 1. Panel b presents an image of a DNA 
origami with a three-by-four grid of binding sites, as designed with ‘Picasso: Design’. Measured distances between individual 
binding sites are in good agreement with the designed origami. Panels d and e show a DNA-PAINT image of microtubules  
in situ, immunolabeled with primary and secondary antibodies. Hollow microtubule structures, observed here as two parallel 
lines because of the 2D projection, are characteristic for a high labeling density and localization precision.

Expected results for multiplexed DNA-PAINT experiments by Exchange-PAINT are shown in Figure 2. Panels d, e and f show 
in vitro DNA origami imaged with multiple ‘Exchange’ rounds before (d) and after (e,f) alignment. The image after alignment 
shows that the DNA nanostructure is in good agreement with the designed pattern of binding sites. In situ Exchange-PAINT 
images of microtubules and Tom20, which localizes to mitochondria, are shown in panel g. The inset in panel g shows gold 
particles imaged in both rounds and demonstrates the alignment steps for the two images. The gold particles colocalize after 
the alignment procedure, and the different channels do not comprise any cross talk between them.

Results for counting DNA-PAINT binding sites via quantitative PAINT (qPAINT) can be found in Figure 3. Visual inspection 
of individual origami structures shows they match the predicted binding sites from the qPAINT analysis.

Expected results for ultra-resolution imaging, including the intermediate steps for drift correction and a final image from averaging 
multiple structures, can be seen in Figure 4. Key features of a successful ultra-resolution experiment are very high NeNA localization 
precision (~1 to 1.5 nm) and the ability to visually separate individual binding sites spaced 5 nm apart on the origami structures.

TABLE 1 | Troubleshooting table (continued).

Steps Problem Possible reason Solution

Step 48 The sample drifts in 
xy and/or focus is 
lost during image 
acquisition

Setup not equilibrated Before image acquisition, allow the sample to ‘equilibrate’ 
on the microscope for 5–15 min. Adjust room temperature to 
maintain a constant ambient temperature to avoid additional 
thermal drift of microscope and stage components

Step 
49B(iii)

The imager strands 
are difficult to  
wash away

Cellular samples are highly cross-
linked through the fixation process. 
Imager strands might be trapped in 
the cross-linked network

We recommend incubating with the washing solution for  
3 min so that the imager strands can diffuse into the  
large reservoir. In addition, washing with gentle flow  
can be effective

Box 3, 
step 6

The simulation of a 
DNA-PAINT data set 
takes a long time

The time required to simulate data 
sets is dependent on the number of 
structures, imager concentration, 
frames and image size

As computation time increases with image size, it is  
recommended to avoid exceeding an image size of  
64 × 64 pixels. A simulation with the standard settings 
should take <1 min on the described analysis computer
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Note: Any Supplementary Information and Source Data files are available in the 
online version of the paper.
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Supplementary Figure 1 

Overview of “Picasso: Design” 

(a) The main window showing the origami canvas with the hexagonal tiles. (b) Extensions dialog to set extensions corresponding to 
each selected color. (c) Plate export dialog to specify the export format of the plates. (d) Pipetting dialog to select a folder with *.csv 
files to generate a list of sequences that need to be pipetted and to create a visual pipetting aid. (e) Folding table to calculate volumes 
that are needed for pipetting. 
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Supplementary Figure 2 

Overview of “Picasso: Simulate” 

The main window has two preview windows, the left one to display the positions of structures in the full frame, the right one to display 
an individual structure. Structural parameters such as number and structure definition can be set in the group box “Structure”. Al l 
PAINT-related parameters, i.e. mean dark and bright times are set with the “PAINT parameters” group box. The group box “Imager 
parameters” is used to define properties of the simulated imaging probe. 
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Supplementary Figure 3 

Overview of “Picasso: Localize” 

(a) The main window after the analysis of a movie file. Yellow boxes indicate the identification of a spot, green crosses show the fitted 
subpixel coordinate. (b) The contrast setting dialog. (c) The parameters setting dialog. 
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Supplementary Figure 4 

Overview of “Picasso: Render” 

(a) The main window with two picked regions of interest (yellow circles). (b) The display settings dialog for the render scene in (a). (c) 
The info dialog for the picked regions in (a). (d) The tools settings dialog. 
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Supplementary Figure 5 

Overview of “Picasso: Filter” 

(a) The main window showing properties (columns) of localizations (rows). (b) Filtering in a histogram of a property column. (c) Filtering 
in a two-dimensional histogram of two property columns. The green areas in (b) and (c) have been selected with a pressed left mouse 
button. After releasing the mouse button, any localization with property values outside the green range will be removed. 
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Supplementary Figure 6 

20 nm DNA origami grid 
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Supplementary Figure 7 

10 nm DNA origami grid 
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Supplementary Figure 8 

LMU Logo 
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Supplementary Figure 9 

MPI Logo 
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Supplementary Figure 10 

Custom-made flow chamber 

(a) Two stripes of double-sided sticky tape are placed on a 76x26 mm microscopy slide with a distance of ~ 8mm. A coverglass is 
placed on top of the sticky tape stripes. After pressing the coverglass thoroughly against the sticky tape, overlapping tape can be 
removed. (b) To immobilize DNA nanostructures, fluids are pipetted from one side while simultaneously being sucked out with a lab 
wiper from the other side. (c) The coverglass is sealed with epoxy glue and can be used with the coverglass facing towards the 
objective in a microscope stage once the glue is hardened. 
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Supplementary Manual 

This manual describes details about the Picasso program. 

File Format and Name Conventions 

Movie Files 

Picasso accepts two type of raw movie files: TIFF (preferably from μManager, https://www.micro-manager.org) 

and raw binary data (file extension “.raw”). 

When loading raw binary files, the user will be prompted for movie metadata such as the number of frames, 

number of pixels, etc. Alternatively, this metadata can be supplied by an accompanying metadata file with the 

same filename as the raw binary file, but with the extension “.yaml”. See “YAML Metadata Files” for more 

details. 

HDF5 Files 

HDF5 is a generic and efficient binary file format for storing data (https://support.hdfgroup.org/HDF5/). In 

Picasso, HDF5 files are used for storing tabular data of localization properties with the file extension “.hdf5”. 

Furthermore, Picasso saves statistical properties of groups of localizations in an HDF5 file. 

Generally, several datasets can be stored within an HDF5 file. These datasets are accessible by specifying a 

path within the HDF5 file, similar to a path of an operating system. When saving localizations, Picasso stores 

tabular data under the path “/locs”. When saving statistical properties of groups of localizations, Picasso saves 

the table under the path “/groups”. 

Importing HDF5 files in MATLAB and Origin 

In MATLAB, execute the command “locs = h5read(filename, dataset)”. Replace dataset with ‘/locs’ for 

localization files and with ‘/groups’ for pick property files. 

In Origin, select “File > Import > HDF5” or drag and drop the file into the main window. 

Localization HDF5 Files 

Localization HDF5 files must always be accompanied by a YAML metadata file with the same filename, but 

with the extension ‘.yaml’. See “YAML Metadata File” for more details. The localization table is stored as a 

dataset of the HDF5 file in the path “/locs”. This table can be visualized by opening the HDF5 file with “Picasso: 

Filter”. The localization table can have an unlimited number of columns. Table 1 describes the meaning of 

Picasso’s main column names. 
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Column Name Description C Data Type 

frame The frame in which the localization occurred, starting with zero for the 
first frame. 

unsigned long 

x The subpixel x coordinate in camera pixels float 

y The subpixel y coordinate in camera pixels float 

photons The total number of detected photons from this event, not including 
background or camera offset 

float 

sx The Point Spread Function width in camera pixels float 

sy The Point Spread Function height in camera pixels float 

bg The number of background photons per pixel, not including the camera 
offset 

float 

lpx The localization precision in x direction, in camera pixels, as estimated 
by the Cramer-Rao Lower Bound of the Maximum Likelihood fit. 

float 

lpy The localization precision in y direction, in camera pixels, as estimated 
by the Cramer-Rao Lower Bound of the Maximum Likelihood fit. 

float 

net_gradient The net gradient of this spot which is defined by the sum of gradient 
vector magnitudes within the fix box, projected to the spot center. 

float 

likelihood The log-likelihood of the fit float 

iterations The number of iterations of the fit procedure long 

group (Optional) An identifier to assign multiple localizations to groups, for 
example by picking regions of interest 

long 

len (Optional) The length of the event, if localizations from consecutive 
frames have been linked 

long 

n (Optional) The number of localizations in this event, if localizations from 
consecutive frames have been linked, potentially diverging from the “len” 
column due to a transient dark time tolerance 

long 

photon_rate (Optional) The mean number of photons per frame, if localizations from 
consecutive frames have been linked. The total number of photons is set 
in the “photons” column. 

float 

Table 1 | Name, description and data type for the main columns used in Picasso. 

HDF5 Pick Property Files 

When selecting “File > Save pick properties” in “Picasso: Render”, the properties of picked regions are stored 

in an HDF5 file. Within the HDF5 file, the data table is stored in the path “/groups”. 

Each row in the “groups” table corresponds to one picked region. For each localization property (see Table 1), 

two columns are generated in the “groups” table: the mean and standard deviation of the respective column 

Nature Protocols: doi:10.1038/nprot.2017.024



 
Super-Resolution Microscopy with DNA-PAINT 
 

 128 

 3 

over the localizations in a pick region. For example, if the localization table contains a column “len”, the 

“groups” table will contain a column “len_mean” and “len_std”. 

Furthermore, the following columns are included: “group” (the group identifier), “n_events” (the number of 

localizations in the region) and “n_units” (the number of units from a qPAINT measurement). 

YAML Metadata Files 

YAML files are document-oriented text files that can be opened and changed with any text editor 

(http://www.yaml.org). In Picasso, YAML files are used to store metadata of movie or localization files. 

Each localization HDF5 file must always be accompanied with a YAML file of the same filename, except for the 

extension, which is “.yaml”. Deleting this YAML metadata file will result in failure of the Picasso software! 

Raw binary files may be accompanied by a YAML metadata file to store data about the movie dimensions, etc. 

While the metadata file in this case is not required, it reduces the effort of typing in this metadata each time the 

movie is loaded with “Picasso: Localize”. To generate such a YAML metadata file, load the raw movie into 

“Picasso: Localize”, then enter all required information in the appearing dialog. Check the checkbox “Save info 

to yaml file” and click ok. The movie will be loaded and the metadata saved in a YAML file. This file will be 

detected the next time this raw movie is loaded and the metadata does not need to be entered again. 

 

Supplementary Table 1: Laser power conversion table 

Set Power (mW) Power at sample (mW) Power density at sample (kW/cm2) 

20 13.7 0.82 

30 20.8 1.24 

40 28 1.67 

50 34.8 2.07 

60 42.2 2.52 

70 48.5 2.89 

 

Power was set at the driver unit of the Coherent Sapphire Laser, 200 mW nominal power, 561 nm. Laser 

power was measured with a digital power meter (THORLABS, PM100D) by placing a microscopy slide thermal 

power sensor (THORLABS, S170C) with immersion oil in the sample holder. The power density was calculated 

as an average of the the gaussian illumination with an area of 256 px2 with pixel size of 160 nm. 
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Supplementary Table 2: DNA-PAINT sequences 

Shortname Docking sequence Imager sequence 
P1 TTATACATCTA CTAGATGTAT-Dye 
P2 TTATCTACATA TATGTAGATC-Dye 
P3 TTTCTTCATTA GTAATGAAGA-Dye 
P4 TTATGAATCTA GTAGATTCAT-Dye 
P5 TTTCAATGTAT CATACATTGA-Dye 
P6 TTTTAGGTAAA CTTTACCTAA-Dye 
P7 TTAATTGAGTA GTACTCAATT-Dye 
P8 TTATGTTAATG CCATTAACAT-Dye 
P9 TTAATTAGGAT CATCCTAATT-Dye 
P10 TTATAATGGAT GATCCATTAT-Dye 

 

Supplementary Table 3: List of core staples 

Position Name Sequence 

A1 21[32]23[31]BLK TTTTCACTCAAAGGGCGAAAAACCATCACC 

B1 23[32]22[48]BLK CAAATCAAGTTTTTTGGGGTCGAAACGTGGA 

C1 21[56]23[63]BLK AGCTGATTGCCCTTCAGAGTCCACTATTAAAGGGTGCCGT 

D1 23[64]22[80]BLK AAAGCACTAAATCGGAACCCTAATCCAGTT 

E1 21[96]23[95]BLK AGCAAGCGTAGGGTTGAGTGTTGTAGGGAGCC 

F1 23[96]22[112]BLK CCCGATTTAGAGCTTGACGGGGAAAAAGAATA 

G1 21[120]23[127]BLK CCCAGCAGGCGAAAAATCCCTTATAAATCAAGCCGGCG 

H1 21[160]22[144]BLK TCAATATCGAACCTCAAATATCAATTCCGAAA 

I1 23[128]23[159]BLK AACGTGGCGAGAAAGGAAGGGAAACCAGTAA 

J1 23[160]22[176]BLK TAAAAGGGACATTCTGGCCAACAAAGCATC 

K1 21[184]23[191]BLK TCAACAGTTGAAAGGAGCAAATGAAAAATCTAGAGATAGA 

L1 23[192]22[208]BLK ACCCTTCTGACCTGAAAGCGTAAGACGCTGAG 

M1 21[224]23[223]BLK CTTTAGGGCCTGCAACAGTGCCAATACGTG 

N1 23[224]22[240]BLK GCACAGACAATATTTTTGAATGGGGTCAGTA 

O1 21[248]23[255]BLK AGATTAGAGCCGTCAAAAAACAGAGGTGAGGCCTATTAGT 

P1 23[256]22[272]BLK CTTTAATGCGCGAACTGATAGCCCCACCAG 

A2 19[32]21[31]BLK GTCGACTTCGGCCAACGCGCGGGGTTTTTC 

B2 22[47]20[48]BLK CTCCAACGCAGTGAGACGGGCAACCAGCTGCA 
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D2 22[79]20[80]BLK TGGAACAACCGCCTGGCCCTGAGGCCCGCT 

E2 19[96]21[95]BLK CTGTGTGATTGCGTTGCGCTCACTAGAGTTGC 

F2 22[111]20[112]BLK GCCCGAGAGTCCACGCTGGTTTGCAGCTAACT 

H2 19[160]20[144]BLK GCAATTCACATATTCCTGATTATCAAAGTGTA 

I2 22[143]21[159]BLK TCGGCAAATCCTGTTTGATGGTGGACCCTCAA 

J2 22[175]20[176]BLK ACCTTGCTTGGTCAGTTGGCAAAGAGCGGA 

L2 22[207]20[208]BLK AGCCAGCAATTGAGGAAGGTTATCATCATTTT 

M2 19[224]21[223]BLK CTACCATAGTTTGAGTAACATTTAAAATAT 

N2 22[239]20[240]BLK TTAACACCAGCACTAACAACTAATCGTTATTA 

P2 22[271]20[272]BLK CAGAAGATTAGATAATACATTTGTCGACAA 

A3 17[32]19[31]BLK TGCATCTTTCCCAGTCACGACGGCCTGCAG 

B3 20[47]18[48]BLK TTAATGAACTAGAGGATCCCCGGGGGGTAACG 

D3 20[79]18[80]BLK TTCCAGTCGTAATCATGGTCATAAAAGGGG 

E3 17[96]19[95]BLK GCTTTCCGATTACGCCAGCTGGCGGCTGTTTC 

F3 20[111]18[112]BLK CACATTAAAATTGTTATCCGCTCATGCGGGCC 

H3 17[160]18[144]BLK AGAAAACAAAGAAGATGATGAAACAGGCTGCG 

I3 20[143]19[159]BLK AAGCCTGGTACGAGCCGGAAGCATAGATGATG 

J3 20[175]18[176]BLK ATTATCATTCAATATAATCCTGACAATTAC 

L3 20[207]18[208]BLK GCGGAACATCTGAATAATGGAAGGTACAAAAT 

M3 17[224]19[223]BLK CATAAATCTTTGAATACCAAGTGTTAGAAC 

N3 20[239]18[240]BLK ATTTTAAAATCAAAATTATTTGCACGGATTCG 

P3 20[271]18[272]BLK CTCGTATTAGAAATTGCGTAGATACAGTAC 

A4 15[32]17[31]BLK TAATCAGCGGATTGACCGTAATCGTAACCG 

B4 18[47]16[48]BLK CCAGGGTTGCCAGTTTGAGGGGACCCGTGGGA 

C4 15[64]18[64]BLK GTATAAGCCAACCCGTCGGATTCTGACGACAGTATCGGCCGCAAGGCG 

D4 18[79]16[80]BLK GATGTGCTTCAGGAAGATCGCACAATGTGA 

E4 15[96]17[95]BLK ATATTTTGGCTTTCATCAACATTATCCAGCCA 

F4 18[111]16[112]BLK TCTTCGCTGCACCGCTTCTGGTGCGGCCTTCC 

G4 15[128]18[128]BLK TAAATCAAAATAATTCGCGTCTCGGAAACCAGGCAAAGGGAAGG 

H4 15[160]16[144]BLK ATCGCAAGTATGTAAATGCTGATGATAGGAAC 

I4 18[143]17[159]BLK CAACTGTTGCGCCATTCGCCATTCAAACATCA 

J4 18[175]16[176]BLK CTGAGCAAAAATTAATTACATTTTGGGTTA 

K4 15[192]18[192]BLK TCAAATATAACCTCCGGCTTAGGTAACAATTTCATTTGAAGGCGAATT 
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L4 18[207]16[208]BLK CGCGCAGATTACCTTTTTTAATGGGAGAGACT 

M4 15[224]17[223]BLK CCTAAATCAAAATCATAGGTCTAAACAGTA 

N4 18[239]16[240]BLK CCTGATTGCAATATATGTGAGTGATCAATAGT 

O4 15[256]18[256]BLK GTGATAAAAAGACGCTGAGAAGAGATAACCTTGCTTCTGTTCGGGAGA 

P4 18[271]16[272]BLK CTTTTACAAAATCGTCGCTATTAGCGATAG 

A5 13[32]15[31]BLK AACGCAAAATCGATGAACGGTACCGGTTGA 

B5 16[47]14[48]BLK ACAAACGGAAAAGCCCCAAAAACACTGGAGCA 

C5 13[64]15[63]BLK TATATTTTGTCATTGCCTGAGAGTGGAAGATT 

D5 16[79]14[80]BLK GCGAGTAAAAATATTTAAATTGTTACAAAG 

E5 13[96]15[95]BLK TAGGTAAACTATTTTTGAGAGATCAAACGTTA 

F5 16[111]14[112]BLK TGTAGCCATTAAAATTCGCATTAAATGCCGGA 

G5 13[128]15[127]BLK GAGACAGCTAGCTGATAAATTAATTTTTGT 

H5 13[160]14[144]BLK GTAATAAGTTAGGCAGAGGCATTTATGATATT 

I5 16[143]15[159]BLK GCCATCAAGCTCATTTTTTAACCACAAATCCA 

J5 16[175]14[176]BLK TATAACTAACAAAGAACGCGAGAACGCCAA 

K5 13[192]15[191]BLK GTAAAGTAATCGCCATATTTAACAAAACTTTT 

L5 16[207]14[208]BLK ACCTTTTTATTTTAGTTAATTTCATAGGGCTT 

M5 13[224]15[223]BLK ACAACATGCCAACGCTCAACAGTCTTCTGA 

N5 16[239]14[240]BLK GAATTTATTTAATGGTTTGAAATATTCTTACC 

O5 13[256]15[255]BLK GTTTATCAATATGCGTTATACAAACCGACCGT 

P5 16[271]14[272]BLK CTTAGATTTAAGGCGTTAAATAAAGCCTGT 

A6 11[32]13[31]BLK AACAGTTTTGTACCAAAAACATTTTATTTC 

B6 14[47]12[48]BLK AACAAGAGGGATAAAAATTTTTAGCATAAAGC 

C6 11[64]13[63]BLK GATTTAGTCAATAAAGCCTCAGAGAACCCTCA 

D6 14[79]12[80]BLK GCTATCAGAAATGCAATGCCTGAATTAGCA 

E6 11[96]13[95]BLK AATGGTCAACAGGCAAGGCAAAGAGTAATGTG 

F6 14[111]12[112]BLK GAGGGTAGGATTCAAAAGGGTGAGACATCCAA 

G6 11[128]13[127]BLK TTTGGGGATAGTAGTAGCATTAAAAGGCCG 

H6 11[160]12[144]BLK CCAATAGCTCATCGTAGGAATCATGGCATCAA 

I6 14[143]13[159]BLK CAACCGTTTCAAATCACCATCAATTCGAGCCA 

J6 14[175]12[176]BLK CATGTAATAGAATATAAAGTACCAAGCCGT 

K6 11[192]13[191]BLK TATCCGGTCTCATCGAGAACAAGCGACAAAAG 

L6 14[207]12[208]BLK AATTGAGAATTCTGTCCAGACGACTAAACCAA 
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M6 11[224]13[223]BLK GCGAACCTCCAAGAACGGGTATGACAATAA 

N6 14[239]12[240]BLK AGTATAAAGTTCAGCTAATGCAGATGTCTTTC 

O6 11[256]13[255]BLK GCCTTAAACCAATCAATAATCGGCACGCGCCT 

P6 14[271]12[272]BLK TTAGTATCACAATAGATAAGTCCACGAGCA 

A7 9[32]11[31]BLK TTTACCCCAACATGTTTTAAATTTCCATAT 

B7 12[47]10[48]BLK TAAATCGGGATTCCCAATTCTGCGATATAATG 

C7 9[64]11[63]BLK CGGATTGCAGAGCTTAATTGCTGAAACGAGTA 

D7 12[79]10[80]BLK AAATTAAGTTGACCATTAGATACTTTTGCG 

E7 9[96]11[95]BLK CGAAAGACTTTGATAAGAGGTCATATTTCGCA 

F7 12[111]10[112]BLK TAAATCATATAACCTGTTTAGCTAACCTTTAA 

G7 9[128]11[127]BLK GCTTCAATCAGGATTAGAGAGTTATTTTCA 

H7 9[160]10[144]BLK AGAGAGAAAAAAATGAAAATAGCAAGCAAACT 

I7 12[143]11[159]BLK TTCTACTACGCGAGCTGAAAAGGTTACCGCGC 

J7 12[175]10[176]BLK TTTTATTTAAGCAAATCAGATATTTTTTGT 

K7 9[192]11[191]BLK TTAGACGGCCAAATAAGAAACGATAGAAGGCT 

L7 12[207]10[208]BLK GTACCGCAATTCTAAGAACGCGAGTATTATTT 

M7 9[224]11[223]BLK AAAGTCACAAAATAAACAGCCAGCGTTTTA 

N7 12[239]10[240]BLK CTTATCATTCCCGACTTGCGGGAGCCTAATTT 

O7 9[256]11[255]BLK GAGAGATAGAGCGTCTTTCCAGAGGTTTTGAA 

P7 12[271]10[272]BLK TGTAGAAATCAAGATTAGTTGCTCTTACCA 

A8 7[32]9[31]BLK TTTAGGACAAATGCTTTAAACAATCAGGTC 

B8 10[47]8[48]BLK CTGTAGCTTGACTATTATAGTCAGTTCATTGA 

C8 7[56]9[63]BLK ATGCAGATACATAACGGGAATCGTCATAAATAAAGCAAAG 

D8 10[79]8[80]BLK GATGGCTTATCAAAAAGATTAAGAGCGTCC 

E8 7[96]9[95]BLK TAAGAGCAAATGTTTAGACTGGATAGGAAGCC 

F8 10[111]8[112]BLK TTGCTCCTTTCAAATATCGCGTTTGAGGGGGT 

G8 7[120]9[127]BLK CGTTTACCAGACGACAAAGAAGTTTTGCCATAATTCGA 

H8 7[160]8[144]BLK TTATTACGAAGAACTGGCATGATTGCGAGAGG 

I8 10[143]9[159]BLK CCAACAGGAGCGAACCAGACCGGAGCCTTTAC 

J8 10[175]8[176]BLK TTAACGTCTAACATAAAAACAGGTAACGGA 

K8 7[184]9[191]BLK CGTAGAAAATACATACCGAGGAAACGCAATAAGAAGCGCA 

L8 10[207]8[208]BLK ATCCCAATGAGAATTAACTGAACAGTTACCAG 

M8 7[224]9[223]BLK AACGCAAAGATAGCCGAACAAACCCTGAAC 
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N8 10[239]8[240]BLK GCCAGTTAGAGGGTAATTGAGCGCTTTAAGAA 

O8 7[248]9[255]BLK GTTTATTTTGTCACAATCTTACCGAAGCCCTTTAATATCA 

P8 10[271]8[272]BLK ACGCTAACACCCACAAGAATTGAAAATAGC 

A9 5[32]7[31]BLK CATCAAGTAAAACGAACTAACGAGTTGAGA 

B9 8[47]6[48]BLK ATCCCCCTATACCACATTCAACTAGAAAAATC 

D9 8[79]6[80]BLK AATACTGCCCAAAAGGAATTACGTGGCTCA 

E9 5[96]7[95]BLK TCATTCAGATGCGATTTTAAGAACAGGCATAG 

F9 8[111]6[112]BLK AATAGTAAACACTATCATAACCCTCATTGTGA 

H9 5[160]6[144]BLK GCAAGGCCTCACCAGTAGCACCATGGGCTTGA 

I9 8[143]7[159]BLK CTTTTGCAGATAAAAACCAAAATAAAGACTCC 

J9 8[175]6[176]BLK ATACCCAACAGTATGTTAGCAAATTAGAGC 

L9 8[207]6[208]BLK AAGGAAACATAAAGGTGGCAACATTATCACCG 

M9 5[224]7[223]BLK TCAAGTTTCATTAAAGGTGAATATAAAAGA 

N9 8[239]6[240]BLK AAGTAAGCAGACACCACGGAATAATATTGACG 

P9 8[271]6[272]BLK AATAGCTATCAATAGAAAATTCAACATTCA 

A10 3[32]5[31]BLK AATACGTTTGAAAGAGGACAGACTGACCTT 

B10 6[47]4[48]BLK TACGTTAAAGTAATCTTGACAAGAACCGAACT 

D10 6[79]4[80]BLK TTATACCACCAAATCAACGTAACGAACGAG 

E10 3[96]5[95]BLK ACACTCATCCATGTTACTTAGCCGAAAGCTGC 

F10 6[111]4[112]BLK ATTACCTTTGAATAAGGCTTGCCCAAATCCGC 

H10 3[160]4[144]BLK TTGACAGGCCACCACCAGAGCCGCGATTTGTA 

I10 6[143]5[159]BLK GATGGTTTGAACGAGTAGTAAATTTACCATTA 

J10 6[175]4[176]BLK CAGCAAAAGGAAACGTCACCAATGAGCCGC 

L10 6[207]4[208]BLK TCACCGACGCACCGTAATCAGTAGCAGAACCG 

M10 3[224]5[223]BLK TTAAAGCCAGAGCCGCCACCCTCGACAGAA 

N10 6[239]4[240]BLK GAAATTATTGCCTTTAGCGTCAGACCGGAACC 

P10 6[271]4[272]BLK ACCGATTGTCGGCATTTTCGGTCATAATCA 

A11 1[32]3[31]BLK AGGCTCCAGAGGCTTTGAGGACACGGGTAA 

B11 4[47]2[48]BLK GACCAACTAATGCCACTACGAAGGGGGTAGCA 

C11 1[64]4[64]BLK TTTATCAGGACAGCATCGGAACGACACCAACCTAAAACGAGGTCAATC 

D11 4[79]2[80]BLK GCGCAGACAAGAGGCAAAAGAATCCCTCAG 

E11 1[96]3[95]BLK AAACAGCTTTTTGCGGGATCGTCAACACTAAA 

F11 4[111]2[112]BLK GACCTGCTCTTTGACCCCCAGCGAGGGAGTTA 
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G11 1[128]4[128]BLK TGACAACTCGCTGAGGCTTGCATTATACCAAGCGCGATGATAAA 

H11 1[160]2[144]BLK TTAGGATTGGCTGAGACTCCTCAATAACCGAT 

I11 4[143]3[159]BLK TCATCGCCAACAAAGTACAACGGACGCCAGCA 

J11 4[175]2[176]BLK CACCAGAAAGGTTGAGGCAGGTCATGAAAG 

K11 1[192]4[192]BLK GCGGATAACCTATTATTCTGAAACAGACGATTGGCCTTGAAGAGCCAC 

L11 4[207]2[208]BLK CCACCCTCTATTCACAAACAAATACCTGCCTA 

M11 1[224]3[223]BLK GTATAGCAAACAGTTAATGCCCAATCCTCA 

N11 4[239]2[240]BLK GCCTCCCTCAGAATGGAAAGCGCAGTAACAGT 

O11 1[256]4[256]BLK CAGGAGGTGGGGTCAGTGCCTTGAGTCTCTGAATTTACCGGGAACCAG 

P11 4[271]2[272]BLK AAATCACCTTCCAGTAAGCGTCAGTAATAA 

A12 0[47]1[31]BLK AGAAAGGAACAACTAAAGGAATTCAAAAAAA 

B12 2[47]0[48]BLK ACGGCTACAAAAGGAGCCTTTAATGTGAGAAT 

C12 0[79]1[63]BLK ACAACTTTCAACAGTTTCAGCGGATGTATCGG 

D12 2[79]0[80]BLK CAGCGAAACTTGCTTTCGAGGTGTTGCTAA 

E12 0[111]1[95]BLK TAAATGAATTTTCTGTATGGGATTAATTTCTT 

F12 2[111]0[112]BLK AAGGCCGCTGATACCGATAGTTGCGACGTTAG 

G12 0[143]1[127]BLK TCTAAAGTTTTGTCGTCTTTCCAGCCGACAA 

H12 0[175]0[144]BLK TCCACAGACAGCCCTCATAGTTAGCGTAACGA 

I12 2[143]1[159]BLK ATATTCGGAACCATCGCCCACGCAGAGAAGGA 

J12 2[175]0[176]BLK TATTAAGAAGCGGGGTTTTGCTCGTAGCAT 

K12 0[207]1[191]BLK TCACCAGTACAAACTACAACGCCTAGTACCAG 

L12 2[207]0[208]BLK TTTCGGAAGTGCCGTCGAGAGGGTGAGTTTCG 

M12 0[239]1[223]BLK AGGAACCCATGTACCGTAACACTTGATATAA 

N12 2[239]0[240]BLK GCCCGTATCCGGAATAGGTGTATCAGCCCAAT 

O12 0[271]1[255]BLK CCACCCTCATTTTCAGGGATAGCAACCGTACT 

P12 2[271]0[272]BLK GTTTTAACTTAGTACCGCCACCCAGAGCCA 

  

Supplementary Table 4: List of biotinylated staples 

No 
Posi

tion Name Sequence Mod 
1 C02 18[63]20[56]BIOTIN ATTAAGTTTACCGAGCTCGAATTCGGGAAACCTGTCGTGC 5'-BT 
2 C09 4[63]6[56]BIOTIN ATAAGGGAACCGGATATTCATTACGTCAGGACGTTGGGAA 5'-BT 
3 G02 18[127]20[120]BIOTIN GCGATCGGCAATTCCACACAACAGGTGCCTAATGAGTG 5'-BT 
4 G09 4[127]6[120]BIOTIN TTGTGTCGTGACGAGAAACACCAAATTTCAACTTTAAT 5'-BT 
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5 K02 18[191]20[184]BIOTIN ATTCATTTTTGTTTGGATTATACTAAGAAACCACCAGAAG 5'-BT 
6 K09 4[191]6[184]BIOTIN CACCCTCAGAAACCATCGATAGCATTGAGCCATTTGGGAA 5'-BT 
7 O02 18[255]20[248]BIOTIN AACAATAACGTAAAACAGAAATAAAAATCCTTTGCCCGAA 5'-BT 
8 O09 4[255]6[248]BIOTIN AGCCACCACTGTAGCGCGTTTTCAAGGGAGGGAAGGTAAA 5'-BT 

 

Supplementary Table 5: Exemplary folding table 

Component Initial conc. (µM) Parts Pool conc. (nM) Target conc. (nM) Volume (µl) Excess 

Scaffold 0.1 1 100 10 4 1 

Core Mix 100 164 609.7560976 100 6.56 10 

P1 Mix 100 12 8333.333333 1000 4.8 100 

Biotin 1:10 100 80 1250 10 0.32 1 

H2O     20.32  

10x Folding 
Buffer 

    4  

Total Volume     40  

 

 

 

Supplementary Table 6: Experimental conditions 

Figure Type Sample Imager Buffer Frames !"#! $" Power PPT Camera 

1b, 7c in vitro 20 nm grids P1 B+ 7500 300 ms 5 nM 1.5 kW/cm2 Yes EMCCD 

1d, e in situ Microtubules P3 C 50000 100 ms 2 nM 2.5 kW/cm2 No EMCCD 

2d–f in vitro Exchange 
rectangle 

P1,P3 B+ 7500 300 ms 10 nM 6 kW/cm2 Yes EMCCD 

2g in situ Microtubules / 
Mitochondria 

P1,P3 C 20000 150 ms 0.8 nM 2 kW/cm2 
 

No EMCCD 

3d–f  
4d, f 

in vitro 10 and 20 nm 
grids, LMU logo 

P1 B+ 80000 350 ms 0.7 nM 4.5 kW/cm2 Yes sCMOS 

4b, c, e in vitro 10  and 20 nm 
grids, MPI logo 

P1 B+ 80000 350 ms 1 nM 4.5 kW/cm2 Yes sCMOS 

 

Nature Protocols: doi:10.1038/nprot.2017.024



 
Super-Resolution Microscopy with DNA-PAINT 
 

 136 

 11 

For full details on acquisition settings see corresponding YAML files. 

 

Supplementary Table 7: Dye recommendations 

Excitation Rank Excitation wavelength (nm) Dye Compatible with PCA/PCD/Trolox System 
Red 1 640 Atto647N  Yes 
 2 640 Cy5 Yes 

 3 640 Atto655 No 

Green 1 561 Cy3b Yes 
 2 561 Atto565 Yes 

 3 561 Cy3 Yes 

Blue 1 488 Atto488 Yes 
 2 488 Alexa488 Yes 
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Site-Specific Labeling of Affimers for DNA-PAINT Microscopy
Thomas Schlichthaerle, Alexandra S. Eklund, Florian Schueder, Maximilian T. Strauss,
Christian Tiede, Alistair Curd, Jonas Ries, Michelle Peckham, Darren C. Tomlinson, and
Ralf Jungmann*

Abstract: Optical super-resolution techniques allow fluores-
cence imaging below the classical diffraction limit of light.
From a technology standpoint, recent methods are approach-
ing molecular-scale spatial resolution. However, this remark-
able achievement is not easily translated to imaging of cellular
components, since current labeling approaches are limited by
either large label sizes (antibodies) or the sparse availability of
small and efficient binders (nanobodies, aptamers, genetically-
encoded tags). In this work, we combined recently developed
Affimer reagents with site-specific DNA modification for high-
efficiency labeling and imaging using DNA-PAINT. We
assayed our approach using an actin Affimer. The small
DNA-conjugated affinity binders could provide a solution for
efficient multitarget super-resolution imaging in the future.

Super-resolution (SR) microscopy techniques[1] are evolving
to become standard characterization tools in the life sciences.
Due to the use of target-specific fluorescent labels, super-
resolution—in contrast to electron microscopy (EM)—ena-
bles high-contrast imaging in complex 3D cellular architec-
tures,[2] and thus combines the advantages of increased spatial
resolution with molecular affinity probes. While the use of
labels with high target specificity such as antibodies is one of
the biggest advantages of fluorescence microscopy over, for
example, EM, it is at the same time also one of the most
severe limitations for SR approaches to date. As current SR
methods reach localization precisions on the order of only
a few nanometers,[3] this achievement does not translate to
achievable image resolution in biological specimens due to
the relatively large size of commonly used labeling probes. In

the case of primary and secondary antibodies, the size of the
probes easily adds an additional linkage error of around 10–
15 nm to the actual position of the molecule of interest.[1] This
results in the fact that high-performance super-resolution
techniques actually report the location of the probe rather
than the one of the biomolecules under investigation.

The ideal labeling probe would need to be small and
target-specific to reduce the linkage error and allow high
labeling densities due to minimal steric hindrance. Further-
more, quantitative imaging approaches[4] demand stoichio-
metric labeling, that is, ideally one reporter molecule should
be bound to exactly one copy of the target molecule.

The issue of efficient labeling using small probes has
recently been advanced by the development of novel affinity
reagents including nanobodies,[5] aptamers,[6] and genetically
encoded self-labeling tags such as SNAP or HALO.[7] Besides
the size of the labeling probe, it is equally important to be able
to engineer these binders against a large library of target
molecules in a rapid and straightforward fashion. This has
traditionally been difficult for, nanobodies, for example, since
the selection process of novel binders usually relies on
immunization of animals,[8] which makes it both time-
consuming and expensive. While aptamers are promising
candidates for the rapid development of small and efficient
labeling probes, only a few candidates have been shown to
work for extracellular target molecules. Self-labeling tags
such as SNAP (19.4 kDa) or HALO (33 kDa) allow efficient
target labeling, however, they require genetic engineering of
cell lines, for example, using CRISPR/Cas,[9] Zinc finger,[10] or
TALEN technology.[11] The same argument holds true for the
large amount of GFP-tagged cell lines which can be targeted
using GFP nanobodies.[5a, 12] In addition, GFP fusion (25 kDa)
adds an additional linkage error to the one from the nano-
body (15 kDa).

Affimers[13] are a recently developed class of labeling
probes (ca. 10–12 kDa, ca. 2 nm) that are isolated from large
phage-display libraries (approx. 1010 members). The ability to
quickly isolate Affimers[14] with high specificity and affinity
that can be used in a range of applications[15] highlights their
potential as alternatives to traditional antibodies. In SR
microscopy, Affimer reagents have been used to image
tubulin and a receptor tyrosine kinase by site-specific labeling
with a fluorophore.[13b] Interestingly, the anti-tubulin Affimer
labels interphase microtubules in a similar way to a widely
used antibody, but it also labels the central region of the
cytokinetic furrow, from which antibodies are usually
excluded. This highlights a further advantage of using smaller
probes, namely, that their small size allows them to penetrate
dense structures that exclude antibodies.
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In this work, we combined site-specific DNA labeling of
Affimers with the recently developed DNA-PAINT super-
resolution technique.[16] In DNA-PAINT, the apparent
“switching” between bright and dark states of dye molecules
used for super-resolution reconstruction is achieved through
the transient interaction of a dye-labeled imager strand with
its complementary docking strand linked to a target molecule
of interest. In order to perform DNA-PAINT on proteins in
a cellular context, the docking strand needs to be attached to
an affinity reagent (e.g., antibodies). To achieve quantitative,
site-specific one-to-one labeling of Affimers with DNA-
PAINT docking strands, we made use of a C-terminal cysteine
modification of the Affimer to site-specifically attach a single
DNA strand using cysteine-maleimide chemistry.[17] We
assayed the achievable imaging resolution of an actin Affimer
in comparison to phalloidin, a small molecule commonly used
for actin labeling and super-resolution imaging, and achieved
comparable results.[18]

To site-specifically modify Affimers, we first labeled
a reduced C-terminal cysteine residue with maleimide-
DBCO which was then linked to azide-functionalized DNA
using a strain-promoted azide–alkyne cycloaddition (SPAAC)
reaction (Figure 1, see also Material and Methods in the
Supporting Information for details). Subsequently, the
Affimer was purified using a HisTrap column to remove the
free unreacted DNA (Figure S1 in the Supporting Informa-
tion). The successful conjugation was evaluated using SDS-
PAGE gel analysis. In comparison to the unconjugated
Affimer, the molecular weight increased by around 5 kDa,
which suggests a stoichiometric 1:1 labeling of DNA to
Affimers (Figure S2).

The DNA-PAINT docking strand was additionally labeled
with a fixed Atto488 dye (Figure 1), which allowed us to
rapidly identify a specific cellular phenotype using diffrac-
tion-limited widefield microscopy before subsequent DNA-
PAINT image acquisition was performed. We then labeled
actin filaments in fixed Cos7 cells with our purified DNA–
Affimer conjugate and performed 3D DNA-PAINT micros-
copy (Figure 2a). Comparison of the diffraction-limited
image acquired using the fixed Atto488 dye shows a clear
improvement in resolution and highlights the high labeling
specificity and efficiency of our DNA-conjugated actin
Affimer (Figure 2b,c, see also Figure S3 for comparison

with phalloidin labeling). To quantify the achievable reso-
lution, we overlaid thirteen single actin fibers by the center of
each filament and measured a line width of approximately
18 nm (FWHM). In comparison, we also performed the same

Figure 1. a) Site-specific DNA labeling of Affimer reagents. Insertion sites for binder evolution against target proteins are highlighted in orange.
The site-specifically attached DNA strand (dotted box) contains an additional Atto488 fluorophore for fast diffraction-limited imaging. b) Labeling
of single cysteines using maleimide-DBCO (left). Subsequently, azide-labeled DNA is added and binds covalently to the DBCO (center). Finally,
DNA-labeled Affimers can be used for DNA-PAINT imaging (right). Affimer cartoons modified from PDB ID: 4N6T.

Figure 2. a) DNA-PAINT imaging of Affimer-labeled actin network in
fixed Cos7 cells (color indicates height). b) Diffraction-limited zoom-in
of the highlighted area in (a). c) Super-resolved zoom-in of the
highlighted area in (a) shows increased spatial resolution and dense
actin labeling. Scale bars: 5 mm (a), 1 mm (b, c).
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analysis on a phalloidin dataset and measured a line width of
approximately 13 nm. Both values are in good agreement
with earlier studies[18, 19] (Figure S4), taking the different
binder size of phalloidin versus Affimers into account.

Additionally, we performed a copper-catalyzed cyclo-
addition reaction (CuAAC) as alternative labeling strategy
(Figure S5), achieving similar labeling and imaging perfor-
mance (Figure S6). While labeling efficiency and image
quality is similar, we recommend the use of SPAAC because
it is less time consuming and involves fewer reagents. In
addition, we also performed direct stochastic optical recon-
struction microscopy (dSTORM) imaging using an Alexa647-
labeled Affimer (Figure S7) to further demonstrate the wide
applicability of Affimers as labeling reagents for super-
resolution methods.

Next, we assayed the achievable 3D resolution of our
DNA-conjugated Affimers and DNA-PAINT by evaluating
the actin network in Cos7 cells in three dimensions (Fig-
ure 3a,b). We were able to confirm two distinct layers of actin
in 3D (Figure 3 d) with an apparent thickness of approx-
imately 40 nm and a distance of around 130 nm (Figure 3e),
as previously reported using dual-objective STORM imag-
ing[18] (See Figure S8 for additional 3D data). The combina-
tion of the efficient labeling of the actin Affimers with the
high-resolution capability of DNA-PAINT allowed us to
achieve similar imaging performance (localization precision
⇡ 5 nm) using a standard inverted fluorescence microscope
without the need for dual-objective detection. In the DNA-
PAINT case, the higher resolution in 2D, as well as in 3D, is
due to the high photon numbers available from the repetitive
and transient binding of probes, rather than improved
instrumentation.

In conclusion, site-specific conjugation of single DNA
strands to Affimer reagents provides an attractive route for
DNA-based super-resolution techniques due to their small
label size and quantitative labeling capability. We envision

applications in absolute quantitative microscopy approaches
such as qPAINT and multiplexed target detection using
orthogonal Affimer binders coupled to distinct DNA sequen-
ces, for example, for Exchange-PAINT microscopy. In
general, cysteine-based DNA labeling of affinity reagents
could be an efficient way to obtain quantitative DNA-PAINT
reagents and it should also be possible to apply it for other
probes such as nanobodies,[5a] FAB fragments,[20] or Dar-
pins.[21]
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Supplementary Figure 1 | Histag purification to remove unbound DNA. The Affimer binds via its Histag to the HisTrap 

column and the unbound DNA can be removed from the solution. Washing the column with 500 mM Imidazole elutes the Protein 

and Protein-DNA conjugates.  
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Supplementary Figure 2 | SDS-PAGE gel of actin 14c Affimer. Arrows indicate the shift of unlabeled Affimer (left lane) towards 

the higher molecular weight of the DNA labeled Affimer (second to left lane). 
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Supplementary Figure 3 | Actin imaging with phalloidin-DNA in Cos7 cells. (a) Overview image of super-resolved actin 

filaments imaged with phalloidin-DNA conjugate. (b) Diffraction-limited (standard deviation of first 10000 frames) zoom-in of 

highlighted area (white box) in a. (c) Super-resolved zoom-in of the same area showing the actin filaments. (d) Z-section of the 

highlighted area (white arrow) indicating the two-layer organization of the actin filaments. (e) Cross-sectional histogram analysis 

shows a layer-to-layer distance of 135 nm. Scale bars: 10 µm (a), 5 µm (b), 1 µm (c), 100 nm (d). 

 
 
 

 

Supplementary Figure 4 | Apparent actin filament width from Affimer and Phalloidin imaging. (a) Cross-sectional profile 

of 13 filaments aligned by the center of each filament (Dataset from the Affimer binder, Figure 2). Red: Gaussian fit with FWHM 

of ~18 nm. (b) Cross-sectional profile of 24 filaments aligned by the center of each filament (Dataset from the Phalloidin binder, 

Supplementary Figure 3). Red: Gaussian fit with FWHM of ~13 nm. 
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Supplementary Figure 5 | Alternative labeling strategy using copper-catalysed azide alkyne cycloaddition (CuAAC). 

First reaction of Propargyl-Maleimide to the reduced cysteine residue takes place at 4 °C for 12 h. After buffer exchange via 

Amicon 10 kDa Spin Filters, the second reaction takes place at 25 °C for 1 h, which links the alkyne group to the Azide-labeled 

DNA. The final conjugate can be used for DNA-PAINT imaging, where the fluorophore-labeled DNA strand binds transiently to 

the handle strand on the Affimer. 

 
 
 

 

Supplementary Figure 6 | 2D imaging with actin Affimer labeled via copper-catalysed azide alkyne cycloaddition. (a) 

Overview image of Cos7 cell, imaged without fixed Atto 488 fluorophore on the P3 handle sequence. (b) Zoom in image from 

white box in a. (c) Standard deviation (diffraction-limited) image of first 75000 frames. Scale bars: 5 µm (a), 2 µm (b, c). 
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Supplementary Figure 7 | dSTORM using actin Affimer. (a) Diffraction-limited actin image using Alexa647-labeled Affimers. 

(b) 3D-dSTORM super-resolution image (color indicates height). Localization precision (NeNA metric): 23 nm. Scale bar: 1 µm. 

 
 
 

 
Supplementary Figure 8 | 3D Actin imaging in Cos7 cells with Affimers. (a) Overview image of actin Affimer stained Cos7 

cell with colormap representing the z-height. (b) 1 µm wide horizontal and vertical sections from dashed boxes in (a). Colormap 

indicates the z-height. Dual layer organization of the actin network can be visualized. (c) Diffraction-limited image of the same 

cell visualized with the fixed Atto488 fluorophore on the DNA handle strand. (d) Zoom into the area in the vertical section 

indicated by the white arrow showing the dual-layer organization in greater detail. A histogram analysis shows that the two layers 

of the actin network are ~150 nm apart in z. Scale bars: 5 µm (a, c), 2.5 µm (b, lateral) and 200 nm (b, vertical), 50 nm (d). 
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Materials & Methods 
 

Buffer reagents 

Buffer C consists of 1xPBS (ThermoFisher Scientific, Cat.No. 20012-019) mixed with 500 mM Sodium 

Chloride at pH 7.2. 

 

Oxygen Scavenger System – PCD/PCA/Trolox 

100xPCD (Sigma-Aldrich, Cat. No. P8279-25UN) includes 9.3 mg PCD solved in 13.3 ml of buffer (50% 

glycerol stock in 50 mM KCL, 1 mM EDTA and 100 mM Tris-HCL at pH 8.0). It is usually stored as 20 µl 

aliquots at -20 °C. 

 

40´PCA (Sigma-Aldrich, Cat. No. 37580-25G-F) solution includes 154 mg PCA in 10 ml H2O and is 

adjusted to pH 9.0 with NaOH. It is stored as 20 µl aliquots at -20 °C. 

 

100´Trolox (Sigma-Aldrich, Cat. No. 238813-1G) solution includes 100 mg Trolox, 430 µl methanol and 

345 µl NaOH (1M) in 3.2 ml of H2O and is aliquoted in 20 µl batches and stored at -20 °C. 

 

10´ SDS-PAGE Gel Buffer Running Buffer consists of 250 mM Tris, 1.92 M Glycine and 0.1% (w/v) SDS 

at pH 8.3. 

 

4´ Gel Loading Buffer includes 250 mM Tris-HCL pH 6.8, 40 % (v/v) Glycerol, 5 % (w/v) SDS, 0.005 % 

(w/v) Bromophenol Blue and 400 mM DTT. 

 

dSTORM buffer: 10 mM Tris-HCl (pH 8.0), 50 mM NaCl, 5 mg/ml glucose, 114 mM β-mercaptoethanol, 

0.5 mg/ml glucose oxidase and 40 μg/ml catalase, used fresh and kept on ice. 

 

Actin Affimer (14c) Production 

Affimer reagents were produced as described before1. 

 

Actin Affimer14c Protein Sequence 

MASNSLEIEELARFAVDEHNKKENALLEFVRVVKAKEQSDTPHWWWTTMYYLTLEAKDGGKKKLYEA

KVWVKESPVHPKRLNFKDLQEFKPVGDACAAAHHHHHHHH 

 



 
Site-Specific Labeling of Affimers  
 

 150  

Strain-promoted Azid-Alkyne Cycloaddition (SPAAC) 

Affimers are concentrated via Amicon 10kDa spin filters (Merck/EMD Millipore, Cat. No. UFC501096) 

and buffer exchanged into 5 mM TCEP (Pierce, Cat. No.: 20490) in 1´PBS (ThermoFisher Scientific, 

Cat.No. 20012-019) + 3 mM EDTA (Ambion, Cat. No. AM9261) at pH 7. 5 mM TCEP in 1´PBS + 3 mM 

EDTA is then added to the Affimer and is incubated for 2 h at 4 °C on a shaker. Subsequently, Amicon 

10 kDa Spin Filters are prewashed with 1´PBS, and Affimers are buffer exchanged into 1´PBS for 

5´5min at 14 000´g and the volume is adjusted to 100 µl. DBCO-Maleimide Crosslinker (Sigma-Aldrich, 

Cat. No. 760668) is added in 20´ molar excess in 5 µl to the Affimer and incubated overnight at 4 °C on 

a shaker. Crosslinker aliquots are stored at 40 mg/ml concentration in DMF (Thermo Fisher Scientific, 

Cat. No. 20673). 

DBCO crosslinker is removed via 10 kDa Amicon Spin Filters for 5´5min at 14 000´g. Azide-DNA is 

added to the Affimer crosslinker at 10´ excess for 1 h at 20 °C. The final product is buffer exchanged into 

HisTrap binding buffer (20 mM Sodium Phosphate, 500 mM NaCl, 20 mM Imidazole) via Amicon 10 kDa 

Spin Filters. Purification from free DNA was performed using a GE Aekta purifier system and a HisTrap 

1 ml column (GE, Cat. No. 29-0510-21) via a one-step purification scheme with 500 mM Imidazole (Carl 

Roth, Cat. No. X998.4) and 500 mM NaCl. Peak fractions are afterwards concentrated and buffer-

exchanged via Amicon 10 kDa spin filters. The conjugated product does not necessarily have to be 

purified from the unreacted DNA, however it is highly recommended, to avoid unspecific staining from 

the free DNA. Note: The reaction was performed with and without fixed Atto 488 fluorophore on the azide-

modified DNA. 

 

Example Calculations 

Supplementary Table 1 | Affimer preparation (after reduction/buffer exchange) 

Affimer 

MW (g/mol) 12577 

measured concentration (mg/ml) 1.34 

desired amount in nmol 10 

  

volume of Affimer to use (µl) 93.86 

add volume of 1xPBS (µl) 6.14 
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Supplementary Table 2 | Crosslinker dilution calculation. Take 20x in 5 µl 

DBCO-Mal 

MW (g/mol)  427.45 

c (mg/ml) 40 

c (nmol/µl) 93.58 

desired amount (nmole) 200 

desired c (nmol/µl) 40 

dilution factor 2.34 

  

crosslinker (µl) 4.27 

add volume of PBS to crosslinker (µl) 5.73 

 

è Add 5 µl of diluted crosslinker to 100 µl of reduced Affimer 

 

Affimer after crosslinker reaction: 1.229 mg/ml – 97.7 pmol/µl (take 40 µl – 3.909 nmole) 

 

Supplementary Table 3 | Addition of azide-modified DNA via SPAAC. Adding 10x molar excess of 

DNA to Affimer+Crosslinker 

DNA-P1-Atto488 

MW (g/mol) 5885 

c (mmol/l) 5 

desired amount (nmole) 39.09  

Volume of DNA to add to Affimer (µl) 7.82 

 

This is an example calculation. More Affimer can be used; the limiting factor is more often the amount of 

DNA available. 
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Copper-catalysed azide alkyne cycloaddition reaction (CuAAC) 

Affimers are concentrated via Amicon 10kDa spin filters and buffer exchanged into 5 mM TCEP (Pierce, 

Cat. No.: 20490) in 1´PBS (ThermoFisher Scientific, Cat.No. 20012-019) + 3 mM EDTA (Ambion, Cat. 

No. AM9261) at pH 7. 5 mM TCEP in 1´PBS + 3 mM EDTA is then added to the Affimer and is incubated 

for 2 h at 4 °C on a shaker. Subsequently, Amicon 10 kDa Spin Filters (Merck/EMD Millipore, Cat. No. 

UFC501096) are prewashed with 1xPBS, and Affimers are buffer exchanged into 1´PBS for 5´5min at 

14 000´g and the volume is adjusted to 100 µl. Propargyl-Maleimide Crosslinker (Jena Bioscience, Cat. 

No. CLK-TA113-25) is added in 20´ molar excess in 5 µl to the Affimer and incubated overnight at 4 °C 

on a shaker. Crosslinker aliquots are stored at 400 mM concentration in DMF (Thermo Fisher Scientific, 

Cat. No. 20673). 

Propargyl-Maleimide crosslinker is removed via 10 kDa Amicon Spin Filters at 5´5min for 14 000´g. 

Azide-DNA is added including 0.1 mM CuSO4 (Sigma-Aldrich, Cat. No. C1297-100g), 0.5 mM THPTA 

(Sigma-Aldrich, Cat. No. 762342-100mg), 5 mM Sodium L-Ascorbate (Sigma-Aldrich, Cat. No. A7631-

25mg) and 5 mM Aminoguanidine hydrochloride (Sigma-Aldrich, Cat. No. 396494-25g) to the Affimer 

with the alkyne group at 10´ excess for 1 h at 25 °C. The final product is buffer exchanged into 1´PBS 

using Amicon 10kDa spin filters. The conjugated product was not purified from non-reacted DNA. The 

conjugated product does not necessarily have to be purified from the unreacted DNA, however it is highly 

recommended, to avoid unspecific staining from the free DNA. Note: The reaction was performed only 

with DNA handles without the fixed fluorophore on the 3’-end, however should be translatable to use also 

with an additional fixed dye. 
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Example Calculations 

Steps 1 & 2 are the same as previously written.  

 

Supplementary Table 4 | Addition of azide-modified DNA via CuAAC. 

Name Stock Target concentration Dilution factor Volume (µl) 

PBS (pH 7.2, 1´)    41.36 

Alkyne-Affimer (mM) 0.21 0.07 3.02 33.14 

Azide-DNA (mM) 5 0.7 7.14 14 

CuSO4 (mM) 20 0.1 200 0.5 

THPTA (mM) 50 0.5 100 1 

Aminoguanidine hydrochloride 

(mM) 
100 5 20 5 

Sodium ascorbate (mM) 100 5 20 5 

     

Final volume (µl)    100 

 

 

Labeling efficiencies 

Labeling efficiencies of the DNA-conjugated Affimers were determined via absorption spectroscopy after 

HisTag purification. Typical labeling efficiencies were on the order of 0.65 DNA/fluorophore molecules 

per Affimer.  
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SDS-PAGE Gel 

Samples were diluted in Gel Loading buffer and heated to 95 °C for 5 min. The samples were then loaded 

onto a Mini-PROTEAN TGX Stain-Free Gel (Biorad, Cat. No. 456-8083). 7.5 µl of Ladder (Biorad, Cat. 

No. 1610363) was loaded next to the Affimers. The gel was run at 180 Volt for 35 min. Gel imaging was 

performed with 2 min activation of the stain-free technology and imaged with autoexposure on a Biorad 

gel imaging system (Biorad, Gel Doc XR+). 

 

 

Synthesis of phalloidin-DNA construct 

1st step, disulfide reduction: 97.1 nmol (11.9 OD260) of the synthetic 5´-thiol (C6)pTTATACATCTA DNA 

oligonucleotide (Eurofins Genomics) present in its homo-dimeric disulfide form was reduced at 37 °C for 

one hour with a 10´ excess of TCEP-HCl (Tris(2-carboxyethyl)phosphine hydrochloride), from a solution 

of 100 mM in water, brought to pH 8.5 with 1 N NaOH), in a buffer containing 100 mM HEPES-NaOH, 2 

mM EDTA at pH 7.4. The oligonucleotide was ethanol-precipitated, centrifuged and the pellet was dried 

using a SpeedVac concentrator (Savant, Thermo Scientific). 

 

2nd step, synthesis of the phalloidin-DNA construct: the reaction mixture contained 75 µl of 100 mM 

HEPES-NaOH, 2 mM EDTA at pH 7.8 as buffer, plus 50 µl of the reduced 5´-modified oligonucleotide, 

40 µl (200 nmol) of the amino modified phalloidin tosylate derivative (from Enzo Life Sciences, CASRN 

17466-45-4, Cat. No. ALX-350-266-M001), both substances dissolved in water, respectively, and 41 µl 

(96 nmol) of maleimide-PEG2-succinimidyl ester (Sigma-Aldrich, CASRN 955094-26-5, Cat. No. 

746223), dissolved in DMF. The mixture was incubated at room temperature and the progress of the 

reaction was followed by analytical RP-HPLC on an XBridge™ C18 column, 5 µm, 3.0´150 mm (Waters). 

 

After 4 hours of total incubation time the reaction mixture was separated on a semi-preparative column 

(Gemini-NX C18, 5 µm, 110A, 250 x 10.0 mm, Phenomenex). RP-HPLC was performed using an 

increasing gradient of acetonitrile (7 to 40 % v/v) in 100 mM Et3NHOAc at pH 7.8. 

The corresponding fractions of several peaks were pooled, lyophilized, and the separated compounds 

were dissolved in water and analyzed by their UV-spectrum as well as by mass spectrometry. 35.17 nmol 

(4.93 OD260) of the desired construct (calculated monoisotopic MW: 4582.079 g/mol, measured: 4582.057 

g/mol) were finally obtained and used downstream for cell staining experiments. 
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Cell culture 

Cos7 cells (ATCC, Cat. No. CRL-1651) were passaged every other day and used between passage 

number 5 and 20. The cells were maintained in DMEM (ThermoFisher Scientific, Cat. No. 10566016) 

supplemented with 10 % Fetal Bovine Serum (ThermoFisher Scientific, Cat. No. 10500-064) and 1 % 

Pencillin/Streptomycin (ThermoFisher Scientific, Cat. No. 15140-122). Passaging was performed using 

1´PBS and Trypsin-EDTA 0.05 % (ThermoFisher Scientific, Cat.No. 25300-054). 24 h before 

immunostaining, cells were seeded on IBIDI 8-well glass coverslips (ibidi, Cat. No. 80827) at 30,000 

cells/well. Prefixation was performed with prewarmed 0.4% Glutaraldehyde (SERVA, Cat. No. 23115.01) 

and 0.25% Triton X-100 (Carl Roth, Cat. No. 6683.1) for 90 seconds followed by the main fixation at 3 % 

glutaraldehyde for 15 min. Reduction was done using 1 mg/ml Sodium Borohydride (Carl Roth, Cat. No. 

4051.1) in 1´PBS followed by one brief 1xPBS rinse and 3´5 min washing with 1´PBS. Blocking and 

permeabilization was done for 90 min with sterile filtered 3% (w/v) BSA (Sigma-Aldrich, Cat. No. A4503-

10g) and 0.25% (v/v) Triton X-100 in PBS at room temperature. Cells were stained overnight with Affimer 

in sterile filtered 3% (w/v) BSA in 1xPBS on a shaker at 4 °C. Cells were washed 3´ for 5 min in 1´PBS, 

incubated with 1:10 dilution of 90 nm gold particles (cytodiagnostics, Cat. No. G-90-100) in 1´PBS as 

drift markers, washed 3´5 min and immediately imaged.  

 

 

Microscopy setup 

Fluorescence imaging was carried out on an inverted Nikon Eclipse Ti microscope (Nikon Instruments) 

with the Perfect Focus System, applying an objective-type TIRF configuration with an oil-immersion 

objective (Apo SR TIRF 100´, NA 1.49, Oil). Two lasers were used for excitation: 561 nm (200 mW, 

Coherent Sapphire) or 488 nm (200 mW, Toptica iBeam smart). The laser beam was passed through a 

cleanup filter (ZET488/10x or ZET561/10x, Chroma Technology) and coupled into the microscope 

objective using a beam splitter (ZT488rdc or ZT561rdc, Chroma Technology). Fluorescence light was 

spectrally filtered with two emission filters (ET525/50m and ET500lp for 488 nm excitation and ET600/50 

and ET575lp for 561 nm excitation, Chroma Technology) and imaged on a sCMOS camera (Andor Zyla 

4.2) without further magnification, resulting in an effective pixel size of 130 nm after 2´2 binning. 
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DNA-PAINT super-resolution image acquisition 

Cells were screened for a certain phenotype with 488 nm laser excitation at 0.01 kW/cm2. After acquisition 

of the 488 channel, the excitation was switched to 561 nm, focal plane and TIRF angle were readjusted 

and imaging was subsequently performed using ~3 kW/cm2 561 laser excitation. Imager strand 

concentration varied dependent on the measurement from 200 pM – 800 pM Cy3b-P1 and was adjusted 

to minimize double-binding events. Imaging was performed in 1´PCA (Sigma-Aldrich, Cat. No. 37580-

25G-F)/1´PCD (Sigma-Aldrich, Cat. No. P8279-25UN)/1´Trolox (Sigma-Aldrich, Cat. No. 238813-1G) in 

Buffer C (1´PBS + 500mM NaCl) and imaged for 300,000-500,000 frames at 15 ms / 50 ms exposure 

time (see also Supplementary Table 7). 3D imaging was performed using an astigmatism lens in the 

detection path.  

 

3D direct stochastic optical reconstruction microscopy (3D dSTORM) 

For dSTORM imaging, the C-terminal cysteine of actin Affimer 14c was directly labelled with the 

maleimide derivative of Alexa Fluor 647 (Thermo Fisher Scientific), as described previously1. The labelled 

Affimer was stored at −20°C at a final concentration of 0.25 mg/ml in an equal volume of 80% glycerol. 

Coverslips (#1.5, 25-mm diameter; Scientific Laboratory Supplies, MIC3350) were cleaned as described 

previously2. VOT-E36 cells (a kind gift from Mathew Holley, University of Sheffield) were cultured as 

described3. Cells were differentiated in culture medium supplemented with 10 μM retinoic acid at 37°C, 

5% CO2 for 7 days. Cells were fixed in 2% paraformaldehyde (PFA) dissolved in PEM buffer (80 mM 

PIPES pH 6.8, 5 mM EGTA, 2 mM MgCl2). Cells were permeabilised with 0.5% Triton X-100 for 5 min 

and washed three times with PBS, before blocking with 5% BSA in PBS for 1 hr. Cells were incubated 

with labelled actin Affimer (1:1000) prepared in PBS supplemented with 0.25% BSA for 1 hr at room 

temperature. Coverslips were washed three times with PBS prior to imaging. 

dSTORM data acquisition and reconstruction were carried out as described previously1. Data was 

acquired over 143,000 frames, with 200 µl of dSTORM buffer initially present and further 200 µl volume 

added when the blinking rate of the labels was noticeably reduced. 

 

Image data analysis 

Images were reconstructed with the Picasso and SMAP Software Suite. Drift correction was performed 

with a redundant cross-correlation and/or gold particles as fiducials. 
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Supplementary Table 5 | Handle sequences 

Handle Name Sequence 5’-mod 3’-mod Vendor 

P1-Atto488 TTA TAC ATC TA 
TTTT 

Azide Atto 488 Biomers.net 

P1 TTATACATCTA  Azide None Biomers.net 

P3 TTTCTTCATTA Azide None Biomers.net 

 

 

Supplementary Table 6 | Imager sequences 

Imager name Sequence 5’-mod 3’-mod Vendor 

P1* CTAGATGTAT None Cy3b Eurofins Genomics 

P3* GTAATGAAGA none Cy3b Eurofins Genomics 

 

 
Supplementary Table 7 | Imaging parameters 

Dataset Parameters  
Laser power 

@561 nm 

Localization 

precision (NeNA) 

Figure 2 50 ms, 3D, 300k Frames, 800 pM P1* 3.3 kW/cm2 4.9 nm 

Figure 3 50 ms, 3D, 479285 Frames, 800 pM P1* 3.3 kW/cm2 4.7 nm 

Supplementary 

Figure 3 
50 ms, 3D, 171229 Frames, 800 pM P1* 3.3 kW/cm2 5.6 nm 

Supplementary 

Figure 5 
15 ms, 2D, 300k Frames, 1 nM P3* 1.78 kW/cm2 8.0 nm 

Supplementary 

Figure 6 
50 ms, 3D, 300k Frames, 800 pM P1* 3.3 kW/cm2  5.0 nm 
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Bacterially Derived Antibody Binders as Small Adapters for
DNA-PAINT Microscopy
Thomas Schlichthaerle+,[a, b] Mahipal Ganji+,[a, b] Alexander Auer,[a, b] Orsolya Kimbu Wade,[a, b]

and Ralf Jungmann*[a, b]

Current optical super-resolution implementations are capable
of resolving features spaced just a few nanometers apart. How-
ever, translating this spatial resolution to cellular targets is lim-
ited by the large size of traditionally employed primary and
secondary antibody reagents. Recent advancements in small
and efficient protein binders for super-resolution microscopy,
such as nanobodies or aptamers, provide an exciting avenue
for the future; however, their widespread availability is still lim-
ited. To address this issue, here we report the combination of
bacterial-derived binders commonly used in antibody purifica-
tion with DNA-based point accumulation for imaging in nano-
scale topography (DNA-PAINT) microscopy. The small sizes of
these protein binders, relative to secondary antibodies, make
them an attractive labeling alternative for emerging super-
resolution techniques. We present here a labeling protocol for
DNA conjugation of bacterially derived proteins A and G for
DNA-PAINT, having assayed their intracellular performance by
targeting primary antibodies against tubulin, TOM20, and the
epidermal growth factor receptor (EGFR) and quantified the in-
creases in obtainable resolution.

Super-resolution microscopy is starting to become a standard
tool for cell biology research.[1] Several seminal discoveries that
were only feasible by surpassing the classical diffraction limit
of light have been made.[2] Recent technical advances in super-
resolution are providing sub-5 nm spatial resolution capabili-
ties,[3] so the size of the labeling probes is becoming increas-
ingly more important.

A popular branch of super-resolution techniques consists of
approaches based on the localization of single molecules.[4]

DNA-based point accumulation for imaging in nanoscale top-
ography (DNA-PAINT) is a variation of these single-molecule lo-
calization microscopy (SMLM) methods, in which the necessary
blinking behavior used for downstream super-resolution recon-

struction is mediated by the transient hybridization of short
dye-labeled oligonucleotides (“imager” strands), which interact
transiently with their complementary docking strands on the
target of interest.[5] DNA-PAINT possesses several advantages
over more traditional SMLM methods such as photoactivated
localization microscopy (PALM)[6] or stochastic optical recon-
struction microscopy (STORM).[7] These advantages are mainly
based on the fact that blinking in DNA-PAINT is decoupled
from the photophysical properties of dye molecules, thus al-
lowing for the use of bright and photostable dyes rather than
ones that efficiently photoswitch. Additionally, the target iden-
tity is encoded in the DNA sequence (a programmable probe),
similar to a molecular barcode. The binding interaction be-
tween imager and docking strands occurs only transiently, so
separate imaging rounds can be performed sequentially by
using different DNA species harboring the same fluorophore,
allowing for technically unlimited multiplexing.[5b]

However, for application of DNA-PAINT to a question in cell
biology, the docking strands need to be “linked” to the target
of interest through DNA-conjugated affinity reagents.[5b, 8] The
optimal labeling probe should ideally be smaller than the
target protein under investigation, allow for quantitative label-
ing (1:1 stoichiometry), be available for a large variety of tar-
gets, and ultimately be cost-effective. A multitude of small
binders for super-resolution microscopy have recently been in-
troduced, with nanobodies,[9] aptamer probes,[10] or other small
protein scaffolds[11] among them. Although these binders offer
great future promise, antibody-based affinity reagents are—for
many applications—still the preferred labels for many targets
of interest. This is mainly due to the fact that the available
probe library vastly exceeds those of any other available bind-
ers. However, monoclonal antibodies can be costly and some-
times unavailable in sufficient quantities to perform direct DNA
labeling. Immunostaining with secondary antibodies, on the
other hand, adds a large linkage error to the already rather
large size of a primary antibody. There is thus a need for small
secondary adapter binders.

Previously, nanobodies were reported to bind primary anti-
bodies from mouse and rabbit as host species for super-resolu-
tion microscopy.[12] Inspired by this, we introduce here the use
of DNA-conjugated bacterially derived protein A (molecular
weight 46 kDa) and protein G (molecular weight 22 kDa) mole-
cules as small binders for primary antibodies in combination
with DNA-PAINT super-resolution microscopy (Figure 1). Protei-
n A, derived from Staphylococcus aureus, has a high affinity to-
wards various mammalian immunoglobulin G (IgG) molecules
(e.g. , to IgG1 with ⇡10 nm) and binds to the Fc domain; how-
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ever, the binding varies for different species and IgG subclass-
es.[13] Protein G, derived from Streptococcus sp. , has a high af-
finity towards various different IgG subclasses from different
species, determined[14] in the case of rat IgG to be ⇡1 nm.
These two proteins are commonly used for antibody purifica-
tion[15] and have previously been applied in immunogold stain-
ing for electron microscopy,[16] as well as for the attachment of
antibodies to DNA nanostructures.[17] Thus, their small sizes
and high affinities make them ideal tools for super-resolution
microscopy and provide advantages over primary/secondary
antibody staining.

Different methods have been introduced to conjugate DNA
docking strands to protein-based affinity reagents. Typically, a
bifunctional chemical crosslinker harboring a reactive moiety
(which can subsequently react with a modified DNA oligo-
nucleotide) was used to react with amino groups or reduced
thiols.[3c, 8, 18] To produce DNA-modified secondary labeling re-
agents, protein A from Staphylococcus aureus and protein G
from Streptococcus sp. were conjugated to DNA-PAINT docking
strands in a two-step reaction sequence. First, proteins were al-
lowed to react with a trans-cyclooctene N-hydroxysuccinimidyl
ester (TCO-NHS) crosslinker and subsequently with commer-

cially available tetrazine-labeled DNA (Tz-DNA; see the Experi-
mental Section for details). Additionally, protein A and prote-
in G were labeled with NHS-Ester Alexa Fluor 647 for diffrac-
tion-limited imaging. To assess the general feasibility of our la-
beling approach, we first acquired confocal images of rat anti-
a-tubulin stained with protein G (labeled with an Alexa
Fluor 647 fluorophore) and rabbit anti-TOM20 protein A conju-
gates (also labeled with an Alexa Fluor 647 fluorophore) in
A549 cells (Figure S1 in the Supporting Information). These
immunofluorescence images clearly show specific microtubule
and mitochondrial staining, indicating that protein A and pro-
tein G can bind stably and specifically to primary rabbit and rat
antibodies, respectively. These results made us confident that
fluorescently labeled protein A and protein G could be used as
a replacement system for secondary antibodies for immuno-
staining and fluorescence imaging.

We then turned our attention to the DNA-conjugated secon-
dary binders as candidates for DNA-PAINT super-resolution mi-
croscopy. As an initial proof-of-concept demonstration for
DNA-PAINT imaging with these small bacterially derived bind-
ers, microtubules and TOM20 were chosen for proteins G and
A, respectively. Both targets (Figure 2) could be resolved with
DNA-PAINT, and the resulting images show features well below
the diffraction limit (see arrows in Figure 2 B, C). These datasets
are qualitatively similar in performance to typical secondary-
antibody-based DNA-PAINT data.[3c, 5c, 19]

Our first results confirmed that proteins G and A can be
used as secondary antibody substitutes: protein G for rat or
rabbit primary antibody targets and protein A for rabbit (Fig-
ure S2). We furthermore assayed binding of proteins A and G
to primary mouse antibodies and succeeded with specific la-
beling of epidermal growth factor receptor (EGFR) proteins
(Figure S3). A detailed overview of the possible binding part-
ners of proteins A and G that we have assayed in this study
can be found in Table S1. We also checked for potential non-
specific binding of proteins A and G to cellular targets without
primary antibody staining and did not find increased back-
ground signals (Figure S4).

Because we expected to observe measurable decreases in
the observed sizes of targets labeled with these proteins, rela-
tive to targets labeled with primary and secondary antibodies
(Figure 1 A), we next designed experiments to test this hypoth-
esis with DNA-PAINT imaging of EGF surface receptors. The
fact that these surface receptors are homogeneously distribut-
ed on cell surfaces makes them excellent test candidates for
super-resolution imaging. Recently, EGFRs were imaged by im-
munostaining with single-stranded DNA-based aptamers (SO-
MAmers) together with DNA-PAINT super-resolution microsco-
py to reveal their nanoscale distribution on the cell surface.[10a]

To image EGFRs by using our newly identified small proteins
and to compare this with primary and secondary antibody
imaging, A549 cells were fixed and immunostained by using a
monoclonal rabbit antibody against EGFRs. As expected, DNA-
PAINT super-resolution images of both staining procedures
(secondary antibodies and protein A binders) showed homoge-
neously distributed receptors on the cell surfaces (Figure 3 A–C
and H–J). Two nanoclusters that were spaced ⇡80 nm apart

Figure 1. Small bacterially derived protein adapters for DNA-PAINT. A) Sche-
matic representation of primary-/secondary-antibody-based labeling (left)
and small bacterially derived protein adapter labeling (right), highlighting
a decrease in overall label size (Modified from PDB IDs: 1FCC and 1IGT).
B) Schematic representation of the DNA-PAINT concept. Transient hybridiza-
tion of fluorophore-labeled single-stranded oligonucleotides to their com-
plementary target strands, conjugated to target binders, enables program-
mable super-resolution imaging.
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Figure 2. DNA-PAINT imaging with bacterially derived protein adapters. A) Microtubule overview super-resolution image in an A549 cell stained with protein G
as secondary binder for the rat anti-a-tubulin antibody. B), C) Zoom-ins on the dense microtubule network, in which individual microtubule tracks can be re-
solved in B) the DNA-PAINT image, but not in C) the diffraction-limited image (white arrows). D) Mitochondrion network stained with protein A as secondary
binder for rabbit anti-TOM20 antibody. Zoom-ins reveal E) mitochondrial cavities that could not be observed with F) diffraction-limited imaging. Scale bars:
A), D) 5 mm, B), C) 2 mm, E), F) 500 nm.

Figure 3. EGFR nanocluster imaging reveals a decrease in size with small bacterially derived protein adapters. A) Overview image of EGF receptors in A549
cells labeled with primary/secondary antibodies for DNA-PAINT. B), C) Zoom-ins on marked area in (A) show B) distribution of EGFR nanoclusters that are not
visible in C) diffraction-limited imaging. D), E) Zoom-ins on two nanoclusters ⇡80 nm apart. Left nanocluster shows a full-width half-maximum (FWHM) of
30 nm, right nanocluster a FWHM of 36 nm. F), G) Center-of-mass-aligned nanoclusters stained with primary/secondary antibodies from n = 25 788 EGFR nano-
clusters show a FWHM of 26 nm. H) Overview image of EGF receptors in A549 cells labeled with protein A against the primary rabbit anti-EGF receptor anti-
body. I), J) Zoom-ins on marked area in (H) reveal I) single spots that are not visible in J) the diffraction-limited imaging. K), L) Two nanoclusters are 43 nm
apart ; the left nanocluster reveals a FWHM of 13 nm, the right nanocluster a FWHM of 8.8 nm. M), N) Center-of-mass aligned image of EGF receptor nano-
clusters stained with the small bacterially derived secondary adapter protein A from n = 6567 spots shows a FWHM of 13 nm. Scale bars: A), H) 5 mm, B), C), I),
J) 1 mm, D) 50 nm, F) 10 nm, K) 25 nm, M) 10 nm.
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could be resolved (Figure 3 D, E), whereas, in comparison, two
nanoclusters only 43 nm apart could be visualized in the case
of the protein A staining (Figure 3 K, L). To quantify the size dis-
tributions of individual EGFR nanoclusters labeled with primary
and secondary antibodies, in relation to those labeled with pri-
mary antibodies and protein A as secondary adapters, we
aligned thousands of molecules to their center of mass and
measured the FWHM of the resulting distributions. The pri-
mary-/secondary-antibody-staining approach yielded a consid-
erably larger size distribution (FWHM = 26 nm) than the pro-
tein A labeled primary antibody approach (FWHM = 13 nm, Fig-
ure 3 F, G, M, N; see also Figure S5). These results demonstrate
that labeling based on protein A is superior to antibody-based
labeling in terms of reducing the linkage error in DNA-PAINT
imaging.

After the quantification of this reduction of artefacts from
secondary antibody-based labeling probes in comparison with
protein A labeling as secondary adapter, we investigated the
achieved reduction in linkage error further in a more challeng-
ing 3D imaging application. For this, microtubule structures
with—according to electron microscopy studies[20]—a diameter
of ⇡25 nm were chosen. A recent DNA-PAINT study demon-
strated that the coronas of labeling probes around micro-
tubule filaments can be resolved with super-resolution fluores-
cence microscopy as hollow 3D cylinders.[21] By employing this
biological system for 3D evaluation of our labeling approach,
the potential decrease in the surrounding labeling coronas
around single microtubule filaments as a function of the size
of the labeling probe was investigated (Figure 4). Both ap-
proaches (secondary antibodies and protein G) revealed the
expected coronas around the microtubules, but their diame-
ters were, as expected, different. For primary/secondary anti-
body staining, we obtained a diameter of 57 nm (Figure 4 D, E),
whereas the staining approach based on protein G resulted in
a considerably smaller diameter of 48 nm observed with 3D
DNA-PAINT microscopy (Figure 4 I, J). These results confirmed
that using staining based on protein G or protein A as secon-
dary labeling probes yields a smaller linkage error to the true
target position than secondary-antibody staining.

Additionally, we assayed the applicability of using proteins A
and G in a multiplexed DNA-PAINT imaging experiment. For
this, we preincubated DNA-coupled protein A with a primary
TOM20 rabbit antibody and DNA-coupled protein G with a pri-
mary microtubule rat antibody and removed excess protein A
and G binders from the coupled reagents. We then performed
simultaneous labeling of TOM20 and microtubules followed by
a two-round Exchange-PAINT[5b] experiment using two orthog-
onal Cy3b imager strands (Figure S6) and thus verified that
multiplexed imaging is indeed possible.

In conclusion, we have extended the use of bacterially de-
rived binders for immunoglobulins—namely proteins A and
G—as secondary binders for DNA-PAINT microscopy. The key
advantage of this approach is that proteins A and G are cost-
effective and commercially available in much larger quantities
than secondary antibodies or nanobodies. Additionally, their
small sizes allow for reduction of the linkage error to the true
target position as shown with EGF receptor and microtubule

imaging. In the future, these small secondary binders can be
evaluated for more species and IgG subclasses, as well as engi-
neered for higher affinity.[13b, 22] In addition, engineering of
these proteins to carry unique chemical groups such as cys-
teine or unnatural amino acid residues could be employed for
quantitative 1:1 labeling of protein to docking strands, which
would enable applications in the direction of quantitative
imaging such as quantitative points accumulation in nanoscale
topography (qPAINT).[23]

Experimental Section

Buffer reagents : Buffer C consisted of phosphate-buffered saline
(PBS; Thermo Fisher Scientific, cat. no. 20012-019, 1 î) mixed with
sodium chloride (500 mm) at pH 7.2. Oxygen scavenger system:
protocatechuate 3,4-dioxygenase (PCD)/protocatechuic acid (PCA)/
(⌃)-6-hydroxy-2,5,7,8-tetramethylchromane-2-carboxylic acid
(Trolox). PCD (Sigma–Aldrich, cat. no. P8279-25UN, 100 î) included
PCD (9.3 mg) dissolved in buffer [13.3 mL, glycerol stock (50 %) in
KCl (50 mm), EDTA (1 mm), Tris·HCl (100 mm), pH 8.0] . It was usually
stored as aliquots (20 mL) at ˇ20 8C. PCA (Sigma–Aldrich, cat. no.
37580-25G-F, 40 î) solution included PCA (154 mg) in H2O (10 mL)
and was adjusted to pH 9.0 with NaOH. It was stored as aliquots
(20 mL) at ˇ20 8C. Trolox (Sigma–Aldrich, cat. no. 238813-1G, 100 î)
solution included Trolox (100 mg), methanol (430 mL), and NaOH
(1 m, 345 mL) in H2O (3.2 mL) and was aliquoted in 20 mL batches
and stored at ˇ20 8C.

Protein A/G labeling through TCO-Tz conjugation : Protein A
(Thermo Fisher Scientific, cat. no. 21181) and protein G (Thermo
Fisher Scientific, cat. no. 21193) were aliquoted at 2.5 mg mLˇ1 in
1 î PBS and stored at ˇ20 8C. Conjugation of single-stranded DNA
to protein A or protein G was performed as described previously
for nanobodies.[18] In brief, DNA and proteins were cross-linked by
use of coupling between a trans-cyclooctene (TCO) and a methyl-
tetrazine (Tz). The Tz variant we used was a tetrazine-PEG5 (meth-
yltetrazine). The TCO variant we used was a TCO-NHS ester ((E)-
cyclooct-4-enyl-2,5-dioxo-1-pyrrolidinyl carbonate). TCO-NHS ester
crosslinker (Jena Bioscience, cat. no. CLK-1016-25) was added at
10 î molar excess in 5 mL to the protein, and incubation was car-
ried out for 2 h at 4 8C on a shaker. Crosslinker aliquots were
stored at 10 mg mLˇ1 in DMF (Thermo Fisher Scientific, cat. no.
20673). Subsequently, Zeba spin desalting columns (Thermo Fisher
Scientific, cat. no. 89882) were used to remove unreacted crosslink-
er, and Tz-DNA was added at fivefold molar excess for 1 h at 20 8C.
The final product was buffer-exchanged with 10 kDa Amicon spin
filters (Merck, cat. no. UFC501096) and used for immunostaining at
a concentration of 10 mg mLˇ1.

Protein A/G conjugation with Alexa Fluor 647 NHS ester: Protei-
n A/G was conjugated with Alexa Fluor 647 NHS ester (Thermo
Fisher Scientific, cat. no. A20006) in tenfold molar excess for 2 h at
4 8C on a shaker. Conjugated construct was purified from the free
fluorophore with 10 kDa Amicon spin filters (Merck, cat. no.
UFC501096).

Antibody–DNA conjugation : DNA-labeled antibodies were pre-
pared as previously reported.[3c] Secondary donkey anti-rat anti-
body (cat. no. 711-005-152, Jackson ImmunoResearch, 1 mg mLˇ1,
300 mL) was concentrated with 100 kDa Amicon spin filters (cat. no.
UFC500396, Merck/EMD Millipore), and the volume was adjusted
to 100 mL in PBS (1 î). A tenfold molar excess over antibody of mal-
eimide-PEG2-succinimidyl ester crosslinker (Sigma–Aldrich, cat. no.
746223) in DMF (5 mL) was added to the antibody (100 mL), and the
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reaction was allowed to proceed for 90 min at 4 8C on a shaker in
the dark. Afterwards excess crosslinker was removed with zeba
desalting spin columns (cat. no. 89882, Thermo Fisher Scientific).
Meanwhile, thiol-DNA (1 mm dissolved in H2O, 30 mL) was added to
dithiothreitol (DTT; cat. no. 20291, Thermo Fisher Scientific,
250 mm, 70 mL) and reduced for 2 h at room temperature on a
shaker in the dark. A Nap5 column (cat. no. 17-0853-02, GE Health-

care) was used to remove DTT from reduced DNA, and peak frac-
tions were pooled and concentrated with Amicon spin filters (cat.
no. UFC500396, Merck/EMD Millipore, 3 kDa). DNA (10 î molar
excess) was added to the antibody–crosslinker construct, and incu-
bation was carried out overnight at 4 8C on a shaker in the dark.
Amicon spin filters (100 kDa) were used to remove excess DNA,
and the antibody was adjusted to 100 mL in PBS (1 î) and stored

Figure 4. 3D imaging of microtubules reveals a decrease in diameter with small secondary labeling adapters. A) Overview image of stained rat anti-microtu-
bule labeled with protein G. Color encodes for the Z-height. B) Zoom-in on area highlighted in (A) shows a closer view of the microtubule organization.
C) Cross-sectional view through a microtubule stretch highlighted in (B). D) Cross-sectional view of an average of five microtubules. E) A ring-fit of the average
microtubule cylinder shows a diameter of 48 nm (radius 24 nm). F) Overview image of primary-/secondary-antibody-labeled microtubules. G) Zoom-in on area
highlighted in (F) shows a closer view of the microtubule architecture. H) Microtubule cross-section of highlighted area in (G). I) Cross-sectional view of aver-
age of five microtubules. J) An analysis of the diameter of the primary-/secondary-antibody-stained microtubules shows an increased diameter of 57 nm
(radius 28.5) in comparison with the small bacterially derived secondary labeling probe. Scale bars : A), F) 10 mm, B), G) 1 mm, C), D), H), I) 50 nm.
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for further use at 4 8C. Final usage concentration was 10 mg mLˇ1.
Secondary anti-rat antibody was conjugated to the P1 handle. DNA
handle and imager sequences can be found in Tables S2 and S3, re-
spectively.

Cell culture : A549 cells (ATCC, cat. no. CRL-1651) or HeLa cells
(Leibniz Institute DSMZ, Catalogue of Human and Animal Cell
Lines(http://www.dsmz.de), cat. no. ACC-57) were passaged every
other day and used between passage number 5 and 20. The cells
were maintained in Dulbecco’s modified Eagle’s medium (DMEM;
Thermo Fisher Scientific, cat. no. 10566016) supplemented with
fetal bovine serum (Thermo Fisher Scientific, cat. no. 10500-064,
10 %) and penicillin/streptomycin (Thermo Fisher Scientific, cat. no.
15140-122, 1 %). Passaging was performed with PBS (1 î) and tryp-
sin-EDTA (Thermo Fisher Scientific, cat. no. 25300-054, 0.05 %). Cells
were seeded 24 h before immunostaining on ibidi eight-well glass
coverslips (ibidi, cat. no. 80827) at 30 000 cells/well. For optimized
microtubule imaging, prefixation was performed with prewarmed
glutaraldehyde (SERVA, cat. no. 23115.01, 0.4 %) and Triton X-100
(Carl Roth, cat. no. 6683.1, 0.25 %) for 90 s. Main fixation was per-
formed with use of glutaraldehyde (3 %) for 15 min. For imaging of
mitochondria, cell-surface receptors, and microtubule networks,
paraformaldehyde (PFA, 3 %) and glutaraldehyde (0.1 %) fixation as
main fixation without prefixation was performed for 15 min. After-
wards, reduction was carried out with sodium borohydride (Carl
Roth, cat. no. 4051.1, 1 mg mLˇ1) in PBS (1 î) followed by one brief
PBS (1 î) rinse and 3 î 5 min washing with PBS (1 î). Blocking and
permeabilization were done for 90 min with sterile filtered bovine
serum albumin (BSA Sigma–Aldrich, cat. no. A4503-10g, 3 %, w/v)
and Triton X-100 (0.25 %, v/v) in PBS (1 î) at room temperature.
Cells were stained with primary antibodies against tubulin (Thermo
Fisher Scientific, cat. no. MA1-80017) or EGFR (Cell Signaling, cat.
no. 4267S or Thermo Fisher Scientific, cat. no. MA5-13319) together
with protein A or protein G overnight on the sample in sterile
filtered BSA (3 %, w/v) in PBS (1 î) on a shaker at 4 8C. Cells were
washed 3 î for 5 min in PBS (1 î). For secondary antibody staining,
cells were additionally incubated with DNA-labeled anti-rat or anti-
rabbit for 1 h at room temperature and afterwards washed for 3 î
5 min in PBS (1 î). For drift correction purposes, cells were incubat-
ed with gold particles (cytodiagnostics, cat. no. G-90-100, 1:10 dilu-
tion of 90 nm) in PBS (1 î), washed 3 î quickly, and immediately
imaged.

Super-resolution microscopy setup : DNA-PAINT was carried out
with an inverted Nikon Eclipse Ti microscope (Nikon Instruments)
and the Perfect Focus System, by applying an objective-type total
internal reflection fluorescence (TIRF) configuration with an oil-
immersion objective (Apo SR TIRF 100 î , NA 1.49, oil). Two lasers
were used for excitation: 561 nm (200 mW, Coherent Sapphire) or
488 nm (200 mW, Toptica iBeam smart). The laser beam was
passed through a cleanup filter (ZET488/10x or ZET561/10x,
Chroma Technology) and coupled into the microscope objective
with use of a beam splitter (ZT488rdc or ZT561rdc, Chroma Tech-
nology). Fluorescence light was spectrally filtered with two emis-
sion filters (ET525/50m and ET500lp for 488 nm excitation and
ET600/50 and ET575lp for 561 nm excitation, Chroma Technology)
and imaged with a sCMOS camera (Andor Zyla 4.2) without further
magnification, resulting in an effective pixel size of 130 nm after
2 î 2 binning. Astigmatism for 3D imaging was introduced with the
commercially available N-STORM adapter (Nikon Instruments). A
second setup was interchangeably used for DNA-PAINT imaging
consisting of an inverted Nikon Eclipse Ti 2 microscope (Nikon In-
struments) with the Perfect Focus System, by applying an objec-
tive-type TIRF configuration with an oil-immersion objective (Apo

SR TIRF 100 î , NA 1.49, oil). For excitation, a 560 nm laser (2 W,
MPB Communication, Inc.) was coupled into a single-mode fiber.
The beam was coupled into the microscope body by use of a com-
mercial TIRF Illuminator (Nikon Instruments). The laser beam was
passed through a cleanup filter (ZET561/10x, Chroma Technology).
The beam splitter (ZT561rdc, Chroma Technology) was used. Fluo-
rescence light was spectrally filtered with two emission filters
(ET600/50 and ET575lp for 561 nm excitation, Chroma Technology)
and imaged with a sCMOS camera (Andor Zyla 4.2) without further
magnification, resulting in an effective pixel size of 130 nm after
2 î 2 binning. Astigmatism for 3D imaging was introduced with an
N-STORM Adapter (Nikon Instruments). Imaging parameters can be
found in Table S4.

Confocal setup : The confocal imaging was performed at the Imag-
ing Facility of the Max Planck Institute of Biochemistry, Martinsried,
with a ZEISS (Jena, Germany) LSM780 confocal laser scanning mi-
croscope equipped with a ZEISS Plan-APO 63 î /NA 1.46 oil immer-
sion objective.

DNA-PAINT super-resolution microscopy : Cells were imaged with
use of ⇡3 kW cmˇ2 561 nm laser excitation. Imager strand concen-
tration varied depending on the measurement from 200 pm to
800 pm Cy3B-P1 and was adjusted to minimize double-binding
events. Imaging was performed in PCA (Sigma–Aldrich, cat. no.
37580-25G-F, 1 î)/PCD (Sigma–Aldrich, cat. no. P8279-25UN, 1 î)/
Trolox (Sigma–Aldrich, cat. no. 238813-1G, 1 î) in buffer C [PBS
(1 î) + NaCl (500 mm)] with imaging for 10 000–50 000 frames at
100–250 ms exposure time (see also Table S3). 3D imaging was per-
formed by using an astigmatism lens in the detection path.

Multiplexed imaging with exchange-PAINT: P5-conjugated prote-
in G was incubated overnight with primary microtubule rat anti-
body, whereas P1-conjugated protein A was incubated (separately)
overnight with primary TOM20 rabbit antibody. Unbound protein A
or protein G from the coupled reagents was removed by centrifu-
gal filtration with MWCO spin filters (Merck, cat. no. UFC500396,
100 kDa). The coupled reagents were then incubated together
with fixed A549 cells for one hour for immunostaining of microtu-
bules and TOM20. The cells were then washed thoroughly with
PBS to remove excess protein A/G and antibody reagents and
post-fixed with PFA (3 %). The cells were imaged by DNA-PAINT
super-resolution microscopy in two rounds with a buffer wash in-
between. In round 1 we imaged microtubules by using Cy3B-P5
(1.5 nm). After washing off free Cy3B-P5, we then introduced Cy3B-
P1 (2 nm) to image TOM20.

Image data analysis : Images were reconstructed with the Picasso
and SMAP Software Suite. Drift correction was performed with a re-
dundant cross-correlation and/or gold particles as fiducials. Locali-
zation precision was determined through a NeNA analysis.[24]
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Supplementary Figure 1 | Confocal imaging of bacterial-derived secondary antibody adapters. a-c) Microtubule network stained 
with AF647-labeled protein G against primary rat anti-a-tubulin antibody. d-f) Mitochondrial network stained with AF647-labeled 
protein A against primary rabbit anti-Tom20 antibody. Scale bars, 10 µm. 
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Supplementary Figure 2 | Imaging rabbit anti-TOM20 with protein G and rat anti-alpha tubulin with protein A. a) DNA-
conjugated protein G imaging as secondary probe for rabbit anti-TOM20 reveals mitochondrial structure. This data shows that 
protein G can be used as a secondary binder against primary rabbit antibody. b) DNA-conjugated protein A imaging as secondary 
probe for rat anti-microtubule does not exhibit any specific staining pattern. Protein A cannot be used as secondary binders for 
rat IgG2a antibodies. Scale bars, 5 µm. 
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Supplementary Figure 3 | Mouse anti-EGFR receptor imaging with protein A/G in A549 cells. a) Imaging with DNA-conjugated 
protein A as secondary binder. b) Imaging with DNA-conjugated protein G as secondary binder. Protein A/G can be used as a 
secondary binder against mouse primary IgG2a antibodies. Scale bars, 5 µm. 
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Supplementary Figure 4 | Control experiments without any primary antibodies in A549 cells. a) P1 imager strand only added to 
cells. b) P3 imager only added to cells. c) DNA-labeled (P1 docking strand) protein G staining only imaged with P1 imager strand.  
d) DNA-labeled (P1 docking strand) protein A staining only imaged with P1 imager strand. We do not see any non-specific labeling 
of cellular structures with protein A/G or the DNA imager strands in the absence of primary antibodies. Scale bars, 5 µm. 
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Supplementary Figure 5 | EGF receptor nanoclusters imaged with different binders. a) Individual EGF receptor nanoclusters 
stained with protein A against rabbit anti-EGFR antibody. b) Individual EGF receptor nanoclusters stained with primary-secondary 
antibody sandwich. Individual nanoclusters selected from data from Figure 3. Scale bars, 200 nm. 

 
 
 
 
 

 
 
Supplementary Figure 6 | Exchange-PAINT imaging in A549 cells. a) Microtubule imaging with DNA-labeled protein G against 
primary rat anti-microtubule reveals the filamentous structure. b) TOM20 imaging with DNA-labeled protein A against primary 
rabbit anti-TOM20 reveals the mitochondrial network. c) Overlay of microtubule imaging and TOM20. Scale bars, 5 µm. 
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Supplementary Table 1 | Binding of Protein A/G to Antibody Species 

Primary Antibody Species (subclass) Protein A Protein G 

Rabbit (n.a.) + + 

Rat (IgG2a) - + 

Mouse (IgG2a) + + 

 
 
Supplementary Table 2 | Docking sequences 

Sequence name Sequence 5’-mod 3’-mod Vendor 

P1 TTATACATCTA  TZ None Biomers.net 

P3 TTTCTTCATTA TZ None Biomers.net 

P5 TTTCAATGTAT TZ None Biomers.net 

 

 

Supplementary Table 3 | Imager sequences 

Sequence name Sequence 5’-mod 3’-mod Vendor 

P1* CTAGATGTAT None Cy3b Eurofins Genomics 

P3* GTAATGAAGA None Cy3b Eurofins Genomics 

P5* CATACATTGA None Cy3b Eurofins Genomics 
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Supplementary Table 4 | Imaging parameters 

Dataset Parameters  
Laser power 

@561 nm 

Localization 

precision (NeNA) 

Microscope 

Figure 2a 100 ms, 2D, 50k Frames, 1.5 nM, P3* 2 kW/cm2 4.6 nm Setup 1 

Figure 2d 100 ms, 2D, 40k Frames, 2 nM, P1* 1.5 kW/cm2 5.6 nm Setup 1 

Figure 3a 100 ms, 2D, 30k Frames, 0.5 nM, P3* 1.5 kW/cm2 4.5 nm Setup 2 

Figure 3h 100 ms, 2D, 30k Frames, 0.5 nM, P3* 1.5 kW/cm2 4.7 nm Setup 2 

Figure 4a 250 ms, 3D, 60k Frames, 1 nM, P5*  3.3 kW/cm2 3.4 nm Setup 1 

Figure 4f 250 ms, 3D, 20k Frames, 200 pM, P1* 3.3 kW/cm2 2.6 nm 
Setup 1 

 

Supplementary 

Figure 2a 
100 ms, 2D, 40k, 5 nM, P1* 1.5 kW/cm2 7.9 nm 

Setup 1 

Supplementary 

Figure 2b 
100 ms, 2D, 2.5k, 5 nM, P3* 1.5 kW/cm2 n.a. 

Setup 1 

 

Supplementary 

Figure 3a 
100 ms, 2D, 50k, 5 nM, P5* 1.5 kW/cm2 6 nm 

Setup 1 

Supplementary 

Figure 3b 
100 ms, 2D, 40k, 5 nM, P1* 1.5 kW/cm2 5.4 nm 

Setup 1 

Supplementary 

Figure 4 
100 ms, 2D, 2.5k, 5 nM, P1*/P3* 1.5 kW/cm2 n.a. 

Setup 1 

Supplementary 

Figure 6a 
100 ms, 2D, 50k, 1.5 nM, P5* 1.5 kW/cm2 7.1 nm 

Setup 1 

Supplementary 

Figure 6b 
100 ms, 2D, 30k, 2 nM, P1* 1.5 kW/cm2 5.5 nm 

Setup 1 
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Direct Visualization of Single Nuclear Pore Complex Proteins Using
Genetically-Encoded Probes for DNA-PAINT
Thomas Schlichthaerle+, Maximilian T. Strauss+, Florian Schueder+, Alexander Auer,
Bianca Nijmeijer, Moritz Kueblbeck, Vilma Jimenez Sabinina, Jervis V. Thevathasan, Jonas Ries,
Jan Ellenberg, and Ralf Jungmann*

Abstract: The nuclear pore complex (NPC) is one of the
largest and most complex protein assemblies in the cell and,
among other functions, serves as the gatekeeper of nucleocy-
toplasmic transport. Unraveling its molecular architecture and
functioning has been an active research topic for decades with
recent cryogenic electron microscopy and super-resolution
studies advancing our understanding of the architecture of the
NPC complex. However, the specific and direct visualization of
single copies of NPC proteins is thus far elusive. Herein, we
combine genetically-encoded self-labeling enzymes such as
SNAP-tag and HaloTag with DNA-PAINT microscopy. We
resolve single copies of nucleoporins in the human Y-complex
in three dimensions with a precision of circa 3 nm, enabling
studies of multicomponent complexes on the level of single
proteins in cells using optical fluorescence microscopy.

Super-resolution techniques allow diffraction-unlimited
fluorescence imaging[1] and with recent advancements, true
biomolecular resolution is well within reach.[2] One imple-
mentation of single-molecule localization microscopy
(SMLM) is called DNA points accumulation in nanoscale
topography[2b] (DNA-PAINT), where dye-labeled DNA
strands (called “imager” strands) transiently bind to their
complements (called “docking” strands) on a target of
interest, thus creating the typical “blinking” used in SMLM
to achieve super-resolution. While localization precisions
down to approximately one nanometer (basically the size of

a single dye molecule) are now routinely achievable from
a technology perspective, this respectable spatial resolution
has yet to be translated to cell biological research. Currently,
this is mainly hampered by the lack of small and efficient
protein labels. Recent developments of nanobody- or apta-
mer-based tagging approaches[3] are providing an attractive
route ahead, however both approaches are not yet deploying
their full potential either due to limited binder availability (in
the case of nanobodies) or lack of large-scale analysis of
suitable super-resolution probes (in the aptamer case).

While we are convinced that some of these issues might be
resolved in the future, we introduce herein the combination of
widely-used, genetically-encoded self-labeling enzymes such
as SNAP-tag[4] and HaloTag[5] with DNA-PAINT to enable
1:1 labeling of single proteins in the nuclear pore complex
(NPC) using ligand-conjugated DNA-PAINT docking
strands. The NPC is responsible for the control of nucleocy-
toplasmic transport and a highly complex and sophisticated
protein assembly. NPCs contain multiple copies of approx-
imately 30 different nuclear pore proteins called nucleoporins
(NUPs) and have an estimated total molecular mass of about
120 MDa, placing NPCs among the largest cellular protein
complexes.[6] Owing to their diverse function in controlling
molecular transport between the nucleus and the cytoplasm,
NPCs are a major target for structural biology research with
characterization by for example, cryogenic electron micros-
copy[6] (cryo-EM) or optical super-resolution techniques.[7]

State-of-the-art cryo-EM studies,[8] reaching impressive
pseudo-atomic resolution, have advanced our structural
understanding in recent years. It is now possible to not only
elucidate how NUPs in NPCs are arranged, but also to shed
light on how structural changes of NPCs are connected to
their dysfunction.[9] However, even with recent advancements
in cryo-EM instrumentation, molecular specificity necessary
to resolve single NUPs in NPCs proves still elusive, mainly
due to the lack of high protein-specific contrast. Fluores-
cence-based techniques on the other hand offer exquisite
molecular contrast and specificity owing to the use of dye-
labeled affinity reagents targeting single protein copies in
cells. However, until recently, the necessary resolution to
spatially resolve single small proteins in a larger complex has
not been achieved because of limitations in labeling (small
and efficient probes) and imaging technology (providing sub-
10-nm spatial resolution). In order to spatially resolve sub-10-
nm distances using SMLM, one needs to obtain a localization
precision of circa 4 nm. This is readily achievable with DNA-
PAINT, as a comparably large number of photons is available
for localization per single binding—that is, blinking—event.
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While one can easily reach tens of thousands of photons per
blinking event with DNA-PAINT, this is hard to achieve using
STORM. Furthermore, the intrinsic resistance of DNA-
PAINT to photobleaching enables repetitive localizations
with high precision, while in the STORM case, the available
photon budget is limited by a few fixed, target-bound
fluorophores. Herein, we thus combine DNA-PAINT micros-
copy with small, genetically-encoded self-labeling enzymes
such as SNAP- and HaloTag to overcome limitations in
optical super-resolution microscopy.

We present a straightforward protocol to target these tags
in a variety of engineered cell lines using the DNA-
conjugated ligands benzylguanine (BG) and chloroalkane
against SNAP-tag[4] and HaloTag,[5] respectively (Figure 1a
and b). We investigate the achievable labeling precision and
reduction of linkage error of SNAP-tag and HaloTag,
examine their performance in contrast to DNA-conjugated
nanobodies against GFP-tagged proteins in single NPCs and
further compare them to primary and secondary antibody
labeling. Finally, we resolve, for the first time, single copies of
NUP96 proteins in the Y-complex of the NPC, spaced only
circa 12 nm apart.

To implement genetically-encoded self-labeling tags for
DNA-PAINT, we first assayed our ability to use BG-modified
docking strands to target SNAP-tags C-terminally fused to
NUP96 proteins in U2OS cell lines created by CRISPR/Cas9

engineering.[10] Labeling was performed post-fixation and
-permeabilization using standard labeling protocols[7b]

adapted for DNA-PAINT (see Online Methods). The result-
ing 2D DNA-PAINT image is shown in Figure 1c. A zoom-in
reveals the expected 8-fold symmetry of NUP96 proteins in
the super-resolution micrograph (Figure 1d). We then per-
formed labeling of NUP107-GFP fusion proteins using
a DNA-conjugated anti-GFP nanobody[11] and obtained
qualitatively similar results (Figure 1e–f, see also Supplemen-
tary Figure 1 in the Supporting Information for zoom-outs
and comparison to diffraction-limited data).

To evaluate labeling quality and precision in a quantitative
manner, we next compared results of more traditional
labeling of NUP107-GFP using primary-secondary antibodies
to those of NUP96-SNAP, NUP96-Halo, NUP107-SNAP, and
NUP107-GFP cell lines targeted with their respective small
ligands. The NPC architecture presents a well-suited model to
benchmark novel labeling approaches with regards to overall
labeling efficiency and limits of spatial resolution, in a sense
similar to an in vitro DNA origami calibration standard,[12] but
inside a cell. Previous EM studies revealed that NUP96 and
NUP107 proteins are present in the Y-complex, which forms
the cytoplasmic as well as nuclear NPC double ring arrange-
ment in an 8-fold symmetry. The two double rings are spaced
approximately 50 nm apart with each side containing 16
protein copies.[8a, 13] The two copies of the proteins in each

Figure 1. a) Comparison of different labeling probes (secondary antibody: yellow, GFP nanobody: green, HaloTag: magenta, SNAP-tag: blue)
conjugated with DNA strands for DNA-PAINT imaging (cartoons are based on protein database (PDB) entries: Secondary antibody (1IGT), GFP
nanobody (3K1K), HaloTag (4KAF), SNAP-tag (3KZZ)). Proteins are to scale. b) NPCs contain 16 copies of NUP96 and NUP107 in the
cytoplasmic as well as the nuclear ring. Top right: C-terminally-labeled (blue, highlighted by green arrows) NUP96 structure (orange) highlighted
in the zoom-in of a symmetry center on the ring (ca. 12 nm apart). Bottom right: N-terminally-labeled (blue, highlighted by green arrows),
NUP107 structure (orange) in the zoom-in of a symmetry center on the ring (ca. 12 nm apart). Distances and cartoons derived from PDB entry:
Nup(5A9Q). c) DNA-PAINT overview image of NUP96-SNAP in U2OS cells. d) Zoom-in of highlighted area reveals the arrangement of NUP96 in
NPCs. e) DNA-PAINT overview image of NUP107-GFP in HeLa cells. f) Zoom-in of highlighted area. Scale bars: 5 mm (c, e), 100 nm (d, f).
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symmetry center are arranged in Y-complexes spaced circa
12 nm apart (Figure 1b). In order to quantitatively compare
different labeling approaches, we first acquired 2D DNA-
PAINT data using identical image acquisition parameters (see
Supplementary Tables 1–3 in the Supporting Information for
details). Next, we selected single NPC structures in the
reconstructed super-resolution image, aligned them on top of
each other (that is, the center of the NPC rings, thus creating
a sum image) and performed a radial distance measurement
over all localizations. This analysis yields two observables for
comparison; first, the median fitted ring radius and second,
the width of this distribution. Dissimilar fitted radii for the
same protein labeled using different tags are a measure for
potential systematic biases introduced by a preferential
orientation of the labeling probes. The width of the distribu-
tion on the other hand is a proxy for label-size-induced
linkage error, that is, broader distributions originate from
“larger” labeling probes. Our data in Figure 2 provides
a quantitative comparison of NUP107-SNAP, NUP107-GFP,
NUP96-SNAP, and NUP96-Halo cell lines targeted with their
respective DNA-conjugated labeling probes (see also Sup-
plementary Figures 2–6 in the Supporting Information).
Furthermore, we compare our results with NUP107-GFP
labeled using primary and DNA-conjugated secondary anti-
bodies. We obtained radii of 53.7⌃ 13.1 nm for NUP107-
SNAP (Figure 2a and Supplementary Figure 2 in the Sup-

porting Information) and 54.6⌃ 11.9 nm for NUP107-GFP
(nanobody staining) (Figure 2b and Supplementary Figure 3
in the Supporting Information), as well as 55.9⌃ 12.6 nm for
NUP96-SNAP (Figure 2c and Supplementary Figure 4 in the
Supporting Information) and 56.2⌃ 10.2 nm for NUP96-Halo
(Figure 2d and Supplementary Figure 5 in the Supporting
Information), in close overall agreement to earlier EM- and
fluorescence-based studies.[7b, 8a] For the antibody-stained
sample against NUP107-GFP (Figure 2e and Supplementary
Figure 6 in the Supporting Information), we obtained a con-
siderably larger radius of 65.9 nm. This could be explained by
primary and DNA-conjugated secondary antibodies poten-
tially binding preferentially towards the outside of the NPCs.
However, not only did the antibody-stained samples yield
a larger apparent NPC radius, also the measured width of the
distribution (18 nm) was larger compared to the genetically-
encoded tags due to the increased size of the antibodies. In the
case of genetically-encoded tags, the width of the distributions
is considerably smaller (see also Supplementary Table 4 in the
Supporting Information) due to the reduced linkage error to
the actual protein location.[3c,e,14]

Next, we sought out to further optimize image acquisition
conditions with respect to overall localization precision,
sampling of single protein sites, and three-dimensional
image acquisition (Supporting Information, Supplementary
Figure 7). This allowed us to visualize single copies of NUP96

Figure 2. a) NUP107-SNAP overview image (left). Zoom-in to individual NPCs and sum image (n = 398) (right). b) NUP107-GFP nanobody
overview image (left). Zoom-in to individual NPCs and sum image (n = 486) (right). c) NUP96-SNAP overview image (left). Zoom-in to individual
NPCs and sum image (n =288) (right). d) NUP96-Halo overview image (left). Zoom-in to individual NPCs and sum image (n =191) (right).
e) NUP107-GFP-Antibody overview image (left). Zoom-in to individual NPCs and sum image (n = 185) (right). f) Violin plots of the distances
between ring center and localizations. Median radii and standard deviation were obtained for each label: NUP107-SNAP (from a, 127773 fitted
localizations, 53.7⌃13.1 nm radius), NUP107-GFP (from b, 219398 fitted localizations, 54.6⌃11.9 nm radius), NUP96-SNAP (from c, 57297
fitted localizations, 55.9⌃12.6 nm), NUP96-Halo (from d, 45143 fitted localizations, 56.2⌃10.2 nm radius), NUP107-GFP-Anitbody (from e,
69834 fitted localizations, 65.9⌃17.5 nm). See also Supplementary Table 2 in in the Supporting Information. Scale bars: 500 nm (overviews),
100 nm (individual NPCs and sum image).
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proteins (Figure 3) using the NUP96-Halo cell line, which we
chose based on its superior performance in the 2D study
presented above (smallest distribution width). An overview of
a typical 3D DNA-PAINT dataset is shown in Figure 3a.
Zooming in to some of the NPCs (Figure 3 b) reveals
distinctive pairs of close-by “localization clouds” (arrows in
Figure 3b), which we attribute to single NUP96 proteins. To
quantitatively asses the Euclidian distance of the two copies
of NUP96 on the two cytoplasmic or nuclear rings of the NPC,
we selected about 50 pairs in NPCs, aligned them on top of
each other and subsequently carried out particle averaging
with Picasso.[2b, 15] We then performed a cross-sectional histo-
gram analysis of the resulting sum image and fitted the
distribution with two Gaussian functions (Figure 3c). The fit
yields a peak-to-peak distance of about 12 nm, well in
agreement with the expected distance of NUP96 proteins on
adjacent Y-complexes as derived from EM models.[8a] Fur-
thermore, each peak fit exhibits a standard deviation of only
circa 3 nm, highlighting the high localization precision and
accuracy achievable with the combination of genetically-
encoded tags with DNA-PAINT. Additionally, we measured
the separation between the cytoplasmic and the nuclear rings
for NUP96-Halo, yielding a distance of about 61 nm (Fig-
ure 3d), which we could clearly resolve. The capability to
separate the nuclear from the cytoplasmic side of the NPC is
a necessity to convince us, that the NUP pairs in each
symmetry center (Figure 3b and c) are indeed part of either
the nuclear or cytoplasmic rings of the NPC. Furthermore, we
obtained qualitatively and quantitatively similar results for

the NUP96-SNAP cell line (Supporting Information, Supple-
mentary Figure 8).

In conclusion, we present an approach to combine DNA-
PAINT with genetically-encoded self-labeling tags. This
provides a tool to investigate single proteins in higher order
protein complexes in cells. However, we could only achieve
a relatively modest labeling efficiency of approximately 30%
(Supporting Information, Supplementary Table 5). Thus, one
of the main challenges in the field remains, which is a route to
highly efficient labeling probes (> 90% labeling efficiency)
without requiring genetic engineering. Besides the availability
of peptide tags combined with nanobodies[16] and small
scaffolds like nanobodies,[3a] affimers,[17] darpins,[18] or
SOMAmers[19] novel approaches are necessary to tackle this
challenge. Probes could include optimized host–guest sys-
tems,[20] direct transient binders,[21] or rationally-designed
small proteins.[22] However, even with our current labeling
efficiency, studies of single proteins in multicomponent
complexes are within reach.

Acknowledgements

We thank Bianca Sperl for experimental support. We thank
Sandra Correia for assistance with generating the cell lines.
This work has been supported in part by the German
Research Foundation through the Emmy Noether Program
(DFG JU 2957/1-1 to R.J.), the SFB1032 (project A11 to R.J.),
the European Research Council through an ERC Starting

Figure 3. a) Overview image of NUP96-Halo imaged using 3D DNA-PAINT (color indicates height, range: ˇ200 (blue) to 200 nm (red)).
b) Selection of single NPCs. Arrows are highlighting two copies of NUP96 proteins in the same symmetry center of the same ring (that is at the
same height) spaced ca. 12 nm apart from each other (color indicates height, range: ˇ100 (blue) to 100 nm (red)). c) Cross-sectional histogram
of 3D-summed pairs (n =45) of NUP96 proteins in single symmetry centers as highlighted by arrows in b yields ca.12 nm distance between single
proteins. d) NUP96-Halo-labeled NPCs show the typical eightfold symmetry (xy-projection, left) and the organization in nuclear and cytoplasmic
rings (xz-projection, right). Micrographs represent sum data from aligned NPCs (n= 31). Bottom: Cross-sectional histogram of localizations in
the xz-projection yields ca. 61 nm separation between cytoplasmic and nuclear rings. Scale bars: 2 mm (a), 50 nm (b, d).

Angewandte
ChemieCommunications

13007Angew. Chem. Int. Ed. 2019, 58, 13004 –13008 ⌫ 2019 The Authors. Published by Wiley-VCH Verlag GmbH & Co. KGaA, Weinheim www.angewandte.org



 
  8 Appendix 
 

   181 

 

Grant (MolMap; grant agreement number 680241 to R.J.) and
an ERC Consolidator Grant (ERC CoG-724489 to J.R.), the
Allen Distinguished Investigator Program through The Paul
G. Allen Frontiers Group (to J.E. and R.J.), the National
Institutes of Health Common Fund 4D Nucleome Program
(Grant U01 EB021223/ U01 DA047728 to J.E. and J.R.), the
European Molecular Biology Laboratory (EMBL; B.N.,
M.K., V.J.S., J.V.T., J.R., and J.E.), the Max Planck Founda-
tion (to R.J.) and the Max Planck Society (to R.J.). T.S. and
A.A. acknowledge support by the QBM graduate school.
M.T.S. acknowledges support from the International Max
Planck Research School for Molecular and Cellular Life
Sciences (IMPRS-LS). V.S.J. acknowledges support by the
Boehringer Ingelheim Fonds. The cell lines are available via
Cell Line Services (CLS, clsgmbh.de).

Conflict of interest

The authors declare no conflict of interest.

Keywords: DNA-PAINT · genetically encoded tags ·
nuclear pore complex · single-molecule imaging ·
super-resolution microscopy

How to cite: Angew. Chem. Int. Ed. 2019, 58, 13004–13008
Angew. Chem. 2019, 131, 13138–13142

[1] a) S. J. Sahl, S. W. Hell, S. Jakobs, Nat. Rev. Mol. Cell Biol. 2017,
18, 685 – 701; b) M. Sauer, M. Heilemann, Chem. Rev. 2017, 117,
7478 – 7509.

[2] a) M. Dai, R. Jungmann, P. Yin, Nat. Nanotechnol. 2016, 11, 798 –
807; b) J. Schnitzbauer, M. T. Strauss, T. Schlichthaerle, F.
Schueder, R. Jungmann, Nat. Protoc. 2017, 12, 1198 – 1228;
c) F. Balzarotti, Y. Eilers, K. C. Gwosch, A. H. Gynna, V.
Westphal, F. D. Stefani, J. Elf, S. W. Hell, Science 2017, 355,
606 – 612.

[3] a) J. Ries, C. Kaplan, E. Platonova, H. Eghlidi, H. Ewers, Nat.
Methods 2012, 9, 582 – 584; b) S. Sograte-Idrissi, N. Oleksiievets,
S. Isbaner, M. Eggert-Martinez, J. Enderlein, R. Tsukanov, F.
Opazo, Cells 2019, 8, 48; c) F. Opazo, M. Levy, M. Byrom, C.
Schafer, C. Geisler, T. W. Groemer, A. D. Ellington, S. O.
Rizzoli, Nat. Methods 2012, 9, 938 – 939; d) V. Fabricius, J.
Lefõbre, H. Geertsema, S. F. Marino, H. Ewers, J. Phys. D 2018,
51, 474005; e) S. Strauss, P. C. Nickels, M. T. Strauss, V.
Jimenez Sabinina, J. Ellenberg, J. D. Carter, S. Gupta, N.
Janjic, R. Jungmann, Nat. Methods 2018, 15, 685 – 688.

[4] A. Keppler, S. Gendreizig, T. Gronemeyer, H. Pick, H. Vogel, K.
Johnsson, Nat. Biotechnol. 2003, 21, 86 – 89.

[5] G. V. Los, L. P. Encell, M. G. McDougall, D. D. Hartzell, N.
Karassina, C. Zimprich, M. G. Wood, R. Learish, R. F. Ohana,
M. Urh, D. Simpson, J. Mendez, K. Zimmerman, P. Otto, G.
Vidugiris, J. Zhu, A. Darzins, D. H. Klaubert, R. F. Bulleit, K. V.
Wood, ACS Chem. Biol. 2008, 3, 373 – 382.

[6] M. Beck, E. Hurt, Nat. Rev. Mol. Cell Biol. 2017, 18, 73 – 89.
[7] a) A. Loschberger, S. van de Linde, M. C. Dabauvalle, B. Rieger,

M. Heilemann, G. Krohne, M. Sauer, J. Cell Sci. 2012, 125, 570 –
575; b) A. Szymborska, A. de Marco, N. Daigle, V. C. Cordes,
J. A. Briggs, J. Ellenberg, Science 2013, 341, 655 – 658.

[8] a) A. von Appen, J. Kosinski, L. Sparks, A. Ori, A. L. DiGuilio,
B. Vollmer, M. T. Mackmull, N. Banterle, L. Parca, P. Kastritis,

K. Buczak, S. Mosalaganti, W. Hagen, A. Andres-Pons, E. A.
Lemke, P. Bork, W. Antonin, J. S. Glavy, K. H. Bui, M. Beck,
Nature 2015, 526, 140 – 143; b) D. H. Lin, T. Stuwe, S. Schilbach,
E. J. Rundlet, T. Perriches, G. Mobbs, Y. Fan, K. Thierbach, F. M.
Huber, L. N. Collins, A. M. Davenport, Y. E. Jeon, A. Hoelz,
Science 2016, 352, aaf1015; c) S. J. Kim, J. Fernandez-Martinez, I.
Nudelman, Y. Shi, W. Zhang, B. Raveh, T. Herricks, B. D.
Slaughter, J. A. Hogan, P. Upla, I. E. Chemmama, R. Pellarin, I.
Echeverria, M. Shivaraju, A. S. Chaudhury, J. Wang, R. Williams,
J. R. Unruh, C. H. Greenberg, E. Y. Jacobs, Z. Yu, M. J.
de la Cruz, R. Mironska, D. L. Stokes, J. D. Aitchison, M. F.
Jarrold, J. L. Gerton, S. J. Ludtke, C. W. Akey, B. T. Chait, A.
Sali, M. P. Rout, Nature 2018, 555, 475 – 482.

[9] M. Eibauer, M. Pellanda, Y. Turgay, A. Dubrovsky, A. Wild, O.
Medalia, Nat. Commun. 2015, 6, 7532.

[10] a) B. Koch, B. Nijmeijer, M. Kueblbeck, Y. Cai, N. Walther, J.
Ellenberg, Nat. Protoc. 2018, 13, 1465 – 1487; b) J. V. Thevatha-
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 2 

Materials and Methods 

Tissue culture. McCoy‘s 5A Medium modified (cat: 26600-023) was ordered from Gibco. Fetal Bovine Serum (FBS) (cat: 10500-064), 

1× Phosphate Buffered Saline (PBS) pH 7.2 (cat: 20012-019), 0.05% Trypsin–EDTA (cat: 25300-054) and Penicillin-Streptomycin (cat: 

15140-122) were purchased from Thermo Fisher Scientific. HeLa cells were purchased from the Leibniz Institute DSMZ (cat: ACC-57). 

U2OS cells were purchased from ATCC (cat: ATCC HTB-96). Glass-bottomed 8-well µ-slides (cat: 80827) and sticky slide VI (cat: 80608) 

were obtained from ibidi. Falcon tissue culture flasks (cat: 734-0965) were ordered from VWR.  

Cell Fixation and immunostaining. 16% (w/v) Paraformaldehyde (cat: 28906) and DTT (cat: 20291) were purchased from Thermo 

Fisher Scientific. Triton X-100 (cat: 6683.1) and Ammonium chloride (cat: K298.1) was purchased from Roth. Bovine Serum Albumin (cat: 

A4503-10G) was ordered from Sigma-Aldrich. Halo- and SNAP-ligand-modified oligos were custom-ordered from Biomers.net (see 

Supplementary Table 3). GFP Nanobody was ordered from NanoTag Biotechnologies (cat: N0301-1mg, Clone 1H1), Secondary 

polyclonal antibodies (cat: 711-005-152, 115-005-003) were purchased from Jackson ImmunoResearch. Primary rabbit polyclonal anti-

GFP antibody was purchased from MBL (cat: 598). 

Cell imaging. EDTA 0.5 M pH 8.0 (cat: AM9261), Sodium Chloride 5 M (cat: AM9759) and Tris 1 M (cat: AM9856) were ordered from 

Ambion. Ultrapure water (cat: 10977-035) was purchased from Thermo Fisher Scientific. Potassium chloride (cat: 6781.1) was ordered 

from Roth. Sodium hydroxide (cat: 31627.290) was purchased from VWR. Glycerol (cat: G5516-500ML), Methanol (cat: 32213-2.5L), 

Protocatechuate 3,4-Dioxygenase Pseudomonas (PCD) (cat: P8279), 3,4-Dihydroxybenzoic acid (PCA) (cat: 37580-25G-F) and (+-)-6-

Hydroxy-2,5,7,8-tetra-methylchromane-2-carboxylic acid (Trolox) (cat: 238813-5G) were purchased from Sigma-Aldrich. Dye modified 

DNA oligos were custom-ordered from MWG (see Supplementary Table 4). 90-nm-diameter Gold Nanoparticles (cat: G-90-100) were 

ordered from cytodiagnostics. 

Cell line generation. The generation of cell lines was according to published procedures, where homozygosity of the cell lines has been 

verified by sequencing, Southern and Western blots. After FACS sorting and clonal expansion for all cell lines, several clones with 

homozygous gene replacement could be isolated after one round of CRISPR facilitated recombination. The NUP96 cell line was 

furthermore described elsewhere[1].  

Buffers. The imaging buffer was supplemented with: 100× Trolox: 100 mg Trolox, 430 μl 100 % Methanol, 345 μl 1M NaOH in 3.2 ml 

H2O. 40× PCA: 154 mg PCA, 10 ml water and NaOH were mixed and pH was adjusted 9.0. 100× PCD: 9.3 mg PCD, 13.3 ml of buffer 

(100 mM Tris-HCl pH 8, 50 mM KCl, 1 mM EDTA, 50 % Glycerol). Cell-imaging-buffer (buffer C): 1× PBS pH 7.2, 500 mM NaCl, 1× PCA, 

1× PCD, 1× Trolox. 

PEG surface. PEG surfaces were prepared as previously reported[2]. In brief, the coverslips (no. 1.5 high precision, 60x18 mm2) were 

rinsed twice and bath-sonicated in a Teflon-based custom-made slide holder in Milli-Q water for 10 min. Rinsing and bath-sonication was 

repeated with methanol and acetone. To activate the surface, the coverslips were bath-sonicated in 1 M KOH for 20 min and rinsed with 

Milli-Q water afterwards. After blow drying the coverslips with nitrogen, they were incubated with 95 ml methanol mixed with 5 ml acetic 

acid and 1 ml aminosilane for 20 min in the dark. Afterwards they were washed with methanol and water for 2 min and blow dried with 

nitrogen. The aminosilanized coverslips were stored under Argon atmosphere for <2 weeks until they were used. 24 h before use, the 

imaging chambers were assembled with double sided sticky tape. 16 mg of mPEG (Rapp Polymere, cat. no.: 125000-35) was dissolved 

in 70 µl of freshly prepared sodium bicarbonate buffer (10 mM sodium bicarbonate, pH 8.5) and mixed 20:1 with biotin-PEG (Rapp 

Polymere, cat. no.: 135000-25-35). To remove air bubbles, the mix was briefly spun down for 30 s and added to the assembled chamber. 

The chamber was sealed with silicon (picodent) and stored at room temperature overnight in the dark. Before use, the chamber was 

washed with 1 ml Milli-Q water. 

Cysteine-based GFP-Nanobody labeling and purification. GFP nanobodies were DNA-labeled as previously reported[3]. Nanobodies 

were concentrated via Amicon 10 kDa spin filters and buffer exchanged into 5 mM TCEP in 1× PBS + 3 mM EDTA at pH 7.5. 5 mM TCEP 

in 1× PBS + 3 mM EDTA was then added to the GFP Nanobody and was incubated for 2 h at 4 °C on a shaker. Subsequently, Amicon 

10 kDa Spin Filters were prewashed with 1× PBS, and Nanobody was buffer-exchanged into 1× PBS for 5× 5 min at 14 000×g and the 

volume was adjusted to 100 µl. DBCO-Maleimide Crosslinker was added in 20 molar excess in 5 µl to the GFP Nanobody and incubated 

overnight at 4 °C on a shaker. Crosslinker aliquots were stored at 40 mg/ml concentration in DMF. DBCO crosslinker was removed via 

10 kDa Amicon Spin Filters for 5× 5min at 14 000× g. Azide-DNA was added to the GFP Nanobody crosslinker at 10× excess for 1 h at 

20 °C. The final product was buffer exchanged into Anion exchange binding buffer (1× PBS, pH 7.2) via Amicon 10 kDa Spin Filters. 

Purification from free DNA was performed using a GE Aekta purifier system and a RESOURCE Q 1 ml column via a 30 min gradient 

purification scheme from 1× PBS to 1× PBS + 1 M NaCl. Peak fractions were afterwards concentrated and buffer-exchanged via Amicon 

10 kDa spin filters into 1× PBS. 

Antibody conjugation. Antibodies were conjugated to DNA-PAINT docking sites via maleimide-PEG2-succinimidyl ester chemistry as 

previously reported[4] (see Supplementary Table 3 for handle sequences). In short, secondary antibodies were concentrated via 100 

kDa amicon spin filters to a final concentration of 1-3 mg/ml. 100 µl of antibody was labelled with the maleimide-Peg2-succinimidyl ester 

for 90 min at 10x molar excess at 4 °C on a shaker. Crosslinker stocks of 10 mg/ml in DMF were diluted in 1x PBS to reach 10x molar 

excess in 5 µl, which were subsequently added to the antibody. After the reaction had been done, unreacted crosslinker was removed 

via a zeba spin column. Thiolated DNA was reduced using DTT for 2 h at room temperature. DTT was purified from the reduced DNA via 

a Nap5 column and fractions containing DNA were concentrated via 3 kDa amicon spin filters. The reduced DNA was then added to the 

antibody bearing a functional maleimide group in 10x molar excess and incubated over night at 4 °C on a shaker in the dark. Antibody-

DNA constructs were finally purified via 100 kDa amicon.  
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Cell culture. Hela cells and U2OS cells were passaged every other day and used between passage number 5 and 20. The cells were 

maintained in DMEM supplemented with 10 % Fetal Bovine Serum and 1 % Penicillin/Streptomycin. Passaging was performed using 

1× PBS and Trypsin-EDTA 0.05 %. 24 h before immunostaining, cells were seeded on ibidi 8-well glass coverslips at 30,000 cells/well. 

Cell fixation. Prefixation was performed with prewarmed 2.4 % Paraformaldehyde for 20 seconds followed by the permeabilization at 

0.4 % Trion-X 100 for 10 seconds. Next, cells were fixed (main fixation) with 2.4 % for 30 min. After 3× rinsing with 1× PBS the cells were 

quenched with 50 mM Ammoniumchloride (in 1× PBS) for 4 minutes. Then, cells were washed 3× with 1×PBS followed by incubation in 

1× PBS for 5 minutes twice. Next, cells were stained with the corresponding ligand (see below). Finally, cells were washed 3× for 5 min 

in 1× PBS, incubated with 1:1 dilution of 90 nm gold particles in 1× PBS as drift markers, washed 3× 5 min and immediately imaged.  

Staining with SNAP. For SNAP-labeling, cells were incubated with 1 µM of SNAP-ligand-modified DNA oligomer in 0.5 % BSA and 1 mM 

DTT for 2 hours. 

Staining with Halo. For Halo-labeling, cells were incubated with 1 µM Halo-ligand-modified DNA oligomer in 3 % (w/v) BSA in 1× PBS 

for overnight at 4°C on a shaker. 

Staining with GFP. GFP-Nanobody staining was done in 3% BSA in 1xPBS at 4°C overnight on a shaker. 

Staining with antibodies. Antibody staining was done in two steps. First, cells were incubated with primary antibody anti-GFP (1:100) 

in 3% BSA at 4°C PBS overnight. After three washes for 5 min with 1× PBS, the sample was incubated with the secondary antibody 

(dilution 1:100) at RT for 1 hours. 

Super-resolution microscope setup. Fluorescence imaging was carried out on an inverted Nikon Eclipse Ti microscope (Nikon 

Instruments) with the Perfect Focus System, applying an objective-type TIRF configuration with an oil-immersion objective (Apo SR TIRF 

100×, NA 1.49, Oil). TIRF/Hilo angle was adjusted for highest signal to noise ratio when imaging. A 561 nm (200 mW, Coherent Sapphire) 

laser was used for excitation. The laser beam was passed through cleanup filters (ZET561/10, Chroma Technology) and coupled into the 

microscope objective using a beam splitter (ZT561rdc, Chroma Technology). Fluorescence light was spectrally filtered with an emission 

filter (ET600/50m and ET575lp, Chroma Technology) and imaged on a sCMOS camera (Andor Zyla 4.2) without further magnification, 

resulting in an effective pixel size of 130 nm (sCMOS after 2×2 binning).  

Imaging conditions 

Figure 1c-e. Imaging was carried out using an imager strand concentration of 300 pM (P3-Cy3B) in cell imaging buffer. 15,000 frames 

were acquired at 200 ms integration time. The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 30 mW 

(measured before the back focal plane (BFP) of the objective), corresponding to 0.7 kW/cm2 at the sample plane. 

Figure 1f-h. Images were acquired with an imager strand concentration of 2 nM (P3-Cy3B imager) in cell imaging buffer. 40,000 frames 

were acquired at 200 ms integration time. The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 80 mW 

(measured at the back focal plane (BFP) of the objective), corresponding to 1.8 kW/cm2 at the sample plane. 

Figure 2a. Images were acquired with an imager strand concentration of 2 nM of P3-Cy3B in cell imaging buffer. 30,000 frames were 

acquired at 200 ms integration time and a readout bandwidth of 200 MHz. Laser power (@560 nm) was set to 50 mW (measured before 

the back focal plane (BFP) of the objective), corresponding to 1.1 kW/cm2 at the sample plane. 

Figure 2b. Imaging was carried out using an imager strand concentration of 2 nM (P3-Cy3B) in cell imaging buffer. 30,000 frames were 

acquired at 200 ms integration time. The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 50 mW (measured 

before the back focal plane (BFP) of the objective), corresponding to 1.1 kW/cm2 at the sample plane. 

Figure 2c. Images were acquired with an imager strand concentration of 2 nM (P3-Cy3B imager) in cell imaging buffer. 30,000 frames 

were acquired at 200 ms integration time. The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 50 mW 

(measured at the back focal plane (BFP) of the objective), corresponding to 1.1 kW/cm2 at the sample plane. 

Figure 2d. Images were acquired with an imager strand concentration of 2 nM of P3-Cy3B in cell imaging buffer. 30,000 frames were 

acquired at 200 ms integration time. The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 50 mW (measured 

at the back focal plane (BFP) of the objective), corresponding to 1.1 kW/cm2 at the sample plane. 

Figure 2e. Imaging was carried out using an imager strand concentration of 300 pM (P3-Cy3B) in cell imaging buffer. 30,000 frames 

were acquired at 200 ms integration time. The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 50 mW 

(measured before the back focal plane (BFP) of the objective), corresponding to 1.1 kW/cm2 at the sample plane. 

Figure 3a, b. Images were acquired with an imager strand concentration of 2 nM (P3-Cy3B imager) in cell imaging buffer. 100,000 frames 

were acquired at 200 ms integration time. The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 40 mW 

(measured at the back focal plane (BFP) of the objective), corresponding to 1.0 kW/cm2 at the sample plane. 

For all imager strand sequences see Supplementary Table 4. 
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3D DNA-PAINT calibration using latex microspheres. The 3D look-up table was measured as previously reported[5]. In short, first an 

ibidi sticky slide VI was assembled with the pegylated coverslip. Then, 50 μl of 1:10 avidin coated microspheres diluted in 1× PBS were 

flown into the ibidi sticky slide chamber with the prepared PEG-Biotin surface and incubated for 10 min. Then the chamber was washed 

using 180 μl of 1x PBS. Second, 500 nM biotinylated oligonucleotides (10 nt, P1 docking site sequence, Supplementary Table 4) was 

then flown into the chamber and incubated for 10 min. Next, the chamber was washed with 180 μl of 1× PBS. Next, the chamber was 

incubated with 1:10 dilution of 90 nm gold particles in 1× PBS as drift markers for 5 min and subsequently washed with 80 μl 1× PBS. 

Finally, 180 μl imaging buffer with dye-labeled imager strands was flown into the chamber. 500 pM Cy3B labeled imager with sequence 

P1 and 1× PCA, 1× PCD, 1× Trolox in buffer C was used. Latex microspheres attached to the PEG surface were identified using bright-

field illumination and the radius was measured. The recoded latex microsphere data using DNA-PAINT was reconstructed using two-

dimensional gaussian fitting. Lateral drift correction was performed using the gold nanoparticle. Gaussian width (sigma x and sigma y) 

were averaged in radial sections and linked to the corresponding z height to gather the calibration data[6]. Finally, the calibration data was 

fitted using sixth degree polynomial fit to generate the look-up table. 

Image analysis. Raw fluorescence data was subjected to spot-finding and subsequent super-resolution reconstruction using the ‘Picasso’ 

software package[4b]. x, y drift correction was performed via a redundant cross-correlation and gold particles as fiducial markers. Drift 

correction in z was performed via 90 nm gold particles. 

Radius analysis. To determine the radius of NPCs, picked NPCs were averaged using the ‘Picasso:average3’ module as previously 

described[4b]. In brief, localizations of particles are aligned on top of each other by rendering them and using cross-correlation to determine 

displacement. To account for ring-like structures, a 100× symmetry was set. Each dataset was averaged with the following oversampling 

settings: 3× 15, 1× 20, 1× 40. Based on the resulting “superparticle”, the center of mass was determined. The localizations were 

subsequently transformed into polar coordinates with the center of mass as the center point. The radius was calculated by taking the 

median of the polar coordinate distances. 

Labeling efficiency calculation. To analyse the labelling efficiency for the different labelling methods (NUP96-Halo, NUP96-SNAP, 

NUP107-SNAP, NUP107-GFP). 100 nuclear pores were picked for each 3D dataset, and the apparent clusters were counted and 

compared to the expected 32 copies of the proteins. 

Parameter optimization for 3D imaging. For parameter optimization two main aspects for DNA-PAINT imaging should be considered: 

Resolution (x, y, z) and repetitive sampling. To estimate the resolution capabilities, 125 single clusters in nuclear pores were picked and 

center-of-mass-aligned with the Picasso average3 module. Localization distributions of aligned clusters were fitted with a Gaussian fit. 

For the analysis of repetitive sampling, the picked single 125 clusters were linked (max. distance: 26 nm, max. transient dark frames: 5) 

and DBSCANned (minimum local event density: 5, Radius: 26 nm) using the Picasso software to obtain the events per site as well as 

mean frame of the visits.  
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Supplementary Figure 1 | Diffraction-limited and super-resolution imaging comparison. (a) NUP96-SNAP super-resolved image. 

(b) Diffraction-limited image of the same area. (c) NUP107-GFP-NB super-resolved image. (d) Diffraction-limited image of the same area. 

Scale bars: 1 µm. 
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Supplementary Figure 2 | Overview of NUP107-SNAP, n=398. Scale bar: 500 nm. 
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Supplementary Figure 3 | Overview of NUP107-GFP-NB, n=486. Scale bar: 500 nm. 
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Supplementary Figure 4 | Overview of NUP96-SNAP, n=288. Scale bar: 500 nm. 
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Supplementary Figure 5 | Overview of NUP96-Halo, n=191. Scale bar: 500 nm. 

 

 

Supplementary Figure 6 | Overview of NUP107-GFP-AB, n=200. Scale bar: 500 nm. 
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Supplementary Figure 7 | 3D parameter optimization. For optimization of imaging parameters to resolve the two copies of NUP96 

proteins spaced ~12 nm apart, certain criteria need to be fulfilled, which are high spatial resolution as well as sufficient repetitive sampling 

of binding sites. (a) Center of mass alignment of 125 single protein clusters (x-y projection). (b) Center-of-mass alignment of the single 

protein clusters (x-z projection). (c) Histogram analysis of the x-y projection yields ~4 nm localization precision. (d) Histogram analysis of 

the x-z projection yields ~12 nm localization precision. (e) Histogram of events per cluster yields a mean of 23.0 (STD: 5.7) visits of imager 

strands per site. (f) Histogram analysis of the mean frame per cluster yields a mean value of 44008 (STD: 8627), highlighting that the 

clusters were repetitively visited over the whole course of image acquisition (100k frames). Analysis based on Figure 3 dataset. Scale 

bars: 10 nm (a, b). 
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Supplementary Figure 8 | NUP96-SNAP 3D DNA-PAINT. (a) 3D DNA-PAINT overview image of NPCs labeled via Nup96-SNAP (color 

indicates height, range: -200 (blue) to 200 nm (red)). (b) Selection of single NPCs. Arrows are highlighting two copies of NUP96 proteins 

in the same symmetry center of the same ring (i.e. at the same height) spaced ~12 nm apart from each other (color indicates height, 

range: -100 (blue) to 100 nm (red)). (c) Cross sectional histogram of 3D-averaged pairs (N = 27) of NUP96-SNAP proteins in single 

symmetry centers as highlighted in (b). Scale bars: 2 µm (a), 50 nm (b). 

Imaging was carried out using an imager strand concentration of 2 nM (P3-Cy3B). 50k frames were acquired at 200 ms integration time. 

The readout bandwidth was set to 200 MHz. Laser power (@561 nm) was set to 40 mW (measured before the back focal plane (BFP) of 

the objective). This corresponds to 1 kW/cm2 at the sample plane. 
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Supplementary Table 1 | Imaging parameters 

Dataset Parameters  Power @561 nm NeNA precision 

Figure 1c,d and SI Figure 1a,b 300ms, 2D, 15k Frames, 5nM. P3* 0.7 kW/cm2 6.3 nm 

Figure 1e,f and SI Figure 1c,d 200ms, 2D, 30k Frames, 2nM, P3* 1.8 kW/cm2 6.9 nm 

Figure 2a and SI Figure 2  200 ms, 2D, 30k Frames, 1 nM, P3* 1.1 kW/cm2 3.6 nm 

Figure 2b and SI Figure 3 200 ms, 2D, 30k Frames, 2nM, P3* 0.6 kW/cm2 6.0 nm 

Figure 2c SI Figure 4 200 ms, 2D, 30k Frames, 1 nM, P3* 1.1 kW/cm2 2.9 nm 

Figure 2d and SI Figure 5 200 ms, 2D, 30k Frames, 1 nM, P3* 1.1 kW/cm2 4.5 nm 

Figure 2e and SI Figure 6 200ms, 2D, 30k Frames, 300 pM, P3* 0.6 kW/cm2 4.5 nm 

Figure 3 and SI Figure 7 200ms, 3D, 100k Frames, 2nM, P3* 1 kW/cm2 6.0 nm 

SI Figure 6a 200 ms, 2D, 30k Frames, 300 pM, P3* 1.1 kW/cm2 2.2 nm 

SI Figure 6b 200 ms, 2D, 30k Frames, 1 nM, P3* 1.1 kW/cm2 6.0 nm 

SI Figure 8 200 ms, 3D, 50k Frames, 2 nM, P3* 1 kW/cm2 5.1 nm 

 
 
Supplementary Table 2 | Imager sequences 

Imager name Sequence 5’-mod 3’-mod Vendor 

P1* CTAGATGTAT None Cy3b Eurofins Genomics 

P3* GTAATGAAGA None Cy3b Eurofins Genomics 

 
 
Supplementary Table 3 | Handle sequences 

Handle Name Sequence 5’-mod 3’-mod Vendor 

P1 TTATACATCTA  BG (Snap Ligand) None Biomers.net 

P3 TTTCTTCATTA BG (Snap Ligand) None Biomers.net 

P1 TTATACATCTA Halo Ligand (O2) None Biomers.net 

P3 TTTCTTCATTA Halo Ligand (O2) None Biomers.net 

P1 TTATACATCTA Thiol (for AB conjugation) None Eurofins Genomics 

P3 TTTCTTCATTA Thiol (for AB conjugation) None Eurofins Genomics 

P1 TTATACATCTA Biotin None Eurofins Genomics 

 
 
Supplementary Table 4 | NPC radius quantification, SE = standard error 

Dataset Median (nm) Mean (nm) Std (nm) SE of Median (nm) SE of Mean (nm) # Pores # Locs 

NUP107-SNAP 53.7 54.2 13.1 0.8 0.7 398 127773 

NUP107-GFP-NB 54.6 54.8 11.9 0.7 0.5 486 219398 

NUP96-SNAP 55.9 56.5 12.6 0.9 0.7 288 57297 

NUP96-Halo 56.2 56.6 10.2 0.9 0.7 191 45143 

NUP107-GFP-AB 65.9 66.1 17.5 1.5 1.2 200 69834 
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Supplementary Table 5 | NPC labeling efficiency (LE) estimation 

Dataset Mean LE (%) Median LE (%) Std (%) # Pores 

NUP107-SNAP 28.1 28.1 4.9 100 

NUP107-GFP-NB 27.5 28.1 4.4 100 

NUP96-SNAP 28.2 28.1 4.1 100 

NUP96-Halo 29.7 31.3 5.4 100 
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Focal adhesions (FAs) are integrin-based structures that mediate the attachment of 
cells to the extracellular matrix (ECM) and govern mechano-chemical signaling 
cascades upon cell adhesion1,2. Even though FAs have a crucial function for a wide 
range of cell biological processes, it is still unknown how their resident proteins 
assemble on molecular scales. In particular, it remains unclear how the two integrin 
activators talin and kindlin assemble at the plasma membrane to facilitate receptor 
activation3-5. Here, we use DNA-PAINT super-resolution microscopy6,7 to visualize and 
quantify the localization of β1 integrin, talin-1 and kindlin-2 with molecular resolution 
in cells. Our experiments and simulations indicate that talin distributes across the 
plasma membrane at molecular distances of 40-50 nm at initial stages of cell adhesion. 
Dual target Exchange–PAINT experiments demonstrate that a significant portion of 
talin-1 and kindlin-2 molecules co-localize on molecular scales specifically in the 
adhesion area, and triple-target super-resolution imaging reveals their specific 
association with active β1 integrin receptors. Together, the data provide the first 
molecularly resolved view of FA’s lateral organization and provide evidence for an 
integrin-talin-kindlin complex underlying cell-ECM adhesion. 

 
The adhesion of cells to the extracellular matrix (ECM) is essential for the development and 

survival of metazoans and key to the function and repair of virtually all mammalian tissues1. 

Cell-ECM adhesions form after the activation of integrin receptors by two intracellular proteins, 

talin and kindlin, leading to integrin clustering and the recruitment of additional cytoplasmic 

proteins that condense in macromolecular complexes called focal adhesions (FAs)3,8. 

Previous super-resolution microscopy approaches revealed that FAs are characterized by a 

horizontal layering that compartmentalizes chemical and mechanical activities9,10, but owing 

to the inability to resolve FA proteins on truly molecular scales, a detailed understanding of 

FAs’ lateral organization is thus far elusive. It is still unclear, for instance, how integrin 



 
Spatial association of integrin-talin-kindlin during cell matrix adhesions 
 

 198 

clustering occurs at the nanoscale, even though avidity regulation is an established concept 

of integrin-mediated cell adhesion5,11. Debated models range from the formation of integrin 

clusters through homomerization12, the assembly of heterogeneous substructures13, to 

specific nano-clusters into which active and inactive integrin receptors segregate14. In addition, 

it is unknown how the integrin-binding proteins talin and kindlin, which govern the first steps 

of integrin activation and FA formation11,15, assemble in cell adhesion sites, and it is 

controversially discussed whether both proteins can approach the relatively short cytoplasmic 

domain of β integrin receptors simultaneously. We therefore sought to establish a quantitative 

technique to visualize these proteins with molecular-scale resolution in cells. 

To resolve individual molecules, we used DNA-PAINT, which allows quantitative and 

multiplexed super-resolution imaging with sub-10-nm spatial resolution6,7,16 and combined it 

with genetically-encoded labeling tags17. DNA-PAINT uses the sequence-specific, transient 

binding of dye-labeled DNA oligonucleotides to their target-bound complements to create the 

blinking events necessary in single-molecule-based super-resolution approaches. To analyze 

the molecular organization of talin, we genetically inserted a HaloTag into a previously 

validated talin-1 insertion site18,19 after the integrin-binding FERM domain at amino acid (aa) 

447 and stably expressed the construct in cells genetically depleted of talin-1 and talin-2 (talin-

Halo447)20 (Supplementary Figure 1). We then seeded these cells onto fibronectin (FN)-

coated glass slides and targeted the HaloTag in talin using a chloroalkane-modified DNA-

PAINT ‘docking’ strand. Subsequent addition of the complementary Cy3b-labeled imager 

strand, DNA-PAINT image acquisition using TIRF microscopy, and data postprocessing21 

revealed distinct talin-1 localization clouds in FAs as well as the plasma membrane (MEM, 

Figure 1a-c) with a localization precision of about 5 nm (Figure 1d-f, Supplementary Figure 2). 

To quantify how many talin-1 molecules reside within a given localization cloud, we performed 

quantitative-PAINT (qPAINT) analyses16 by placing DNA origami structures with a defined 

number of single binding sites next to talin-Halo447 expressing cells, and then analyzed the 

signals associated with DNA origamis and cells (Figure 1g, Supplementary Figure 3). To 

obtain molecularly precise quantification, qPAINT relies on the fact that the observed target 

binding frequency scales linearly with the imager strand concentration and the number of 

binding sites. The individual binding sites on DNA origami nanostructures served as calibration 

sites for comparison with the talin-1 localization clouds within the cell. We observed highly 

similar values for both localization clouds (DNA origami: 0.96±0.3 units; talin-1: 0.97±0.378 

units) and confirmed with control experiments analyzing two and three docking sites the 

expected correlation between binding frequency and binding site number in our experiments 

(Figure 1e-f, Supplementary Figure 4). Thus, the observed localization clouds represent 

individual talin-1 molecules. 
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Next, we developed an analysis pipeline that distinguishes specific from non-specific signals 

and calculates the distance from one protein to its nearest neighbor to analyze the data in an 

automated fashion (Supplementary Figure 5) at a resolution of 25 nm (Supplementary Figure 

6). We used the ‘Nearest Neighbor Distance’ (NND) value to systematically evaluate how 

labeled talin-1 molecules assemble during cell adhesion formation and FA maturation (Figure 

2a, b). At the initial phase of cell adhesion, in the absence of identifiable adhesion complexes, 

single talin-1 molecules seemed randomly spaced at the plasma membrane with an NND of 

about 125 nm. After 15-25 min, when talin-1 started to aggregate in small FAs, these distances 

reduced to about 55 nm and then compacted with the onset of anisotropic cell spreading to a 

45 nm spacing. This NND value then remained constant even in fully spread cells with large 

FAs (16 h). A fraction of talin-1 was consistently found outside of FAs in the MEM at distances 

>100 nm, and this value seemed largely insensitive to the cell adhesion state (Figure 2b). 

Consistent with our experiments above, qPAINT measurements indicated individual talin-1 

molecules in the observed localization clouds at all analyzed time points (Supplementary 

Figure 7). 

Since talin’s primary binding partners in FAs are integrin receptors, we inserted a SNAP-tag 

into the extracellular domain of β1 integrin (before aa 108) and stably expressed the construct 

in integrin-deficient fibroblasts22. The reconstituted β1 integrin-SNAP cells, targeted with 

benzylguanine-modified DNA-PAINT docking strands, displayed restored cell morphology, 

and DNA-PAINT imaging revealed the expected localization of β1 integrin to FAs and the 

MEM. After 16 h of spreading, β1 integrin molecules assembled with molecular distances of 

about 50 nm in FAs and >100 nm in the MEM, reminiscent of the talin-1 distribution (Figure 

2c). To test whether talin follows integrin receptor localization, we seeded talin-Halo447 cells 

onto micropatterned surfaces upon which FN-coated stripes were interspaced with passivated 

areas that cannot be engaged by integrin receptors. As expected, talin-1 was assembling at 

short molecular distances in FAs on FN-stripes and large separation distances in passivated 

areas (Figure 2d). Thus, the molecular assembly of talin-1 depends on integrin-ECM 

engagement. 

To investigate talin’s molecular organization in more detail, we next examined different 

theoretical models to describe the observed talin-1 NND distribution. Intriguingly, the data 

were best described by a homogenous Poisson function indicating – at least down to our 

detection limit – a random organization of molecules (Figure 2e). Since talin was implicated 

as an adaptor protein that governs the horizontal layering of FAs9,10, we tested our lateral talin-

1 distribution for the presence of overlying patterns or clusters by evaluating distances to the 

third and fifth talin-1 molecule, covering a spacing of about 40-120 nm. However, also these 

data sets were consistent with a random organization of molecules indicating that talin-1 does 

not assemble in lateral FA substructures on these length scales. Finally, we estimated the 
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absolute molecular density of talin-1 in FAs, by assuming a 100 % labeling and detection 

efficiency and a random organization of talin-1 molecules. These simulations predicted an 

average talin-to-talin distance of 40-50 nm at early time points of spreading (5 min) and 20-25 

nm in mature FAs (16 h) with a molecular density of about 600 talin-1 molecules/μm2 (Figure 

2e). Together, these data suggest that the organization of FA molecules at the plasma 

membrane during receptor clustering is not set by a previously hypothesized function of talin 

as a molecular ruler23,24.  

Cell adhesion requires the engagement of integrin receptors with talin but also kindlin. It has 

been shown that the FERM domains of talin and kindlin bind the cytoplasmic tail of β-integrins 

at two adjacent but distinct motifs25,26, yet it is unclear whether both proteins can co-assemble 

with integrin receptors in cells3,15. We therefore generated an N-terminal SNAP-tagged kindlin-

2 construct (SNAP-Kindlin), co-expressed it with talin-Halo447 in kindlin-1/2 and talin-1/2- 

deficient fibroblasts27 (Supplementary Figure 8), and performed dual target super-resolution 

microscopy using Exchange-PAINT6 (Supplementary Figure 9). As expected, kindlin-2 was 

observed at high densities in FAs with intermolecular distances of 55 nm, while talin-1 

assembled with a NND of about 40 nm in these cells (Figure 3a-c). Intriguingly, individual talin-

1 and kindlin-2 molecules were frequently observed in close proximity with an average ‘kindlin-

to-talin’ (K2T) distance of about 27 nm (Figure 3c).  

To explore this in more detail, we first simulated two random distributions with the 

experimentally observed molecular densities of talin-Halo447 and SNAP-Kindlin. The results 

indicated that about 30 % of talin-1 and kindlin-2 molecules are expected to non-specifically 

localize within a distance of 25 nm, merely due to the high protein density in FAs. Next, we 

experimentally examined a positive control, in which a Halo-SNAP cassette was inserted into 

talin-1; Halo- and SNAP-tag are only separated by seven aa in this construct (talin-F7), which 

thus mimics co-localization. These experiments demonstrated that perfect co-localization is 

indicated by about 60 % of all kindlin and talin molecules assembling within 25 nm, which was 

again consistent with theoretical simulations considering the labeling efficiencies of both tags 

(Supplementary Figure 9). Remarkably, 45 % of talin-1 and kindlin-2 signals were co-localized 

in talin-Halo447 and SNAP-Kindlin reconstituted cells indicating the specific, spatial 

association of both integrin activators (Figure 3d). To validate this observation, we co-

expressed a talin-1 construct, in which the HaloTag was located at talin’s C-terminus, with 

SNAP-Kindlin. As expected, this C-terminally tagged talin-1 displayed a significantly reduced 

overlap with kindlin-2 signals (Figure 3d, Supplementary Figure 10, 11). Together, these data 

show that the FERM domains of talin-1 and kindlin-2 spatially associate at the plasma 

membrane of FAs. Since we did not detect significant molecular co-localization of talin-1 and 

kindlin-2 outside FAs (Figure 3d), the complex formation appears to occur specifically within 

the adhesion area.  
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In view of the proposed models of integrin activation3,15, the results above imply that talin-1 

and kindlin-2 indeed associate in FAs to induce or maintain the active state of integrin 

receptors. To test this directly, we established three-target Exchange-PAINT experiments to 

visualize talin-1 and kindlin-2 molecules together with single integrin receptors. To detect 

active integrins, we utilized the 9EG7 antibody which binds to an extended conformation of 

the β1 subunit28. Talin-1 and kindlin-2 distributions were again characterized by an average 

molecular distance of about 45-55 nm, whereas active β1 integrin receptors were spaced at 

larger distances, presumably because the 9EG7 antibody detects only the activated fraction 

of all β1 integrin molecules, and because the here used cells express additional integrin 

receptors such as αvβ3. Nonetheless, we frequently observed β1 integrin localizations in 

vicinity of talin-kindlin clusters with average integrin-to-kindlin (I2K) and integrin-to-talin (I2T) 

distances of about 35 nm (Figure 4a-c). To again test the specificity of this observation, we 

analyzed our experimental data by localizing an active integrin receptor and then calculating 

its related next-kindlin and next-talin signal (I2KT). We compared these I2KT tuples with 

simulated data in which β1 integrin, kindlin-2 and talin-1 were randomly distributed at the 

experimentally observed molecular densities. Generating a 2D heat map of both data sets 

revealed a significant enrichment of short I2KT tuples in the experimental data set (Figure 4d), 

and bootstrap analysis confirmed that these differences are indeed highly significant (Figure 

4e and Supplementary Figure 12). Thus, integrin β1, talin-1 and kindlin-2 undergo a specific, 

spatial association during cell-ECM adhesion.  

Altogether, our results reveal the lateral organization of FAs’ three indispensable core proteins 

on the molecular scale. We find that talin concentrates upon receptor clustering to molecular 

densities in the order of 600 molecules/μm2. This value is lower than a previously published 

estimate of integrin receptor density29 but sufficiently high to facilitate frequent inter-molecular 

associations. In addition, talin-1 and kindlin-2 undergo spatial association specifically in the 

cell adhesion area, where they frequently assemble with β1 integrins in the extended state. 

This suggests that either activating integrin receptors or maintaining their active conformation 

is a process that involves the spatial association of all three proteins. 
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Figure 1: Molecular Nanoscale Analysis using DNA-PAINT. a. Overlay of diffraction-
limited and super-resolved DNA-PAINT images of talin-Halo447 expressing cells. b. Zoom 
into FAs talin localization clouds. c. Zoom into the MEM reveals the presence of talin at 
the free plasma membrane. d.-f. DNA-PAINT imaging allows to resolve FA proteins, here 
talin-1, with unprecedented resolution. f. Histogram analysis of (e) shows that signals with 
a separation distance of 15 nm can be resolved (sPeak1=3.5 nm, sPeak2=5.6 nm). g. DNA 
origami structures carrying individual binding sites were placed next to talin-Halo447 cells 
to calibrate the influx rate and estimate the number of molecules per localization cloud. 
Inset: Close-ups of DNA origami structures. h. Repetitive binding events of imager strands 
to DNA origami and Talin-Halo447 clouds indicate similar binding kinetics. i. Histogram 
showing the number of binding sites on DNA origamis and talin localization clouds. Scale 
bars: 15 µm (a), 370 nm (g), 110 nm (g inset), 100 nm (b, c), 30 nm (d), 7 nm (e ).  
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Figure 2: Molecular assembly of talin-1 upon cell adhesion. a. Talin-1 localization 
clouds in talin-Halo447 expressing cells 15 min and 16 h after initiation of cell-matrix 
adhesion. b. NND analysis reveals compaction of talin-1 molecules in FAs upon 
receptor clustering and FA maturation (yellow); the talin-1 spacing in MEM is unaffected 
by the cell adhesion state (magenta). c. Localization clouds in integrin deficient cells 
reconstituted with β1-integrin-SNAP108. NND analysis demonstrates distances 
between individual β1 integrin molecules of about 50 nm in FAs and >100 nm in MEM 
similar to talin-1 (b). d. Talin-Halo447 expressing cells on micropatterned 1 µm-thick 
fibronectin stripes (FN) - separated by passivated 2 µm stripes (P) - demonstrates that 
talin’s localization is governed by integrin mediated ECM engagement. e. Talin 
distribution of the 1st, 3rd and 5th nearest neighbor in FAs. Distributions were fitted with 
2D Poisson density function (red line) indicating a random organization of talin-1 
molecules on length scales between 40–120 nm. f. Random distribution simulations 
were used to estimate the absolute molecular density of talin-1 in FAs. Scale bars: 10 
μm (a, c), 5 μm (d), 1 μm (d inset), 500 nm (a, c inset). 
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Figure 3: Spatial association of talin-1 and kindlin-2 in FAs. a. Talin-1/2 and kindlin-1/2 
deficient cells were reconstituted with Talin-Halo447 and SNAP-Kindlin. Zoom into FAs 
reveals adjacent talin-1 and kindlin-2 localization clouds. b. Neighboring talin-1 (magenta) 
and kindlin-2 (yellow) localization clouds are frequently closer than 25 nm. c. NND analyses 
show the expected similar distributions and spacing between kindlin-2 (K2K) and talin-1 
molecules (T2T). The average kindlin-to-talin distances (K2T) are significantly lower at 
around 26 nm. d. Theoretical simulations indicate 30 % of unspecific density-dependent co-
localization of talin-1 and kindlin-2 in FAs at the observed molecular densities (S1). 45 % of 
labelled kindlin-2 molecules are within 25 nm of the next talin-1 molecule in Talin-Halo447 
expressing cells (i). Co-localization is significantly reduced to 40 % in cells expressing C-
terminally tagged talin-1 (c). Talin-F7 (F7) was used as a positive control to mimic perfect 
co-localization. Note that the obtained values are consistent with the theoretical simulations 
(S2) considering a 30% labeling efficiency of both tags. The observed effects are specific 
to FAs and not observed in MEM region. Scale bars: 6 µm (a), 100 nm (a insets), 20 nm 
(b). 
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Figure 4: Three-target DNA-PAINT imaging reveals spatial association of integrin-talin-
kindlin in FAs. a. Talin-1/2 and kindlin-1/2 deficient cells reconstituted with Talin-Halo447 and 
SNAP-Kindlin were labelled with a DNA conjugated antibody (9EG7) recognizing the extended 
β1 integrin conformation. b. Zoom into FAs reveals close proximity of talin-1 (magenta), kindlin-
2 (yellow) and extended β1 integrin (cyan). c. NND analyses confirms the expected distribution 
of talin-1 (T2T) and kindlin-2 (K2K) at around 40 nm; labeled β1 is observed at larger distances 
of about 85 nm (I2I); average integrin-to-kindlin (I2K) and integrin-to-talin (I2T) distances were 
observed at 35 nm. d. Randomly simulated distributions, accounting for the observed talin-1, 
kindlin-2 and β1 integrin molecular densities, were compared to experimental data by plotting 
I2K and corresponding I2T tuples for each detected integrin. e. Statistical evaluation of 
bootstrapped data (sample size=1000 data points, test runs=1000) revealed high p-values for 
intrinsic data bootstrapping (‘sim vs sim’ and ‘exp vs exp’) but low p-values when comparing 
experimental with simulated data sets (‘exp vs sim’) suggesting non-random, spatial 
association of integrin-talin-kindlin during cell-ECM adhesions. Scale bars: 8 µm (a), 100 nm 
(a insets), 20nm (b). 
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Supplementary Figures 
 

 
Supplementary Figure 1: List of constructs. 
 
 

 
Supplementary Figure 2: Average nearest neighbor analysis (NeNa). a. Median 
localization precision of less than 10 nm for most experiments performed throughout two years 
of experimental work depicts robustness of setup leading to highly reproducible and 
comparable results. b. The overall achieved median localization precision of 7.2 nm, derived 
from NeNa calculations, ultimately results in about 17 nm resolution for single protein 
localization analysis. 
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Supplementary Figure 3: qPAINT analysis. a. DNA origami scheme illustrating transient 
binding events of dye-labeled imager strands. For qPAINT analysis DNA origami structures 
were measured alongside the cells to determine and calibrate the binding events on single 
docking sites. b. Visualization of DNA origamis seeded next to the cell. c. Close-up of one 
DNA origami structure (indicated in b) with overlay of individual localization map. d. 
Comparison of binding events over time of one single site on the DNA origami and one 
localization cluster within the FA. e. Statistical analysis of large numbers of single docking 
sites on origami structures allows for calibration of mean number of events per site. 
Subsequent comparison to the events per localization cloud within the FA area reveals single 
molecules per localization cloud. Scale bars: 200nm (b), 25nm (c). 
 



 
  8 Appendix 
 

   211 

 
Supplementary Figure 4: Control experiments for qPAINT analysis. a. Super-resolved 
DNA-PAINT image of DNA origami structures with either one or three consecutive binding 
sites per spot. b. Close-up of DNA origami structure with single binding sequence and 
corresponding trace displays the binding frequency of a single binding site. c. Close-up of 
DNA origami structure with three consecutive binding sequences (3xP3) and corresponding 
trace displays the higher binding frequency at respective label site. d. Number of binding sites 
per label site could not be discriminated visually, but qPAINT analysis reveals either one or 
three binding sites per localization cloud. e. Super-resolved DNA-PAINT image of talin-F7 
expressing cell mimicking either one or two binding sites per localization cloud by labeling 
SNAP and Halo pockets with P3 docking strands. f. Zoom in FA area reveals single distinct 
localization clouds (yellow circle) and localization clouds in very close proximity (magenta 
circle). g. Trace of localizations for single and two proximal localization clouds h. qPAINT 
analysis depicts different number of binding sites per localization cloud corresponding to one 
or two binding sites per molecule. Scale bars: 7 μm (e), 300 nm (a), 100 nm (f), 25 nm (b,c), 
20 nm (g) 
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Supplementary Figure 5: Workflow of data acquisition and subsequent data processing 
using Picasso Software. a. Data was acquired using a Cy3b imager sequences, sCMOS 
camera and inverted TIRF microscope. In general, 80.000 frames with an integration time of 
100 ms and 20 mW laser exposure at the sample were used (power density: 0.8 kW/cm2). b. 
Images were reconstructed by identification and fitting of single-molecule spots in each frame. 
c. First, images were drift corrected using 5-10 gold particles as fiducial markers. d. 
Subsequently, images were drift corrected using image substack redundant cross-correlation 
(RCC). e. In an additional post-processing step, the sigma value (sx/sy) derived from the 
gaussian localization fit in b, was filtered to eliminate double binding and spurious binding 
events. f. Next, regions of interest were picked and used for further NND analysis. g. DBSCAN 
analysis was used to detect distinct localization clouds in ROIs. h. Further, mean frame filtering 
was used to remove DBSCAN detected clouds, which are not continuously visited by an 
imager strand over the whole course of imaging. i. Filtering of the standard deviation frame 
removes long binding events (imager sticking). j. Gaussian blur-based masking was 
performed to discriminate between FA and MEM regions. k. Final DBSCAN procedure with 
adjusted parameter sets dependent on the used imager sequences and individual localization 
cloud data is generated. The center of mass for each individual localization cloud was 
calculated to allow for nearest neighbor distance analysis using a kd-tree algorithm. 
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Supplementary Figure 6: DBSCAN resolution limit analysis. a. Design schematics for four 
different DNA origami structures with 12 binding sites spaced 20 nm, 9 binding sites at 25 nm 
or 30 nm and 7 binding sites spaced 35 nm apart (from left to the right). b. Super-resolved 
DNA-PAINT images of all DNA origami structures visually reveal distinct binding sites. c. 
Images of DBSCAN analysis with parameter sets used for FA analysis on DNA origami 
structures show proper separation of localization clouds down to 25 nm and merging of clouds 
at 20 nm distances due to increased crosstalk between individual localization clouds. d. 
Nearest neighbor distance (NND) histograms depict the proper localization cloud detection by 
fully automized DBSCAN based analysis at least down to 25 nm. Scale bar: 20 nm (b,c) 
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Supplementary Figure 7: Time resolved talin qPAINT analysis. a. DNA origami structures 
were seeded next to cells and analysed alongside at defined time points as qPAINT 
calibration. b. qPAINT analysis reveals single binding sites per talin localization cloud at each 
FA maturation time point, whereas double labeling of F7 construct and 3xP3 show a clear shift 
towards two binding sites and three binding sites per localization cloud, respectively. c. 
Boxplots of qPAINT analysis reveal medians around one binding site for time course data, two 
and three binding sites for F7 and triple P3 origami data. Scale bar: 10 μm (at 15’), 5 μm (at 
25’, 40’, 16h). 
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Supplementary Figure 8: Westernblot analysis of talin protein expression levels. From 
left to right. qko talin-1/-2 /kindlin-1/-2 flox: Expression level of talin and kindlin-2 in wildtype 
floxed cell line. Talin-Halo447 (not sorted): Overexpression of talin in talin-1/-2 / kindlin-1/-2 
deficient fibroblasts (qko) reconstituted with SNAP-Kindlin and talin-Halo447. Talin-Halo447 
(sorted) population 1/2: Sorting for lower 20 % talin expression level in two different 
populations, talin bands appear similar as wildtype talin-1/-2 and kindlin-1/-2 floxed cell line. 
Similarily, SNAP-kindlin bands of talin-Halo447 FACS sorted qko cells depict band intensities 
comparable to wildtype mKindlin2 expression. 
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Supplementary Figure 9: Comparison of Imager Strands and Labeling Probes. a. DNA-PAINT 
images of FAs using P3 or P1 imager strand. b. Comparison of P1 and P3 traces reveal different binding 
kinetics. P3 imager binds shorter than P1. c. After adjusting the parameter in the analysis pipeline, the 
same molecular densities are detected with P1 and P3. d. Distribution curves of the NND in FAs and 
membrane region using P1 and P3 show no apparent differences. e. DNA-PAINT images of the same 
FA area labeled with SNAP or HaloTag using talin-F7 construct. f. Traces of Halo labeled with P1 and 
SNAP labeled with P3. g. Analysis of the molecular density in FAs, labeled with SNAP (BG) or HaloTag 
(CA), show approximately 30% less SNAP labeling compared to Halo. h. Nearest neighbor distance 
distribution curve of SNAP (BG) and Halo (CA) in FAs and in the membrane region reveal a lower 
frequency count for SNAP and thus display a decreased number of detected localization clouds. Scale 
bars: 200 nm (a,e). 
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Supplementary Figure 10: Simulations for Exchange Colocalization Experiments. a. 
Histograms of simulated colocalization data assuming a labeling efficiency of 30%, randomly 
organized localization clouds and the molecular density for kindlin and talin from the 
experiments. In addition, the simulations assume a certain percentage of complex formation 
at 12-16 nm (from 0% up to 100% complex formation) and were analyzed using the simulated 
x- and y-coordinates without subjecting the spots to an additional simulated DNA-PAINT 
process and the established cluster detection pipeline. The histograms reveal that 
colocalization of two populations under 15% is not detectable due to the inherent statistical 
variability. b. The percentage of complex formation was plotted against the percentage of 
localization clouds closer than 25 nm. This simulation nicely reproduces the kindlin-talin 
exchange colocalization data, where 100% complex formation shows around 60% 
colocalization (talin-F7= 58% colocalization) whereas 0% complex formation has still 40% 
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colocalization (Talin-Halo + SNAP-mKindlin (c) = 40% colocalization). This high percentage is 
presumably due to the high molecular densities in focal adhesions. Almost no difference can 
be detected up to 15% complex formation. The talin-Halo447 and SNAP-mKindlin2 cell line (i) 
experiment reveal a colocalization of 45%, which is in good accordance to a 40-50% simulated 
complex formation. 
 
 

 
Supplementary Figure 11: Nearest neighbor distance comparison of talin-Halo (c-term) 
and talin-Halo447 qko cell line. Talin-Halo (c-term) or talin-Halo447 stably transfected in 
kindlin-1/2 and talin-1/2- deficient fibroblasts together with SNAP-Kindlin exhibit expected 
comparable NNDs in FAs (magenta) of about 45 nm (left) and 40 nm (right) distances. 
Moreover, SNAP-Kindlin NNDs are equivalent in both cell lines. 
 
 

 
Supplementary Figure 12: Comparison of Integrin-Talin-Kindlin Experimental Data with 
Simulations using Bootstrap Method. To determine the goodness of fit and significance 
level between experimental data and simulated data a 2d Kolmogorov-Smirnov (K-S) test was 
established. Bootstrap method was utilized to calculate the level of differences by repeatingly 
calculating p-values. In detail, 1000 data points (tuples) were randomly sampled out of each 
data set consisting of 30.000 tuples and the maximum difference (p value) obtained by 
performing 2d K-S test. The above described process is repeated for 1000 times to obtain a 
series of maximum differences between two data sets leading to the mean differences. 
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Supplementary Materials & Methods  
 

Labeling probes and reagents. Chloroalkane (CA; HaloTag ligand) or benzylguanine (BG; 

SNAP-tag ligand)-modified docking strands carrying an Atto488 dye at the 3’-end were 

custom-ordered from Biomers.net. Imager strands with a Cy3b modification at the 3’-end were 

purchased from Eurofins; for oligonucleotide sequences see Supplementary Table 1 and 2. 

For imaging, the following antioxidant stock solutions were used: 40x PCA solution (154 mg 

PCA diluted in 10 ml ddH2O, pH 9.0); 100x Trolox (100 mg of Trolox in 430 µl Methanol, 345 

µl NaOH (1M) and 3.2ml ddH20); 100x PCD solution (9.3 mg of PCD diluted in 13.3 ml of 50 

% glycerol with 50 mM KCl, 1 mM EDTA and 100 mM Tris–HCl, pH 8.0). PCD, PCA and Trolox 

stocks were stored at -20 °C. In addition, the following antibodies and reagents were used: α-

integrin 9EG7 (BD Biosciences, 553715), α-Talin (Sigma, T3287), α-Kindlin-2 (Sigma, K3269), 

paraformaldehyde (Roth, 4980.1), Triton X-100 (Roth, 3051.4), bovine serum albumin (Serva, 

11930.03) and dimethylformamid (Thermo Fisher, 20673).  

 

Plasmid construction. Talin-1 expression constructs are based on human talin-1 cDNA 

(NM_006289). For internal tagging, a linker encoding for 5’SalI/3’NotI restriction sites was 

generated after the base pair encoding for aa 447, and HaloTag (Promega), SNAP-tag (New 

England Biolabs) or the F7 cassette were inserted by Gibson Cloning. The C-terminal fusion 

construct (htln1-Halo-Cterm) was generated using EcoRI/BamHI restriction sites. The 

assembled cDNAs were then transferred into pLPCXmod that drives expression through a 

CMV promotor and the correct sequence of all constructs was confirmed by DNA sequencing 

(Eurofins Genomics). Kindlin expression constructs are based on mouse Kindlin-2 (Gene ID: 

218952), which was tagged N-terminally with SNAP-tag via Gibson cloning using HindIII/NotI 

restriction sites. The construct was cloned into pLPCXmod with a crippled CMV promoter to 

avoid overexpression. The human SNAP-tagged β1 integrin was cloned by exchanging the 

GFP cDNA from the extracellularly tagged β1A integrin 

(NM_002211, GeneID:3688) described before1 with SNAP cDNA in a loop in the hybrid 

domain (before aa  108) using AgeI and XhoI. 

 

Cell Culture. Cells were maintained in high glucose DMEM (ThermoFisher, 31966047) 

supplemented with 10 % Fetal Bovine Serum (ThermoFisher, 10270106) and 1 % 

Penicillin/Streptomycin (Sigma, P4333). The talin constructs were stably expressed in double 

knockout fibroblasts deficient for talin-1 and talin-2 (Tln1-/-Tln2-/-; dKO)2 as previously 

described3, or co-expressed with kindlin-2 in quadruple knockout fibroblasts deficient for talin-
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1, talin-2, kindlin-1 and kindlin-2 (Tln1-/-Tln2-/- K1-/-K2-/-; qKO)4. To control expression artefacts 

this qko cell line, expressing talin-halo447 and SNAP-kindlin, was FACS sorted for lower 20 

% talin expression level using HaloTag® TMR ligand (Promega G825A) labeling as sorting 

marker. The integrin-SNAP construct was analyzed in integrin pan knockout cells (αv-/-β1-/-β3-

/-β7-/-)5. For imaging, 40,000 cells were seeded on ibidi μ-Dishes (Ibidi, 81158,) with or without 

coating of 10 µg/ml fibronectin (Calbiochem, 341631). 

 
Cell fixation and labeling of Halo- or SNAP-tag. Cells were fixed with pre-warmed 4 % PFA 

solution for 10 min, washed 3× with phosphate buffered solution (PBS), and stained with 1 μM 

of either chloroalkane (HaloTag) or benzylguanine (SNAP-tag)-linked docking strands, as 

summarized in Supplementary Table 1. Staining was performed in PBS containing 0.2 % 

Triton X-100 overnight. Cells were then washed 3× for 5 min in 1× PBS, incubated with a 1:3 

dilution of 90 nm gold particles (Cytodiagnostics, G-90-100) as drift markers in 1× PBS for 5 

min, washed again 3× 5 min in PBS, and immediately imaged. 

 

Stamp production for micropatterning. To produce polydimethylsiloxane (PDMS) stamps 

for microcontact printing, we use photolithography to create micro-structured silicon wafers as 

a master. The silicon wafers (MicroChemicals) were dipped into 1% hydrofluoric acid 

(MicroChemicals) to make the surface hydrophobic and promote the adhesion of the resist. 

The wafer was then coated with AZ40XT D11 (MicroChemicals, Merck) photo-resist and soft 

baked ramped to 125°C. Desired areas are exposed to UV light using laser direct imaging 

(Protolaser LDI, LPKF). The exposed wafer was then post baked at 110°C before 

development (AZ 726 MIF, MicroChemicals) and silanization (Trichloro(1H,1H,2H,2H-

perfluoro-octyl)silane, Sigma-Aldrich). Next, PDMS monomer and cross linker (DC 184 

elastomer kit, Dow Corning) was mixed in a 10:1 ratio and poured onto the master. After 

degassing in a desiccator, the PDMS stamp was cured overnight at 50°C. 

 

Microcontact printing. PDMS stamps were treated with UV light (PSD-UV, novascan) for 5 

min and inked with 50 µg/ml FN (Yo proteins) solution (80% unlabelled FN, 20% labelled with 

Alexa Fluor 647 NHS ester (Thermo Fisher Scientific)) for 45 min. Subsequently, a petri dish 

(µ-Dish, Ibidi) was treated with UV light for 15 min, stamps were washed with deionized water, 

dried and placed on the petri dish. A droplet of a solution containing 2 mg/ml poly-L-lysine-

grafted polyethylene glycol (PLL-PEG, 2 kDa PEG chains, SuSoS), 10 mM HEPES, and 150 

mM NaCl was placed at the side of the stamp to allow flowing into the free space under the 

stamp. After 30 min stamps were removed and another drop of PLL-PEG solution was added. 
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Next, the surface was covered with a glass slide for 30 min to ensure coverage with PLL-PEG. 

The glass slide was then removed and the patterned surface was washed 3× 5 min in PBS 

and stored in PBS. 

 
Super-resolution microscopy. Fluorescence imaging was carried out on an inverted Nikon 

Eclipse Ti microscope (Nikon Instruments) equipped with the Perfect Focus System, applying 

an objective-type TIRF configuration with an oil-immersion objective (Apo SR TIRF 100×, NA 

1.49, Oil). TIRF angle was adjusted for highest signal to noise ratio prior to imaging. For 

excitation of Atto488 and Cy3b, a 488 nm laser (Toptica iBeam smart, 200 mW) or a 561 nm 

(Coherent Sapphire, 200 mW) laser were used. The lasers were fiber coupled and, after 

entering the microscope, the laser beam was passed through cleanup filters (ZET488/10x or 

ZET561/10, Chroma Technology) and coupled into the microscope objective using a beam 

splitter (ZT488rdc or ZT561rdc, Chroma Technology).). Fluorescence light was spectrally 

filtered with two emission filters (ET525/50m and ET500lp for 488 nm excitation and 

ET600/50m and ET575lp for 561 nm laser excitation, Chroma Technology) and imaged on a 

sCMOS camera (Andor Zyla 4.2) without further magnification resulting - after 2x2 binning - in 

an effective pixel size of 130 nm per pixel. 

 
DNA-PAINT imaging in cells. FAs of cells were focused by using 488 nm excitation, which 

excited the fixed Atto488 fluorophore on the DNA docking site. For DNA-PAINT imaging, 

samples were imaged using 561 nm excitation wavelength and a laser power of 20 mW at the 

sample (power density: 0.8 kW/cm2); qPAINT measurements were performed with reduced 

laser power of 10 mW at the sample (power density: 0.4 kW/cm2). Depending on the docking 

site sequence, the imager strand concentration was set between 250 pM–2.5 nM and imaging 

was performed in the presence of antioxidants using a solution of 1x PCA (Stock 40x PCA 

solution; Sigma, 37580), 1x PCD (Stock 100x PCD solution; Sigma, P8279) and 1x Trolox 

(Stock 100x Trolox solution; Sigma, 238813) in 1× PBS + 500 mM NaCl. To experimentally 

mimic different molecular densities, chloroalkane (CA)-P1 and chloroalkane (CA)-P3 docking 

strands were mixed in different ratios (1:2 – 1:10) to ensure only partial P1 imager binding, 

and subsequently added to fixed cells as described above. Typically, 80.000 frames at 100 

ms exposure time were acquired for NND imaging, and 160.000 frames and 100 ms for 

qPAINT measurements. 

 

Multiplexed imaging with Exchange-PAINT. Chloroalkane (CA)-P1 and benzylguanine 

(BG)-P3 (in case of three-target Exchange PAINT also P5-conjugated 9EG7 antibody) were 

diluted in 1× PBS containing 0.02 % Triton X-100 and added to PFA-fixed qKO cells 

expressing SNAP-Kindlin-2 and talin-Halo447. The cells were then washed thoroughly with 
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1× PBS and imaged in two (or three) subsequent steps by DNA-PAINT super-resolution 

microscopy. In the first step, SNAP-Kindlin-2 was imaged using 2.5 nM Cy3b-P3 imager strand 

concentration (250 pM Cy3b-R2 for triple color experiments). After washing, 2.5 nM Cy3b-P1 

(or 250 pM Cy3b-R1 for triple color experiments) was added to image talin-Halo447. For triple 

color experiments, an additional round of exchange was performed with Cy3b-P3 (1nM) to 

label 9EG7 bound β1 integrin. To confirm that results are unaffected by the employed docking 

strand sequence, experiments were repeated using CA-P3 and BG-P1 docking strands in 

combination with the respective imager strands.  

 
Exchange-PAINT experiments for docking strand damage and label efficiency. To test 

for docking stand breaks due to laser light and the influence of buffer exchange, talin-Halo447, 

expressed in double knockout fibroblasts deficient for talin-1 and talin-2 (Tln1-/-Tln2-/-; dKO), 

was labeled with Chloroalkane (CA)-P3 as described above, measured a first round ( 80.000 

frames, 100 ms exposure), washed thoroughly with 1xPBS and imaged a second round 

(80.000 frames , 100 ms exposure) analogously. Docking strand sequence label influence (P1 

vs. P3) was determined by labeling talin-Halo447 expressing cells with either CA-P1 or CA-

P3 docking strands accordingly and performing sequential imaging of cells prior to analysis. 

To determine influence of Halo and SNAP label efficiency, talin-F7 construct was stably 

expressed in double knockout fibroblasts deficient for talin-1 and talin-2 (Tln1-/-Tln2-/-; dKO) 

and labeled with CA-P1 and benzylguanine (BG)-P3 respectively. Sequential imaging was 

performed, starting with SNAP measurement (P3 imager sequence) followed by thorough 

washing steps using 1xPBS and a second measurement round of Halo (P1 sequence). 

 
DNA Origami self-assembly. DNA origami structures were designed using the Picasso 

software6. The DNA origami self-assembly was performed in a reaction mix (Supplementary 

Table 3) containing 10 nM p7249 scaffold strand M13mp18 (tilibit nanosystems), 100 nM 

folding staples (Eurofins, Supplementary Table 4), 10 nM biotinylated staples (Eurofins, 

Supplementary Table 5) and 1 µM P3-docking strand in 5 mM Tris and 1 mM EDTA buffer 

containing 12.5 mM MgCl2. Subsequently, the DNA origami self-assembled in a thermocycler 

running the following cycling protocol: Step 1: 80°C for 5 min; step 2: immediate cool down to 

60°C; step 3: further cool down from 60°C to 4°C in steps of 1°C per 3.21 min.  

 

PEG precipitation for DNA origami. Polyethylenglycol (PEG) was used to decrease the 

solubility of origami in solution and induce origami precipitation7. Origami solution in 1× TE 

buffer with 12.5 mM MgCl2 was mixed 1:1 with 15 % PEG-buffer (7.5g PEG-8000, 1× TAE, 

12.5 mM MgCl2, 500 mM NaCl) and centrifuged at 20.000 ×g at 4°C for 30 min. The 
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supernatant was removed and origamis were resuspended in folding buffer (12.5 mM MgCl2, 

5 mM Tris, 1 mM EDTA at pH 8.0). Centrifugation and supernatant removal was repeated 

three additional times. Origamis were then stored at -20°C.  

 

Cell experiments with DNA origami. Cells were seeded, fixed and labelled as described 

above. To perform qPAINT experiments, labeling solution was removed and cells were 

washed 3× times with 1× PBS. Next, 200 µl BSA-Biotin solution (1 mg/ml BSA in buffer A+ 

(10 mM Tris-HCL, 100 mM NaCl and 0.05% Tween 20, pH 8.0)) was added and incubated for 

10 min. The dish was then carefully washed with buffer A+, 200 µl streptavidin solution (0.5 

mg/ml in buffer A+) was added and incubated for another 10 min. Afterwards, the dish was 

washed with buffer A+ and subsequently with buffer C (1× PBS + 500 mM NaCl). Then, 200 

µl of biotin labeled DNA origami solution was added (200 pM in buffer C) and incubated for 60 

min. Finally, the dish was carefully washed with buffer C and imaging buffer was added.  

 
Antibody conjugation with DNA-PAINT docking strands. Integrin β1 9EG7 antibody was 

conjugated to DNA-PAINT docking strands via available amine groups using a bifunctional 

NHS-ester crosslinker harboring an additional trans-cyclooctene moiety (TCO; TCO-NHS 

ester ((E)cyclooct-4-enyl-2,5-dioxo-1-pyrrolidinyl carbonate), Jena Bioscience, CLK-1016-25), 

which was later reacted with a methyltetrazine-PEG5 modified DNA strand to yield the final 

antibody-DNA conjugate8. In brief, the antibody storage buffer was exchanged via dialysis to 

1× PBS overnight at 4°C under constant stirring. The antibody was then concentrated with 

100 kDa Amicon spin filters (Merck/EMD Millipore, UFC500396), TCO-NHS ester crosslinker 

was added at 10× molar excess and incubated for 2 h at 4°C on a shaker. Afterwards, 7k zeba 

spin desalting columns (ThermoFisher, 89882) were used to remove unreacted crosslinker. 

Tz-DNA was added to the purified antibody-crosslinker solution at 5x molar excess and 

incubated for 1 h at room temperature. Subsequently, amicon spin filters were used to remove 

free Tz-DNA and the antibody conjugate was stored at 4°C.  

 

Image reconstruction. Images were reconstructed with the Picasso Software. Drift correction 

was performed stepwise starting with the gold nanoparticles for global drift correction followed 

by image sub-stack cross-correlation analysis. Localization precision was determined by 

nearest neighbor based analysis (NeNA)9.  

 

qPAINT analysis. First, images were localized and drift corrected as described previously6. 

Then, single binding sites on DNA origami structures were picked using the ‘Picasso-Render-

picking-tool’ (about 200-500 single origami binding sites/image). Afterwards, the picked single 
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binding sites were calibrated to one unit per pick and the influx rate was estimated from the 

binding kinetics of the picked single binding sites on DNA origamis6,10. The binding kinetics 

depend on the imager strand length, GC content, buffer salt concentration and imager 

concentration.  Subsequently, talin localization clouds were picked (about 1000-1500 

picks/image) and the mean number of binding sites in FAs were calculated from the calibrated 

influx rate.  

 

Data processing and analysis. For further analysis, we used DBSCAN (density based 

clustering of application with noise) as a data clustering algorithm6,11. This DBSCAN clustering 

algorithm detects localization clouds by looking for minimal numbers of localizations within a 

circle with radius, ε. Moreover, the algorithm utilizes a minimum number of points (MinPts) 

within an area of the circle as a second parameter. For ε, we used the localization precision 

in pixels of our images (NeNA) and MinPts were chosen according to the binding frequency 

of the imager strand (Extended Data 4). Furthermore, we used a mean frame filter and a 

standard deviation filter to remove unspecific signals of the imager strands.  

For NND calculations, we used custom written python scripts based on kd-tree analysis12 to 

calculate the nearest neighbor within a localization cloud dataset. For co-localization analysis, 

the nearest neighbor distance for each localization cloud of one dataset with respect to the 

reference dataset was calculated (kindlin-to-talin, integrin-to-talin, and integrin-to-kindlin). 

Molecular densities were calculated by dividing the determined number of localization clouds 

within the FA mask by the respective FA mask area.  

 

Statistical analysis. Determining if two data sets were equal, two-sample t-tests were applied 

with a p-value threshold of less than 0.05 defining statistical significance (Fig. 3d, Extended 

Data 9). To determine the goodness of fit between experimental data and simulated data in 

Fig. 4d, a 2D Kolmogorov-Smirnov (K-S) test was used13. Bootstrapping was performed to 

calculate the mean differences and standard deviation. In brief, 1000 data points (tuples) were 

randomly sampled out of each data set consisting of approximately 30.000 tuples. This 

procedure was applied on both data sets and the maximum difference obtained by performing 

a K-S test. This process was repeated 1000 times to obtain a series of maximum differences 

between the two data sets leading to the mean differences and stdv (Extended Data 16). 

Simulated vs simulated data and experimental vs experimental data were compared as a 

control, resulting in high p-values for intrinsic data. Then, experimental data (integrin-kindlin-

talin distances; I2KT) vs randomly simulated data were compared, leading to high differences 

and thus low p-values (ns P	>	0.05; * P	≤	0.05; ** P	≤	0.01; *** P 	≤	0.001).  
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Fitting of NND distributions. Plotting the NND over a logarithmic distance scale results in 

symmetric, Gaussian-shaped distributions pointing towards a structural order parameter. The 

simplest assumption of order is a random point localization, which - in two dimensions- is 

mathematically described by the 2D Poisson point process and its respective homogeneous 

Poisson density probability function (𝜌 being the density): 

𝛲(𝑟) = 2𝜋𝑟𝜌𝑒pqr,s  

 

NND data was fitted in Origin9.1 using this custom built fitting function (Fig. 3e).  

 

Simulation parameters. Simulations of random particle distributions were performed with 

custom python scripts. In brief, for random distributions, random x- and y-coordinates were 

generated using the molecular particle densities extracted from the measured DNA-PAINT 

data. In agreement with previously published data and our own talin-F7 experiments14,15 

(Extended Data 10), we assumed labeling efficiencies of 30 % (Halo-tag) and 20 % (SNAP-

tag). DNA-PAINT simulations were performed with the previously reported Picasso software6 

using parameters that were extracted from our experimental data to mimic raw data for image 

reconstruction and post processing filter steps (shown in Supplementary Table 6). To estimate 

the absolute molecular density and the corresponding NND, we set the CA labeling efficiency 

to 30 %. To determine the localization cloud detection efficiency of the DBSCAN analysis, we 

compared hand-picked data with automatically analyzed data, which revealed a detection 

efficiency of about 50-60 % (Fig. 2f). For simulations of complex formation, clusters were 

simulated to be within 12-16 nm, which corresponds to the measured distances in the F7 

control construct (Fig. 3d, Extended Data 13). To calculate the degree of co-localization within 

three random distributions, clusters were simulated with the measured molecular density of 

the respective experiment (Fig. 4d). All simulation scripts are available upon request. 

 

 

 
Supplementary Table 1: Ligands with conjugated DNA-PAINT handles 

Docking 
strand 

Sequence 5’-mod 3’-mod Company 

CA-P1 TTA TAC ATC 

TAT T 

Chloroalkane Atto488 Biomers 

CA-P3 TTT CTT CAT 

TAT T 

Chloroalkane Atto488 Biomers 
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CA-R1 TTT CCT CCT 

CCT CCT CCT 

CCT 

Chloroalkane None Biomers 

SNAP-R2 AAA CCA CCA 

CCA CCA CCA 

CCA AA 

Benzylguanine Atto488 Biomers 

BG-P1 TTA TAC ATC 

TAT T 

Benzylguanine Atto488 Biomers 

BG-P3 TTT CTT CAT 

TAT T 

Benzylguanine Atto488 Biomers 

BG-P5 TTT CAA TGT 

AT 

Benzylguanine Atto488 Biomers 

TZ-P3 TTT CTT CAT 

TA 

Tetrazine (Methyltetrazin-

PEG5) 

None Biomers 

 

 

Supplementary Table 2: DNA-PAINT sequences 

Imager strand Sequence 5’-mod 3’-mod Company 
P1 AGA TGT AT None Cy3b Eurofins 

P3 AAT GAA GA None Cy3b Eurofins 

P5 TAC ATT GA None Cy3b Eurofins 

R1 AGGAGGA None Cy3b Metabion 

R2 TGGTGGT None Cy3b Metabion 
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Supplementary Table 3: Folding Protocol 
 

Component 
Initial 
conc.[µM] Parts 

Pool conc. 
[nM] 

Target conc. 
[nM] 

Vol. 
[ul] Excess 

Scaffold 0.1 1 100 10 4 1 

Core Mix 100 164 609.76 100 6.56 10 

P3 Mix 100 12 8333.3 1000 4.8 100 

Biotin 1:10 100 80 1250 10 0.32 1 

H2O 
    

20.32 
 

10x Folding 

Buffer 
    

4 
 

Total Vol. 
    

40 
 

 
 
Supplementary Table 4: Core staples and extension for DNA origami assembly. 
Color coded staples were extended in the respective structures at the 3’-end with a 

P3 DNA-PAINT docking site: 5’- staple – TTTCTTCATTA -3’; red: 35 nm origami; 

orange: 30 nm origami; light green: 25 nm origami; dark green: 20 nm origami 

 
Plate  Plate 

position Oligo name Sequence 
1 A1 21[32]23[31]BLK TTTTCACTCAAAGGGCGAAAAACCATCACC 

1 A2 19[32]21[31]BLK GTCGACTTCGGCCAACGCGCGGGGTTTTTC 

1 A3 17[32]19[31]BLK TGCATCTTTCCCAGTCACGACGGCCTGCAG 

1 A4 15[32]17[31]BLK TAATCAGCGGATTGACCGTAATCGTAACCG 

1 A5 13[32]15[31]BLK AACGCAAAATCGATGAACGGTACCGGTTGA 

1 A6 11[32]13[31]BLK AACAGTTTTGTACCAAAAACATTTTATTTC 

1 A7 9[32]11[31]BLK TTTACCCCAACATGTTTTAAATTTCCATAT 

1 A8 7[32]9[31]BLK TTTAGGACAAATGCTTTAAACAATCAGGTC 

1 A9 5[32]7[31]BLK CATCAAGTAAAACGAACTAACGAGTTGAGA 

1 A10 3[32]5[31]BLK AATACGTTTGAAAGAGGACAGACTGACCTT 

1 A11 1[32]3[31]BLK AGGCTCCAGAGGCTTTGAGGACACGGGTAA 

1 A12 0[47]1[31]BLK AGAAAGGAACAACTAAAGGAATTCAAAAAAA 

1 

B1 23[32]22[48]BLK 

CAAATCAAGTTTTTTGGGGTCGAAACGTG

GA 
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1 

B2 22[47]20[48]BLK 

CTCCAACGCAGTGAGACGGGCAACCAG

CTGCA 

1 

B3 20[47]18[48]P3 

TTAATGAACTAGAGGATCCCCGGGGGGT

AACG TTTCTTCATTA 

1 

B4 18[47]16[48]BLK 

CCAGGGTTGCCAGTTTGAGGGGACCCGT

GGGA 

1 

B5 16[47]14[48]BLK 

ACAAACGGAAAAGCCCCAAAAACACTGG

AGCA 

1 

B6 14[47]12[48]BLK 

AACAAGAGGGATAAAAATTTTTAGCATAA

AGC 

1 

B7 12[47]10[48]P3 

TAAATCGGGATTCCCAATTCTGCGATATA

ATG TTTCTTCATTA 

1 

B8 10[47]8[48]BLK 

CTGTAGCTTGACTATTATAGTCAGTTCAT

TGA 

1 

B9 8[47]6[48]BLK 

ATCCCCCTATACCACATTCAACTAGAAAA

ATC 

1 

B10 6[47]4[48]BLK 

TACGTTAAAGTAATCTTGACAAGAACCGA

ACT 

1 

B11 4[47]2[48]P3 

GACCAACTAATGCCACTACGAAGGGGGT

AGCA TTTCTTCATTA 

1 B12 2[47]0[48]BLK ACGGCTACAAAAGGAGCCTTTAATGTGAGAAT 

1 

C1 21[56]23[63]BLK 

AGCTGATTGCCCTTCAGAGTCCACTATTAAAG

GGTGCCGT 

1 

C2 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

C3 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

C4 15[64]18[64]BLK 

GTATAAGCCAACCCGTCGGATTCTGACGACAG

TATCGGCCGCAAGGCG 

1 C5 13[64]15[63]BLK TATATTTTGTCATTGCCTGAGAGTGGAAGATT 

1 

C6 11[64]13[63]BLK 

GATTTAGTCAATAAAGCCTCAGAGAACCC

TCA 

1 C7 9[64]11[63]BLK CGGATTGCAGAGCTTAATTGCTGAAACGAGTA 

1 

C8 7[56]9[63]BLK 

ATGCAGATACATAACGGGAATCGTCATAAATAA

AGCAAAG 
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1 

C9 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

C10 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

C11 1[64]4[64]BLK 

TTTATCAGGACAGCATCGGAACGACACCAACC

TAAAACGAGGTCAATC 

1 C12 0[79]1[63]BLK ACAACTTTCAACAGTTTCAGCGGATGTATCGG 

1 D1 23[64]22[80]BLK AAAGCACTAAATCGGAACCCTAATCCAGTT 

1 D2 22[79]20[80]BLK TGGAACAACCGCCTGGCCCTGAGGCCCGCT 

1 D3 20[79]18[80]BLK TTCCAGTCGTAATCATGGTCATAAAAGGGG 

1 D4 18[79]16[80]BLK GATGTGCTTCAGGAAGATCGCACAATGTGA 

1 D5 16[79]14[80]BLK GCGAGTAAAAATATTTAAATTGTTACAAAG 

1 D6 14[79]12[80]BLK GCTATCAGAAATGCAATGCCTGAATTAGCA 

1 D7 12[79]10[80]BLK AAATTAAGTTGACCATTAGATACTTTTGCG 

1 D8 10[79]8[80]BLK GATGGCTTATCAAAAAGATTAAGAGCGTCC 

1 D9 8[79]6[80]BLK AATACTGCCCAAAAGGAATTACGTGGCTCA 

1 D10 6[79]4[80]BLK TTATACCACCAAATCAACGTAACGAACGAG 

1 D11 4[79]2[80]BLK GCGCAGACAAGAGGCAAAAGAATCCCTCAG 

1 D12 2[79]0[80]BLK CAGCGAAACTTGCTTTCGAGGTGTTGCTAA 

1 E1 21[96]23[95]BLK AGCAAGCGTAGGGTTGAGTGTTGTAGGGAGCC 

1 E2 19[96]21[95]BLK CTGTGTGATTGCGTTGCGCTCACTAGAGTTGC 

1 E3 17[96]19[95]BLK GCTTTCCGATTACGCCAGCTGGCGGCTGTTTC 

1 E4 15[96]17[95]BLK ATATTTTGGCTTTCATCAACATTATCCAGCCA 

1 E5 13[96]15[95]BLK TAGGTAAACTATTTTTGAGAGATCAAACGTTA 

1 E6 11[96]13[95]BLK AATGGTCAACAGGCAAGGCAAAGAGTAATGTG 

1 E7 9[96]11[95]BLK CGAAAGACTTTGATAAGAGGTCATATTTCGCA 

1 E8 7[96]9[95]BLK TAAGAGCAAATGTTTAGACTGGATAGGAAGCC 

1 E9 5[96]7[95]BLK TCATTCAGATGCGATTTTAAGAACAGGCATAG 

1 E10 3[96]5[95]BLK ACACTCATCCATGTTACTTAGCCGAAAGCTGC 

1 E11 1[96]3[95]BLK AAACAGCTTTTTGCGGGATCGTCAACACTAAA 

1 E12 0[111]1[95]BLK TAAATGAATTTTCTGTATGGGATTAATTTCTT 

1 F1 23[96]22[112]BLK CCCGATTTAGAGCTTGACGGGGAAAAAGAATA 

1 F2 22[111]20[112]BLK GCCCGAGAGTCCACGCTGGTTTGCAGCTAACT 

1 

F3 20[111]18[112]P3 

CACATTAAAATTGTTATCCGCTCATGCGGGCC 

TTTCTTCATTA 
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1 F4 18[111]16[112]BLK TCTTCGCTGCACCGCTTCTGGTGCGGCCTTCC 

1 F5 16[111]14[112]BLK TGTAGCCATTAAAATTCGCATTAAATGCCGGA 

1 F6 14[111]12[112]BLK GAGGGTAGGATTCAAAAGGGTGAGACATCCAA 

1 

F7 12[111]10[112]P3 

TAAATCATATAACCTGTTTAGCTAACCTTTAA 

TTTCTTCATTA 

1 F8 10[111]8[112]BLK TTGCTCCTTTCAAATATCGCGTTTGAGGGGGT 

1 F9 8[111]6[112]BLK AATAGTAAACACTATCATAACCCTCATTGTGA 

1 F10 6[111]4[112]BLK ATTACCTTTGAATAAGGCTTGCCCAAATCCGC 

1 

F11 4[111]2[112]P3 

GACCTGCTCTTTGACCCCCAGCGAGGGAGTTA 

TTTCTTCATTA 

1 F12 2[111]0[112]BLK AAGGCCGCTGATACCGATAGTTGCGACGTTAG 

1 

G1 21[120]23[127]BLK 

CCCAGCAGGCGAAAAATCCCTTATAAATCAAGCC

GGCG 

1 

G2 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

G3 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

G4 15[128]18[128]BLK 

TAAATCAAAATAATTCGCGTCTCGGAAACCAGGC

AAAGGGAAGG 

1 G5 13[128]15[127]BLK GAGACAGCTAGCTGATAAATTAATTTTTGT 

1 G6 11[128]13[127]BLK TTTGGGGATAGTAGTAGCATTAAAAGGCCG 

1 G7 9[128]11[127]BLK GCTTCAATCAGGATTAGAGAGTTATTTTCA 

1 

G8 7[120]9[127]BLK 

CGTTTACCAGACGACAAAGAAGTTTTGCCATAAT

TCGA 

1 

G9 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

G10 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

1 

G11 1[128]4[128]BLK 

TGACAACTCGCTGAGGCTTGCATTATACCAAGC

GCGATGATAAA 

1 G12 0[143]1[127]BLK TCTAAAGTTTTGTCGTCTTTCCAGCCGACAA 

1 H1 21[160]22[144]BLK TCAATATCGAACCTCAAATATCAATTCCGAAA 

1 H2 19[160]20[144]BLK GCAATTCACATATTCCTGATTATCAAAGTGTA 

1 H3 17[160]18[144]BLK AGAAAACAAAGAAGATGATGAAACAGGCTGCG 

1 H4 15[160]16[144]BLK ATCGCAAGTATGTAAATGCTGATGATAGGAAC 
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1 H5 13[160]14[144]BLK GTAATAAGTTAGGCAGAGGCATTTATGATATT 

1 H6 11[160]12[144]BLK CCAATAGCTCATCGTAGGAATCATGGCATCAA 

1 H7 9[160]10[144]BLK AGAGAGAAAAAAATGAAAATAGCAAGCAAACT 

1 H8 7[160]8[144]BLK TTATTACGAAGAACTGGCATGATTGCGAGAGG 

1 H9 5[160]6[144]BLK GCAAGGCCTCACCAGTAGCACCATGGGCTTGA 

1 H10 3[160]4[144]BLK TTGACAGGCCACCACCAGAGCCGCGATTTGTA 

1 H11 1[160]2[144]BLK TTAGGATTGGCTGAGACTCCTCAATAACCGAT 

1 H12 0[175]0[144]BLK TCCACAGACAGCCCTCATAGTTAGCGTAACGA 

2 A1 23[128]23[159]BLK AACGTGGCGAGAAAGGAAGGGAAACCAGTAA 

2 A2 22[143]21[159]BLK TCGGCAAATCCTGTTTGATGGTGGACCCTCAA 

2 A3 20[143]19[159]BLK AAGCCTGGTACGAGCCGGAAGCATAGATGATG 

2 A4 18[143]17[159]BLK CAACTGTTGCGCCATTCGCCATTCAAACATCA 

2 A5 16[143]15[159]BLK GCCATCAAGCTCATTTTTTAACCACAAATCCA 

2 A6 14[143]13[159]BLK CAACCGTTTCAAATCACCATCAATTCGAGCCA 

2 A7 12[143]11[159]BLK TTCTACTACGCGAGCTGAAAAGGTTACCGCGC 

2 A8 10[143]9[159]BLK CCAACAGGAGCGAACCAGACCGGAGCCTTTAC 

2 A9 8[143]7[159]BLK CTTTTGCAGATAAAAACCAAAATAAAGACTCC 

2 A10 6[143]5[159]BLK GATGGTTTGAACGAGTAGTAAATTTACCATTA 

2 A11 4[143]3[159]BLK TCATCGCCAACAAAGTACAACGGACGCCAGCA 

2 A12 2[143]1[159]BLK ATATTCGGAACCATCGCCCACGCAGAGAAGGA 

2 B1 23[160]22[176]BLK TAAAAGGGACATTCTGGCCAACAAAGCATC 

2 B2 22[175]20[176]BLK ACCTTGCTTGGTCAGTTGGCAAAGAGCGGA 

2 

B3 20[175]18[176]P3 

ATTATCATTCAATATAATCCTGACAATTAC 

TTTCTTCATTA 

2 B4 18[175]16[176]BLK CTGAGCAAAAATTAATTACATTTTGGGTTA 

2 B5 16[175]14[176]BLK TATAACTAACAAAGAACGCGAGAACGCCAA 

2 B6 14[175]12[176]BLK CATGTAATAGAATATAAAGTACCAAGCCGT 

2 

B7 12[175]10[176]P3 

TTTTATTTAAGCAAATCAGATATTTTTTGT 

TTTCTTCATTA 

2 B8 10[175]8[176]BLK TTAACGTCTAACATAAAAACAGGTAACGGA 

2 B9 8[175]6[176]BLK ATACCCAACAGTATGTTAGCAAATTAGAGC 

2 B10 6[175]4[176]BLK CAGCAAAAGGAAACGTCACCAATGAGCCGC 

2 

B11 4[175]2[176]P3 

CACCAGAAAGGTTGAGGCAGGTCATGAAAG 

TTTCTTCATTA 

2 B12 2[175]0[176]BLK TATTAAGAAGCGGGGTTTTGCTCGTAGCAT 
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2 

C1 21[184]23[191]BLK 

TCAACAGTTGAAAGGAGCAAATGAAAAATCTAG

AGATAGA 

2 

C2 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

C3 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

C4 15[192]18[192]BLK 

TCAAATATAACCTCCGGCTTAGGTAACAATTTCA

TTTGAAGGCGAATT 

2 C5 13[192]15[191]BLK GTAAAGTAATCGCCATATTTAACAAAACTTTT 

2 C6 11[192]13[191]BLK TATCCGGTCTCATCGAGAACAAGCGACAAAAG 

2 C7 9[192]11[191]BLK TTAGACGGCCAAATAAGAAACGATAGAAGGCT 

2 

C8 7[184]9[191]BLK 

CGTAGAAAATACATACCGAGGAAACGCAATAAG

AAGCGCA 

2 

C9 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

C10 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

C11 1[192]4[192]BLK 

GCGGATAACCTATTATTCTGAAACAGACGATTG

GCCTTGAAGAGCCAC 

2 C12 0[207]1[191]BLK TCACCAGTACAAACTACAACGCCTAGTACCAG 

2 D1 23[192]22[208]BLK ACCCTTCTGACCTGAAAGCGTAAGACGCTGAG 

2 D2 22[207]20[208]BLK AGCCAGCAATTGAGGAAGGTTATCATCATTTT 

2 D3 20[207]18[208]BLK GCGGAACATCTGAATAATGGAAGGTACAAAAT 

2 D4 18[207]16[208]BLK CGCGCAGATTACCTTTTTTAATGGGAGAGACT 

2 D5 16[207]14[208]BLK ACCTTTTTATTTTAGTTAATTTCATAGGGCTT 

2 D6 14[207]12[208]BLK AATTGAGAATTCTGTCCAGACGACTAAACCAA 

2 D7 12[207]10[208]BLK GTACCGCAATTCTAAGAACGCGAGTATTATTT 

2 D8 10[207]8[208]BLK ATCCCAATGAGAATTAACTGAACAGTTACCAG 

2 D9 8[207]6[208]BLK AAGGAAACATAAAGGTGGCAACATTATCACCG 

2 D10 6[207]4[208]BLK TCACCGACGCACCGTAATCAGTAGCAGAACCG 

2 D11 4[207]2[208]BLK CCACCCTCTATTCACAAACAAATACCTGCCTA 

2 D12 2[207]0[208]BLK TTTCGGAAGTGCCGTCGAGAGGGTGAGTTTCG 

2 E1 21[224]23[223]BLK CTTTAGGGCCTGCAACAGTGCCAATACGTG 

2 E2 19[224]21[223]BLK CTACCATAGTTTGAGTAACATTTAAAATAT 

2 E3 17[224]19[223]BLK CATAAATCTTTGAATACCAAGTGTTAGAAC 
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2 E4 15[224]17[223]BLK CCTAAATCAAAATCATAGGTCTAAACAGTA 

2 E5 13[224]15[223]BLK ACAACATGCCAACGCTCAACAGTCTTCTGA 

2 E6 11[224]13[223]BLK GCGAACCTCCAAGAACGGGTATGACAATAA 

2 E7 9[224]11[223]BLK AAAGTCACAAAATAAACAGCCAGCGTTTTA 

2 E8 7[224]9[223]BLK AACGCAAAGATAGCCGAACAAACCCTGAAC 

2 E9 5[224]7[223]BLK TCAAGTTTCATTAAAGGTGAATATAAAAGA 

2 E10 3[224]5[223]BLK TTAAAGCCAGAGCCGCCACCCTCGACAGAA 

2 E11 1[224]3[223]BLK GTATAGCAAACAGTTAATGCCCAATCCTCA 

2 E12 0[239]1[223]BLK AGGAACCCATGTACCGTAACACTTGATATAA 

2 F1 23[224]22[240]BLK GCACAGACAATATTTTTGAATGGGGTCAGTA 

2 F2 22[239]20[240]BLK TTAACACCAGCACTAACAACTAATCGTTATTA 

2 

F3 20[239]18[240]P3 

ATTTTAAAATCAAAATTATTTGCACGGATTCG 

TTTCTTCATTA 

2 F4 18[239]16[240]BLK CCTGATTGCAATATATGTGAGTGATCAATAGT 

2 F5 16[239]14[240]BLK GAATTTATTTAATGGTTTGAAATATTCTTACC 

2 F6 14[239]12[240]BLK AGTATAAAGTTCAGCTAATGCAGATGTCTTTC 

2 

F7 12[239]10[240]P3 

CTTATCATTCCCGACTTGCGGGAGCCTAATTT 

TTTCTTCATTA 

2 F8 10[239]8[240]BLK GCCAGTTAGAGGGTAATTGAGCGCTTTAAGAA 

2 F9 8[239]6[240]BLK AAGTAAGCAGACACCACGGAATAATATTGACG 

2 F10 6[239]4[240]BLK GAAATTATTGCCTTTAGCGTCAGACCGGAACC 

2 

F11 4[239]2[240]P3 

GCCTCCCTCAGAATGGAAAGCGCAGTAACAGT 

TTTCTTCATTA 

2 F12 2[239]0[240]BLK GCCCGTATCCGGAATAGGTGTATCAGCCCAAT 

2 

G1 21[248]23[255]BLK 

AGATTAGAGCCGTCAAAAAACAGAGGTGAGGC

CTATTAGT 

2 

G2 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

G3 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

G4 15[256]18[256]BLK 

GTGATAAAAAGACGCTGAGAAGAGATAACCTTG

CTTCTGTTCGGGAGA 

2 G5 13[256]15[255]BLK GTTTATCAATATGCGTTATACAAACCGACCGT 

2 G6 11[256]13[255]BLK GCCTTAAACCAATCAATAATCGGCACGCGCCT 

2 G7 9[256]11[255]BLK GAGAGATAGAGCGTCTTTCCAGAGGTTTTGAA 
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2 

G8 7[248]9[255]BLK 

GTTTATTTTGTCACAATCTTACCGAAGCCCTTTA

ATATCA 

2 

G9 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

G10 

 BIOTIN 

PLACEHOLDER  see Supplementary Table 5 

2 

G11 1[256]4[256]BLK 

CAGGAGGTGGGGTCAGTGCCTTGAGTCTCTGA

ATTTACCGGGAACCAG 

2 G12 0[271]1[255]BLK CCACCCTCATTTTCAGGGATAGCAACCGTACT 

2 H1 23[256]22[272]BLK CTTTAATGCGCGAACTGATAGCCCCACCAG 

2 H2 22[271]20[272]BLK CAGAAGATTAGATAATACATTTGTCGACAA 

2 H3 20[271]18[272]BLK CTCGTATTAGAAATTGCGTAGATACAGTAC 

2 H4 18[271]16[272]BLK CTTTTACAAAATCGTCGCTATTAGCGATAG 

2 H5 16[271]14[272]BLK CTTAGATTTAAGGCGTTAAATAAAGCCTGT 

2 H6 14[271]12[272]BLK TTAGTATCACAATAGATAAGTCCACGAGCA 

2 H7 12[271]10[272]BLK TGTAGAAATCAAGATTAGTTGCTCTTACCA 

2 H8 10[271]8[272]BLK ACGCTAACACCCACAAGAATTGAAAATAGC 

2 H9 8[271]6[272]BLK AATAGCTATCAATAGAAAATTCAACATTCA 

2 H10 6[271]4[272]BLK ACCGATTGTCGGCATTTTCGGTCATAATCA 

2 H11 4[271]2[272]BLK AAATCACCTTCCAGTAAGCGTCAGTAATAA 

2 H12 2[271]0[272]BLK GTTTTAACTTAGTACCGCCACCCAGAGCCA 

 

 
Supplementary Table 5: Biotinylated staples 

No Pos. Name Sequence Mod. 

1 C02 18[63]20[56]BIOTIN ATTAAGTTTACCGAGCTCGAATTC

GGGAAACCTGTCGTGC 

5'-BT 

2 C09 4[63]6[56]BIOTIN ATAAGGGAACCGGATATTCATTAC

GTCAGGACGTTGGGAA 

5'-BT 

3 G02 18[127]20[120]BIOTIN GCGATCGGCAATTCCACACAACA

GGTGCCTAATGAGTG 

5'-BT 

4 G09 4[127]6[120]BIOTIN TTGTGTCGTGACGAGAAACACCAA

ATTTCAACTTTAAT 

5'-BT 

5 K02 18[191]20[184]BIOTIN ATTCATTTTTGTTTGGATTATACTA

AGAAACCACCAGAAG 

5'-BT 
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6 K09 4[191]6[184]BIOTIN CACCCTCAGAAACCATCGATAGCA

TTGAGCCATTTGGGAA 

5'-BT 

7 O02 18[255]20[248]BIOTIN AACAATAACGTAAAACAGAAATAA

AAATCCTTTGCCCGAA 

5'-BT 

8 O09 4[255]6[248]BIOTIN AGCCACCACTGTAGCGCGTTTTCA

AGGGAGGGAAGGTAAA 

5'-BT 
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Supplementary Table 6: Parameter for DNA-PAINT simulations 
 
Parameter Value 
kon 1715000 M-1s-1 

Imager concentration 2.5 nM 

Bright time  400 ms 

Incorporation  100 % 

Power density 1.24 kW cm-2 

Photon detection rate 30 Photons ms-1 kW-1 cm2 

Integration time 100 ms 

Frames 80000  

Pixelsize 130 nm 
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